OpenEdge® Getting Started:
Developing BPM Applications with Developer Studio
# Table of Contents

**Preface**...13
- About this documentation...13
- Information on Documentation...13
- Conventions Used in this Manual...14
- Product support contact information...15

**Chapter 1: OpenEdge Business Process Server overview**...17
- Business Process Server components...19
- How Business Process Server works...21
- Business Process Server user types...22

**Chapter 2: Introduction to Progress OpenEdge BPM Designer**...25
- Supported platforms...26
- Functions...26
  - File types...27
  - Terminology...27

**Chapter 3: Getting started with Progress Developer Studio for OpenEdge**...29
- Opening Progress Developer Studio for OpenEdge...29
- Exploring Progress OpenEdge BPM Designer...30
  - Using the menubar...31
  - Using the Tasks pane...34
  - Using the palette...36
- Using keyboard shortcuts...37
- Configuration parameters...38
- Localizing Progress Developer Studio for OpenEdge...38

**Chapter 4: Developing BPM projects**...39
- Project facets...39
  - Project facet properties...40
- Creating a BPM project...40
  - Creating a Business Process...41
  - Creating a Web application...43
  - Using common resources...44
- Exporting BPM applications...46
Importing BPM applications.................................................................47
Managing multiple processes...............................................................48
  Adding a new Business process.........................................................48
  Adding a new Web application.........................................................49
  Adding new Common Resources.....................................................49
  Converting single process BPM projects.........................................50
  Navigating multiple processes.........................................................51
Importing a process file........................................................................51
Generating OpenEdge JSDO Catalog...................................................52
  Validating dataslots using semantic annotations................................52
Using a process file as a template......................................................54
  Using a process file from recent releases........................................54
Using a project as a template...............................................................55
Creating a simulation project............................................................56

Chapter 5: Performing additional operations......................................59
  Publishing an application.................................................................59
  Managing pages................................................................................61
  Generating 360 degree view............................................................62
    Opening a subprocess...................................................................63
  Printing the process template........................................................64
  Exporting the process template.......................................................64
    Generating a process summary....................................................66
  Managing phases............................................................................68
    Creating a phase..........................................................................68
    Resizing a phase.........................................................................69
    Performing additional phase operations......................................70

Chapter 6: Rollbase Integration..........................................................71
  Rollbase as a presentation type for OE BPM....................................71

Chapter 7: Designing a process template diagram...............................73
  Creating a process template diagram...............................................73
  Changing shapes.............................................................................75
  Connecting worksteps.....................................................................76
    Using multiple connectors.........................................................77
  Adding notes...................................................................................79

Chapter 8: Managing gestures............................................................81
  Using mouse gestures......................................................................81
  Creating custom gestures...............................................................82
    Using the Gesture Editor............................................................82
## Chapter 13: Using dataslots

- Reviewing the Dataslots tab.................................................................118
- Supported dataslot types......................................................................119
- Using system dataslots........................................................................121
- Creating user-defined dataslots..............................................................122
  - Dataslot properties........................................................................123
  - Defining the dataslot description......................................................130
  - Defining the dataslot format............................................................130
  - Setting the dataslot access..............................................................133
- Exporting and importing dataslots..........................................................134
  - Exporting dataslots........................................................................134
  - Importing dataslots........................................................................136

## Chapter 14: Setting workstep properties

- About worksteps................................................................................138
- Workstep properties........................................................................139
- Defining properties of Start workstep...................................................140
  - Specifying general properties of Start workstep............................140
  - Using the Fields tab of Start workstep properties............................140
  - Using the Messaging tab of Start workstep properties.....................141
  - Using the Advanced tab of Start workstep properties......................142
- Defining properties of Activity worksteps..............................................142
  - Specifying general properties of Activity workstep.........................142
  - Using Fields tab of Activity workstep properties............................144
  - Defining collaboration tasks............................................................145
  - Using Advanced tab of Activity workstep properties......................146
- Defining properties of Adapter worksteps..............................................150
  - Specifying general properties of Adapter workstep.........................150
  - Using the Dataslots tab of Adapter workstep properties...................151
  - Using the Advanced tab of Adapter workstep properties..................153
- Defining properties of Subprocess worksteps........................................153
  - Parent Process: Subprocess interaction..........................................154
  - Specifying general properties of Subprocess workstep...................154
  - Using the Dataslot tab of Subprocess workstep properties...............155
  - Using the Advanced tab of Subprocess workstep properties.............157
- Defining properties of Message worksteps..........................................157
  - Specifying general properties of Message workstep.........................158
  - Using the Dataslots tab of Message workstep properties..................158
  - Using the Messaging tab of Message workstep properties...............158
  - Other Message workstep properties..............................................159
- Defining properties of End worksteps..................................................159
  - Using the Messaging tab of End workstep properties.......................159
Chapter 15: Introducing monitoring process.................................171

Introduction..................................................................................171
Supported events............................................................................172
Designing a monitoring process........................................................172
Configuring monitoring workstep......................................................173
Using dataslots...............................................................................176
Using process refresh.......................................................................177
Simulating a monitoring process.......................................................177

Chapter 16: Defining workstep presentation format.......................179

Defining workstep presentation for Business Processes..................180
Defining Auto-generated HTML presentations....................................182
Defining custom presentations.........................................................182
Defining Flow presentations.............................................................183
Defining Mobile presentation..........................................................185
Defining Rollbase presentation.........................................................186
Defining GUI presentation...............................................................187
Defining Tablet presentation............................................................188
Defining Other presentation.............................................................188
Defining workstep presentations for Web applications.....................189
Using the Auto-generated presentation............................................190
Using the custom presentation.........................................................190
Customizing presentation pages.......................................................190
Chapter 17: Using alerts

- Reviewing the Alerts tab ................................................................. 195
- Defining an alert .............................................................................. 196
- Associating an alert with a workstep ........................................... 197
- Associating an alert with an overdue action ................................. 198

Chapter 18: Working with Graphical Event Logic tool

- Benefits .......................................................................................... 199
- Exploring the GEL tool ................................................................. 200
- Using the GEL tool in BPM projects ............................................ 201
  - GEL Actions in BPM projects ..................................................... 201
  - Adding data operations ............................................................. 201
  - Adding value expressions ......................................................... 202
  - Adding control structures and custom script ........................... 203
- Using JSTools API .......................................................................... 205
- Other GEL tool operations .......................................................... 206
- Adding information to action blocks .......................................... 206
- Customizing GEL Actions ............................................................ 206

Chapter 19: Using the Servers view

- Creating a server ............................................................................ 213
- Adding server runtime environment ......................................... 215
- Creating a Business Process Cluster Server ............................... 216
  - Adding server runtime environment ....................................... 217
- Opening Servers view .................................................................. 217
  - Copying modules ....................................................................... 218
  - Publishing project modules ..................................................... 219

Chapter 20: Configuring and running simulation

- Designing a simulation ................................................................. 222
  - Adding a process ........................................................................ 223
  - Simulation constraints .............................................................. 223
- Exploring the Progress OpenEdge BPM Simulation perspective ... 224
- Configuring a simulation scenario .............................................. 225
  - Adding a scenario ...................................................................... 225
  - Modifying simulation settings for a scenario ........................... 226
  - Importing and exporting a scenario ......................................... 226
  - Configuring simulation parameters for a process ..................... 228
- Managing performers ................................................................. 232
- Managing resources ...................................................................... 233
### Defining objectives
- Setting calendar: 234
- Performing other operations: 236
- Choosing a randomization method: 236
- Specifying a date: 237
- Validating the simulation project: 238
- Running a process simulation: 239
- Viewing process information: 241
- Viewing project information: 243
- After completion of simulation: 245
- Generating a simulation report: 246
- Viewing simulation report details: 247
- Adding custom reports: 248
- Comparing simulation results: 249

### Chapter 21: Configuring dashboard widgets
- Using the Widgets Configuration tool: 251
- Enabling Google gadgets: 255

### Chapter 22: Working with User Management tool
- Types of members: 259
- Starting User Management tool: 260
- Printing organization chart: 261
- Managing nodes: 261
  - Managing users: 261
  - Managing groups: 262
  - Managing queues: 263
- Importing users: 264

### Chapter 23: Working with Business Calendar
- Understanding the Business Calendar: 265
- Using the Business Calendar tool: 266
  - Managing calendars: 266
  - Managing schedules: 266
  - Overwriting a schedule: 267

### Chapter 24: Managing messages and channels
- Using the Message Manager: 269
  - Defining the message template: 270
  - Defining the message header: 270
  - Defining payload properties: 270
  - Defining message correlation: 271
## Contents

- Exporting and importing messages................................................................. 271
- Using the Channel Manager............................................................................ 272
- Exporting and importing channels................................................................. 273

### Chapter 25: Managing business objects.................................................. 275
- Using the Business Object Manager.............................................................. 275
  - Importing business objects........................................................................ 277
  - Exporting a business object....................................................................... 279
  - Generating business objects..................................................................... 279
- Using business objects in applications....................................................... 280
  - Using business objects in a link............................................................... 280
  - Using business objects in scripts............................................................ 280

### Chapter 26: Using Managed Adapter Browser........................................... 283
- Using the Managed Adapter Browser......................................................... 283
  - Preconfiguring managed adapters.......................................................... 284

### Chapter 27: Defining rules with Rule Wizards.......................................... 287
- Accessing Rule Wizards............................................................................... 289
- Using the New Rule wizard......................................................................... 289
- Using the Schedule Rule wizard................................................................. 290
- Using the Process Path Rule wizard........................................................... 292
- Using the Time-Out Rule wizard............................................................... 294
- Using the Monitoring Rule wizard.............................................................. 296
- Using the Business Metric Rule wizard...................................................... 297
- Using the Decision Counter Rule wizard.................................................... 299
- Using the Task Assignment Rule wizard.................................................... 301
- Using the Process Control Rule wizard...................................................... 303
- Using the File Poller Rule wizard.............................................................. 304

### Chapter 28: Managing changes in Business Processes............................. 307
- Managing changes through Process Refresh............................................. 307
  - Criteria for changes in Process Refresh.................................................. 308
Preface

For details, see the following topics:

• About this documentation
• Information on Documentation
• Conventions Used in this Manual
• Product support contact information

About this documentation

This guide provides documentation for Progress OpenEdge BPM Designer.
BPM Designer provides a graphical, integrated development environment where business executives, solution providers, IT professionals and Web designers can collaboratively create executable processes.

Information on Documentation

This documentation contains information for the following types of Progress OpenEdge Business Process Server users. In the following table, we recommend the guides that are most relevant to each type of user.
Table 1: Documentation

<table>
<thead>
<tr>
<th>If you are the …</th>
<th>Read the …</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application User</td>
<td>BPM Studio User's Guide</td>
</tr>
<tr>
<td></td>
<td>BPM Events User's Guide</td>
</tr>
<tr>
<td></td>
<td>Terminology Guide</td>
</tr>
<tr>
<td></td>
<td>Tutorial Guide</td>
</tr>
<tr>
<td>Application Developer</td>
<td>Application Developer’s Guide</td>
</tr>
<tr>
<td></td>
<td>BP Server Developer’s Guide</td>
</tr>
<tr>
<td></td>
<td>Customization Guide</td>
</tr>
<tr>
<td></td>
<td>Managed Adapters Guide</td>
</tr>
<tr>
<td></td>
<td>Web Services Developer’s Guide</td>
</tr>
</tbody>
</table>

For the latest documentation updates, see OpenEdge Product Documentation on PSDN.

Conventions Used in this Manual

This document uses the following conventions and terminology notations to distinguish elements of text:

Table 2: Conventions in this Manual

<table>
<thead>
<tr>
<th>Convention (styles and terms)</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>bold</td>
<td>Indicates titles of command buttons, checkboxes, options, lists, dialog boxes and portal page names.</td>
</tr>
<tr>
<td>bold italic</td>
<td>Represents notes that alert you on specific Business Process Server elements and similar advisory information.</td>
</tr>
<tr>
<td>italic</td>
<td>Indicates folder paths, file names and book titles.</td>
</tr>
<tr>
<td>monospace</td>
<td>Represents code segments or examples.</td>
</tr>
<tr>
<td>backward slash ()</td>
<td>Indicates the path in a Windows environment. For UNIX, a forward slash is used.</td>
</tr>
<tr>
<td>OEBPS_Home</td>
<td>Represents the installed folder of Business Process Server that contains essential components and files. The default location is C:\Progress\OpenEdge\oebpm\server.</td>
</tr>
</tbody>
</table>
### Purpose

<table>
<thead>
<tr>
<th>Convention (styles and terms)</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Studio_Home</td>
<td>Represents the installed folder of BPM Designer that contains essential components and files. The default location is <code>C:\Progress\OpenEdge\oebpm\studio</code>.</td>
</tr>
<tr>
<td>Workspace_Home</td>
<td>Represents the Workspace folder of Progress Developer Studio for OpenEdge. The default location is <code>C:\Users\&lt;user_name&gt;.&lt;user_domain&gt;\Progress\Developer Studio 3.7\workspace</code>.</td>
</tr>
</tbody>
</table>

### Product support contact information

If the product documentation does not provide a solution to your specific issue, or if you need clarification on the issue, then contact our Product Support team. You can contact the team through the Internet, telephone, or postal mail, as per the details provided in the following table.

**Table 3: Product Support Contact Information**

<table>
<thead>
<tr>
<th>To contact by</th>
<th>Use</th>
</tr>
</thead>
</table>
| Web site      | [http://progresslink.progress.com/supportlink](http://progresslink.progress.com/supportlink)  
If you are an existing customer, then you can log in to the above site for product support. If you are a first-time user, then you need to create an account first. |
| Telephone¹    | 1-781-280-4999 for US, Latin America and Canada  
1-781-280-4543 for the Product Support Fax Line |
| Postal Address¹ | Progress Software Corporation  
14 Oak Park Drive  
Bedford, MA 01730, USA. |

To enable us to quickly answer your questions, please provide the following information:

- Your name, installation site address, and the license key for Business Process Server software.
- Your Business Process Server version and build number.
- Your operating system, application server, and browser, with version and service pack details, if any.
- Your database management system, version, and information on JVM and JDBC used.

¹ For support telephone numbers and offices in your region, visit the support website above. This contact information is for customer support only.
OpenEdge Business Process Server overview

Progress Software Corporation is a leading global provider of automated business process management solutions. The company’s product, Progress OpenEdge Business Process Server (henceforth referred to as Business Process Server or BP Server), is a comprehensive business process management platform, which enables companies to quickly transform their business processes into flexible and manageable Web applications, distributed over intranets, extranets, and the Internet.
Business Process Server addresses every stage in the business life cycle: define, integrate, publish, monitor, analyze, improve, and control. By adopting an end-to-end approach, Business Process Server incorporates all the key elements required to meet the ever-changing demands of e-business while ensuring e-business success. By providing integrated management tools, Business Process Server lets you monitor operations proactively, modifying automated processes dynamically based on changing external operations online. An overview of a typical automated business process management solutions is shown in Figure 1: Business Process Server overview on page 18.

Figure 1: Business Process Server overview

For details, see the following topics:

• Business Process Server components
• How Business Process Server works
• Business Process Server user types
Business Process Server components

Business Process Server is a suite of integrated components that enables you to easily build intranet, extranet, and Internet applications and manage your e-business. Business Process Server consists of the following components as in Figure 2: Business Process Server components on page 19:

Figure 2: Business Process Server components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Process Portal Home</td>
<td>The Home module of Business Process Portal is the primary interface for application users, enabling them to interact with Business Process Server applications. Users can complete entries to various tasks and applications, and link to the support infrastructure required to complete these tasks.</td>
</tr>
<tr>
<td>Business Process Portal Management</td>
<td>The Management module enables managers to query, report on, and control processes and resources, visible only to the managers.</td>
</tr>
<tr>
<td>Business Process Portal Administration</td>
<td>The Administration module enables Business Process Server Administrators to modify configuration parameters, manage user or group access control, and install or uninstall Business Process Server applications.</td>
</tr>
</tbody>
</table>

Table 4: Business Process Server components
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web services</td>
<td>This component allows application developers to: publish their applications as Web services, and find and convert other available Web services on the Internet into Business Process Server applications.</td>
</tr>
<tr>
<td>BPM Webflow</td>
<td>This component provides a framework for developing and implementing Web-enabled workflow applications.</td>
</tr>
<tr>
<td>Progress Developer Studio for OpenEdge</td>
<td>This is the primary application development tool for Business Process Server, which provides an Eclipse-based integrated development environment in which users can create BPM projects, processes, Web applications, and rule files.</td>
</tr>
<tr>
<td>Business Process Modeler</td>
<td>This tool is used to design templates for basic business processes, and to run simulations of processes and individual worksteps.</td>
</tr>
<tr>
<td>BP Server</td>
<td>This is a flexible, lightweight, scalable workflow process engine for intranets, extranets, and the Internet.</td>
</tr>
<tr>
<td>BPM Events</td>
<td>This open, event-driven rule engine is used to formulate and enforce policies in business applications.</td>
</tr>
</tbody>
</table>
How Business Process Server works

The following figure provides an overview of the interaction between Business Process Server components. Figure 3: How Business Process Server works

The following explanations correspond to the labels shown in the above figure, and describe how the components operate.

1. Progress Developer Studio for OpenEdge and Business Process Modeler provide an integrated development environment (IDE) for Business Process Server, where you can design and publish business processes. The application developer designs a process template (with the *.spt or *.swt extension) in the IDE that reflects the business flow and other business process requirements. Business rules for the process template can be defined using the Rule Editor, a BPM Events component that is launched with Progress Developer Studio for OpenEdge.


3. Once the process template is defined, Business Process Server Administrators use the Administration module to install the business process on the BP Server. Administrators can also configure Business Process Server components, manage user or group access control, and publish Business Process Server applications as Web services. Once installed, users access applications through servlets that pass the requests over an RMI/IIOP connection to the BP Server within an EJB Container.
4. The EJB Container provides a runtime environment that executes and manages Java-based program components that run on the server side of a client/server network. Within the EJB Container are the BP Server and BPM Events server.

5. The BP Server writes events to event tables in the database. Each Business Process uses JDBC to connect to database server as well as store events in the database. Within the BP Server, BPM Process Store uses JDBC to connect to the database server process and retrieve the events deposited by the BP Server process. BPM Process Store interprets the events and populates the process tables. These populated tables are used by Business Process Portal modules.

6. Once the process template is installed as a Business Process Server application, application users can use the Home module to do the following:
   - Access applications
   - Obtain information to perform their tasks
   - Launch the application to start process instances from the BP Server

7. Once the process template is installed as an Business Process Server application, managers can use the Management module (if they have access privileges) to monitor execution of process instances and create reports. Servlets receive requests from managers and pass them onto the BP Server over an RMI/IIOP connection. Managers use the Report Builder to define management reports that retrieve information through JDBC to the database server.

8. BPM Events is a rule-based event or message processing server that loads application rules and executes them against the BP Server and/or external events or messages. This server persists data in the database for recovery and with the help of JDBC connects to the database.

9. Managed Adapters exchange information between Business Process Server applications and external applications by converting Business Process Server-specific protocol to the protocol of an external system such as a database or ERP system. When users add a Managed Adapter to a work step, they can define complex mapping between Business Process Server dataslots and adapter inputs or outputs of the external application. At runtime when the work step is executed, the Managed Adapter sets the adapter inputs and configuration, and maps the outputs to the appropriate output dataslots.

10. BPM Webflow is a run-time component that executes the presentation flows. This component provides a Model, View, Controller (MVC) paradigm for developing presentation flow-based applications and executing them in a Web container.

11. Business Process Servers Web services component allows BP Server applications to be published as Web services.


Business Process Server user types

There are four user types within Business Process Server, Application users, Managers, Application developers, Business Process Server administrators.

User types

Each Business Process Server user type is defined below:

- **Application users** — Application Users use Business Process Server applications to coordinate specific business tasks with another department within their company, with another company within their organization,
and/or with a business partner in another organization. The Home module in Business Process Portal serves as the primary interface in which Application Users run Business Process Server applications.

- **Managers** — Managers are typically experts in a particular business domain, such as quality assurance or human resources. They might need to work with managers from other groups in automating some of the business procedures that these groups share. The Management module in Business Process Portal serves as the primary Business Process Server interface for business managers to coordinate and integrate business processes, enabling them to exchange information with one another, and to share functionality over such standard communication channels as the Internet or e-mail.

- **Application developers** — Application developers are responsible for analyzing business processes and developing interfaces associated with creating tasks or processes. Application developers are often not domain experts themselves, but work closely with Managers to define business processes and determine the requirements of an application. Application developers use Progress Developer Studio for OpenEdge or Business Process Modeler to define the business process; the resulting process template file is tested, simulated, published, and run as a Business Process Server application.

- **Business Process Server administrators** — Business Process Server administrators are responsible for configuring Business Process Server components, managing user or group profiles and access control, and installing or uninstalling Business Process Server applications. The Administration module in Business Process Portal serves as the primary interface for Business Process Server Administrators to administer applications.

All Business Process Server user types can communicate by using one or more Business Process Server applications. They can also communicate with external applications.
Introduction to Progress OpenEdge BPM Designer

This chapter introduces OpenEdge BPM Designer in Progress Developer Studio for OpenEdge (henceforth also referred to as BPM Designer or Progress Developer Studio for OpenEdge), which enables you to develop process templates and publish them as Business Process Server applications, without exiting the development environment.

BPM Designer uses the Eclipse-based Integrated Development Environment (IDE), a comprehensive cross-platform environment which provides stable, universal platform for application development. This open, scalable, and standards-based development environment reduces the time spent in application development and supports a user’s choice of version control system and application server. The current version of BPM Designer is based on the Eclipse Foundation SDK (version 3.6.0) integrated development environment.

BPM Designer enables you to integrate the various files contained in a typical project, and to develop an entire project within a single development environment. After developing your project, use the Publish wizard to install it on the Business Process Server, to provide a connection with Web services and other Business Process Server users.

Note: Progress Software Corporation also provides the Business Process Modeler, a more basic version of Progress BPM Designer. For more information, see the Business Process Modeler User’s Guide.

For details, see the following topics:

- Supported platforms
- Functions
- Terminology
Supported platforms

BPM Designer has been extensively tested on the platforms, tools, and applications supported by Business Process Serve. Table 5: Supported Platforms on page 26 provides the supported platforms.

Table 5: Supported Platforms

<table>
<thead>
<tr>
<th>Category</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Process Server</td>
<td>This Progress Developer Studio for OpenEdge version is designed to work with Business Process Server components.</td>
</tr>
<tr>
<td>Version</td>
<td></td>
</tr>
</tbody>
</table>

Functions

Progress Developer Studio for OpenEdge enables you to perform a variety of functions without exiting the Eclipse environment. For example, you can:

- Design a business process using the worksteps, connectors and other process template elements provided in the BPM Designer user interface. A process template must contain a Start workstep, intermediate worksteps that can include Activity, Adapter and Subprocess worksteps, and one or more End worksteps.

- Define performers and resources for the new process. These process-level performers and resources are available for each instance of the process.

- Assign performers and resources to worksteps. Types of performers include the following:
  - Individual users, groups of users, or queues that perform activity worksteps.
  - Adapters that perform Adapter worksteps.
  - Other processes that act as performers of Subprocess worksteps.

- Define the information flow for the new process by creating dataslots that can provide information into (input) or out of (output) worksteps.

- Configure and run simulations of the process to analyze performer and resource usage, to identify repetitive loops and inefficient bottlenecks, and to predict process performance. BPM Designer also enables you to generate a report on the simulation results in HTML format.

- Define common resources, including business objects, customized adapters and stylesheet files, which can be accessed from and used in all BPM Designer applications.

- Generate rules for a selected workstep or process by either creating new rules, using the Rule Editor, or using Rule Wizards provided by BPM Designer that you can use as templates for building your own rules.

- Save the process to your local server after completing process design.

- Publish a process as an installed application on the Business Process Server.
File types

To integrate Business Process Server file editors with the Eclipse-based IDE, Progress Developer Studio for OpenEdge provides the following new file types:

- SPT - Use this Business Process Template (.spt) extension when you can create a BP Server application by defining a process template that is designed to automate a business process.
- SWT - Use this Business Webapp Template (.swt) extension when you create a Web application that defines a Web-enabled business process.
- BPS - Use this BPM Events Source (.bps) extension when you want to create a rule file in the Rule Editor in BPM Designer.

Terminology

Before starting application development in Progress Developer Studio for OpenEdge, familiarize yourself with basic terms and concepts, provided in Table 6: Business Process Server Terminology on page 27. See the Glossary for additional definitions of commonly used terms. For the complete list of Business Process Server terminology, see the OpenEdge Business Process Server: Terminology guide.

Table 6: Business Process Server Terminology

<table>
<thead>
<tr>
<th>Concept or Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Process</td>
<td>A business process involves multiple worksteps in the form of operations, interactions, and notifications performed by a human user or group of users; an external adapter or a script; or other processes.</td>
</tr>
<tr>
<td>Business Process Server Application</td>
<td>A Business Process Server application is an installed, executable business process template that automates a business flow.</td>
</tr>
<tr>
<td>Process Template</td>
<td>A process template is a model of business flow that includes worksteps, connections, and dataslots. The process template describes the information and data flow of a business process. Process template files are stored in SPT, SWT or XML format. After being published and installed, the process template files are available as Business Process Server applications.</td>
</tr>
<tr>
<td>Business Logic</td>
<td>The control and information flow among worksteps that define a business process.</td>
</tr>
<tr>
<td></td>
<td>• Control Flow - The sequences of worksteps and workstep conditions, as defined in the process template.</td>
</tr>
<tr>
<td></td>
<td>• Information Flow - The definition of process dataslots and the addition of information from dataslots of a workstep.</td>
</tr>
<tr>
<td>Concept or Term</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Process Instance   | A running instance of a Business Process or a Web application. A process instance is created every time you run an application. A process instance has the following characteristics:  
  • Each instance is a self-contained unit and can be modified dynamically at runtime without modifying the process template.  
  • Each instance is uniquely identified by a name within the system.  
  **Note:** Multiple instances of the same application are created by running the application several times. |
| Subprocess         | A process template referenced in a parent process template. Any process template can be included as a subprocess within another process template by using a Subprocess workstep.                                       |
| Workstep           | A step in a business process that can have human or computer performers; or it can be a subprocess. Worksteps in BPM Designer include **Start**, **Activity**, **Adapter**, **Subprocess**, and **End** worksteps.                                          |
| Connector (or Link) | A connection between two worksteps used to describe the control flow of a process.                                                                                                                                                              |
| Performer          | An entity that executes a workstep. Depending on the workstep type, the performer can be a User (a human performer or a group of human performers), an Adapter (an external application or system), or a Subprocess.                                      |
| Dataslot           | A data placeholder that persists through the entire process, used to define the information flow of the business process. Dataslots are associated with processes, where they can add information into (input) or out of (output) worksteps.             |
| Adapter            | A Java class that integrates remote, third-party classes and actions with Business Process Server. An adapter can automate certain functions or tasks performed by a remote server or an external system.               |
Getting started with Progress Developer Studio for OpenEdge

This chapter helps you get started with Progress Developer Studio for OpenEdge, and introduces you to its interface elements and frequently used commands.

For details, see the following topics:

- Opening Progress Developer Studio for OpenEdge
- Exploring Progress OpenEdge BPM Designer
- Using keyboard shortcuts
- Configuration parameters
- Localizing Progress Developer Studio for OpenEdge

Opening Progress Developer Studio for OpenEdge

Progress Developer Studio for OpenEdge enables you to use an Eclipse-based Integrated Development Environment (IDE) to create business processes, which are administered as BPM project files. The IDE project includes all Business Process files (SPT files), Web application files (SWT files), and rule files (BPS files), as well as the folder structure containing those files, their paths, settings, and required resources.

These files and resources are used to load, save, build, or run a project. The project is an organizational tool: the files you open in a project can be in any folder. Restructuring a project tree has no effect on a folder tree, providing independent control of projects and folder structure.
To open Progress Developer Studio for OpenEdge:

1. From the Start menu, select Programs > Progress > Developer Studio.

2. Use the Workspace Launcher dialog box to select a workspace which you can use to create or modify business processes.
   
a) Click Browse to open the Select Workspace Directory dialog box that enables you to locate another workspace folder. Click Make New Folder to create a new workspace folder at the selected location.
   
b) Select the Use this as the default... checkbox to automatically launch the workspace displayed in the Workspace list and to make it the default workspace. Selecting this check box prevents this dialog box from appearing the next time you start Progress Developer Studio for OpenEdge. If you want to re-activate the Workspace Launcher dialog box, click Preferences from the Window menu, and select General > Startup and Shutdown > Workspaces, and then select the Prompt for workspace on startup checkbox.
   
c) Click OK to open Progress Developer Studio for OpenEdge in the workspace shown in the Workspace drop-down list. Once you have selected a workspace, you can later open the Workspace Launcher dialog box by selecting File > Switch Workspace.

After you have selected your workspace, the Welcome page appears if you are opening Progress Developer Studio for OpenEdge for the first time.

Exploring Progress OpenEdge BPM Designer

This section describes the OpenEdge BPM Designer user interface including its panes, menus, and toolbars. The commonly used views and components in the OpenEdge BPM Designer interface are described in the following table:

Table 7: OpenEdge BPM Designer Window Components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu bar</td>
<td>The Menu bar provides access to both Eclipse and OpenEdge BPM Designer development functions. For details, see Using the menubar on page 31.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>The Toolbar contains icons providing shortcuts to commonly used functions. The Toolbar includes both Eclipse and OpenEdge BPM Designer toolbar commands.</td>
</tr>
<tr>
<td>Project Explorer View</td>
<td>The Project Explorer View displays the contents of active projects. It consists of a hierarchical view of all the files that make up the active project.</td>
</tr>
<tr>
<td>Palette</td>
<td>The bar above the Content pane contains icons for selecting, connecting, grouping, and moving the elements in the process template diagram. For details, see Using the palette on page 36.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Outline View</td>
<td>The Outline view provides the following options to view the current process. Click the drop-down list provided and then select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Process</strong>, which lists the worksteps in the current process template.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Performers</strong>, which displays the performers assigned to each activity and adapter worksteps.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Rules</strong>, which displays the rules assigned to the process or to worksteps in the process displayed in the Content pane.</td>
</tr>
<tr>
<td></td>
<td>You can use the adjoining <strong>Search</strong> box to search for a process, workstep, performer, or rule.</td>
</tr>
<tr>
<td>Tasks pane</td>
<td>The Tasks pane contains seven options: Select and Change Layout, Create Phases and Swim Lanes, Draw Shapes, Connect Shapes, Assign Participants, Create Rules, Create Annotations. These options help you in the design of a process template. For details, see <strong>Using the Tasks pane</strong> on page 34.</td>
</tr>
<tr>
<td>Content pane</td>
<td>The Content pane contains the main work space in which the selected project or file is displayed. The Content pane also contains:</td>
</tr>
<tr>
<td></td>
<td>• <strong>File tabs</strong>, located at the top of the pane, which shows active files in the current project. Click on a File tab to display the file in the Content pane.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Content pane tabs</strong>, located at the bottom of the pane, which include the <strong>Diagram</strong> tab, displaying the process template; the <strong>Overview</strong> tab, which displays the process elements in a tabular format; the <strong>Path Analysis</strong> tab, in which you can perform process path analysis; the <strong>Dataslots</strong> tab, in which you can define process dataslots; the <strong>Performers</strong> tab, in which you can define performers at the process level; the <strong>Alerts</strong> tab to define and manage Alerts; and the <strong>Logic</strong> tab, which contains the Graphical Event Logic (GEL) tool to configure defined events.</td>
</tr>
<tr>
<td></td>
<td>• An arrow, at the bottom right corner of the Content pane, provides a bird’s eye view of the entire process template in a 3x3 grid. You can drag the purple box (showing the current process view) to navigate to a specific process view location.</td>
</tr>
<tr>
<td>Properties View</td>
<td>Click your cursor in a blank spot in the diagram to view process properties. You can also click a workstep to view the properties of any selected workstep.</td>
</tr>
</tbody>
</table>

**Note:** All views can be moved to various locations within the user interface. Click the view’s tab and drag it to a location you want to move it to.

**Using the menubar**

This section describes the frequently used menu commands.
Using Eclipse menu commands

Eclipse menu commands that are frequently used in Progress Developer Studio for OpenEdge are shown in Table 8: Eclipse Menu Commands Used in Progress Developer Studio for OpenEdge on page 32. Other menu items in this Eclipse-based environment operate in the standard Eclipse manner, and are not covered in this document. Refer to the Eclipse tutorials or Help topics provided in the Help menu in the Toolbar, or documentation available at the Eclipse Web site (http://www.eclipse.org/) for more details on their usage.

Table 8: Eclipse Menu Commands Used in Progress Developer Studio for OpenEdge

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon and Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>File &gt; New &gt; Project</td>
<td>Opens the <strong>New Project</strong> dialog box. Expand the <strong>BPM</strong> node and click the appropriate options for BPM Project, Business Process, or BPM Simulation Project.</td>
</tr>
<tr>
<td>Open</td>
<td>File &gt; Open File</td>
<td>Opens the <strong>Open File</strong> dialog box, where you can select the process or project file you want to open.</td>
</tr>
<tr>
<td>Save</td>
<td>File &gt; Save</td>
<td>Saves the changes made to the active project and files since the last Save. Click File &gt; Save All to save changes made on all open projects.</td>
</tr>
<tr>
<td>Print</td>
<td>File &gt; Print</td>
<td>Opens the <strong>Print</strong> dialog box, enabling you to print the process template and define its printing properties.</td>
</tr>
<tr>
<td>Build All</td>
<td>Project &gt; Build All</td>
<td>Runs an incremental build on all projects in the Eclipse workspace, modifying only those resources that have been changed since the last build.</td>
</tr>
<tr>
<td>Build Project</td>
<td>Project &gt; Build Project</td>
<td>Builds the currently selected project. This is an incremental build, meaning that the builder analyzes the changes since the last build and minimizes the number of changed files.</td>
</tr>
<tr>
<td>Open Perspective</td>
<td>Window &gt; Open Perspective</td>
<td>Opens a new perspective in Eclipse.</td>
</tr>
</tbody>
</table>

Using commands

In addition to Eclipse menu items, Table 9: Progress Developer Studio for OpenEdge Commands on page 33 describes the commonly-used commands available in the **OpenEdge BPM Designer** perspective.
Table 9: Progress Developer Studio for OpenEdge Commands

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon and Shortcut</th>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import</td>
<td></td>
<td>File &gt; Import</td>
<td>Imports external projects and extracts archive files.</td>
</tr>
<tr>
<td>Process Properties</td>
<td>ALT + ENTER</td>
<td>File &gt; Properties</td>
<td>Enables you to define the current process properties.</td>
</tr>
<tr>
<td>Undo</td>
<td>CTRL + Z</td>
<td>Edit &gt; Undo</td>
<td>Undoes or recreates the last action performed in the Content pane, up to 100 levels. Supports lane, shape, connector and cut/copy/paste operations, as well as Align, Space and Collapse operations. <strong>Caution:</strong> If an operation that cannot be undone is performed, the undo queue is cleared and the previous operations cannot be undone.</td>
</tr>
<tr>
<td>Redo</td>
<td>CTRL + Y</td>
<td>Edit &gt; Redo</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL + C</td>
<td>Edit &gt; Copy</td>
<td>Copies a selected item to the clipboard. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Paste</td>
<td>CTRL + V</td>
<td>Edit &gt; Paste</td>
<td>Pastes the clipboard items in the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Cut</td>
<td>CTRL + X</td>
<td>Edit &gt; Cut</td>
<td>Cuts a selected item from the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Show a View</td>
<td></td>
<td>Window &gt; Show View</td>
<td>Select one of the listed options to show the view.</td>
</tr>
<tr>
<td>Build Module</td>
<td></td>
<td>Project &gt; Build Module</td>
<td>Build the currently selected process (or module) in a BPM project. This is useful if you want to build and publish a single module in a project with multiple processes,</td>
</tr>
<tr>
<td>Build Modules</td>
<td></td>
<td>Project &gt; Build Modules</td>
<td>Builds multiple processes (or modules) contained in a single BPM project or across multiple BPM projects.</td>
</tr>
<tr>
<td>Publish</td>
<td></td>
<td>Project &gt; Publish</td>
<td>Publishes the current project on the Business Process Server.</td>
</tr>
<tr>
<td>Properties</td>
<td></td>
<td>Project &gt; Properties</td>
<td>Displays the properties of the active project.</td>
</tr>
<tr>
<td>Widgets Configuration</td>
<td></td>
<td>Tools &gt; Widgets Configuration Tool</td>
<td>Enables you to define, copy, or modify widgets that are used in Business Process Portal.</td>
</tr>
<tr>
<td>Users</td>
<td></td>
<td>Tools &gt; Users</td>
<td>Enables you to add and manage users, groups, and queues.</td>
</tr>
<tr>
<td>Calendars</td>
<td></td>
<td>Tools &gt; Calendars</td>
<td>Enables you to define an organization-level calendar.</td>
</tr>
<tr>
<td>Channels</td>
<td></td>
<td>Tools &gt; Channels</td>
<td>Enables you to create, import, export, or modify channels.</td>
</tr>
</tbody>
</table>
### Name | Icon and Shortcut | Menu | Description
--- | --- | --- | ---
Messages |  | Tools > Messages | Enables you to create, import, export, or modify messages.
Business Objects |  | Tools > Business Objects | Enables you to create, import, export, or modify business objects.
Managed Adapters |  | Tools > Managed Adapters | Manages various configurations on out-of-the-box and user-defined managed adapters.
Help |  | Help > Help Contents | Launches Eclipse Help which assists you with application development in Progress Developer Studio for OpenEdge.

### Using the Tasks pane

The Tasks pane contains primarily the **Design Tasks** panel, which lists the links used when designing your process template diagram. Clicking any of these links displays the associated panel; for instance, the **Layout Tasks** panel and the **Description** panel for the **Select and Change Layout** link.

**Note:** To hide the Tasks pane, click the adjoining **Hide** icon ( ). To view the Tasks pane again, click the **Show** ( ) icon. You can also expand (and then collapse) any of the panels. To expand a panel, click the **Expand** ( ) icon. To collapse a panel, click the **Collapse** ( ) icon. Alternatively, you can expand (or collapse) a panel by clicking the panel header.

- **Select and Change Layout.** Enables you to align and space process template elements and apply auto-layout. For more information, see [Aligning and spacing worksteps](#) on page 170.
- **Create Phases and Swim Lanes.** Enables you to add a phase or swim lane to the process template diagram. For more information, see [Creating swim lanes](#) on page 113. This option is not available for Web applications.
- **Draw Shapes.** Lists the worksteps and other process template elements (Start, Activity, Decision, Or-Join, End, etc.) that you can drag into the Content pane to create the workflow for your process. For more information, see [Using shapes](#) on page 35.
- **Connect Shapes.** Enables you to draw connections between process template elements. The **Connect Tasks** panel show three types of connectors - Normal flow, Compensation flow, Timeout flow - that you can use to connect worksteps. If the connection is not valid, the connection cursor is displayed in red. Once you select a connector type, you can continue to make connections. To discontinue connecting, click any other Tasks pane link. For more information, see [Connecting worksteps](#) on page 76.
- **Assign Participants.** Displays the performers grouped under 4 categories: Users, Adapters, Sub-Processes, and External. By default, performers include organization-level users and a predefined user, "Creator" for a Business Process, as well as a group of predefined managed adapters and a custom adapter. You can use this link to add, delete or modify the properties of a performer. For more information, see [Defining performers](#) on page 105.
- **Create Rules.** Displays a series of predefined rule wizards. Expand a folder to view its rule wizards. Assign a predefined set of rules to a workstep or a process by dragging the rule wizard icon to the selected target.
For more information, see Accessing Rule Wizards on page 289. This option is not available for Web applications.

- **Create Annotations.** Enables you to add an Annotation, Sticky Note, or a Group notation to the process template diagram. For more information, see Adding notes on page 79.

**Note:** For a brief description of how to use each of these links, expand the Description panel.

### Using shapes

The table below provides information about the Shapes listed when you click the Draw Shapes link in the Tasks pane. These shapes follow standard Business Process Modeling Notation (BPMN) and include Activities (represented by a rounded rectangle); event objects such as Start or End (represented by a circle); and Gateways (represented by a diamond) that indicate a change in the workflow, such as the joining, merging, splitting, or deciding of the flow’s direction.

**Table 10: Shapes in Tasks Pane**

<table>
<thead>
<tr>
<th>Shape</th>
<th>Represents</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Start" /></td>
<td>Start</td>
<td>An event object that specifies the beginning of a business process. Each process must have only one Start workstep.</td>
</tr>
<tr>
<td><img src="image" alt="Activity" /></td>
<td>Activity</td>
<td>This activity represents the basic unit of work that you can assign to one of the following performer types: User (a valid human performer or group), Adapter, or Subprocess.</td>
</tr>
<tr>
<td><img src="image" alt="Decision" /></td>
<td>Decision</td>
<td>This gateway represents a decision point in the process flow. If the specified condition is not met, the default branch is taken.</td>
</tr>
<tr>
<td><img src="image" alt="Exclusive Or-Join" /></td>
<td>Exclusive Or-Join</td>
<td>This gateway enables the process flow to proceed only once from multiple previous worksteps to a next workstep, and terminates any other human-performed previous worksteps. This shape is not available for Web Applications.</td>
</tr>
<tr>
<td><img src="image" alt="Or-Join" /></td>
<td>Or-Join</td>
<td>This gateway connects multiple predecessor worksteps and one successor workstep. The successor workstep is performed if any of the predecessor worksteps have been completed.</td>
</tr>
<tr>
<td><img src="image" alt="And-Gateway" /></td>
<td>And-Gateway</td>
<td>This gateway can act as an And Join or as a Split (or And-Fork). When it connects multiple predecessor worksteps to a single successor workstep, it acts as an And-Join. When it connects one predecessor workstep to multiple successor worksteps, it acts as a Split (or And-Fork). The successor worksteps are performed in parallel and only if the predecessor was completed. This enables you to synchronize the completion of multiple predecessor worksteps. This shape (gateway) is not available for Web applications.</td>
</tr>
</tbody>
</table>
### Using the palette

The palette contains the following utilities:

- **Select shapes** (or **Select**) icon: Use this icon to select an Activity or other shape in the process template diagram to perform operations including copying, moving, and resizing shapes.

- **Pan the diagram** (or **Panning**) icon: Use this icon to move a portion of the diagram into the viewing area. Once you select the Panning icon, the cursor in the Content pane is displayed as a “hand”. The Panning mode persists until you select another mode.

- **Show Gestures** icon: Use this icon to display the list of mouse gestures, which you can use to quickly add shapes, layouts, and perform common process-related actions. For more information, see Using mouse gestures on page 81.

- **Color** icon: Use this icon to apply color to a selected shape, swim lane, or note. Click the icon to display a color palette, from where you can select one of the listed colors, or click **More** to display more color options.

- **Zoom In** icon / **Zoom Out** icon: Use these icons to zoom in or zoom out the view of the current process template in the Content pane. You can select a pre-defined magnification levels (200%, 100%, 75%, 50%, or 25%) or enter a value in the Magnification combo box (100%).

- In the case of Business Process templates, the drop-down list provided displays the current process. This is useful in the case of inline subprocesses (see Defining an inline subprocess on page 109. Click the One Level Up icon or select the parent process or higher subprocess from the adjacent drop-down list.

- **Check Diagram** icon: Enables you to verify if the process template diagram is correct.

- **Show 360° View** icon: Enables you to generate the 360° view for the current process template. For more information, see Generating 360 degree view on page 62.

- **Print Preview** icon: Enables you to preview the current process template before printing it. For more information, see Printing the process template on page 64.

- **Export** icon: Enables you to export the current process template as a Web page (HTML), an SVG or a JPEG file. For more information, see Exporting the process template on page 64.
## Using keyboard shortcuts

*Table 11: Keyboard Shortcuts* on page 37 lists the keyboard shortcuts you can use to facilitate application development.

### Table 11: Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Keys</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + Enter</td>
<td>File &gt; Properties</td>
<td>Enables you to define the current process properties.</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Edit &gt; Select All</td>
<td>Selects all items in the Content pane.</td>
</tr>
<tr>
<td>Ctrl + B</td>
<td>Project &gt; Build All</td>
<td>Enables you to run an incremental build of all your active applications.</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Edit &gt; Copy</td>
<td>Copies a selected item to the clipboard to enable pasting of the item into the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Project &gt; Publish</td>
<td>Publishes the current project to a specified server.</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Edit &gt; Find/Replace</td>
<td>Enables you to find a specified item within displayed text in any text frame.</td>
</tr>
<tr>
<td>Ctrl + H</td>
<td>Search &gt; Search</td>
<td>Enables you to search for a specified file, Java string or plugin.</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td></td>
<td>Enables you to create a new project, by selecting one of the Business Process Server wizards.</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>File &gt; Print</td>
<td>Enables you to print a selected item.</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>File &gt; Save</td>
<td>Enables you to save the changes you made to your active project.</td>
</tr>
<tr>
<td>Ctrl + Shift + S</td>
<td>File &gt; Save All</td>
<td>Enables you to save the changes made in all open projects.</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Edit &gt; Paste</td>
<td>Pastes the clipboard item (cut or copied) into the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>File &gt; Close</td>
<td>Closes the current process template diagram.</td>
</tr>
<tr>
<td>Ctrl + Shift + W</td>
<td>File &gt; Close All</td>
<td>Enables you to close all open projects.</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Edit &gt; Cut</td>
<td>Cuts and copies the selected item to the clipboard to enable pasting of the item into the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Edit &gt; Redo</td>
<td>Recreates the last action performed in the workspace.</td>
</tr>
</tbody>
</table>
Removes the last action performed in the workspace. The Undo/Redo commands support lane, shape, connector and cut/copy/paste operations, as well as Align, Space, and Collapse operations.

**Caution:** All other actions (for example, entering process property information in Properties dialog box) cannot be undone. If an operation that cannot be undone is performed, the undo queue is cleared and the previous operations cannot be undone.

Checks the active diagram and verifies its validity.

### Configuration parameters

BPM Designer contains the default extensions for opening template files:

- **SPT** (for Process Template), used for files for new Business Processes.
- **SWT** (for Web application Template), used for files for new Web applications.
- **SST** (for Simulation Template), used for files for new Simulation projects.

For rule files, the default extension is `.bps` (for BPM Events Source).

**Note:** To configure classpath settings to use an external class in any of your rules, see the Classpath settings for Rule Editor section.

### Localizing Progress Developer Studio for OpenEdge

You can adapt Progress Developer Studio for OpenEdge to a language of your choice. For instructions on how to localize menus, titles of windows, labels of controls, messages, and other displayed text in a specific language, see Chapter 11: “Localizing Business Process Server” in the *Customization Guide*.

Progress Developer Studio for OpenEdge uses “UTF-8” encoding for all saved files. In case you are not using the Eclipse bundled with Progress Developer Studio for OpenEdge installation, you must ensure that your Eclipse installation uses “UTF-8” file encoding.

**To set “UTF-8” encoding for Eclipse::**

1. Exit Progress Developer Studio for OpenEdge, if running.
2. Right-click your Eclipse installation shortcut, then click **Properties**.
3. From the **Properties** dialog box, ensure that the file.encoding parameter (in the Target box) value is set to **UTF-8**.
4. Click **OK** and start Progress Developer Studio for OpenEdge.
Developing BPM projects

This chapter describes how to create projects using Progress Developer Studio for OpenEdge.

For details, see the following topics:

- Project facets
- Creating a BPM project
- Exporting BPM applications
- Importing BPM applications
- Managing multiple processes
- Importing a process file
- Generating OpenEdge JSDO Catalog
- Using a process file as a template
- Using a project as a template
- Creating a simulation project

Project facets

Progress Developer Studio for OpenEdge implements the Faceted Project Framework, which enables you to create a BPM project. A BPM project comprises of units of functionality (or facets) that can be easily added or removed.
A facet represents a unit of functionality in a BPM project. By default, you can create a BPM project with any of the following facets:

- **Process**: to create a BPM project with a Business Process facet.
- **Web Application**: to create a BPM project with a Web application facet.
- **Common Resources**: to create a BPM project with a common resources facet.

Progress Developer Studio for OpenEdge allows you to view project facet properties for any BPM project, as well as apply a facet. For more information, see Project facet properties on page 40.

**Note**: The compiler compliance level for BPM projects is JDK/JRE 1.7. Progress Developer Studio for OpenEdge cannot publish BPM projects with compliance level greater than 1.7. Progress Developer Studio for OpenEdge is installed with Eclipse with JDK/JRE 1.8. However, if you have installed Eclipse with JDK/JRE 1.8, you can use Progress Developer Studio for OpenEdge to create and publish BPM projects with JDK/JRE 1.7 compliance level.

### Project facet properties

Progress Developer Studio for OpenEdge enables you to view the project facet properties for an added BPM project in the **Properties** page. Additionally, you can apply a facet to the project.

You can view the **Properties** page by selecting the created BPM project in the Project Explorer view and clicking **File > Properties**. You can view the list of the following project facets from the **Project Facets** page:

- **Java**: This facet is locked by default. You cannot remove this facet.
- **JavaScript**: This facet is selected for a BPM Project. For this facet, the jsNature is also applied to the project.
- **Process**: This facet is selected if the BPM project contains a Business Process.
- **Web Application**: This facet is selected if the BPM project contains a Web application.
- **Common Resources**: This facet is selected if the BPM project contains common resources.

You can apply a facet to the project by selecting the respective checkbox and clicking **Apply**. You can restore the default facet properties by clicking **Revert**.

### Creating a BPM project

Progress Developer Studio for OpenEdge opens in the selected workspace, and in an Eclipse integrated development environment (IDE) and displays the **OpenEdge BPM Designer** perspective.

**To create a BPM project:**

1. From the **File** menu, select **New > BPM Project** to launch the **BPM Project** wizard.

   **Note**: Alternatively, right-click in the **Project Explorer** view, then select **New > BPM Project** to launch the **BPM Project** wizard.

2. From the first page of the **BPM Project** wizard, enter the name of the new project in the **Project name** box. The name can contain only alphanumeric characters, and must not contain blank spaces or special characters, except underscores (“_”). Project name must start with an alphabetic character.
3. By default, the project is stored in the default workspace folder. To choose another location, clear the **Use default location** checkbox, and then click **Browse** to choose another location.

4. From the **Project type configuration** drop-down list, select the type of configuration (or facet) to be associated with this project. The available options are:

   - **Process**: to associate a Business Process facet with this project.
   - **Common Resources**: to associate a common resource facet with this project.
   - **Web Application**: to associate a web application facet with this project.

5. Click **Next** to continue. The remaining pages of the **BPM Project** wizard varies according to the project type configuration selected. To complete the **BPM Project** wizard, refer to the appropriate section provided in the following table.

### Table 12: Types of projects

<table>
<thead>
<tr>
<th>Project Type</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process</td>
<td>Creating a Business Process on page 41.</td>
</tr>
<tr>
<td>Web application</td>
<td>Creating a Web application on page 43.</td>
</tr>
<tr>
<td>Common Resources</td>
<td>Using common resources on page 44.</td>
</tr>
</tbody>
</table>

**Note**: We recommend that you do not change the default workspace. If you must change the workspace to another location, close Progress Developer Studio for OpenEdge, navigate to the `oebps.conf` file in the `Workspace_Home\.com.savvion.studio\conf` folder, and modify the `oebps.application.home` parameter to point to the new workspace folder before restarting Progress Developer Studio for OpenEdge with the new workspace.

### Creating a Business Process

You can use the **BPM Project** wizard to create a Business Process.

**To create a Business Process:**

1. From the first page of the **BPM Project** wizard, select **Process** from the **Process type configuration** drop-down list.

2. Click **Next** to open the **BPM Process** page.

   If you want to use an existing process as a template to design a new process, from the **Template** section, select one of the following options:

   - **Use an existing file from file system as template**, then click **Browse** to navigate to an existing file (of type SPT, XML, or XPDL) that you can use as a template for your new application. For more information on using a template to create an application, see **Using a process file as a template** on page 54.
Tip: We recommend using an existing SPT file as a template for creating the new process. The SPT file contains the process template and all associated forms. The XML file is a basic version that does not contain associated forms.

- **Use an existing process from workspace as template** option, then click **Browse** to select an existing project that is available in the Project Explorer that you can use as a template for your new application. For information on using an existing project as a template, see Using a project as a template on page 55.

- **Use a Microsoft Project file as template** option, then click **Browse** to navigate to a Microsoft Project file (*.mp*), which you can use as a process for your application.

Note: You can also import existing projects or extract from an archive file using the **Import** functionality. For more information, see Importing a process file on page 51.

3. Click **Next** to open the BPM Process Properties page, in which you can modify the application name and enter the relevant process information in the respective boxes.

The following table describes the application information fields.

**Table 13: Application properties**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>(Optional) The label is the title of the application that users see in Business Process Portal. For example, it is listed in the Administration module under Applications &gt; BP Server, and the Home module in Business Process Portal displays this name together with its Description in the installed applications listed under the Applications tab. If no label is entered, the entry in the Name box is shown in Business Process Portal.</td>
</tr>
<tr>
<td>Version</td>
<td>(Optional) Use this box to add (or edit) the version number of the application.</td>
</tr>
<tr>
<td>Manager</td>
<td>(Required) Displays @CREATOR as the default manager. You can specify another manager, if required. The manager, either a single user or a user group, serves as a back-up performer if the originally assigned workstep performer is not available. If an individual is entered in the Manager box, then any tasks assigned to an unavailable performer are assigned to that user. If a group is entered in the Manager box, then any tasks assigned to an invalid performer are made available to the members.</td>
</tr>
<tr>
<td>Group</td>
<td>(Optional) Indicate which group of users is allowed to view and execute this project. You can only specify one group.</td>
</tr>
<tr>
<td>Duration</td>
<td>(Required) To specify the length of time you estimate is required to complete the process, use the appropriate Duration boxes to specify the duration in terms of days, hours, minutes, and seconds. The specified duration is used to determine the due date. After the due date you specified is passed, the process instance becomes overdue.</td>
</tr>
<tr>
<td>Category</td>
<td>(Optional) Use this box to differentiate between different types of projects.</td>
</tr>
</tbody>
</table>
4. Click **Next** to open the Add BPM Process module to Business Process Server(s) page of the BPM Project wizard. You can use this page (optional) to add the Business Process Servers and configure the publishing settings of the Business Process module. For more information regarding publishing project modules, see Using the Servers view on page 213.

   a) To publish the Business Process as a module on any connected Business Process Server from the Servers view, select the server (if defined) from the Available Business Process Server(s) section.

   b) In the Default Publishing Style section, select the default option for publishing the process module to the selected server. For more information, see Republishing project modules on page 219.

   c) To publish the Business Process as a Web service, select the Publish as web service checkbox.

   d) If you want to publish the Business Process with the user permissions you defined in the previous version of the same process, then select the Inherit ACL option.

5. Click **Next** to open the BPM Process Description page of the BPM Project wizard, in which you can enter the description of the Business Process. This is optional.

6. Click **Finish** to complete the creation of the Business Process.

### Creating a Web application

You can use a Web application to:

- Develop a process that can be integrated as an individual workstep into a complex BPM process. For instance, an approval process that requires several levels of management review and approval, can be defined as a Web application. It can be then used as a single workstep in a process template: thus you can save development time and computer overhead.

- Develop a stand-alone process that may include adapters to access BP Server and other external sources.

- Replace the Start workstep in a process template.

You can use the BPM Project wizard to create a Web application.

**To create a Web application:**

1. From the first page of the BPM Project wizard, select Web Application from the Process type configuration drop-down list.

2. Click **Next** to open the Web Application page.

   If you want to use an existing process as a template to design a new process, from the Template section, select one of the following options:

   - **Use an existing file from file system as template**, then click Browse to navigate to an existing file (e.g., BS_SVBSurvey.swt) located in your workspace folder that you can use as a template for your new application. For more information on using a template to create an application, see Using a process file as a template on page 54.
Tip: We recommend using an existing SWT file as a template for creating the new process. The SWT file contains the process template and all associated forms. The XML file is a basic version that does not contain associated forms.

- **Use an existing web application from workspace as template**, then click **Browse** to select an existing Web application in the Project Explorer that you can use as a template for your new process. For information on using an existing project as a template, see **Using a project as a template** on page 55.

- **Use a Microsoft Project file as template**, then click **Browse** to navigate to a Microsoft Project file (*.mp), which you can as a process for your application.

3. Click **Next** to open the **Web application properties** page, in which you can modify the name of web application, and enter optional information like label, category, sub-category, and author in the respective boxes. For details regarding this information, refer to **Table 13: Application properties** on page 42.

4. Click **Next** to open the **Add Web Application module to Business Process Server(s)** page of the BPM Project wizard.

   If you want to publish the Web application as a module on any connected Business Process server from the **Servers** view, select the server (if defined) from the **Available Business Process server(s)** section. This step is optional.

5. Click **Next** to open the **Web Application Description** page of the BPM Project wizard, in which you can enter the description of the Web application. This is optional and is similar to **Creating a Business Process** on page 41.

6. Click **Finish** to complete the creation of a Web application.

### Using common resources

You can create a BPM Project (with common resources) in the Eclipse integrated development environment (IDE) of Progress Developer Studio for OpenEdge. These common resources can be accessed from and used in all Progress Developer Studio for OpenEdge projects, and can include folders for:

- **Business Objects** - Java sources available to both EJB and Portal servers. Java files in this folder will be compiled into a hidden classes folder. Business Objects of the BPM Project (with common resources) are copied to the **OEBPS_HOME\ebmsapps\common\bo\classes** folder for use in Business Processes and to the **<App_Server>\WEB-INF\classes** folder for use in Web applications.

  **Note:** **<App_Server>** refers to the path of the OEBPS folder for a specific application server. For the value of this configuration parameter, refer to the **oebps.webappdir** parameter in the **OEBPS_HOME\conf\oebps.conf** file.

- **Adapters** - customized adapters for common Business Processes and Web applications. Adapters in Business Processes are copied to the **OEBPS_HOME\ebmsapps\common\lib** folder and adapters in Web applications are copied to the **<App_Server>\WEB-INF\lib** folder.

- **css** - Stylesheet files. These stylesheet files are copied to the **OEBPS_HOME\ebmsapps\common\css** folder and Web applications are copied to the **<App_Server>\ebmsapps\common\css** folder.

- **External Business Objects** - include compiled Java classes, XML resources, and custom dataslots. These are copied to the same location as Business Objects.

- **Images** - Common image files are copied to the **OEBPS_HOME\ebmsapps\common\images** folder and images used in Web applications are copied to **<App_Server>\ebmsapps\common\images**.
• **Javascripts** - include common javascript files. JavaScripts used in Business Process Portal applications are copied to `OEBPS_HOME\ebmsapps\common\javascript` whereas the ones used in Web applications are copied to `<App_Server>\ebmsapps\common\javascript`.

• **lib** folder contains JAR files generated by compilation of files in the `src` folder or pre-existing JAR files. Common JAR files used in Business Process Portal applications are copied to `OEBPS_HOME\ebmsapps\common\lib` whereas the ones used in Web applications are copied to `<App_Server>\WEB-INF\classes`.

You can also use a BPM Project (with common resources) to publish common `bpmportal` resources. However, you must specify the target for the resources in a file that you create called `dir.map`, which should be included as a part of the project. For example, it is possible to publish some of the `bpmportal` resources such as css and javascripts, as part of a BPM Project (with common resources).

For example, assume your project contains a folder called `bpmportal`. It is possible to publish the content of the `bpmportal` folder in the project to the `<App_Server>\bpmportal` folder by adding a `dir.map` file to the project with the following entry:

```plaintext
bpmportal = __sbmweb_archive/bpmportal
```

**(NOTE:** a double underscore (__)) is used to begin the equation)

Other available mappings that can be used in `dir.map` are:

- “__ebmsapp_archive” to map content of the folder to `OEBPS_HOME\ebmsapps`.
- “__webapps_archive” to map content of the folder to `OEBPS_HOME\bpmebflow`.
- “__sbm_archive” to map content of the folder to `OEBPS_HOME`.
- “__sbmweb_archive” to map content of the folder to `<App_Server>` folder (example, for JBoss, `jboss\webapps\deploy\sbm.war`).

### Creating Common Resources

You can use the **BPM Project** wizard to create Common Resources.

**To define Common Resources:**

**Note:** See Chapter 8 in the *Tutorial Guide* to review the FormsDemoCommon (a BPM Project with common resources) and the FormsDemo sample application that together demonstrate the use of Business Objects in an application. For a more general overview, see Chapter 5: Developing Business Objects in the *Application Developer’s Guide*.

1. From the first page of the **BPM Project** wizard, select **Common Resources** from the **Process type configuration** drop-down list.

2. Click **Next** to edit (if required) the Common Resource name. By default, the Common Resource name is the same as that of the BPM project.

3. Click **Next** to open the **Add Common Resources module to Business Process Server(s)** page of the BPM Project wizard.

   If you want to publish the BPM Project (with common resources) as a module on any connected Business Process Server from the **Servers** view, select the server (if defined) from the **Available Business Process server(s)** section. This step is optional. Depending on the application requirement, select one of the following adapter types from the **Adapter Type** section:
• **BP Server Adapter**: to publish the adapter files in Common resources to OEBPS_HOME\ebmsapps\common\lib folder, for use in Business Process.

• **Web Application Adapter**: to publish the adapter files in Common resources to <App_Server>\WEB-INF\lib folder, for use in Web applications.

4. Click **Finish** to complete the creation of Common Resources.

Your BPM Project (with common resources) appears in the **Project Explorer** view in the Progress Developer Studio for OpenEdge user interface.

### Exporting BPM applications

You can use the **Export BPM Applications** wizard to export a BPM project and its associated artifacts from the current workspace to a compressed ZIP format.

This wizard enables you to export the following artifacts of a BPM project:

- Business Objects
- Managed Adapters
- Users
- Messages
- Channels
- Form fragments

To export a BPM project and its associated artifacts:

1. Open the **Export BPM Applications** wizard by doing one of the following:
   
   - From the main menu bar, select **File > Export** to open the **Export** wizard. In the wizard, select the **Progress OpenEdge > BPM Applications** node, and then click **Next**.
   - In the **Project Explorer** view, right-click the BPM project that you want to export and select **Export > BPM Applications** on the context menu.

   The **Export BPM Applications** window appears.

2. Select the **Automatically select dependent project** check box to select dependent artifacts from other associated BPM projects.

   For example, if you select a business process that uses another business process from a different BPM project as a subprocess for an activity, the dependent artifact such as the subprocess (business process from another BPM project) is automatically selected to export.

3. Select the BPM project from the **Projects** section.

   **Note**: By default, the artifacts associated with the selected project are selected in the **Artifacts** section.

4. Select from the **Artifacts** section the artifacts of the project that you want to export.

   **Note**: The artifacts associated with the selected projects are automatically selected. Clear the check box of an artifact you do not want to export.
5. Click the **Select All** button to select all the projects and its artifacts.

   **Note:** Click the **Deselect All** button to clear your selection of all the projects and its artifacts.

6. Click the **Browse** button to select the directory in to which you want to export the selected resources.
   You can specify the directory path as the export location for the ZIP file.

7. Click **Finish**.

   The selected BPM project and its artifacts are exported and saved in a ZIP file in the selected directory.
   You can then use the **Import BPM Applications** wizard to import the ZIP file to copy the exported BPM project and its artifacts into another workspace.

---

**Importing BPM applications**

You can use the **Import BPM Applications** wizard to extract BPM projects and its artifacts from a ZIP file into the current workspace.

   **Note:** You can export the BPM projects and its artifacts to a compressed ZIP file using the **Export BPM Applications** wizard.

The **Import BPM Applications** wizard enables you to import the following artifacts of a BPM project:

- Business Objects
- Managed Adapters
- Users
- Messages
- Channels
- Form fragments

To import the BPM projects and its associated artifacts:

1. Open the **Import BPM Applications** wizard by doing one of the following:
   - From the main menu bar, select **File > Import** to open the **Import** wizard. In the wizard, select the **Progress OpenEdge > BPM Applications** node, and then click **Next**.
   - In the **Project Explorer** view, right-click any BPM project and select **Import > BPM Applications** on the context menu.

   The **Import BPM Applications** window appears.

2. Click the **Browse** button to select the compressed ZIP file that contains the BPM projects and artifacts.
   The BPM projects and its artifacts are extracted from the selected ZIP file and appear in the **Projects** and **Artifacts** section.

3. Use the following options to select the BPM projects and its artifacts to import into the current workspace:
   - **Projects** — To select the BPM projects
Note: You cannot import the project that already exists with the same name in the current workspace. By default, such project appears as disabled in the Projects section.

- **Artifacts** — To select the artifacts of the selected projects
- **Select All** — To select all the projects and its artifacts

Note: Click the Deselect All button to clear your selection of all the projects and its artifacts. You can then choose individual resources to import.

4. Select the **Overwrite resources without warning** check box to overwrite the selected resources which already exist in the current workspace.

5. Click **Finish**.

The selected BPM projects and its artifacts are imported into the current workspace. You can view the projects and its associated artifacts in the **Project Explorer** view.

### Managing multiple processes

In Progress Developer Studio for OpenEdge, you can create multiple Business Processes or web application modules within an existing or (new) BPM project. In the Project Explorer view, all the resources or files pertaining to a process or a web application module are stored in a folder with the same name as the process within the project directory.

Note: You can also add a single common resources file to a BPM project.

For instance, if you create a BPM project, "project1" (as discussed in Creating a BPM project on page 40), a default process, "project1" is created. You can add additional processes (for example, "process1" and "process2") to this project. After adding, you can view the files of the added processes in separate folders within the "project1" project folder in the **Project Explorer** view.

With multiple process support in a BPM project, each new process acts as a separate project module, and all the properties related to a particular process are stored within the module definition.

You can create any number of processes (within Eclipse capability) in a BPM project. You can also delete added processes from a project. Deleting a process deletes all the resources associated with that particular process from the project directory.

### Adding a new Business process

You can create a Business Process and add it to an existing BPM project.

1. From the **File** menu, select **New > Other** to launch the **New** wizard.

2. Select **Progress OpenEdge > BPM > Business Process** and click **Next**. The **BPM Process** wizard appears.

Note: Alternatively, right-click the BPM project in the **Project Explorer** view, then select **New > Business Process** to launch the **BPM Process** wizard.
3. In the **Project name** box, you must specify the BPM project to which you want to add this Business process.
   a) Click **Browse** beside the **Project name** box to open the **Select Project** dialog box, which lists the existing BPM projects.
   b) Select the BPM project to which you want to add the process, then click **OK**. The selected BPM project is displayed in the **Project name** box.

4. Complete the rest of instructions in the **BPM Process** wizard, as described in *Creating a Business Process* on page 41.

On completion of this wizard, the new process is added and displayed in the specified BPM project folder structure in the **Project Explorer** view.

### Adding a new Web application

You can create a Web application and add it to an existing BPM project.

1. From the **File** menu, select **New > Other** to launch the **New** wizard.

2. Select **Progress OpenEdge > BPM > Web Application** and click **Next**. The **Web Application** wizard appears.

   **Note:** Alternatively, right-click the BPM project in the **Project Explorer view**, then select **New > Web Application** to launch the **Web Application** wizard.

3. In the **Project name** box, you must specify the BPM project to which you want to add this Web application.
   a) Click **Browse** beside the **Project name** box to open the **Select Project** dialog box, which lists the existing BPM projects.
   b) Select the BPM project to which you want to add the process, then click **OK**. The selected BPM project is displayed in the **Project name** box.

4. Complete the rest of instructions in the **Web Application** wizard, as described in *Creating a Web application* on page 43.

On completion of this wizard, the new Web application is added and displayed in the specified BPM project folder structure in the **Project Explorer** view.

### Adding new Common Resources

You can create a Common Resource and add it to an existing BPM project.

1. From the **File** menu, select **New > Common Resources** to launch the **New Common Resources** wizard.

   **Note:** Alternatively, right-click the BPM project in the **Project Explorer view**, then select **New > Common Resources** to launch the **New Common Resources** wizard.

2. In the **Project name** box, you must specify the BPM project to which you want to add this Business Process.
a) Click **Browse** beside the **Project name** box to open the **Select Project** dialog box, which lists the existing BPM projects.

b) Select the BPM project to which you want to add the process, then click **OK**. The selected BPM project is displayed in the **Project name** box.

3. In the **Common Resource Name** box, specify the name of the Common Resource.

4. Click **Next** to complete the rest of instructions in the wizard, as described in *Creating Common Resources* on page 45.

On completion of this wizard, the new process is added and displayed in the specified BPM project folder structure in the **Project Explorer** view.

**Converting single process BPM projects**

You can use a BPM project (with a single process) in the current release. In order to do so, Progress Developer Studio for OpenEdge allows you to convert these single process projects to a multiple process BPM project.

**To do so:**

1. Import the BPM project from the previous release to your current workspace. For information regarding importing, see *Importing a process file* on page 51.

2. In the Project Explorer view, right-click the BPM project, then click **Progress OpenEdge > Move and Convert to a Multiple Process BPM Project**. The **Move To Multiple Process Project** dialog box appears.

   **Note:** To convert multiple BPM projects from previous versions, you must import and select these project folders in the **Project Explorer** view, and then perform the above step.

3. You can convert and add the selected projects to a new (or existing) BPM project in the current workspace.

   • To use an existing project, select the **Existing project** option. Type the name of the existing project in the **Project name** box or click **Browse** to open the **Select an existing project** dialog box, which lists the existing BPM projects in your workspace. Select the project and click **OK**.

   • To use a new project, select the **New project** option. Type the name of the new BPM project in the **Project name** box.

4. In the **Single process project(s)** section, you can specify additional single process projects (if required) to be converted and added to the BPM project specified in the **Project name** box.

   • To add projects, click **Add** to open the **Select a single process project** dialog box, which lists the existing single process BPM projects in your workspace. Select the projects to be added and click **OK**. The added projects are listed in the **Single process project(s)** section.

   • To remove any project from the **Single process project(s)** section, select the project and click **Remove**.

5. Before converting the specified single process BPM projects, you can create a backup of the projects in the current (or different) workspace. By default, Progress Developer Studio for OpenEdge creates a backup of the projects in the default workspace. To specify a different workspace folder, click **Browse** and select the folder where you want to create the project backup.

6. Click **Finish** to start the conversion operation.

On successful completion, the **Move and convert: Successful** dialog box appears. The converted project is added as a process version and displayed in the specified BPM project folder strucure in the **Project Explorer** view.
Navigating multiple processes

For a BPM project containing a large number of processes, navigating all the processes and artifacts in each process can be time-consuming and cumbersome. For easier navigation, you can implement the following methods for all the projects listed in the Project Explorer view.

- **Filtering**: to show (or hide) all the Business Processes and Web applications added to BPM projects in your workspace.
- **Content filtering**: to filter the artifacts in your Project Explorer view on basis of content namely, BPM elements.
- **Sorting**: to sort the multiple processes added to BPM projects on basis of name or process type.

To apply filtering:

1. In the Project Explorer view, click View Menu ( ▼ ) > Customize View. The Available Customizations dialog box appears.
2. From the Filters tab, you can implement filtering on basis of project type.
   a) To hide all the Business Processes in your Project Explorer view, select the BP Server Processes check box.
   b) To hide all the Web applications in your Project Explorer view, select the BPM WebFlow Processes check box.
3. From the Content tab, you can implement filtering on basis of content namely, BPM elements. By default, the Project Explorer view displays Java (and JavaScript) elements and Progress Developer Studio for OpenEdge resources. Use the BPM Elements check box (by default, selected) to display each process type in the BPM project with its distinct icon.

   **Note**: You can also clear the other selected checkboxes in the Content tab to display only BPM elements in your Project Explorer view.

   All Business Processes in your Project Explorer view are denoted by the ▶ icon and all Web applications are denoted by the ▶ icon. You can identify and open process templates, based on the displayed icon.

4. Click OK to apply the filtering changes.

You can also sort the list of processes in each BPM project on basis of name or process type. By default, all processes in each BPM project are sorted alphabetically by name. To sort by process type:

- In the Project Explorer view, click View Menu ( ▼ ) > BPM Sort and then select the by type option. Expand any BPM project in the Project Explorer to view all the Business Processes in the project first, followed by all the Web applications in the project.

Importing a process file

Progress Developer Studio for OpenEdge provides the Import feature, which enables you to import external projects into your current workspace. You can also extract an archive file as a project into your workspace.

To import a process file:
1. From File menu, click Import to launch the Import wizard.
2. Select General > Existing Projects into Workspace, and then click Next.
3. To navigate to existing projects, click Browse beside the Select root folder option to open the Browse for Folder dialog box.
   Alternately, click the Select archive file option and click Browse to navigate to any of the supported archive files to import. Click OK, to return to the Import wizard.
4. From the Projects section, select all (or one) of the projects to be imported into your workspace.
5. Select the Copy projects into workspace check box (available only for Select root folder option) to create a copy of the external projects in your workspace.
6. Click Finish to start importing.

   The application appears in the Project Explorer view. Expand the application folder to reveal the SPT or SWT file in the processtemplates folder, and double-click the file to display it in the Content pane.

**Generating OpenEdge JSDO Catalog**

You can now generate an OpenEdge JSDO catalog from the Project pane. This OpenEdge JSDO catalog then facilitates the Rollbase Developers to create application objects in Rollbase. The JSDO Catalog feature currently supports only primitive dataslots.

To generate an OpenEdge JSDO Catalog:

1. In the Project pane, right click on the project module that you want to generate a JSDO catalog for.
2. Select Progress OpenEdge > Generate OpenEdge JSDO Catalog.
   The Generate OpenEdge JSDO Catalog -Select Location dialog box opens.
3. Select the location where you want to save the OpenEdge JSDO Catalog and click OK.
   A .json file is created in the selected location. For more information, refer to Rollbase documentation.
   For JSDO Catalog dataslots validations, see Validating dataslots using semantic annotations on page 52.

**Validating dataslots using semantic annotations**

You can validate the dataslots supported by the JSDO Catalog using semantic annotations. The following tables describe the validations and their semantic types for JSDO Catalog dataslots:
### Table 14: For CHARACTER

<table>
<thead>
<tr>
<th>Validation type</th>
<th>Number type</th>
<th>Semantic type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Integer</td>
<td>&quot;{&quot;type&quot;:&quot;Integer&quot;, &quot;min&quot;:2, &quot;max&quot;:22}&quot;</td>
</tr>
<tr>
<td>Number</td>
<td>Float</td>
<td>&quot;{&quot;type&quot;:&quot;Number&quot;, &quot;min&quot;:3, &quot;max&quot;:33}&quot;</td>
</tr>
<tr>
<td>Email</td>
<td>-</td>
<td>&quot;{&quot;type&quot;:&quot;Email&quot;}&quot;</td>
</tr>
<tr>
<td>URL</td>
<td>-</td>
<td>&quot;{&quot;type&quot;:&quot;URL&quot;}&quot;</td>
</tr>
<tr>
<td>Password</td>
<td></td>
<td>&quot;Password&quot;</td>
</tr>
</tbody>
</table>

### Table 15: For INTEGER, INT64 or DECIMAL

<table>
<thead>
<tr>
<th>Validation type</th>
<th>Number type</th>
<th>Semantic type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Integer</td>
<td>&quot;{&quot;type&quot;:&quot;Integer&quot;, &quot;min&quot;:1, &quot;max&quot;:11}&quot;</td>
</tr>
<tr>
<td>Number</td>
<td>Float</td>
<td>&quot;{&quot;type&quot;:&quot;Number&quot;, &quot;min&quot;:2, &quot;max&quot;:22}&quot;</td>
</tr>
</tbody>
</table>

### Table 16: For DATETIME

<table>
<thead>
<tr>
<th>Validation type</th>
<th>Semantic type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Only</td>
<td>&quot;Date&quot;</td>
</tr>
<tr>
<td>Date and Time</td>
<td>&quot;Datetime&quot;</td>
</tr>
</tbody>
</table>

### Table 17: For LOGICAL

<table>
<thead>
<tr>
<th>Validation type</th>
<th>Semantic type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not available</td>
<td>&quot;{&quot;type&quot;:&quot;Boolean&quot;}&quot;</td>
</tr>
</tbody>
</table>

**Note:** EDITABLE, LENGTH, IP ADDRESS, US SOCIAL SECURITY NUMBER, and DECIMAL dataslots are not supported by JSDO Catalog.
The following is an example of a semantic type, in JSON format, for a CHARACTER dataslot with Number type validation:

```
"chardataslot": {
  "type": "string",
  "ablType": "CHARACTER",
  "default": "",
  "title": "Character dataslot",
  "semanticType": {
    "type": "Number",
    "min": 2,
    "max": 22
  }
}
```

In this example, for `semanticType`:

- **type** indicates the type of validation. In this case, it is Number.
- **min** and **max** indicate the minimum and maximum values that are allowed for this Number, respectively.

**Using a process file as a template**

You can reduce process development time by using an existing process file as the template for your new process in Progress Developer Studio for OpenEdge. You can browse to a specific location (example, your workspace folder) that contains Progress Developer Studio for OpenEdge projects; or you can retrieve a process file which was created in earlier releases of Progress Developer Studio for OpenEdge. The following section describes how to use an existing process file as a template to create a new process.

**Note:** We recommend that you do not use the File > Open File command to create a new process template, because associated folders within the project are not created.

**Using a process file from recent releases**

You can use a process file from a previous release as template to create a new process in Progress Developer Studio for OpenEdge:

1. In the second page of the BPM Project wizard (Creating a Business Process on page 41 for Business Process), enter the name of the new project in the appropriate box.
2. To use an existing process file as a template, select the Use an existing file from file system as template option, then click Browse to open the Select File dialog box, which displays the existing process files.
3. Browse to the SPT within any of the process folders that you can use as a template for your new process. After you select a process file from your Workspace_Home folder and click Open, the process template name (for instance, Assignment) and its path is shown in the File box, and a number in the Version box is automatically inserted that is one increment higher than the selected process file. The process template name and version is entered in the remaining read-only fields.
a) You can change the project name, or change or delete the version number. Specify the duration in the appropriate **Duration** box.

b) Click **Next** to continue.

c) After entering the description (optional), click **Finish** in the BPM Project wizard.

A new project folder is listed in the **Project Explorer** View, along with the process template file with an SPT extension.

4. Select **File > Save All** to save changes to all open projects and files. You can now publish the new application. For more information on publishing, see **Publishing an application** on page 59.

**Importing a process file from earlier releases**

The BPM Studio library is a user library that is automatically generated every time a new application is created in Progress Developer Studio for OpenEdge. This library acts as a reference point for the JAR files required for process applications that is independent of the location of the JAR files. Using this library, Progress Developer Studio for OpenEdge applications can be easily shared among different users who may have different installation roots for their Progress Developer Studio for OpenEdge installation.

For applications that were created earlier and then imported to the more recent Progress Developer Studio for OpenEdge releases that have the library feature, you must replace their hard-coded JAR files with BPM Studio library references.

**To do so, perform the following steps:**

1. After importing a pre-6.5SP2 application (see the Using a process file from older releases topic), click the process name in the Project pane. From **Project** menu, click **Properties**, then click **Java Build Path > Libraries**.

2. Remove the following four JAR files—`bpmwebflow.JAR`, `bpsclient.JAR`, `bpsmisc.JAR`, and `j2ee.JAR`—by selecting each JAR file and clicking **Remove**.

3. Click **Add Library**, select **User Library** and click **Next**, and select **BPM Studio Library** and click **Finish**.

The BPM Studio library is now in the **Libraries** tab. Click **OK**.

**Note:** You can also get the same results by manually editing the **classpath** file under the application folder and replace the four JAR files (`<classpathentry kind="lib" path="<path_name>/bpmwebflow.JAR"/>`, `<classpathentry kind="lib" path="<path_name>/bpsclient.JAR"/>`, `<classpathentry kind="lib" path="<path_name>/bpsmisc.JAR"/>`, and `<classpathentry kind="lib" path="<path_name>/j2ee.JAR"/>`) with the following entry: `<classpathentry kind="con" path="org.eclipse.jdt.USER_LIBRARY/BPM Studio Library"/>`.

**Using a project as a template**

You can significantly reduce process development time by using an existing BPM project as the template for your new project. If you use this option, you can choose to import not only the process file, but also all associated interfaces, rules, and adapters. You can only use this option for existing project files that are displayed in the **Project Explorer** view.

**To use an existing project as template to create a new process:**
1. In the second page of the **BPM Project** wizard (Creating a Business Process on page 41 for Business Process), enter the name of the new project in the appropriate box.

2. To use an existing project as a template, select the **Use an existing process from workspace as template** option (for Business Processes) or the **Use an existing web application from workspace as template** option (for Web application), then click **Browse** to open the **Select project** dialog box, using which you can select the project to be used as a template for your new application.

The process template name (for instance, Assignment) is shown in the **Project** box, and a number in the **Version** box is automatically inserted that is one increment higher than the selected process file. The process template name and version is entered in the remaining read-only fields. You can change the project name, or change or delete the version number.

3. Click **Next** to continue.

4. After entering the description (optional), click **Finish** in the BPM Project wizard.

A new project folder is listed in the Project Explorer view, along with the process template file with an SPT extension.

---

**Creating a simulation project**

Progress Developer Studio for OpenEdge provides the Simulation project, which supports all simulation functions, and allows for easier integration of additional features in future releases.

**To create a Simulation project:**

1. From the **File** menu, select **New > Project** to launch the **New Project** wizard.

2. From the **Progress OpenEdge > BPM** node, click **BPM Simulation Project**, and then click **Next**.

3. In the first page of the **New Simulation Project** wizard, enter the name of the simulation project in the **Name** box. The name can contain only alphanumeric characters, and must not contain blank spaces or special character, except underscores ("_”). Ensure that the project name starts with an alphabetic character. If required, enter a label and description in the respective boxes.

4. By default, the project is stored in the default workspace folder. To choose another location, clear the **Use default location** checkbox, and then click **Browse** to choose another location.

5. Click **Next** to define the simulation properties of this project.

   a) From the **Start Simulation** section, click one of the following options to define when to start to start the simulation:

      - **At current system time** option to activate the simulation at the current time of the system.
      - **At time** option to activate the simulation at a predefined time other than system time. After clicking this option, you need to specify a date and time. To do so, click the adjoining **ellipsis** button. For details, see **Specifying a date** on page 237.

   b) From the **Stop Simulation** section, click any of the following options to define when to stop the simulation:

      - **On completion of process instances** option to stop the simulation when all the instances of the processes in the simulation project are completed.
      - **At time** option to stop the simulation at a predefined time. You can use this option only if you have selected the **At time** option in the **Start Simulation** section. You need to specify a stop time later than the simulation start time. To specify another date and time, click the adjoining **ellipsis** button. For details, see **Specifying a date** on page 237.
• **After duration** option to specify a relative end time for simulation, in terms of duration. You can specify the duration in terms of hours, minutes, and seconds by entering values in the respective boxes.

6. Click **Next** to define the project calendar settings for this simulation project.

   You can use the **Project Calendar** page to define the default calendar settings for your simulation project.
   
   a) From the **Work Days** section, select (or clear) the appropriate checkboxes for the work days.
   
   b) The **Sessions** section table displays the default time segments. The default work-hours are 9:00 - 13:00 and 14:00 - 18:00.
      
      • To add a session, click **Add** opening the **Session** dialog box. Specify the start time (hours and minutes) and the end time (hours and minutes) of the session in the respective boxes. Click **OK** to add the session to the **Sessions** section table.
      
      • To edit any of the listed sessions, select the session, then click **Modify** to open the **Session** dialog box, where you can modify the start and end time.
      
      • To remove any of the listed sessions, select the session, then click **Delete**. Progress Developer Studio for OpenEdge prompts you for confirmation. Click **OK** to remove the session.

   **Note:** The settings defined here are applied to the “default” scenario in your simulation project. You can modify these settings for the default scenario, as well as for any added scenarios in the Simulation perspective, after creating the simulation project. For details, see **Modifying simulation settings for a scenario** on page 226.

7. Click **Next** to add the processes that you want to include in this simulation. You can also configure the simulation settings for each added process.

   a) To add a process to the simulation project, click the **Add** icon in the **Select** section, to open the **Required Project Selection** dialog box. From the list of current processes, select the process to be added then click **OK**.

   The added process is displayed in the **Select** section. You can add as many processes, as required.

   **Note:** To remove a process from the simulation project, select the process, then click the **Remove** icon.

   For each added process, you can configure the simulation start settings (available only for multiple processes), the instance count, and the type of randomization.

   b) From the **Start** section, select the **At time** option to set an absolute time and date, as described in Step 5a. The start time for a process must be later than the absolute start time (if specified) for the simulation project. Alternatively, select the **After duration** option to specify a relative start time (in terms of duration) for the process simulation, as described in Step 5b.

   **Note:** You cannot set an absolute time and date for the process if you have set the simulation start time to system time.
c) Use the Count section to specify the number of process instances. You can either keep the instance count unlimited or specify a maximum value in the Limited To box. You cannot specify an unlimited instance count if you have selected the On completion of process instances option in the third page of the wizard.

d) From the Type drop-down list in the Distribution section, choose a method to randomize the duration of each interval between process instances in the simulation. For information regarding randomizing methods, see Configuring and running simulation on page 221.

8. Click Finish to complete creating the Simulation project.

9. If you are currently not in the Progress OpenEdge BPM Simulation perspective, Progress Developer Studio for OpenEdge prompts you to switch to this perspective. Click Yes to open the simulation project in the Progress OpenEdge BPM Simulation perspective. Alternatively, click No to open the simulation project in your current perspective.

If you select the Remember my decision check box, Progress Developer Studio for OpenEdge does not display any prompt and executes the selected command the next time you create or open a simulation project file (SST). For further details regarding configuring and running a simulation, see Configuring and running simulation on page 221.

**Note:** You can modify the above selected configuration for opening the Progress OpenEdge BPM Simulation perspective using the Simulation > UI page in the Preferences dialog box. For information, see Using the Simulation page on page 101.
Performing additional operations

This chapter describes how to use Progress Developer Studio for OpenEdge for performing additional operations.

For details, see the following topics:

- Publishing an application
- Managing pages
- Generating 360 degree view
- Printing the process template
- Exporting the process template
- Managing phases

Publishing an application

Progress Developer Studio for OpenEdge provides a Publish wizard to facilitate application publishing. The Publish wizard allows you to complete the following tasks:

- Retrieve the project file as input and pack all the referred files into an archive file.
- Connect to the web service on the specified server and upload the package (that is, send the user name and password, verify if the application is already installed; and if yes, prompts you to replace the existing application).
- Send the archive to the Web server and instructs the server to unpack and install the application.
- Display the result of publishing (success/failure).
To publish an application:

1. From the Project Explorer view, select the project to be published.
2. From the Project menu, click Publish to open the Publish Wizard.
   
   **Note:** All project components must be valid in order to publish it. To determine the validity of the application, click ✔ or right-click in a blank area of the main frame and select Check Diagram option. If you have correctly defined the application, “The diagram is complete” message appears. Click OK.

3. From the options displayed in the Server drop-down list, select the server to which you want to connect the project, or modify the default server path. The URL you enter here for example, http://localhost:port/sbm/deployment— is where SOAP can be found as part of the Web application.
4. Enter your Username and Password and then click Next to go to the next page.
   
   **Note:** You can configure target server options from the Publish page in Preferences dialog box. For details, see Using the Publish page on page 101.

The Publish wizard now attempts to connect to the server you selected.

a) If you are publishing the process template for the first time, the second page of the Publish Wizard displays the Web services section. Select the Publish as web service checkbox to publish the process as a Web service.

b) If you are publishing a process template that has been published previously, the second page of the Publish Wizard now displays the options described in Table 18: Publish options for a previously published application on page 60.

Table 18: Publish options for a previously published application

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reinstall</td>
<td>Reinstall the process template</td>
</tr>
<tr>
<td>Select</td>
<td>To</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------</td>
</tr>
<tr>
<td>Refresh process template</td>
<td>Apply simple changes in process flow to running processes and associated instances. You don’t have to create a new version or, migrate instances. For example, select this option (as is shown in the figure above) if you only want to change the format of a few HTML/JSP forms in the application. If the application cannot be refreshed, the Refresh Process Template option is not enabled, and a message appears with a link that will open a window listing the issues preventing a refresh.</td>
</tr>
<tr>
<td>Copy files to server only</td>
<td>Copy any updated files to the connected server.</td>
</tr>
</tbody>
</table>

You can select the **Publish as web service** checkbox to publish the process as a Web service. This checkbox is enabled even if the application was previously installed. If the application had previously been published, reinstalling or refreshing the template automatically republishes the application and this checkbox is not displayed.

c) If you are publishing a process template, which is a version of a previously published application, the second page of the Publish Wizard displays the following options.

- Select the **Inherit ACL** checkbox to retain any user permissions in the version of the application you are creating that are associated with the parent application. By selecting this option, you ensure that when you publish this version on Business Process Portal, it will have the same user permissions that the original application had.

- Select the **Publish as web service** checkbox to publish the process as a Web service.

**Note:** For Business Process Server installed with https enabled, ensure that a valid certificate is added to your JDK. Otherwise, this publish operation using Web services will fail. For information on how to add a certificate, refer JDK documentation.

d) Click **Next** to continue.

5. The last page of the Publish Wizard displays the “Application published successfully” message if the application has been successfully published. You can select the **Go to Business Process Portal** checkbox to automatically open Business Process Portal login page (with address as specified in the adjoining box) in your Web browser when you click **Finish**.

If the Publish Wizard encounters problems in publishing the application, an **Error** window appears. Click **Details** to obtain information about any publishing problems.

---

### Managing pages

Progress Developer Studio for OpenEdge provides a default number of 9 pages (in a 3x3 grid) in the **Diagram** tab to design your process template diagram. Progress Developer Studio for OpenEdge automatically adds pages if your process template diagram does not fit into the 3x3 grid.

You can now add and manage pages in the **Diagram** tab. This enables you to control the page size more efficiently.

**To generate the print preview:**
• From the Diagram tab, right-click a blank portion of your process template diagram, point to Pages option, then select one of the following options:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to right</td>
<td>Adds a page to the right. For the default 3x3 grid, this operation extends the grid size to 3x4.</td>
</tr>
<tr>
<td>Add to bottom</td>
<td>Adds a page to the bottom. For the default 3x3 grid, this operation extends the grid size to 4x3.</td>
</tr>
<tr>
<td>Fit to process</td>
<td>This is a useful option when you want to print a process template and save paper. Click this option to reduce the page count to fit the process template diagram.</td>
</tr>
</tbody>
</table>

Generating 360 degree view

Progress Developer Studio for OpenEdge provides the 360° view, which is a multi-layered Chart view of the current process template diagram. You can generate the 360° view especially for complex process templates, which consist of multiple activity (and adapter) worksteps and complex workstep traversal paths.

To generate the 360° view:

From the palette (see Using the palette on page 36), click the Show 360° View ( ) icon to launch the 360° View of the current project.

Alternatively, you can open the 360° view of the current project by right-clicking the name of the current project (SPT or SWT) file in the Project Explorer, then clicking Open With > 360° View option.

The 360° view diagram consists of color-coded sections, each representing a workstep. Each section displays the label of the workstep along with the estimated time (in days, hours, and minutes) when the workstep will be activated. The estimated time is calculated from the beginning of the process. If the process includes multiple paths, each path is depicted as a sub-section in the chart.

Note: The estimated start time of each workstep can be calculated only when the duration of the preceding worksteps are set in absolute values (in days, hours, minutes, or seconds). The estimated start time cannot be calculated when workstep duration is bound to a INTEGER datalot. For setting workstep duration, you can use the Overdue in box in the General tab of the Activity workstep's Properties view (as discussed in Specifying general properties of Activity workstep on page 142).

The 360° view displays each workstep type with the following color code.

<table>
<thead>
<tr>
<th>Table 19: 360° view color code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workstep Type</td>
</tr>
<tr>
<td>Activity (including external activity and adapter worksteps for a monitoring process)</td>
</tr>
<tr>
<td>Adapter</td>
</tr>
<tr>
<td>Workstep Type</td>
</tr>
<tr>
<td>---------------------</td>
</tr>
<tr>
<td>Start / End / Gateways</td>
</tr>
<tr>
<td>Inline Subprocess</td>
</tr>
</tbody>
</table>

You can perform the following operations in the 360° view.

**Table 20: 360° view operations**

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan the diagram</td>
<td>Drag your mouse.</td>
</tr>
<tr>
<td>Zoom in (or out) on the diagram OR view all workstep labels.</td>
<td>Use your mouse scroll wheel.</td>
</tr>
<tr>
<td>Rotate the diagram around its center point.</td>
<td>Drag your mouse with the right button.</td>
</tr>
<tr>
<td>Open the subprocess in the 360° view.</td>
<td>Click the subprocess workstep section. For additional information, see Opening a subprocess on page 63.</td>
</tr>
<tr>
<td>Calculate a traversal path duration.</td>
<td>Move your mouse over the diagram to highlight the selected path. The estimated duration of the selected path is displayed in the Path Length box.</td>
</tr>
</tbody>
</table>

The 360° view also includes the following icons:

- **Show/Hide Loops** () icon - For any process containing loops, the default 360° view does not include the worksteps encountered after a loop is executed. You can click this icon to display these worksteps in semi-transparent state. In this case, the worksteps gradually progress with fading color.

- **Timeline View** () icon - Click this icon to switch to the Timeline view, which displays the thickness of each workstep corresponding to the time it is likely to take to complete.

The worksteps in the Timeline view with increased thickness require more time to execute. As Activity worksteps are performed by humans and are likely to take the maximum time to complete as compared to the other workstep types, the Timeline view shows Activity worksteps with higher degree of thickness. You can zoom in on the diagram to view the other workstep types in detail.

**Note:** You must click the individual icons again to return to the previous view.

**Opening a subprocess**

You can also view an inline subprocess in the 360° view, by clicking the subprocess workstep section of the parent process diagram. For information regarding an inline subprocess, see **Defining an inline subprocess** on page 109. The 360° view of the parent process is replaced with that of the subprocess.
Note: This feature is not available for Web applications, as it does not support an inline subprocess.

Progress Developer Studio for OpenEdge supports an inline subprocess within another inline subprocess. You can use the breadcrumb trail in the 360° view to track the process hierarchy.

**Figure 4: Breadcrumb trail**

![Breadcrumb trail](image)

You can click the process name button in the breadcrumb track to reload the 360° view of the parent process in the hierarchy.

Note: The Breadcrumb trail does not include external subprocesses, rules, phases, swimlanes, and annotations.

### Printing the process template

You can generate a print preview of a process template diagram before printing it.

**To generate the print preview:**

1. Open the process template to be printed.

2. From the palette (see Using the palette on page 36), click the **Print Preview** icon to view the process diagram in the Print Preview mode.

   In the Print Preview mode, the Tasks pane displays the print-related functions and other options.

3. To enlarge (or reduce) the image scale for printing, increase (or decrease) the scaling percentage in the **Scaling factor** box in the **Options** panel.

   Alternatively, select the **Fit to width/height** option in the **Scale Mode** drop-down list, then enter the width (and height) in pages in the adjoining boxes to set the image scale to fit to the specified pages.

4. If required, define the page setup for printing by clicking the **Page setup** link from the **Print Preview Tasks** panel, opening the **Page Setup** dialog box.

   The dialog box which appears depends on the type of printer you are using. Select the size of the printed document —Letter (8.5 x 11 inches), Legal (8.5 x 14 inches), 11 x 17 inches, etc.—, its source, and whether it has a Portrait or Landscape orientation. Use the fields in the Margins panel to adjust the page's margins.

5. Click the **Print this diagram** link to print the displayed process template.

   The **Print** dialog box opens, in which you can select a number of printing options, including number of copies and page range. The dialog box which appears depends on the type of printer you are using. If you are using Windows, click **Properties** to define additional print properties.

6. To exit the Print Preview mode, click the **Exit print preview** link.

### Exporting the process template

You can export the process template in the following formats:

- Web Page (HTML)
• SVG image
• JPEG image
• XPDL file
• Microsoft Project file
• Process Summary in PDF or MS Excel format

You can even export large process template diagrams as a single file.

**Note:** You can use the Export page of the Preferences dialog box to change the default width and height of the JPG image. For details, see Using the Export page on page 100.

**To save the process template's file and export it in a supported format:**

1. Open the process template that you want to export.

2. From the palette (see Using the palette on page 36, click the Export (.Export) icon.

   The Tasks pane displays the Export Tasks panel which includes the following links.

**Table 21: Links**

<table>
<thead>
<tr>
<th>Links</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save as a single JPEG image</td>
<td>To export the process as a JPG image.</td>
</tr>
<tr>
<td>Generate a Web page</td>
<td>To export the process as an HTML web page.</td>
</tr>
<tr>
<td>Save as a SVG image</td>
<td>To export the process as a SVG (Scalable Vector Graphics) image.</td>
</tr>
<tr>
<td>Generate XPDL</td>
<td>To export the process as an XPDL file. You can use the exported XPDL file as template for creating a new process.</td>
</tr>
<tr>
<td>Generate Microsoft Project file</td>
<td>To export the process as a MS Project file (*.mpx). You can use the exported MPX file as template for creating a new Business Process project or Web application. For more information, see Creating a Business Process on page 41 and Creating a Web application on page 43.</td>
</tr>
</tbody>
</table>

**Note:** The process, which uses an exported MPX file, does not support these process template elements: And, Or-Join, Exclusive Or-Join, Timeout and Compensation flow connectors, Swim lanes, phases, managed adapters, and External Activity (and External Adapter).

| Generate Microsoft Project file    | To export the process as a MS Project file (*.mpx). You can use the exported MPX file as template for creating a new Business Process project or Web application. For more information, see Creating a Business Process on page 41 and Creating a Web application on page 43. |
| Save as Process Summary            | To generate a process summary of the current process in PDF and MS Excel formats. For more information, see Generating a process summary on page 66. |

3. Click the appropriate link, to open the Export dialog box. If your process template file size is very large, use the HTML or SVG format.
4. Navigate to the folder location to which you to export the file. Click **Save** to export the file in the selected format.

5. To close the Export Tasks panel, click the **Exit export** link.

**Generating a process summary**

Progress Developer Studio for OpenEdge enables you to generate a process summary in PDF and MS Excel formats. The process summary presents a summary of the worksteps and other process features for the selected process template.

**To generate the process summary:**

1. Open the process template for which you want a process summary.

2. From the palette (see *Using the palette* on page 36, click the **Export** icon.

3. From the **Export Tasks** panel, click **Save as Process Summary** to open the **Document Generation** dialog box.

4. Choose the appropriate checkboxes to specify the Optional Sections in the process summary.

5. From the **Output** drop-down list, select the format in which you want to generate the process summary output. The available formats are PDF and Excel.

6. Click **Generate** to generate the process summary.
Viewing process summary

Figure 5: Process Summary Document in PDF Format on page 67 displays the process summary in PDF format. The generated process summary in Excel format includes the same information as that in the PDF format.

Figure 5: Process Summary Document in PDF Format

Note: Process summary files are saved directly under the application folder; for instance, if you generate a PDF summary for the Assignment application, the PDF file (summary.pdf) and the process diagram file (report.jpg) are located in the Workspace_Home\Assignment folder.

The first page displays a Process Properties section, including data on General properties, Attributes, and a History of the process (that is, when it was created, saved, checked in, etc.). From the Process Diagram section, you can click the Click here to view process diagram in a different window link to open the process diagram file.

Note: Process summary reports for Web applications do not include all the sections that are displayed for Business Processes. This is because features that are not supported in Web applications, such as the Simulation section, are not shown in process summary reports for Web applications.
1. The bookmarks on the left provides links to Worksteps, Links, Performers, and Dataslots sections. Alerts and Notes sections are also displayed, if Alerts or Notes are present in the process. Expand the bookmarks and then click each of these bookmarks to open the corresponding section for a specific workstep, or to view performers, dataslots, or alerts (if any) available in the process. You can view or print the process summary PDF document, select data in it, or copy data from it.

2. To view the process summary for a specific workstep, expand the Worksteps bookmark and then click the workstep name to display the following information:
   - Workstep details including its general properties (including Loop and Skippable conditions if present) in the General section.
   - Information about dataslots assigned to the workstep in the Fields section. Click the View All User Dataslot Properties link to navigate to the Dataslots section.
   - Information about workstep collaboration (if any) in the Collaboration section. This information is displayed only if you have selected the Collaboration checkbox in the Document Generation dialog box.
   - Information about custom presentation forms or rollback points assigned to the workstep in the Advanced section.

   For Subprocess worksteps, click the Click here to view <AppName> subprocess document link under the Subprocess Document heading to open the process summary document for the nested process.

3. Click Links bookmark to view all the connectors in the process, along with the source and target worksteps for each connector, and associated conditions (if any).

4. Click Performers bookmark to open the Performers section, which lists information about all the performers assigned to the process.

5. You can also click Dataslots, Alerts (visible when the process contains alerts), or Notes (visible when the process contains notes) to view the respective data.

6. Click File > Exit or the Close button ( ) to exit the process summary PDF document.

Managing phases

A phase is a set of tasks, which signifies the completion of a project segment. You can use the Phase function to divide all the tasks in a process into sets of tasks (or subtasks). For example, in a typical Sales process, all subtasks which help achieve Customer Prospecting can be considered a phase.

Phases are represented by vertical lines and are similar to implementing Swim lanes (as discussed in Using swim lanes on page 113. You can define a Phase and its worksteps in the Diagram tab. In the Overview tab, you can view the phase to which a particular task belongs.

---

**Note:** Phases are not supported in Web applications.

Creating a phase

You can create a new phase for a Business Process in the Diagram tab.

To create a phase:
1. Open the Business Process (SPT) in the Diagram tab.
2. From the Tasks pan, click the Create Phases and Swim Lanes link in the Design Tasks panel, and then click the Phase ( ) icon to open the Phase Properties dialog box.

**Note:** You can also use the ‘P’ gesture to add a phase. For details, see Using mouse gestures on page 81.

3. Enter the ID and Name of the new phase in the respective boxes.
4. Click OK to add a new phase to the process template diagram. Move all the worksteps that belong to this phase into the added phase, as seen in the Figure 6: BPM Designer interface with added Phases on page 69.

**Note:** You cannot move a phase.

**Figure 6: BPM Designer interface with added Phases**

---

**Resizing a phase**

You may need to resize a phase either to add a shape to the phase or to quickly move a shape into (or out of) this phase.

- To increase the width of a phase, select the Move shapes when resizing phases checkbox, before resizing the phase. Shapes, adjacent to the phase, move as you resize the phase.
- To make the adjacent shapes a part of this phase or to remove a shape from this phase, clear the Move shapes when resizing phases checkbox, before resizing the phase. Shapes, adjacent to the phase, do not move as you resize the phase.

To resize a phase, position your cursor over the space between two phase headers, then use the slider to adjust the width to the left or to the right.
Performing additional phase operations

You can perform additional operations on a phase by right-clicking the phase header (see the popup menu in Figure 6: BPM Designer interface with added Phases on page 69). Additional operations include changing the phase header display, modifying existing phase properties, and removing a phase.

- To change the phase display header, from the View menu (Figure 6: BPM Designer interface with added Phases on page 69), select either Name or ID to display your selection in the header of each phase.

- To change the properties of the selected phase, click Phase Properties to open the Phase Properties dialog box, in which you can modify the current phase properties.

- To remove the selected phase, click Remove Phase.
Rollbase Integration

You can now use Rollbase as a presentation type similar to using BPM forms to ensure that BPM forms can be displayed in Rollbase which includes completing the task and other actions. Using this feature, users can export BPM process data as an OpenEdge service object and import it into Rollbase. This is done using the feature, Generate JSDO catalog from a BPM process from within the BPM Studio. Once the JSDO object is created, you can use it as a Rollbase object similar to Creating Page, Enable Workflow etc. For more information, refer to Rollbase Documentation.

This chapter explains the process that you need to follow to integrate OE BPM and Rollbase.

The following are the prerequisites:

- Rollbase 3.1 or above (On Premise) should be installed on your machine
- SPA and SSO should be enabled for BP Server

For details, see the following topics:

- Rollbase as a presentation type for OE BPM

Rollbase as a presentation type for OE BPM

To use Rollbase as a presentation type for OE BPM:

1. In BPM Studio, import the relevant project available in the Samples page of Progress Developer Studio.
Note: In Progress Developer Studio, click Help > Samples to find the relevant project in the Samples page.

2. Modify the security settings of the imported project to enable OE preauth filter.

Note: For more information, refer to Rollbase Documentation.

3. Change the presentation type to Rollbase in BPM Studio.

4. Specify the edit page value as metadata for Rollbase presentation type.

5. Add a presentation type to activity1 and specify the metadata as edit page value.

6. Save and publish the application.

7. From PDSOE, generate the OpenEdge JSDO catalog by right clicking on the process.

Note: For more information on how to generate a JSDO catalog, see Generating OpenEdge JSDO Catalog on page 52.

8. Log into Rollbase.

9. Change Authentication Type to OpenEdge in the Administrator setup page.

Note: For more information, refer to Rollbase documentation.

10. Create a Rollbase application from External Data and choose Import from OpenEdge service.

11. In the next page, provide the JSDO catalog generated from PDSOE in step 8.
Designing a process template diagram

This chapter describes how you can design a process template diagram in Progress Developer Studio for OpenEdge.

**Note:** Alternatively, you can design a process template without the knowledge of BPMN shapes. For details, see *Working with the Overview page* on page 87.

For details, see the following topics:

- Creating a process template diagram
- Connecting worksteps
- Adding notes

Creating a process template diagram

*Developing BPM projects* on page 39 describes the procedure of using appropriate wizards to create the project files for Business Processes and Web applications. This section describes how to design a process template for either projects and the differences between them.

When you complete the *New BPM Project* (*Creating a BPM project* on page 40) or the *New Web application* (*Creating a Web application* on page 43) wizard, the *OpenEdge BPM Designer* perspective is launched, with the new process template displayed in the Content pane. It is displayed as a project folder in the Project Explorer and Outline views (these two views are automatically displayed when you use the OpenEdge BPM Designer perspective).
If you do not use the Template section in the wizards, the project opens to a blank process template (SPT or SWT) file in the Content pane. If you use the Template section, the process you select as a template appears in the Content pane.

The BPM Designer interface contains the Project Explorer and Outline views on the left side, the Content pane in the middle, and the Tasks pane on the right side. The Project Explorer and Outline views list the files and structural elements in the process template. The Tasks pane provides Shapes, Performers, and other elements available for the selected process. The name of the current process template is displayed above the Content pane. The Content pane tabs at the bottom enable you to view the template diagram, dataslots, and performers for the process.

A process template typically consists of a single Start workstep, one or more Activity worksteps, and at least one End workstep. The following procedure describes how to create a process template by adding shapes, connectors, and other component templates to the Content pane.

**To save the process template's file and export it in a supported format:**

1. From the Tasks pane, click the Draw Shapes link and then drag any of the shapes available, into the blank Content pane, beginning with the Start shape (рисунок).

   a) Select an Activity shape (рисунок Activity) to represent worksteps performed by a human user (applicable only for Business Processes), an adapter or a subprocess and drag them into the Content pane. Add more Activity Shapes as required.

   b) Add an End workstep (рисунок). The process template must include at least one End workstep.

   **Note:** You can add the rest of the Shapes depending on your process template requirements.

2. From the Tasks pane, use the Connect Shapes link to connect the worksteps. For more information on connecting worksteps, see Connecting worksteps on page 76.

   You can now perform the following operations to complete the process flow diagram:

**Table 22: Completing a Process Flow diagram**

<table>
<thead>
<tr>
<th>To . . .</th>
<th>See . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define dataslots</td>
<td>Using dataslots on page 117.</td>
</tr>
<tr>
<td>Add workstep performers</td>
<td>Defining and assigning performers on page 103.</td>
</tr>
<tr>
<td>Define an alert</td>
<td>Using alerts on page 195.</td>
</tr>
<tr>
<td>Add process simulation</td>
<td>Configuring and running simulation on page 221</td>
</tr>
<tr>
<td>parameters.</td>
<td></td>
</tr>
<tr>
<td>Define workstep properties</td>
<td>Setting workstep properties on page 137</td>
</tr>
<tr>
<td>Define workstep presentation</td>
<td>Defining workstep presentation format on page 179</td>
</tr>
</tbody>
</table>
3. From the palette, click the **Check Diagram** (✓) icon to determine the validity of the process.

   If the new process template is not valid, invalid items are listed in the Problems pane; and a pop-up message is displayed indicating the items that are not valid. If you correctly defined the process template, “The diagram is complete” message appears. Click **OK**.

4. To save changes to all open projects and files, from the **File** menu, click **Save All**.

The major differences between editing functions for a Business Process and a Web application are listed below:

- There are fewer options in the Tasks pane. Unlike in a Business Process, creating phases and swim Lanes are not supported in Web applications.
- There are fewer Shapes available for a Web application. The AND Gateway and Exclusive Or-Join shapes are not supported.
- The **Rules** feature is disabled as rules are not generated in Web applications.
- The **Alerts** tab is not present as this feature is not supported in Web applications.

You can create a process template for a Web application, similar to how you do for a BPM process.

### Changing shapes

BPM Designer allows you to change the shapes after adding them to your Content pane. That means you need not delete an inappropriate shape and drag the correct shape to the Content pane. Table 23: **Changing Shapes** on page 75 lists the valid shapes that you can change to for each process template element.

<table>
<thead>
<tr>
<th>Shape</th>
<th>Change to (in the case of a Business Process)</th>
<th>Change to (in the case of a Web application)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>All other shapes, except End</td>
<td>All other shapes, except End</td>
</tr>
<tr>
<td>Activity</td>
<td>All other shapes, except Start and End</td>
<td>All other shapes, except Start and End</td>
</tr>
<tr>
<td>Decision</td>
<td>Activity, AND Gateway, Message</td>
<td>Only Activity</td>
</tr>
<tr>
<td>XOR Join</td>
<td>All other shapes, except Start and End</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>OR Join</td>
<td>All other shapes, except Start and End</td>
<td>All other shapes, except Start and End</td>
</tr>
<tr>
<td>AND Gateway</td>
<td>All other shapes, except Start and End</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Message</td>
<td>All other shapes, except Start and End</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>End</td>
<td>All other shapes, except Start</td>
<td>All other shapes, except Start</td>
</tr>
</tbody>
</table>

**To change a shape:**

1. Right-click the shape that you want to change, and then point to the **Change To** option.

2. BPM Designer displays the list of valid shapes that you can change to. Click the shape that you want to change to from the options provided, to view the altered shape element in the Content pane.
Connecting worksteps

You can use the **Connect Shapes** link in the Tasks pane to connect the several Shapes or process template elements in your process template. The connections (or connectors) between the process elements determine the workflow of the process. Each shape contains up to 12 points of connection, using which you can make multiple connectors to worksteps and shapes. You will notice that when you click the **Connect Shapes** link, the Tasks pane displays three types of links - Normal flow, Compensation flow, Timeout flow - that you can use to connect worksteps.

Table 24: Types of connectors on page 76 describes these connector types and how they appear when used on a template workstep.

**Table 24: Types of connectors**

<table>
<thead>
<tr>
<th>Connector</th>
<th>Appearance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal (Default)</td>
<td><img src="image" alt="Normal connector" /></td>
<td>The <strong>Normal</strong> connector type provides standard connectors to worksteps. In the case of a workstep with multiple outgoing connectors, the default connector indicates a connector with no condition.</td>
</tr>
<tr>
<td>Normal (Conditional)</td>
<td><img src="image" alt="Conditional connector" /></td>
<td>In case of a workstep with multiple outgoing connectors, this conditional connector indicates a connector with a condition. The workflow selects this connector path if the condition is satisfied.</td>
</tr>
<tr>
<td>Compensation</td>
<td><img src="image" alt="Compensation icon" /></td>
<td>Indicates that compensatory steps will be taken in the event of an Error occurring during the running of the process or a Recovery. The connector from the source workstep of a Compensation flow is indicated by a <img src="image" alt="Compensation icon" /> icon. When you add the Compensation flow to a diagram, the target workstep of the Compensation flow automatically becomes a Rollback Point (see Defining a Rollback on page 167). Worksteps with a Compensation icon (<img src="image" alt="Compensation icon" />) are either Rollback Points or have script (or compensation) defined in the <strong>On Recovery</strong> tab in the <strong>Advanced</strong> tab of the workstep’s <strong>Properties</strong> view.</td>
</tr>
<tr>
<td>Timeout</td>
<td><img src="image" alt="Timeout icon" /></td>
<td>Indicates the direction of a workflow after Overdue Actions have been executed and the Last Overdue action is completed. Add the Timeout flow connector to the diagram, the source workstep of a Timeout Flow is marked with a <img src="image" alt="Timeout icon" />. When you add the Timeout flow to a diagram, the <strong>Activate timeout flow</strong> checkbox in the <strong>Overdue Actions</strong> tab of the <strong>Advanced</strong> tab of the target workstep’s <strong>Properties</strong> view is automatically activated. For more information, see Defining a Timeout in worksteps on page 168.</td>
</tr>
</tbody>
</table>
Note: Keep the Optimize connectors when moving shapes checkbox clear to maintain the point of connection to the shape when you move the connected shape. Alternatively, if you select this checkbox, the shortest path between shapes is used for the connection. For example, if the position of "Activity2" in the process diagram is closer to "Activity1" than the position of "Activity3," then any connector from Activity1 is joined to Activity2.

When you choose one of the above flow types, the representation of the cursor in the Content pane changes to indicate the type of flow you selected. Table 25: Shape and Output Link Matrix on page 77 indicates the type of links that can be used with typical process template components and the number of links (single, multiple, or none), which are allowed to originate from each element.

Table 25: Shape and Output Link Matrix

<table>
<thead>
<tr>
<th>Shape/Workstep</th>
<th>Default</th>
<th>Conditional</th>
<th>Compensation</th>
<th>Timeout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Multiple allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Decision</td>
<td>One allowed</td>
<td>Multiple allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Split</td>
<td>Multiple allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>And-Join</td>
<td>One allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Or-Join</td>
<td>One allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Xor-Join</td>
<td>One allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Activity workstep</td>
<td>Multiple allowed</td>
<td>Multiple allowed</td>
<td>One allowed</td>
<td>One allowed</td>
</tr>
<tr>
<td>Subprocess worksteps</td>
<td>Multiple allowed</td>
<td>Multiple allowed</td>
<td>One allowed</td>
<td>One allowed</td>
</tr>
<tr>
<td>Message</td>
<td>Multiple allowed</td>
<td>Multiple allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>End</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
</tbody>
</table>

Using multiple connectors

You can use multiple incoming and outgoing connectors for a workstep without using an intermediary Or-Join, AND, or Decision. In addition, BPM Designer supports multiple outgoing connectors for Start worksteps; and multiple incoming connectors for Decisions and End worksteps.

The following restrictions apply to workstep connections:

• You cannot have more than one connector of the same type with the same source and target worksteps.
• A connector cannot originate from and terminate at the same workstep.
• The Or-Join and XOR-Join gateways can have only one outgoing connector. When an AND gateway has multiple incoming connectors, it acts as an And-Join and can have only one outgoing connector.

Note: Even though you can now design a business process without using the Or-Join or Decision gateways, these worksteps are still available for users who want to add them to processes to clarify or highlight areas of the process’s workflow.
Using multiple incoming connectors to worksteps

You can add multiple incoming connectors to worksteps. You can also add multiple incoming connectors to Decision, Or-Join and End worksteps. These multiple incoming connectors are the equivalent of an Or-Join shape and, in this case, indicates that Activity 3 will be performed when either Activity 1 or Activity 2 is completed.

Figure 7: Process Diagram with Multiple Connections

Using multiple outgoing connectors from worksteps

You can add multiple outgoing connectors to worksteps. You can also add multiple outgoing connectors from Decision, Or-Join and Start worksteps. With this type of connector, you can add conditions that will direct the process flow.

Note: All connectors are default connectors unless you clear the Default checkbox in the Link Properties dialog box.

If all of the outgoing connectors from a workstep have no specified condition, then these connectors are the equivalent to an And shape, indicating that once the previous workstep is completed, the next worksteps are activated simultaneously. For example, the connectors to Activity 1 and 2 have no condition and these two activities are both started after the Start workstep is completed.

If one or more of the outgoing connectors from a previous workstep has a specified condition, then these connectors are equivalent to a Decision shape. Once the previous workstep is completed, one or more next worksteps can be activated if the connectors to them fulfill specified conditions. But if these conditions are not met in any of the connectors, then all connectors with no condition will be executed. For example, the connectors from Activity 3 to Activities 4, 5 and 7 each have conditions and one or more of these activities will be executed when the specified conditions are met; the connectors from Activity 3 to Activity 6 has no specified condition and these activities will be executed when the specified conditions for Activities 4, 5 and 7 are not satisfied.
Using multiple incoming/outgoing connectors with gateways

Gateways are diamond-shaped objects in a BPMN process diagram; they represent a change in the workflow—it may indicate the joining, merging, splitting or deciding of the flow’s direction. Gateways include Decision (including Exclusive Decisions), XOR Join, OR-Join, and AND Gateway. Decisions (◇) have a single incoming connector and multiple outgoing connectors. Or-Join (◇) and XOR Join (◇) gateways have multiple incoming connectors and a single outgoing connector. When an AND gateway (◇) has multiple incoming connectors, it must have a single outgoing connector—in this case, the AND gateway acts as an And Join. When an AND gateway has a single incoming connector, it can have multiple outgoing connectors—in this case, the AND gateway acts as an And Fork (or Split). These variations in incoming or outgoing connectors for gateways are illustrated in the following figure.

Figure 8: Examples of Gateway connectors

If you want to start multiple parallel worksteps after an Or-Join or XOR Join gateway, you must insert an AND Gateway immediately after the Or-Join or XOR Join gateway.

Defining Loops in the workflow

You can define loops in the workflow without using multiple connectors to and out of worksteps, and without using Decision shapes. For more information, see Defining a Loop condition on page 144.

Adding notes

You can add a note (a Sticky Note, an Annotation, or a Group notation) to any element in a process template diagram. Sticky Notes and Annotations generally have the same functions, and they only differ in visual representation. You can use a Sticky Note or Annotation to indicate specific features or conditions, or as prompts or reminders for other users (for example, "Must be reviewed by all managers"). Use the Group notation to select and insert a caption that describe a group of worksteps that share a similar task (for example, all activities performed by the HR Department in Hiring) or that require the same performer (for example, highlighting all worksteps "Performed by Managers Group in HR Department").

To insert a note into a process:

1. Click the Create Annotations link in the Tasks Pane and drag the Sticky Note (✍️, Annotation ( 따른데) or Group notation ( 따른데) shape into the Content pane. You can also drag any of these notes onto a workstep or other shape, which creates a connection between it and the note.
2. Click the note to view its properties in the Properties view.
a) In the General tab, you can change the appearance of the note (example, Sticky Note to Group). Use the Type drop-down list to specify the new type for the existing note.

b) Click View/Edit link to open the View/Edit dialog box, where you can enter the note’s message or the grouping’s caption in the text area provided. For a Group notation, enter a caption for the group association (for example, Review all grouped worksteps). Use the toolbar icons to format the text as required.

c) You can also insert a hyperlink by right-clicking the text area and selecting the appropriate option. To add a hyperlink to a note, select Insert > Link opening the Link Properties dialog box. Here, specify the text to be used as the hyperlink and the URL.

d) Click OK to apply the changes to the selected note and return to the Properties view.

e) From the Background section, you can select a background color for Sticky Notes. You cannot change colors for Annotation and Group notations. You can also click More to display more color options.

Note: You can also change the background color of one or more Sticky Notes by selecting the note elements in your Content pane and then clicking the Color icon from the palette, to open the color palette. Select one of the listed colors, or click More to open the Color Chooser dialog box to define your custom color.

f) From the Associate With: drop-down list, you can associate the Sticky Note or Annotation with a specific workstep by selecting from the worksteps listed. To disassociate a note from a workstep, select (none) from the drop-down list.

Once you define the properties of the notes, the notes appear in the process template diagram, as shown for a Sticky Note in the following figure.

3. Use your cursor to move or resize the Sticky Note, Annotation, or Group notation as required.
Managing gestures

Progress Developer Studio for OpenEdge provides mouse gestures to quickly add shapes, connectors, and layouts to your Content pane, as well as perform commonly-used actions in your process template.

This chapter describes how you can use mouse gestures in your process template diagram, and to create custom gestures using the Gesture Editor.

For details, see the following topics:

• Using mouse gestures
• Creating custom gestures
• Saving custom gestures

Using mouse gestures

You can view the set of predefined mouse gestures in the Default Gestures dialog box.

1. Create or open the process template diagram (SPT or SWT) where you want to use mouse gestures.

2. Click the Show Gestures ( ) icon from the palette, to open the Default Gestures dialog box which displays the mouse gestures predefined for a Business Process.

Note: Web applications support fewer shapes and layout gestures.
3. Point to each of the shapes, layouts, and actions to view the gesture details in the **Gesture Details** section. The red dot indicates the starting point of the gesture.

4. Click **OK** to close the **Default Gestures** dialog box.

To use any gesture in your Content pane, drag the right mouse button in the required direction. To connect shapes using gestures, press **CTRL** key and then drag the right mouse button between shapes to connect them.

---

**Note**: By default, you can use gestures to connect shapes with the normal flow connector. To connect shapes using the other connector types, select the other connector types (see **Connecting worksteps** on page 76) before using gestures to connect shapes.

---

### Creating custom gestures

Progress Developer Studio for OpenEdge provides the **Gesture Editor**, which enables you to create custom gestures and replace the default gestures.

### Using the Gesture Editor

**To start the Gesture Editor:**

1. From the **OpenEdge > Tools** menu, click **Gestures** to open a blank **Gesture Editor** dialog box.
2. Click **File > New** to populate the **Gesture Editor** with the set of predefined actions and parameters.

The Gesture Editor consists of the following three panes:

- **Actions pane**, containing the list of predefined gesture actions, as listed in **Table 26: List of predefined actions** on page 82. For information regarding the shapes used, see **Using shapes** on page 35.
- **The middle pane**, where you can view (and edit) the action selected in the Actions pane, as well as draw one or many gestures for each action.
- **Gestures pane**, which displays the gestures associated with each action.

#### Table 26: List of predefined actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>shape_start</td>
<td>Creates a Start workstep.</td>
</tr>
<tr>
<td>shape_activity</td>
<td>Creates an Activity workstep.</td>
</tr>
<tr>
<td>shape_activity_performer</td>
<td>Creates an Activity workstep with a performer. You can assign the performer, which can be a human, an adapter (managed or custom), a subprocess (with external reference), or an external (user or adapter) performer. For information regarding performers, see <strong>Defining and assigning performers</strong> on page 103.</td>
</tr>
<tr>
<td>shape_decision</td>
<td>Creates a Decision gateway.</td>
</tr>
<tr>
<td>shape_xor</td>
<td>Creates an Exclusive Or-Join gateway.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>shape_or</td>
<td>Creates an Or-Join gateway.</td>
</tr>
<tr>
<td>shape_and</td>
<td>Creates an And gateway.</td>
</tr>
<tr>
<td>shape_message</td>
<td>Creates a Message workstep.</td>
</tr>
<tr>
<td>shape_end</td>
<td>Creates an End workstep.</td>
</tr>
<tr>
<td>add_swimlane</td>
<td>Adds a swimlane. For information regarding swimlanes, see Using swim lanes on page 113.</td>
</tr>
<tr>
<td>add_phase</td>
<td>Adds a phase. For information regarding phases, see Managing phases on page 68.</td>
</tr>
<tr>
<td>add_group</td>
<td>Adds a group notation shape. For more information, see Adding notes on page 79.</td>
</tr>
<tr>
<td>layout</td>
<td>Performs an auto-layout, which generates an ideal layout for the process template diagram elements. This action is only performed if the auto-generated layout is better than the manual layout.</td>
</tr>
<tr>
<td>layout_force</td>
<td>Performs a forced auto-layout. In this case, the layout of the process template elements is always automatically adjusted.</td>
</tr>
<tr>
<td>layout_force_with_swimlanes</td>
<td>Performs a forced auto-layout, as well as adds swimlanes.</td>
</tr>
<tr>
<td>remove</td>
<td>Removes an added workstep or connector.</td>
</tr>
<tr>
<td>verify</td>
<td>Validates the process template diagram.</td>
</tr>
<tr>
<td>zoom_in / zoom_out</td>
<td>Magnifies or shrinks the view of the process template diagram.</td>
</tr>
<tr>
<td>undo / redo</td>
<td>Undoes or redoes the last action performed in the Content pane, up to 100 previous actions.</td>
</tr>
<tr>
<td>help</td>
<td>Displays help for the customised gestures, similar to the Default Gestures dialog box.</td>
</tr>
</tbody>
</table>

### Designing gestures

**To design a gesture in the Gesture Editor:**

1. From the Actions pane, select the action for which you want to design the gesture.
2. Modify, if required, the default text in the Label and Description boxes to provide additional information for the gesture. You can enter a static label or description; for instance, "End" for label and "Adds an End workstep" for description.
   
   BPM Designer converts any value starting with the "$" sign with the corresponding string in the localization file (example, designer.properties).
3. In the drawing area provided, drag your mouse to draw the gesture icon to be used for the corresponding action. To accept the drawn shape and clear the drawing area, click **Accept**. To discard the drawn shape, simply click in the drawing area.

4. After you click **Accept**, the drawn shape is displayed as a gesture in the **Gestures** pane. To remove the added gesture from the **Gestures** pane, select the gesture to be deleted and click **Discard**.

Depending on the complexity of the action, create multiple gesture samples. For simpler actions, two to three gesture samples are adequate. For complex actions, you need to create more samples.

Repeat Step 3 to Step 4 to add multiple gesture samples.

You can use the checkbox for each gesture in the **Gestures** pane to select the icon to be displayed for this action in the help for the customised gestures. If you select multiple checkboxes, the gesture that you select first is displayed as the gesture icon and the rest of the gestures are displayed in the **Gesture Details** section.

**Guidelines for gestures**

You need to follow the following guidelines when designing a gesture.

- The starting point of a gesture is important. You can use the starting point to distinguish several similar shaped gestures.
- You can use the direction to create two different gestures for the same shape. For instance, you can use a clockwise-drawn circle for a Start workstep, and anti-clockwise circle for the End workstep.
- Always create multiple gesture samples for each action. This ensures that the gesture recognition algorithm compensates most of the variations, thus resulting in reliable recognition.
- Do not try to be too precise when drawing the gesture sample. Do not make the sample size too big or too small. Draw them as you would when using them in practice.
- Draw each gesture with a single stroke. Releasing your mouse indicates the end of the gesture.

**Saving custom gestures**

Progress Developer Studio for OpenEdge stores all gestures (default and custom) in the `Workspace_Home\.com.savvion.studio\gestures` folder. The default gesture set is stored as `default.ptp`. All custom gestures are stored as GLF files (Gesture Library File). For the purpose of starting, Progress Developer Studio for OpenEdge provides a sample gesture set (`sample.glf`) file.

To save your custom gesture:

1. Use the **Gesture Editor** to create your custom gestures for each required action.
2. Click **File > Save**, to open the **Save** dialog box.
3. Type the gesture file name, and then click **Save**.
   
   You can open your custom gesture file (using **File > Open** option in **Gesture Editor**) and modify the same.

**Using custom gestures**

You can now use your saved custom gesture in your process template diagram by replacing the default gesture set (`default.ptp`) with your custom gesture file.
1. From the main menu bar, click **Window > Preferences** to open the **Preferences** dialog box (described in **Setting preferences** on page 98).

2. Expand the **Progress OpenEdge > BPM** node and select **Diagram**.

3. From the **Gestures** section, change the default gestures file (**default.ptp**) by clicking **Browse** next to the **Gestures file** box, then select your custom gestures file in **GLF** format.

4. Click **OK** to close the **Preferences** dialog box.

5. Open the process template diagram (**SPT** or **SWT**) where you want to use your custom gesture.

6. Click the **Show Gestures** ( 🍃 ) icon from the palette, which now displays your custom gesture set.
Working with the Overview page

Progress Developer Studio for OpenEdge allows process modeling and analyzing through the Diagram view. In certain situations, this procedure can be cumbersome, as there is a learning curve involved for the business user, who needs to understand the usage and semantics of BPMN shapes before defining a meaningful process. Consider an instance where a business user wants to quickly outline a large process with a large number of tasks. Instead of adding shapes and defining their properties in the Diagram view, a business user would probably rather work with a project-oriented view of the process by defining a set of tasks, the task/subtask relationships, and additional details without ever needing to switch to the Diagram view. The Diagram view is still a useful view especially for complex flows. However, it is not the only view, nor is it be the only editor for defining new worksteps. Progress Developer Studio for OpenEdge provides the Overview page, which is an effective tool to support project-oriented processes.

For details, see the following topics:

- Introducing the Overview page
- Managing tasks

Introducing the Overview page

The Overview page (or tab) provides a project-oriented approach - including activity timelines - to designing a process, where you can add a set of tasks (or activities), define their relationship, and configure the properties, without switching to the Diagram tab.

The Overview page provides the following benefits:

- You can reduce process design time by over 30% by using the Overview page.
• You can filter process elements in the **Overview** page for analysis. For example, you can choose to view only Tasks or Adapters.

The **Diagram** and **Overview** pages of a process provide different views of the same process. The following are the important common features:

• Any changes made in either of the views are reflected in the other view, when activated.
• All the process template elements in the **Diagram** view (except for Notes, Swim lanes, Phases, and Rules) are also available in the **Overview** page.
• The same **Properties** view for the process and for each workstep is available in both pages.
• As in **Diagram** view, you can group tasks in the **Overview** page and then convert it to an inline subprocess.

### Reviewing the Overview page

You can design a process template from scratch in the **Overview** page of the Progress Developer Studio for OpenEdge interface.

For a blank process template, the **Overview** page does not contain any elements or tasks. For a process template that contains elements, the **Overview** page contains the corresponding elements or tasks.

The **Overview** page displays the following default information about each task in a tabular format:

**Table 27: Task Information**

<table>
<thead>
<tr>
<th><strong>Column</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the task name, with the adjoining icon indicating the shape used. To change the task name, double-click the cell and enter the new task name. An inline subprocess workstep displays an expandable icon, which you can expand to view its worksteps.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of task or workstep. To change the type, click in the cell and then select one of the options available. The available options depend on the workstep and process type (as listed in <em>Changing shapes</em> on page 75).</td>
</tr>
<tr>
<td>Successors</td>
<td>Displays the successor tasks (in case of a single outgoing connector) or multiple tasks (in case of multiple outgoing connectors). To define the successor tasks, click in the cell and then click the <strong>ellipsis</strong> button. From the left pane of the <strong>Add/Modify Successors</strong> dialog box that appears, select the tasks to be added as successors and click <strong>»</strong> to move them to the right pane. To remove tasks added as successors, select the tasks in the right pane and click <strong>£</strong>. You can define successor for any task type, except End.</td>
</tr>
</tbody>
</table>
| Duration   | Displays the default duration (2 hours) of Activity, Adapter, and Embedded Sub-Process task types. To modify the duration, click in the cell and then click the **ellipsis** button. Select either of the following options:
  • **Enter a duration**, to open the **Duration** dialog box, in which you can enter the number of days, hours, or minutes for the workstep duration.
  • **Use a dataslot**, to open the **Select Dataslots** dialog box, which lists the INTEGER and INT64 dataslots available in the process. Select a INTEGER or INT64 dataslot to define a dynamic duration for this workstep. |
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>To change the workstep priority, click in the cell, then select any of the predefined options: Low, Medium, High, or Critical. Click the Use a dataslot option to choose a dynamic dataslot value at runtime.</td>
</tr>
<tr>
<td>Performer</td>
<td>Displays the default performer for Activity, Adapter, and Subprocess worksteps. Click in the cell to select another performer (if defined). For more information regarding performers, see Defining and assigning performers on page 103.</td>
</tr>
<tr>
<td>Milestone Alerts</td>
<td>Applicable only to Start, Activity, Adapter, and Subprocess type tasks. Displays the alerts (if any) associated with the completion of a task (or a milestone). To associate an alert, click in the cell and then click the ellipsis button. From the left pane of the Milestone Alerts dialog box that appears, select the alerts to be added and click to move them to the right pane. To remove any added alert, select the alert in the right pane and click . You can associate multiple milestone alerts with the same task. To associate all of the defined alerts with the task, click . To remove all of the associated alerts with the task, click . For information regarding alerts, see Using alerts on page 195.</td>
</tr>
<tr>
<td>Phase</td>
<td>Indicates the phase (if any) to which the task belongs. For information regarding phases, see Managing phases on page 68.</td>
</tr>
</tbody>
</table>

You can sort the Overview page content by clicking on the column header. You can also search the task list based on a keyword, by entering the keyword in the Search box ( ).

You can also filter the listed tasks by selecting the appropriate filtering criteria. You can apply filtering on basis of the type of tasks (for example, Adapter) and on basis of advanced properties (for example, "Worksteps with skip condition" and "Worksteps that have overdue actions").

**To filter the tasks:**

1. Click the Click to filter ( ) icon.

   The Filter dialog box appears.

2. To enable filtering, select the Enable filtering check box.

   To filter the list of tasks on basis of the workstep type, select one (or more) check boxes in the Type list.
   To filter the list of tasks on basis of advanced workstep properties, select one (or more) check boxes in the Advanced list.

3. Click OK to apply the selected filtering to the list of tasks in the Overview page.

**Managing tasks**

You can create and edit an entire process template in the Overview tab. You can also set the properties of individual tasks (or worksteps) in the Properties view, as described in Setting workstep properties on page 137. You can use the toolbar in the Overview tab to add and manage the tasks of the process template.
Adding a task

To add a task (or a workstep):

1. Click the **Click to add** icon ( ), inserting a default Activity task. To add a task after an existing task, select the existing task and then click the **Click to add** icon.

2. Type the task name in the **Name** column. Task names can include only alphanumeric characters and the underscore (_) character.

3. In the **Type** column, click in the cell and then select from the available workstep options, as required.

   *Table 28: Workstep Type on page 90 lists the available options.*

**Table 28: Workstep Type**

<table>
<thead>
<tr>
<th>Options</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND Gateway</td>
<td>To add an AND gateway. This gateway is not available for Web applications.</td>
</tr>
<tr>
<td>Activity</td>
<td>(default) To add an Activity workstep.</td>
</tr>
<tr>
<td>Adapter</td>
<td>To add an adapter workstep. Displays the Adapter dialog box, in which you can define (or select) any adapter.</td>
</tr>
<tr>
<td>Decision</td>
<td>To add a decision gateway.</td>
</tr>
<tr>
<td>Embedded Sub-Process</td>
<td>To add an inline subprocess. This option is not available for Web applications.</td>
</tr>
<tr>
<td>End</td>
<td>To add an End workstep. This type is only available when there is no successor task specified under the <strong>Successors</strong> column.</td>
</tr>
<tr>
<td>External Activity</td>
<td>To add a monitoring Activity workstep.</td>
</tr>
<tr>
<td>External Sub-Process</td>
<td>To add an external subprocess.</td>
</tr>
<tr>
<td>External Adapter</td>
<td>To add a monitoring Adapter workstep.</td>
</tr>
<tr>
<td>Managed</td>
<td>To add a managed adapter workstep. On selecting this type, the Managed Adapter Browser tool appears. For more details, see Using Managed Adapter Browser on page 283.</td>
</tr>
<tr>
<td>Message</td>
<td>To add a Message workstep. This workstep type is not available for Web applications.</td>
</tr>
<tr>
<td>OR Join</td>
<td>To add an Or-Join gateway.</td>
</tr>
</tbody>
</table>
4. To add more tasks, click the **Click to add** icon.

   The **Successor** column for the previous task now displays the default task name (“Activity 2”) of the added task.

### Performing other operations

After adding tasks, you can perform any of the following operations using the toolbar in the **Overview** tab.

- You can expand (and collapse) the entire task list in order to view (or hide) all elements. To expand the list, click the **Click to expand all nodes** (.fold-vertical) icon. To collapse the list, click the **Click to collapse all nodes** (.fold-vertical) icon.

- To remove a task, select the task and click the **Click to remove** (.remove) icon.

- To group tasks into an inline subprocess, select the tasks and click the **Group tasks** (fold-horizontal) icon. This inserts a subprocess task of type, “Embedded subprocess” and contains the grouped tasks between a Start and End workstep. To ungroup the tasks, select the subprocess task and click the **Ungroup Tasks** (fold-horizontal) icon.

   **Note:** You cannot add nor delete group tasks for sorted and filtered (by workstep type and by advanced properties) data.

- To change the position of a selected task, click the **Move up** (.move-up) icon or the **Move down** icon (.move-down). Changing the position of a task does not alter the task’s predecessor and successor.

- To view any task in the Diagram view, select the task and then switch to the Diagram view.

- You may need to restore the added tasks to its original order. To do so, click the **Restore Default Order of Tasks** (reset) icon.

   **Note:** You can design an entire process template in the **Overview** tab, without switching to the **Diagram** tab. To ensure that all changes in the Overview page are integrated seamlessly in the Diagram view of the process, see that the Auto Layout functionality is enabled in the **Diagram** page of the **Preferences** dialog box (see **Using the Diagram page** on page 100).
Introducing Path Analysis

This chapter describes how you can perform process path analysis using the Path Analysis view.

For details, see the following topics:

- Using the Path Analysis view
- Exploring the Path Analysis view

Using the Path Analysis view

Progress Developer Studio for OpenEdge provides the Path Analysis functionality in the Path Analysis view, which enables you to analyze the timing of process execution.

Path Analysis provides the following functionalities:

- Ability to drill down through a specific path and estimate the time required for the process execution to reach a particular point in the process.
- Displays workstep attributes including duration, priority, and performer.
- Provides process timeline information with:
  - Graphical display of workstep duration.
  - Grid and markers for duration units including days, weeks, and months.
  - Alternate coloring between weeks, to identify week boundaries.
- Displays all process paths from Start to End workstep using nested paths.
• Displays the estimated start time for each workstep, which is calculated by adding the sum of duration of all previous worksteps in that path.

Figure 9: A Sample Approval Process Template on page 94 shows a sample approval process that requires the reviewer to decide if the request meets specific critical criteria. If the performer of the ReviewRequest workstep decides it is non-critical, it is sent by e-mail to a group at a remote location for submission.

Figure 9: A Sample Approval Process Template

The Review Request workstep assigned to any member from MgrGroup has an assigned work time of two hours; and the Submit Request workstep assigned to any member from the ebmsgroup has a work time of 50 minutes.

If any member from the MgrGroup decides the request is critical, it is sent to the Exec Approve workstep (with assigned work time of 50 minutes), in which a senior executive (performer, "exec") then approves or rejects it. The approved requests are sent to the Submit Request2 workstep (work time of 50 minutes). Any member of the MgrGroup can view the request status in the Request Status workstep (with default duration of 2 hours). Each of the Adapter worksteps has an estimated duration of 10 minutes. The entire process has an estimated duration of 6 hours.

Exploring the Path Analysis view

To open the Path Analysis view for any process template (for instance, the process shown in Figure 9: A Sample Approval Process Template on page 94), open the process template and then click the Path Analysis content pane tab.

The Path Analysis view displays the name of each task and the following default columns.

Table 29: Column Information In Path Browser

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the task name, with the adjoining icon indicating the shape used.</td>
</tr>
<tr>
<td>Est. Start</td>
<td>Indicates the time interval in which the task is estimated to start. If there is no time interval, this column displays &quot;(none)&quot; (for instance, in the case of the Start workstep). This value is derived by adding the duration for previous tasks. For instance, the estimated start of 4 hours for the Notify Reject task is a sum of the duration for Review Request and Exec Approve tasks. An asterisk beside an estimate (in this case, for “Request Status” and “End1” tasks), indicates that the estimate may not be accurate because there are parallel paths to reach that point.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Duration</td>
<td>Displays the time required to complete the task. The colors representing the duration are indicated as follows and are relative to the duration of the other tasks.</td>
</tr>
<tr>
<td></td>
<td>• Red for the tasks with the maximum duration (in this case, Review Request and Exec Approve).</td>
</tr>
<tr>
<td></td>
<td>• Green for the tasks with the minimum duration (in this case, Notify Reject and Notify Submit).</td>
</tr>
<tr>
<td></td>
<td>• Yellow for the tasks with the average duration (that is, an average of maximum and minimum duration values). For some processes, if all the tasks have the same duration, their duration is also represented in yellow.</td>
</tr>
<tr>
<td></td>
<td>• All durations that measure between the average and maximum values are represented in gradient colors from yellow to red.</td>
</tr>
<tr>
<td></td>
<td>• All durations that measure between the minimum and average values are represented in gradient colors from green to yellow.</td>
</tr>
<tr>
<td>Priority</td>
<td>Displays the workstep priority. Supported values are: Low, Medium, High, Critical, or dataslot name.</td>
</tr>
<tr>
<td>Performer</td>
<td>Displays the performer for Activity, Adapter, and Subprocess worksteps.</td>
</tr>
<tr>
<td>Timeline</td>
<td>Provides a visual representation of the Estimated Start and Duration data for each task, without displaying the actual numbers. Each timeline starts from the Estimated Start value and continues for the specified Duration. The timeline is tabulated based on the total process time (in this case, 6 hours) with each task timeline representing the work breakdown structure. Timelines also depict the dependencies between tasks (that is, a particular task cannot start before another task is completed). If the timeline for a particular task is displayed in orange (in this case, the Request Status task), it indicates that the estimated start time may not be accurate because there are parallel paths to reach that point.</td>
</tr>
</tbody>
</table>

**Note:** You can expand (and collapse) the process path in order to view (or hide) all elements. To expand the list, click the **Click to expand all nodes** icon. To collapse the list, click the **Click to collapse all nodes** icon.

The Path Analysis view displays all the possible paths that a process execution can take. When you search a particular workstep type (or name) by entering the keyword in the **Search** box, the Path Analysis view displays only those paths that contain the keyword you have searched.

You can also filter the paths by selecting the appropriate filtering criteria. You can apply filtering on basis of the type of tasks (for example, Adapter) and on basis of advanced properties (for example, "Worksteps that have loop" and "Worksteps that can be skipped").

**To apply filtering:**

1. Click the **Click to filter** icon. The **Filter** dialog box appears.
2. To enable filtering, select the **Enable filtering** check box.
To filter the paths on basis of the workstep type, select one (or more) check boxes in the *Type* list. To filter the list of tasks on basis of advanced workstep properties, select one (or more) check boxes in the *Advanced* list.

3. Click **OK** to apply the selected filtering to the paths in the **Path Analysis** view.
Defining process properties

This chapter describes how you can define process properties of a Business Process or Web application. You can define process properties for the first time or modify some of the properties that you have defined when creating the application (refer Creating a Business Process on page 41 and Creating a Web application on page 43).

For details, see the following topics:

• Setting process properties
• Setting preferences

Setting process properties

BPM Designer provides the Properties view where you can set (and modify) properties of the process, and the process template elements (as described in Setting workstep properties on page 137).

The procedures for defining the properties of a process are similar for Business Processes and Web applications.

1. Open the process template file, whose properties you want to define.
2. Click a blank area of the Diagram tab, to open the Properties view.

   By default, it opens to the General tab.

   **Note**: You cannot modify the process name in the Name box. You can define (or modify) the rest of the process properties in the General tab. For information on each of these properties, refer to Table 13: Application properties on page 42.
Chapter 11: Defining process properties

3. (Optional) Click the **Description** tab and enter a description of the process in the text area provided.

4. Click the **Attributes** tab to review existing attributes and modify their values. You can create attributes only in the Administration module of Business Process Portal (for more information, see *Business Process Portal Administrator’s Guide*).

   To review and modify attributes and their values:

   a) From the **Attributes** tab, you can view the process attributes and values. If there are many attributes listed, you can enter a string of letters in the Search box and any attribute name containing that string is displayed in the table provided.

   b) By default, the **Attributes** tab lists the **ProcessType** attribute with value, **BusinessProcess**, **SystemProcess** or **PresentationProcess** (available only for web applications). To add attributes, click **More** to open the **Attributes** dialog box, which lists the default attributes—Executable, Goal, Influencers, Objective, Organizational Unit, Process Type, Risks, Rewards—as well as attributes that have already been defined in Business Process Portal.

   c) Click the **Add** icon to go to Administration module of Business Process Portal, in which you can add more attributes, if required.

   Click the **Refresh** icon to refresh the view of the listed attributes.

   d) Select one or more attributes (except Process Type) listed in the **Attributes** dialog box and click **OK** to add them to the **Attributes** tab in **Properties** view.

   e) To modify the value of an attribute, select the attribute and click **Modify**. You can only modify an attribute if it has been defined as Editable in Business Process Portal.

   f) Click **Clear** to clear the value of the selected attribute. To remove an attribute, click **More** to open the **Attributes** dialog box, and clear the checkbox of the attribute you want to remove from the process.

5. Click the **Portal** tab (only available for Business Process) to specify the order of user-defined dataslots in the current process as additional task columns in Business Process Portal.

   a) View the order of dataslots that will appear as a new column in the My Tasks page of Business Process Portal. To enable a user-defined dataslot to be displayed in this list, you need to select the **Tasks Column** checkbox in the **Access** tab of the **New/Modify Dataslot** dialog box. (For more information, see **Setting the dataslot access** on page 133.

   b) Select one of these dataslots and then click **Move Up** or **Move Down** to place the dataslot in the correct sequence that will then be displayed in the Tasks page in Business Process Portal.

6. Click the **History** tab to review past actions in the process. This read-only tab provides information on when the process was created or published.

7. Use the **Monitoring** tab (available only for Business Process with a monitoring workstep) to define the configurations for a monitoring process. For more information, see **Introducing monitoring process** on page 171.

## Setting preferences

Progress Developer Studio for OpenEdge (Developer Studio) provides the **Preferences** dialog box, a Configuration interface that enables you to easily modify the more commonly used configuration parameters. Once you have defined these configuration parameters in the **Preferences** dialog box, they are automatically set for each new project.

**To set your preferences in Developer Studio:**
1. From the main menu bar, click **Window > Preferences** to open the **Preferences** dialog box.

2. Expand **Progress OpenEdge > BPM** in the left pane, the following options are displayed:
   
   - **Activity**: to set the default properties for an Activity workstep, as discussed in **Using the Activity page** on page 99.
   - **Application**: to set the default properties and attributes for a process, as discussed in **Using the Application page** on page 99.
   - **Diagram**: to set the default size of the Diagram view, as well as appearance and other settings as discussed in, **Using the Diagram page** on page 100.
   - **Export**: to configure the display settings of a process template diagram, when exported in JPG format as discussed in **Using the Export page** on page 100.
   - **Publish**: to define the configuration for the target Business Process Server, as discussed in **Using the Publish page** on page 101.
   - **Simulation**: to set the default simulation-related properties in Simulation perspective, as discussed in **Using the Simulation page** on page 101.

3. After defining the above preferences, click **OK** to close the **Preferences** dialog box.

---

**Note**: To apply the changes made in each page, click **Apply**. Click **Restore Defaults** if you want to restore the values of all options in the page to the default values.

---

**Using the Activity page**

You can use the **Activity** page to configure the default properties of an Activity workstep.

1. From the **Presentation** drop-down list, select the default presentation format (Auto-generated) for Activity workstep.
2. Select the default priority (Low, Medium, High, or Critical) for the Activity workstep in the **Priority** drop-down list.
3. Use the **Duration** boxes to change the default duration (2 hours) of the Activity workstep.

**Using the Application page**

You can use the **Application** page to configure the default properties of a process and the default attributes, and database settings.

1. From the **Default Properties** section, set the default properties for a process including the default manager, group, duration, category, sub-category, and author.
2. From the **Default Attributes** section, view (or modify) the default server location from where you can import attributes.
3. From the **Database** section, view (or modify) the database system to be used for dataslots in the process. The available options are for OpenEdge database systems. The maximum storage allowed for CHARACTER, INTEGER, and INT64 dataslots in process templates varies, depending on the selected database. For information on configuring the dataslot storage, see the **Setting the dataslot storage** section.
Using the Diagram page

You can use the **Diagram** page to configure the following default properties of the **Diagram** tab in the BPM Designer interface.

**Table 30: Diagram Page Settings**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Size</td>
<td>To set the configuration parameters for width and height of the diagram page. Values range from a 1 to 10.</td>
</tr>
<tr>
<td>Show pages</td>
<td>Select this to display the page boundary, as it appears on your default printer. Use this feature to create appropriate page breaks in a lengthy process template diagram.</td>
</tr>
<tr>
<td>Show grid</td>
<td>Select this to view the process template diagram with a grid. The grid is always active, whether visible or not. In the Grid size box, set the space between the grid points. Although grid size ranges from 1 - 50, use values that are multiples of 4. By default, grid size is set to 12. <strong>Note:</strong> Due to Java limitations, a process template diagram may not display correctly if you select a grid size of 10 or less.</td>
</tr>
<tr>
<td>Fill shapes</td>
<td>Select this to view a solid fill for diagram components. Clear this option to display transparent components. You can also view a gradient fill for diagram components by selecting the <strong>Gradient fill</strong> option.</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Select this to align a new component to the grid.</td>
</tr>
<tr>
<td>Snap to shapes</td>
<td>Select this to align each new workstep with the center of neighboring components. If you want to move a shape when the <strong>Snap to shapes</strong> feature is activated, select the workstep and use the arrow keys to move the workstep.</td>
</tr>
<tr>
<td>Auto Layout</td>
<td>Select the quality of the auto layout functionality in the <strong>Overview</strong> page (see Performing other operations on page 91). Options are low (fast), normal, and high (slow). Clear the <strong>Run auto layout after using Tabular View</strong> checkbox to disable the auto layout functionality.</td>
</tr>
<tr>
<td>Gestures</td>
<td>Allows you to enable or disable the Gestures functionality, described in Managing gestures on page 81. For details regarding this operation, see Saving custom gestures on page 84.</td>
</tr>
</tbody>
</table>

Using the Export page

You can use the **Export** page to enter the width and height (in pixels) of the process template diagram when exported in JPG format. The maximum width or height you can specify (in pixels) is 25000. For information on exporting, see **Exporting the process template** on page 64.
Using the Publish page

You can use the Publish page to add, modify, and remove target server options, which are then listed in the Server drop-down list in the Publish Wizard, page 1.

To add a target server:

1. Click Add to open the Add Target dialog box.
2. Enter the target name (required) and its description (optional) in the respective fields.
3. You need to specify at least one target location in the Locations section. To add a location, click Add to open the Add Location dialog box, where you can specify the location in the http://localhost:port/sbm/deployment format. You can also edit or remove a location.
4. Click OK to add the target to the Publish page.

Using the Simulation page

You can use the Simulation page to configure the simulation settings for the simulation project. For details regarding simulation, see Configuring and running simulation on page 221.

1. Use the Start Simulation and Stop Simulation sections to set the default configurations (for the default scenario) for the Simulation Start and Stop settings. For details regarding each of these parameters, see Modifying simulation settings for a scenario on page 226. Use the Currency section to set your default currency symbol.
2. From the Performer page, set the default settings for the performer types—Group, Individual, and System. For details regarding each of these settings, see Managing performers on page 232.
3. From the Process page, you can set the default simulation settings for added processes in the default scenario. For detailed information regarding each of these parameters, see Configuring simulation parameters for a process on page 228.
4. From the Workstep page, you can set the default worktime distribution method and other settings for supported workstep types in the default scenario. For details regarding each of these parameters, see For worksteps on page 229.
5. From the Resource page, you can set the default cost and count for consumable and non-consumable resources. For more information, see Managing resources on page 233.
6. From the UI page, you can set (or modify) your preferred settings for switching between simulation-related perspectives in Progress Developer Studio for OpenEdge. The perspective switches are listed as follows:

   • Open OpenEdge BPM Simulation perspective on launching editor, when creating or opening a simulation project.
   • Open OpenEdge BPM Run Simulation perspective on simulation run, when running a process simulation.
   • Open OpenEdge BPM Simulation perspective on simulation run exit, when exiting the Simulation Runtime perspective after running a process simulation.

The available options for each of the above switches are Always (to launch the respective perspective without any user prompt), Never (to always perform the requested operation in the current perspective without switching the perspective), or Prompt (the default option, which prompts you to switch to the respective perspective).
You can also choose the color settings for status bars and progress bars used in the Simulation perspective. To choose another color, click the bar and then the adjoining color button, opening the **Color** dialog box, where you can select another color. The available bars are listed in Table 31: **Appearance Settings** on page 102.

**Table 31: Appearance Settings**

<table>
<thead>
<tr>
<th>Bar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For Status Bar</strong></td>
<td></td>
</tr>
<tr>
<td>Inactive</td>
<td>Indicates the Simulation and Process Status bars before the simulation run.</td>
</tr>
<tr>
<td>Required</td>
<td>Indicates the total count of required process instances in the Processes Runtime View during the simulation. It also, indicates the time limit for the simulation project in the Simulation Status section of the Simulation Control Editor, during the simulation.</td>
</tr>
<tr>
<td>Created</td>
<td>Indicates the progress status of created process instances in the Processes Runtime View during the simulation.</td>
</tr>
<tr>
<td>Completed</td>
<td>Indicates the progress status of completed process instances in the Processes Runtime View during the simulation run. Indicates the progress status of simulation project in the Simulation Status section of the Simulation Control Editor, during the simulation.</td>
</tr>
</tbody>
</table>

For **Probability Bar** (For details of the **Probability** bar used in the Probability tab of the Properties view in Simulation Perspective; for details, see Setting the probabilities on page 231)

<table>
<thead>
<tr>
<th>Bar Fill Color FG/BG</th>
<th>Indicates the gradient colors (smooth shading of one color to another color) used for the filled portion of the probability bar.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar Empty Color FG/BG</td>
<td>Indicates the gradient colors (smooth shading of one color to another color) used for the empty portion of the probability bar.</td>
</tr>
<tr>
<td>Text</td>
<td>Indicates the color of the text displayed on the probability bar.</td>
</tr>
<tr>
<td>Shadow</td>
<td>Indicates the color of shadow bar accompanying the probability bar.</td>
</tr>
<tr>
<td>Color when selected</td>
<td>Indicates the color of the probability bar, when selected.</td>
</tr>
<tr>
<td>Border</td>
<td>Indicates the border color of the probability bar.</td>
</tr>
</tbody>
</table>
Defining and assigning performers

You can define performers and assign them to worksteps. BPM Designer supports three types of performers—User (human performers), Adapter (a Java class as the performer), and Subprocess (another process which can be assigned to a workstep).

**Note:** Web applications do not support user-type performers.

This chapter describes how to define and assign performers, as well as using swim lanes.

For details, see the following topics:

- Reviewing the Performers tab
- Defining performers
- Assigning performers
- Using swim lanes

### Reviewing the Performers tab

You can review existing performers and define new performers in the Performers tab of the BPM Designer interface.

Click the Performers tab for a new Business Process, to view the All Performers section, which contains all the performers available to the process template.

You can perform the following operations in the Performers tab:
Table 32: Operations in Performers tab

<table>
<thead>
<tr>
<th>Operations</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a performer</td>
<td>See Defining performers on page 105.</td>
</tr>
<tr>
<td>Remove a performer</td>
<td>Select the performer to be removed, then click Remove. You cannot remove the default performer, @CREATOR.</td>
</tr>
<tr>
<td>Modify the performer details</td>
<td>Modify the performer details. You cannot modify the details of the default performer, @CREATOR.</td>
</tr>
<tr>
<td>Filter the performer list</td>
<td>Enter text in the type filter text box to filter the performer list and display all performers whose names contain the matching letters.</td>
</tr>
<tr>
<td>Group (or ungroup) the performer list</td>
<td>By default, all performers are grouped under performer type categories, namely, User (for human performer), Adapter (for adapter performers), or Sub-Process (for subprocess performer). To ungroup the performer list, click the No Grouping icon in the All Performers section. To group the performer list under categories, click the Group by Type icon in the All Performers section.</td>
</tr>
<tr>
<td>Collapse the performer list</td>
<td>Click the Collapse All icon.</td>
</tr>
</tbody>
</table>

You can assign any performer defined in the All Performers section to a workstep. The Performer page stores all performers defined for the process template, whether they are assigned to a workstep or are not assigned.

**Default performers**

In addition to the Performers tab, you can view existing performers by clicking the Assign Participants link in the Tasks pane.

Expand each Performer type to see the available performers for that type. BPM Designer provides the following default performers:

1. For Business Processes, expand the Users folder to display two subfolders, namely:
   - Process, which stores user-type performers defined for the process template. This includes a default user named “Creator.” Creator is a dynamic dataslot value. In this case, “Creator” is the performer whose name is entered in the Creator dataslot of the process instance, and this value can change from instance to instance and can reflect changes made at runtime.
   - Organization, which contains users defined using the User Management tool (see Working with User Management tool on page 259) under three sub-categories namely, Users, Groups, and Queues.

2. Managed adapters enable you to define configuration and mapping between dataslots in a process template and inputs/outputs from a group of out-of-the-box adapters at process design time. These predefined managed adapters provide examples of specialized adapters that are commonly used in managing business processes. For more information, see Using managed adapters on page 107.
Defining performers

You can define performers of any type from the Performers tab. Alternatively, you can define and assign a performer to an Activity workstep using the Assign Participants link in the Tasks pane (see Using the Tasks pane on page 111).

This section describes how to define performers in the Performers tab.

Defining a user as a performer

You can add a new user (human performer), group (group of human performers), or a queue for a Business Process.

To define a user as a performer:

1. From the Performers tab, click Add.
   The New Performer wizard appears.

2. Select the User type of performer from the available options, then click Next.
   The User Performer page appears with options for Business Processes that include User, Adapter, and Sub-Process.

3. Enter an appropriate name for the User performer in the Enter a name box. Alternatively, for performer type, "User," you can link the performer to a CHARACTER dataslot. Type '@' in the Enter a name box to display the list of CHARACTER dataslots in the process. Select the dataslot to be linked to this performer.

   Note: If your process contains a business object dataslot (for example, "bo1"), you can also create an individual user mapped to the business object attribute of type, CHARACTER. Enter the performer name as @<dataslot_name>. (in this example, @bo1.) and then enter the attribute name (only of type, CHARACTER) of the business object. If the business object contains another business object (example, "bo2") as an attribute, you can use a nested expression (in this example, @bo1.bo2.) to enter the attribute name (only of type, CHARACTER) of business object, "bo2."

   Alternatively, click Browse to select a user, group, or queue defined in the User Management tool (as discussed in Working with User Management tool on page 259). The dialog box that appears depends on the performer type that you select in the Select a type section; for example, if you select "User" as the performer type, the User dialog box listing all users defined in the User Management tool appears. Select a user (or group or queue) from those listed, then click OK to display the name in the Enter a name box.

4. Select the user type in the Select a type section to indicate whether the human performer is an individual user, queue, or a group.

   Table 33: Performer Types on page 105 describes each of the human performer types.

Table 33: Performer Types

<table>
<thead>
<tr>
<th>Performer Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>A single human performer.</td>
</tr>
<tr>
<td>Performer Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Group</td>
<td>A group of human performers. Select <strong>Any member(s) of the group</strong> if only one member from the group is required to complete a task OR select <strong>All</strong> if each performer from the group is required to complete the task. You can filter the members of a selected group by entering a valid role (as defined in the Administration module) in the <strong>Role</strong> box. For example, if <strong>All</strong> option is selected, and Manager is entered in the <strong>Role</strong> box, then all managers from this group are required to complete the workstep task.</td>
</tr>
<tr>
<td>Queue</td>
<td>A queue is defined as a group of users with the <strong>Any member(s) of the group</strong> option selected. At this time, queues created in BPM Designer do not automatically appear in Business Process Portal, but the same queue name must be created again in Business Process Portal. Also, queues created in the Administration module of Business Process Portal do not appear in the list of performers in the <strong>Performer</strong> tab.</td>
</tr>
</tbody>
</table>

**Note:** To define the performer of the workstep as an EJB method, enter the name of the EJB in the format: `jndi://<appserver_name>/<jndi_name>:<method_name>`.

**Note:** When you assign a User performer type, BPM Designer checks to see if the performer is an Individual User, then checks if it is a Group of users, then a Queue (If it is none of these, the task is assigned to Manager). For this reason, names for User, Group and Queue must be unique.

5. Click **Finish** to add the new performer to the **Performers** tab.

**Note:** To modify the user performer details, select the performer to be modified and make your changes in the **User** section of the **Performers** tab.

### Defining an adapter as a performer

An adapter (previously called an external performer or EP) is a Java class that provides a mechanism that integrates external third-party classes and actions with Progress Developer Studio for OpenEdge; for instance, an adapter can automate some functions and tasks performed by a server or an external system.

Adapters are the "performers" of Adapter worksteps. Depending on your application requirements, you can use a predefined managed adapter provided by Progress Developer Studio for OpenEdge; or you can develop your own adapters to carry out specific tasks. Progress Developer Studio for OpenEdge provides a series of managed adapters that have complex, specific features. Advanced users can find out more about Managed Adapters in the *Managed Adapters Guide*.

**To define an adapter and add it as a performer:**

1. From the **Performers** tab, click **Add**.

   The **New Performer** wizard appears.

2. Select **Adapter** as the type of the performer, and then click **Next**.

   The **Adapter Performer** page appears.
3. Type the adapter name in the **Enter a name** box. Specify the Java class and method in the appropriate boxes.

4. Select the **Generate Java code** checkbox if you want to generate a Java file for the Adapter workstep.

5. Click **Next**. In the **Description** page, enter a brief description of the custom adapter.

6. Click **Finish** to create the custom adapter and add it to the **Performers** tab.

---

**Note:** To modify the adapter performer details, select the performer to be modified and make your changes in the **Adapter** and **Description** sections of the **Performers** tab.

---

**Using managed adapters**

Progress Developer Studio for OpenEdge provides managed adapters that enable you to define configuration and mapping between dataslots in a BPM Project and inputs/outputs from a group of out-of-the-box adapters at process design time. Managed adapters are compatible with Progress Developer Studio for OpenEdge's adapter configuration and mapping framework.

---

**Note:** You must add and configure the managed adapters before using them in Progress Developer Studio for OpenEdge. For more information on Adapter Configuration and Mapping Framework and on the managed adapters provided in Progress Developer Studio for OpenEdge, see relevant chapters in *Managed Adapters Guide*.

---

Progress Developer Studio for OpenEdge provides the following “out-of-the-box” managed adapters for BPM Projects:

- **Corticon Adapter**: Allows you to invoke business rules, written in Corticon Studio and deployed on Corticon server, using a business process.

- **DB Adapter**: Provides connections to one or more specified databases, and enables you to quickly access SQL statements and parameters.

- **Email Adapter**: Enables Progress Developer Studio for OpenEdge to generate and send e-mail messages.

- **File Adapter**: Reads from and writes to a variety of file formats.

- **FTP Adapter**: Enables you to transfer files from and to your local file system, or an FTP server.

- **JMS Adapter**: Enables you to use Java Message Service (JMS) to communicate asynchronously with external systems and facilitates data exchange between Progress Developer Studio for OpenEdge processes and external applications.

- **OpenEdge Adapter**: Enables you to integrate Business Process Server applications with Progress OpenEdge® solutions.

- **SharePoint Adapter**: Enables you to drive BPM processes around documents that are added or modified in SharePoint.

- **Sonic ESB Adapter**: Enables you to interact with Sonic ESB to invoke a Sonic ESB process or service or send a message to a Sonic ESB endpoint.

- **Web Service Adapter**: Provides a connection to a specified Web Service, and enables the you to map Web service methods to a dataslot in a process. This adapter provides support for both RPC and Document-style Web services.

**To specify a managed adapter as the performer of a workstep:**
1. Click the **Assign Participants** link in the Tasks pane. The **Assign Participants** section appears.

2. Expand the **Adapters > Managed** folder in the **Assign Participants** section to display the managed adapters folders available by default.

3. Expand the respective managed adapter folder, then drag the adapter on an existing workstep (or a blank area of the Content pane) to add the adapter workstep.

   The managed adapter is now assigned as a performer of an Adapter workstep.

**Note:** Progress Developer Studio for OpenEdge also provides the Managed Adapter Browser tool using which you can perform various operations on managed adapters. For details, see Using Managed Adapter Browser on page 283.

### Defining a subprocess as a performer

A Subprocess is a process template that can be included into another process template by using a subprocess workstep. In this case, the performer of the subprocess workstep is the subprocess itself.

You can define a subprocess in a local or remote server as a subprocess performer in your process template without exiting Progress Developer Studio for OpenEdge by performing the following steps:

1. From the **Performers** tab, click **Add**.

   The **New Performer** wizard appears.

2. Select the **Sub-Process** type of performer, and then click **Next**.

3. Enter a name for the subprocess in the **Enter a name** box.

4. In the **Enter an alias** box (available only for Business Process), enter the alias name.

   You can use an alias to appear as the subprocess instance name in Business Process Portal instead of the lengthy subprocess name that appears by default. Alternatively, you can use a CHARACTER dataslot as the alias. Type ‘@’ in the **Enter a name** box to display the list of CHARACTER dataslots in the process. Select the dataslot to be used as the alias. When you use an alias, the subprocess name is in a format `<alias>#$<sub-piid>` that controls the length of the subprocess name.

   **Note:** To use aliases in multiple subprocesses, the **subprocess** box should contain a mapped dataslot for multiple processes and the Alias box must use dataslots of LIST type. In this way, each index can specify the alias for the respective subprocess. For more information, see “Subprocess Alias” in Chapter 16 of the *BP Server Developer’s Guide*.

5. In the **Select a process** box, enter a valid name for the process you want to use as a subprocess. Alternatively, you can select one of the following options:

   - Assign a dataslot as a dynamic performer of the subprocess. Type ‘@’ in the **Select a process** box to display the list of CHARACTER dataslots in the process. Select the dataslot to be used as the subprocess performer.
   - Click **Browse** to select a specific process template file to be assigned as a static subprocess performer.

   Placing an existing process template in the subprocess box converts that process template to a subprocess.
6. Use the **Enter a server URL** box (available only for BPM processes) to connect to a remote server (provided your Business Process Server Administrator has already set up this connection. For more information, see the *Configuring remote server properties in the oebpjsndi.properties file section in the BP Server developer’s Guide*). Enter a valid path to the external server using the following format: 

   jndi://$RemoteMachine><jndiName>

   Alternatively, type '@' in the **Enter a server URL** box to assign a CHARACTER dataslot as the dynamic performer on the remote server.

7. Select the **Indexed** check box (available only for Business Processes) if you want to pass data from a LIST dataslot in a parent process to multiple subprocesses, with each subprocess containing a Primitive dataslot that asynchronously receives specific information from, and sends specific information back to, the LIST dataslot. You can map dataslots in the parent process to dataslots in each subprocess; or, if the dataslot name in each subprocess matches the dataslot name in the parent process, then no mapping is necessary.

   This Indexed feature ensures that dataslot values in a subprocess are not overwritten, and that the correct value from a INTEGER dataslot is returned to its specific slot in the LIST dataslot.

   If you are using a LIST dataslot as the subprocess performer and the **Indexed** check box is not selected, each subprocess that is completed and submits data to the parent process may overwrite data from subprocesses that were completed earlier. Use a non-indexed subprocess only when no data is to be returned or when overwriting of data does not matter. For more information about using a LIST dataslot to invoke multiple subprocesses, see Chapter 4, “Using a LIST Dataslot to Invoke Multiple Subprocesses” in the *Application Developer’s Guide*.

8. Click **Next**. In the **Description** page, enter a brief description of the subprocess.

9. Click **Finish** to create a subprocess performer and add it to the **Performers** tab.

---

**Note:** To modify the subprocess performer details, select the subprocess performer and make your changes in the **Sub-Process** and **Description** sections of the **Performers** tab.

---

### Defining an inline subprocess

The inline subprocess is a self-contained subprocess that contains the same dataslots and other data variables as its parent process, and opens within the same **File** tab as its parent. By creating a process and subprocesses that share the same data variables, you can avoid using external processes as subprocesses to the active project. You may also avoid creating or assigning duplicate dataslots for these external processes, and performing complex dataslot mapping. Inline subprocesses also reduce overheads by avoiding the checking out of multiple external subprocesses that might be part of other Progress Developer Studio for OpenEdge projects.

**Note:** The inline subprocess is not available for Web applications.

Note the following restrictions on the use of inline subprocesses:

- You cannot convert an inline subprocess to a conventional subprocess.
- The Rollback function is not supported for Inline Subprocesses.

You can use one of the following two methods to create an inline subprocess:

- Use the **New Embedded Subprocess** icon from the Tasks pane (see Using the **New Embedded Subprocess** icon on page 110).
- Use the **Collapse** functionality to collapse a group of worksteps having a single input connector and a single output connector to form an inline subprocess (see **Using the Collapse feature** on page 110).

---
Using the New Embedded Subprocess icon

To define an embedded subprocess:

1. From the Tasks pane, click the Assign Participants link, then drag the New Embedded subprocess icon into the process template diagram. Notice that the Embedded Subprocess is indicated by the icon.

2. Open the subprocess workstep’s Properties view and define workstep properties as required.

3. Right-click the subprocess workstep and click Open, to open a blank interface in which you can add shapes, connectors and other data to create an inline subprocess.

4. To return to the parent process or to a higher level subprocess, in the palette, click the One Level Up icon or select the parent process or higher subprocess from the adjacent drop-down list.

Using the Collapse feature

You can define an Inline Subprocess using the Collapse feature by quickly selecting several related worksteps and creating a self-contained inline subprocess which is represented in the diagram as a single workstep.

1. Use the Select tool from the palette to select a workstep or a group of worksteps. The Collapse feature is enabled only if all these worksteps match the criteria of a single point of entry or single point of exit.

2. Right-click the selected worksteps, then select the Collapse option to convert the selected workstep or group of worksteps to an inline subprocess.

3. The inline subprocess workstep is now indicated by an Expandable icon (Figure 10: Inline Subprocess Workstep in Process Template on page 110). Open the workstep’s Properties view and assign a Label, Priority, and other properties, as required.

Figure 10: Inline Subprocess Workstep in Process Template
4. To view the inline subprocess, right-click the inline subprocess workstep and then select Open. The grouped worksteps view appears. The current subprocess, Subprocess 1 in this example, is contained under the tab of the parent process and is displayed in the drop-down list adjacent to the Up One Level ( ⬆️) icon.

**Figure 11: Inline Subprocess Opened in the Parent Tab**

5. To move up one level and, in this example, return to the parent process, click ⬆️. You can use ⬆️ to move up the chain of processes, or you can select a process from those listed in the adjacent box. The current subprocess always appears as the last name in the list of parent process and subprocesses; therefore, the combo box is disabled when the parent process is active.

6. If the worksteps you have grouped include Subprocess worksteps, you can drill down further into the subprocesses by right-clicking the workstep and selecting Open. To move up the chain, click ⬆️ or select from the parent process/subprocesses list, which displays all visited inline subprocesses.

### Assigning performers

After defining a performer, you must assign the performer to a workstep. By default, when you drag an Activity shape ( ◀️) from the Tasks pane to the content pane, you create an activity with no performer assigned. In certain cases, you may want to add this type of activity with an unspecified performer to your process template. You can then perform any of the procedures, described in the following sections, to assign a performer:

#### Using the Tasks pane

You can use the Assign Participants link in the Tasks pane to define a new performer and then add the appropriate workstep (depending on the performer type) to the process template.

The new performer icons provided in BPM Designer are listed in Table 34: Assign Participants link in Tasks Pane on page 112.
Table 34: Assign Participants link in Tasks Pane

<table>
<thead>
<tr>
<th>Icon</th>
<th>Purpose</th>
<th>Navigation path</th>
</tr>
</thead>
<tbody>
<tr>
<td>New User</td>
<td>To create a new user type performer.</td>
<td>Expand Users &gt; Process.</td>
</tr>
<tr>
<td>New Adapter</td>
<td>To create a custom adapter performer.</td>
<td>Expand Adapters &gt; Custom.</td>
</tr>
<tr>
<td>New subprocess</td>
<td>To create a subprocess performer.</td>
<td>Expand Sub-Process &gt; External References.</td>
</tr>
<tr>
<td>New Embedded subprocess</td>
<td>To create an embedded subprocess (not available for web applications).</td>
<td>Expand Sub-Process.</td>
</tr>
</tbody>
</table>

You can drag any of these performers into the process template diagram to open the respective dialog boxes for a User, an Adapter or a Subprocess. After you have created the performer, a workstep is automatically inserted in the process template diagram which is performed by the performer you just created. This new performer is also added to those listed in the Tasks pane under the respective Users, Adapters, or Subprocesses folder.

1. Click the Assign Participants link in the Tasks pane to open a list of performer types.
2. Expand the folder of the Performer type you want to assign to the activity. Select a specific new performer icon and drag it on an existing activity shape or on the blank template.

**Note:** To assign a performer created using the User Management tool, expand Users > Organization, then drag the performer from the respective subcategory to an existing activity or on the blank template. The assigned performer is also added to the performer list in Users > Process and to the Performers tab.

Table 35: Activity Shape with assigned performer on page 112 illustrates the appearance of the activity shape after a performer is assigned to it.

Table 35: Activity Shape with assigned performer

<table>
<thead>
<tr>
<th>Activity Shape Appearance</th>
<th>Performer Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Activity 1" /></td>
<td>For a individual performer or group member (with Any option selected).</td>
</tr>
<tr>
<td><img src="image" alt="Activity 1" /></td>
<td>For a group member (with All members option selected).</td>
</tr>
<tr>
<td><img src="image" alt="Activity 1" /></td>
<td>For a custom adapter.</td>
</tr>
</tbody>
</table>
### Changing the workstep performer

You can change the assigned performer of an activity workstep to any other performer or performer type.

1. Right-click an Activity, Adapter, or Subprocess workstep and then select the **Change Performer** option to open the **Change Performer** dialog box.
2. From any of the listed performer types, select a specific performer and click **OK**.

You can also change the performer through the Activity or Subprocess workstep’s **Properties** view. This procedure, however, only enables you to change to a performer of the same performer type.

### Using swim lanes

A swim lane is a horizontal colored lane across the process template which displays the worksteps performed by a specific user-type performer. Process template designers can use swim lanes to associate human performers with the worksteps they perform. You can also add a swim lane that has no specific performer, and any workstep added to this blank swim lane and retains its original performer. Performers of Activity worksteps are automatically updated when an Activity workstep is added to a swim lane or moved from one swim lane to another. Other workstep types can be included in a swim lane, but, unlike Activity worksteps, their performers are not automatically updated.

**Note:** Swim lanes are not supported for Web applications.

### Creating swim lanes

**To add a new swim lane:**

1. From the Tasks pane, click the **Create Phases and Swim Lanes** link in the Design Tasks panel.
2. Click the **Swim Lane** icon in the **Create Phases and Swim Lanes** section.

   The **New Lane** dialog box appears.
3. Enter the ID and Name of the new swim lane in the respective boxes.
4. Click the **ellipsis** button next to the **Performer** box to assign a performer to the swim lane.

---

<table>
<thead>
<tr>
<th>Activity Shape Appearance</th>
<th>Performer Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Activity 2" /></td>
<td>For a managed adapters. The shape varies according to the managed adapter used.</td>
</tr>
<tr>
<td><img src="image" alt="Activity 6" /></td>
<td>For a subprocess performer.</td>
</tr>
</tbody>
</table>
5. Select the **Select a performer** option to open the **Select a Performer** dialog box which displays a list of available performers that you can assign to the swim lane.

**Note:** You can use the **Clear performer** option to create a swim lane with no performer assigned to it.

To search a performer (user or group), use the Search box to enter a string of letters to filter the number of users presented in the **Performers** dialog box—for example, enter “mgr” to show all performers that contain that string of letters in their name. Click to clear filter criteria from the Search box.

6. Select a user name from those listed in the **Select a Performer** dialog box, then click **OK**. You can also add a new performer to those listed (see Defining a user as a performer on page 105).

7. Click the **Appearance** tab to apply a unique color to the swim lane.

8. Select an option from the colors listed. You can also click **More** to display more color options.

You can also change the color of multiple swim lanes by selecting the lanes and clicking the **Color** icon in the palette, to open the color palette, where you can select one of the listed colors, or click **More** to display more color options.

9. Click **OK** to add a new swim lane for the specified performer to the process template diagram. Move the workstep that this user is performing into its swim lane.

By default, BPM Designer adds a new swim lane below existing swim lanes. You can also insert a swim lane between existing lanes.

Swim lanes have two headers. The primary Pool Header contains all the swim lanes and displays the name of the Process Model. The Lane Header displays the Name, ID, or Performer of each lane, as determined by selecting one of these options from the View menu in the Lane Popup Menu. The Pool Header remains as a black and white header, but you can define a color for each Swim Lane.

**Figure 12: BPM Designer User Interface with Swim Lanes**

You can assign the same performer to different swim lanes. You need not have to add all worksteps that have the same performer to the performer’s swim lane; these worksteps can also be placed in that part of the diagram outside the swim lanes.
Resizing swim lanes

You may need to resize a swim lane either to add a shape to the swim lane or to quickly move a shape into (or out of) this swim lane.

- To increase the width of a swim lane, select the Move shapes when resizing swim lanes checkbox, before resizing the swim lane. Shapes, adjacent to the swim lane, move as you resize the swim lane.
- To make the performer of the adjacent worksteps to that of this swim lane or to remove a shape from this swim lane, clear the Move shapes when resizing swim lanes checkbox, before resizing the swim lane. Shapes, adjacent to the swim lane, do not move as you resize the swim lane.

You can resize a swim lane by passing your cursor over the space between two swim lane headers and using the slider to adjust the swim lane’s size up or down.

Performing additional swim lane operations

You can perform additional operations on a swim lane by right-clicking the swim lane header. Additional operations include:

- Changing the swim lane header display.
- Inserting a new lane between existing swim lanes.
- Removing a swim lane.
- Modifying existing lane properties.

To change the swim lane display header:

- From the View menu, select either Name, ID, or Performer to view your selection in the header of each swim lane.

To remove a swim lane:

- Click Remove Lane, after removing all worksteps from the swim lane.

To change the properties of a swim lane:

- Click Properties to display the current swim lane properties (as defined in the New Lane dialog box) in the Properties view. You can modify each property, as described in Creating swim lanes on page 113.

Swim lane restrictions

The following restrictions apply when you change the performer of an Activity workstep in a swim lane:

- You cannot move a swim lane.
- When you move an Activity workstep from one swim lane to another, that workstep is automatically updated and reassigned to the swim lane performer.
- If you assign the swim lane to a new performer, the Activity worksteps in the swim lane are automatically reassigned to the new performer.
- Other types of worksteps can also be added to a performer’s swim lane, but these types of worksteps are not automatically updated to match the swim lane performer.
- You cannot add an external subprocess workstep to a swim lane.
Using dataslots

You can use dataslots to manage information flow in a business process. Dataslots are global variables that enable the process to support exchange of data across worksteps. Typically, a dataslot is defined as the output of one workstep and the input of the successor workstep. Information—in this case, the value of the dataslot—is therefore passed from one workstep to the next workstep.

This chapter describes how to use dataslots in Progress Developer Studio for OpenEdge, and covers the following features:

- Provides a set of predefined system dataslots for Business processes.
- Supports a wide range of dataslot types.
- Enables you to define customized dataslots that are specific to your requirements and can be used in process templates.
- Supports importing and exporting dataslots singly or in bulk.

**Note:** You can assign dataslots to individual worksteps in the process, using the **Fields** tab in the workstep's **Properties** view. For more information, see **Setting workstep properties** on page 137.

For details, see the following topics:

- Reviewing the Dataslots tab
- Supported dataslot types
- Using system dataslots
- Creating user-defined dataslots
- Exporting and importing dataslots
Reviewing the Dataslots tab

You can review existing dataslots in a process and define new dataslots in the Dataslots tab of the OpenEdge BPM Designer interface. If you are adding a new process template for a Business process, then only predefined system dataslots are listed.

If you are modifying an existing process template, predefined dataslots, as well as dataslots that you have created for this process template, are listed.

**Note:** Web applications do not include any predefined system dataslots.

Click the Dataslots tab for a new Business Process, to view the All Dataslots section, which contains all the dataslots available to the process template.

You can perform the following operations in the Dataslots tab:

**Table 36: Dataslots tab operations**

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a user-defined dataslot</td>
<td>See Creating user-defined dataslots on page 122.</td>
</tr>
<tr>
<td>Remove a dataslot</td>
<td>Select the dataslot to be removed, then click Remove. You cannot remove any of the system dataslots. You cannot remove any user-defined dataslot assigned to a workstep.</td>
</tr>
<tr>
<td>Modify existing dataslots</td>
<td>Select the dataslot to be modified, then modify its properties in the respective sections of the Dataslots tab. You cannot modify the properties of any system dataslot.</td>
</tr>
<tr>
<td>Import or export dataslots</td>
<td>See Exporting and importing dataslots on page 134.</td>
</tr>
<tr>
<td>Filter the dataslot list</td>
<td>Enter text in the type filter text box to filter the dataslot list and display all dataslots whose names contain the matching letters.</td>
</tr>
<tr>
<td>Group the dataslot list by type (or by tag)</td>
<td>By default, all dataslots are grouped under dataslot type category, as discussed in Supported dataslot types on page 119. To group the dataslot list by tag namely, System (for system dataslots) or User (for user-defined dataslots), click the Group by Tags (Tags) icon in the All Dataslots section. To group the dataslot list by type, click the Group by Type (Type) icon in the All Dataslots section.</td>
</tr>
<tr>
<td>Collapse the dataslot list</td>
<td>Click the Collapse All (Collapse) icon.</td>
</tr>
</tbody>
</table>
### Supported dataslot types

Table 37: OpenEdge ABL Dataslot Types Supported by Progress Developer Studio for OpenEdge on page 119 lists the OpenEdge ABL dataslot types supported for BPM projects in both the Business Process and Web Application.

**Note:** For more information on ABL data types and their default values, refer to the Data Types section in the OpenEdge Development: ABL Reference guide.

<table>
<thead>
<tr>
<th>Dataslot Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER</td>
<td>A dataslot containing numbers, letters, and special characters.</td>
</tr>
<tr>
<td>LONGCHAR</td>
<td>A dataslot containing numbers, letters, and special characters.</td>
</tr>
</tbody>
</table>
| DATETIMETZ    | A dataslot containing dates. DATETIMETZ datatype has three parts: date, time, and an integer representing the time zone offset from Coordinated Universal Time (UTC). The unit of time is milliseconds from midnight. The unit of time zone offset is minutes. Supports the following DATETIME-TZ formats in OpenEdge:
  - yyyy-MM-dd'T'HH:mm:ss.SSS(+-)zz:zz or yyyy-MM-dd HH:mm:ss.SSS(+-)zz:zz
  - yyyy-MM-dd'T'HH:mm:ss.SSS or yyyy-MM-dd HH:mm:ss.SSS
  - yyyy-MM-dd'T'HH:mm:ss or yyyy-MM-dd HH:mm:ss
  - yyyy-MM-dd
  For example, 1995-01-17T12:12:12.234+05:30 or 1995-01-17 12:12:12.234+05:30. |
| DECIMAL       | A dataslot containing decimal numbers up to 50 digits in length, including up to 10 digits to the right of the decimal point. |
| INTEGER       | A dataslot containing 32-bit data (whole numbers). |
| INT64         | A dataslot containing 64-bit data (whole numbers). |
| LOGICAL       | A dataslot containing logical data that is evaluated as TRUE or FALSE. |
| Handle        | A dataslot containing a handle which is a pointer to an ABL handle-based object. This can be a static object defined during compilation or a dynamic object defined at runtime. |
| Rowid         | A dataslot containing a unique internal identifier for a row within a single database storage area. |
| Memptr        | A dataslot containing a sequence of bytes in memory. You can use this dataslot type to manipulate the contents of a BLOB database or temp-table field in ABL language. |
| Raw           | A dataslot containing any data, including data from databases other than OpenEdge. |
### Dataslot Type Description

<table>
<thead>
<tr>
<th>Dataslot Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataset</td>
<td>A dataslot containing the values of ABL ProDataset. This dataslot can be mapped to DataSet or DataSet-Handle in ABL.</td>
</tr>
<tr>
<td>Table</td>
<td>A dataslot containing the values of ABL temp-table. This dataslot can be mapped to Table or Table-Handle in ABL.</td>
</tr>
<tr>
<td>List</td>
<td>A dataslot that treats a collection of related data items as a single entity. For example, a LIST dataslot can be used to hold choices for CHARACTER dataslots where the choices are dynamically determined by querying a database.</td>
</tr>
<tr>
<td>Map</td>
<td>A dataslot that enables you to select from a list of choices that can change dynamically. It also stores the choices that are made and these choices can be viewed and used in other worksteps.</td>
</tr>
<tr>
<td>Number</td>
<td>A dataslot containing a numeric value. The Number dataslot contains Double as a subtype. The numeric value is displayed as a decimal; for example, 2.2.</td>
</tr>
<tr>
<td>Document</td>
<td>A dataslot to which you can attach one or more documents, upload to or download from the server. There are no restrictions on the file type. The dataslot must be specified as an editable dataslot in a workstep if you want to attach a file to it.</td>
</tr>
<tr>
<td>Object</td>
<td>A dataslot containing a serializable Java object. Typical Object dataslot types include Vector and Array which are passed as input or output dataslots to Adapters.</td>
</tr>
<tr>
<td>Business Object</td>
<td>A dataslot that encapsulates all the data and behavior associated with an entity of a business process. This dataslot type can retrieve data from internal and/or external database sources.</td>
</tr>
</tbody>
</table>

Table 38: Dataslots and associated formats for auto-generated forms on page 120 describes how these dataslot types appear in the presentation interface:

### Table 38: Dataslots and associated formats for auto-generated forms

<table>
<thead>
<tr>
<th>Dataslot Type</th>
<th>Format types</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER</td>
<td>Is displayed as text. There are three CHARACTER types: Text Field, Text Area, and Combo.</td>
</tr>
<tr>
<td>DATETIME-TZ</td>
<td>Represents a specific instant in time. There are two DATETIME-TZ types: Date and Time and Date only.</td>
</tr>
<tr>
<td>INTEGER</td>
<td>Is displayed as a numerical value and supports only Text Field as the format type.</td>
</tr>
<tr>
<td>INT64</td>
<td>Is displayed as a numerical value and supports only Text Field as the format type.</td>
</tr>
<tr>
<td>LOGICAL</td>
<td>Returns a value as TRUE of FALSE. This dataslot supports only Checkbox as the format type.</td>
</tr>
<tr>
<td>LIST</td>
<td>Is displayed as a list box with a list of entries. This dataslot supports only List as the format type.</td>
</tr>
</tbody>
</table>
Format types

<table>
<thead>
<tr>
<th>Dataslot Type</th>
<th>Format types</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP</td>
<td>Returns a key mapped to multiple values. This dataslot supports only TextField as the format type.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>A serialized Java object. This dataslot supports only Field as the format type.</td>
</tr>
</tbody>
</table>

**Note:** Format types associated with a dataslot are only applicable when you use the dataslot in a workstep with auto-generated HTML presentation. The HANDLE, ROWID, MEMPTR, RAW, DATASET, TABLE, and BUSINESS OBJECT datatypes do not have a format type.

### Using system dataslots

Progress Developer Studio for OpenEdge provides predefined system dataslots for a Business Process, which are displayed by default in the **Dataslots** tab and are designed to extend the functionality of user-defined dataslots. Predefined system dataslots are read-only and their values are assigned at runtime.

**Note:** You cannot modify, remove, or export a System dataslot.

The following table summarizes the predefined system dataslots.

**Table 39: Predefined System Dataslots in Business Process Server Applications**

<table>
<thead>
<tr>
<th>Dataslot Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AllDataslots</td>
<td>OBJECT</td>
<td>Contains (at runtime) all the user-defined dataslots and the associated values for the user-defined dataslots in a Hashtable. The Hashtable key is the dataslot name.</td>
</tr>
<tr>
<td>Creator</td>
<td>CHARACTER</td>
<td>Contains the creator (at runtime) of the process instance. The value of this box can be the login name of a Business Process Portal user.</td>
</tr>
<tr>
<td>Priority</td>
<td>CHARACTER</td>
<td>Contains the priority (at runtime) of the process (not the workstep priority). This box appears in all automatically generated HTML forms. Restrict priority values to Low</td>
</tr>
<tr>
<td>ProcessInstanceId</td>
<td>INT64</td>
<td>Contains the instance ID of the running process at run-time. This value is a unique identifier of each instance of this process.</td>
</tr>
<tr>
<td>ProcessTemplateName</td>
<td>CHARACTER</td>
<td>Contains the process name (at runtime). The process name is a string formed by concatenating the process template name with a unique number.</td>
</tr>
<tr>
<td>ProcessTemplateName</td>
<td>CHARACTER</td>
<td>Contains the process template name (SPT).</td>
</tr>
</tbody>
</table>
Creating user-defined dataslots

You can create dataslots, which are specific to a process. You can create a dataslot from any of the supported dataslot types (see Supported dataslot types on page 119) by performing the following procedures.

To define dataslots:

1. From the Dataslots tab, click Add.
   
   The first page of the New Dataslot wizard appears.

2. Enter a unique name for the dataslot in the Enter a unique ID text field. Valid dataslot names must start with a letter and can only included alphanumeric characters and the underscore (_). The maximum length of a dataslot name is 30 characters, due to column width restrictions.
   
   The following restrictions apply to dataslot names:
   
   - Although Progress Developer Studio for OpenEdge accepts reserved Java words (or Java identifiers) as dataslot names, do not use them as dataslot names or the application publishing will fail. For example, do not use “LOGICAL” or “Object” as a dataslot name, however you can use “myboolean” or “myobject”.

3. Select the dataslot type from the Select a type list. The options are: CHARACTER (default), LONGCHAR, DATETIMETZ, DECIMAL, INTEGER, INT64, LOGICAL, Handle, Rowid, Memptr, Raw, Dataset, Table, List, Map, Number, Object, and Business Object. For more information, see Supported dataslot types on page 119.

4. Specify the dataslot tags in the Enter tags separated by commas text field. OpenEdge BPM Designer provides a default tag named “User” for all user-defined dataslots. You can either retain this default tag, type your own tag in the Enter tags separated by commas text field, or click Browse to select a tag. You can then assign these tags to new and existing dataslots.

5. Click Next. The Value page appears.

6. You can use the Value page to set the initial value of the dataslot. Clear the Undefined check box to specify a initial value of the selected dataslot.

   Note: The appearance of the Value page depends on the type of dataslot that you have selected. For detailed information about setting the initial value, see the respective sub-section for the dataslot type in Dataslot properties on page 123.

7. Click Next. The Dataslot description page appears.
8. Specify a brief description of the dataslot in the **Description** page.
9. Click **Finish** to create the new dataslot, and add the defined dataslot to the **Dataslots** tab.

**Dataslot properties**

After defining a dataslot, you can configure the dataslot properties in the respective sections of the **Dataslots** tab. The variations in the dataslot properties are described in the following sub-sections.

**For a CHARACTER dataslot**

You can configure the properties of a CHARACTER dataslot in the following sections of the **Dataslots** tab:

**Table 40: CHARACTER dataslot properties**

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataslot</td>
<td>To modify the ID, type, and tags of the dataslot (defined in <em>Creating user-defined dataslots</em> on page 122). You cannot modify the dataslot ID if the dataslot is assigned to any workstep in the process.</td>
</tr>
<tr>
<td>Description</td>
<td>To specify the dataslot description, as discussed in <em>Defining the dataslot description</em> on page 130.</td>
</tr>
<tr>
<td>Initial Value</td>
<td>To specify the initial value of the dataslot. Enter text in the text area provided to create a static value; that is, a value that is displayed for each instance of the process. For example, entering “Carl” as the value for a dataslot, “Assignee”, it results in Carl being the Assignee for each process instance. Alternatively, to create a dynamic value, enter a dataslot name, preceded by the @ symbol, that displays the value of the designated dataslot at runtime. In this case, entering “@Creator” as the value for the Assignee dataslot means that the person who created the instance is the assignee. This value can change from instance to instance and can reflect changes made at runtime.</td>
</tr>
<tr>
<td>Note:</td>
<td>When you select Combo as the format type for a CHARACTER dataslot from the <strong>Default Format</strong> section and then define a choice list, you must assign the CHARACTER dataslot’s initial value from the defined list. Otherwise, the process fails to publish. The CHARACTER dataslot’s initial value must not contain the bar (“</td>
</tr>
<tr>
<td>Storage</td>
<td>Specifies the size of data storage for the dataslot. For more information.</td>
</tr>
<tr>
<td>Note:</td>
<td>Storage options are available only for the CHARACTER, DECIMAL, and Number dataslots.</td>
</tr>
<tr>
<td>Access</td>
<td>(Not available for Web applications) Specifies the access properties for the dataslot. For more information, see <em>Setting the dataslot access</em> on page 133.</td>
</tr>
</tbody>
</table>
To configure dataslot properties including the format type, label, and validations. For more information, see Defining the dataslot format on page 130.

If you have assigned the dataslot to a workstep, this section specifies how the dataslot is used in the process. For example, "Input for Activity 1" indicates that this dataslot is an input (or non-editable) dataslot for this workstep. For information on how to assign dataslots to individual worksteps in a process, see Setting workstep properties on page 137.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Format</td>
<td>To configure dataslot properties including the format type, label, and validations. For more information, see Defining the dataslot format on page 130.</td>
</tr>
<tr>
<td>Usage</td>
<td>If you have assigned the dataslot to a workstep, this section specifies how the dataslot is used in the process. For example, &quot;Input for Activity 1&quot; indicates that this dataslot is an input (or non-editable) dataslot for this workstep. For information on how to assign dataslots to individual worksteps in a process, see Setting workstep properties on page 137.</td>
</tr>
</tbody>
</table>

For a INTEGER and INT64 dataslot

You can configure the properties of a INTEGER or INT64 dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For more information on CHARACTER dataslot properties, see .

The only difference is the Initial Value section, where you can specify an initial value in the text field. The default value is 0.

**Note:** Clear the Unknown check box to enable the text field to enter a value.

The below table lists the valid range for INTEGER and INT64 dataslots.

<table>
<thead>
<tr>
<th>Dataslot</th>
<th>Minimum value (inclusive)</th>
<th>Maximum value (inclusive)</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTEGER</td>
<td>-2,147,483,648</td>
<td>2,147,483,647</td>
</tr>
</tbody>
</table>

For a LOGICAL dataslot

You can configure the properties of a LOGICAL dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For more information on CHARACTER dataslot properties, see .

The only difference is in the Initial Value section, where you can select True or False (default) option as the initial value of the dataslot.

**Note:** Clear the Unknown check box to enable the options.

For a DATETIMETZ dataslot

You can configure the properties of a DATETIMETZ dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot.

The only difference is in the Initial Value section, where you can:

1. Select the Date option to use the calendar to set the date.
You can modify the default date by clicking the icon. You can also enter the specific time in hour, minute, and second, which you want to use for the dataslot. This dataslot converts string to date-time formats and vice versa.

2. Alternatively, select the Start Time option to use the "@STARTTIME" dataslot value as the starting time for the DATETIMETZ dataslot.

**For a DECIMAL dataslot**

You can configure the properties of a DECIMAL dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 123. The only difference is in the Initial Value section, where you can enter a initial value of the dataslot.

**For a Document dataslot**

You can configure the properties of a Document dataslot in the respective sections (same sections as that for String dataslot) of the Dataslots tab.

The only difference is in the Value section, where you can specify one of the following values:

- Select the Single Document option to attach a single document to the dataslot. Click Browse to select the file you want to attach.
- Select the Document Bundle option to attach multiple documents to the dataslot. Select the Editable by author only checkbox (available only for process models) to enable only the user who receives the documents to update and reattach the documents; other users cannot view these changes.

**Note:** You can only attach documents stored in the `<project_name>\docs` folder.

When the process is instantiated, the specified document is located and copied as the initial value of the Document dataslot, and the value of the Document dataslot is set to the specified document file.

**Note:** Each document associated with a Document dataslot in a process must have a unique name. For more information on Document dataslots, see the Developing BPM Applications with Developer Studio manual in the OpenEdge documentation set.

**For a List dataslot**

You can configure the properties of an List dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 123.

The only difference is in the Initial Value section, where you can:

- Click Add to add a list element to the Value table.
- Select a value in the Value table and click Remove to remove a value from the dataslot.
- Select a value in the panel and click Move Up or Move Down to change the order of the values.

Values in a List dataslot are now read from a `<Values>` tag. The `<Value>` tag is compatible with the `<DataValue>` tag used in earlier releases is also read.
**Note:** For more information, see the About List Dataslots section in the *Application Developer’s Guide.*

### For a Number dataslot

You can configure the properties of a Number dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 103.

The only difference is in the **Initial Value** section, where you can specify the initial value of the dataslot. The Number dataslot supports only the storage type DOUBLE.

### For a Rowid dataslot

You can configure the properties of a Rowid dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 123.

### For an Object dataslot

An object dataslot contains a serializable Java object of a class available on the BP Server. You can use a project-specific class file (.JAR) or common JAR files which are available on publishing a Common Resource project. The class object is instantiated when a BP Server application instance is created or when a Web application is accessed.

You can configure the properties of an Object dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 123.

The only difference is in the **Initial Value** section, where you can specify the following:

1. In the **Java Class Name** box, enter a unique name for the serializable Java object. Specify the Class Name (including the package name).
   - Classes, which are project-specific, are stored in `<project_name>`\lib folder (for Business Processes) or in `<project_name>`\WEB-INF\lib folder (for Web applications).
   - Classes, which are available on the BP Server after you publish a Common Resource project, are stored in `OEBPS_Home\ebmsapps\common\classes` folder (for a Business Process) or in `WebApp_Home\WEB-INF\classes` folder (for Web application) wherein the `WebApp_Home` is application-server-specific and is the value of the `oebps.webappdir` property in `OEBPS_Home\conf\oebps.conf` file.

2. Use the **Constructor Parameters** section to define the parameters of the class constructor, which is invoked when the process instance is created. The object variables are initialized by invoking the proper constructor with the appropriate parameter values.
   a) Define the parameters by clicking **Add**, to open the **Add** dialog box.
   b) Specify the Java class name in the **Type** box and enter the value of the parameter.
      You can specify the methods for this class object in the **Before Activation** and **When Completed** tabs of the **Advanced** tab in workstep properties. For more information regarding using these tabs, see **Setting workstep properties** on page 137.

3. Click **OK** to add the constructor parameter in the **Constructor Parameters** section.
For a Business Object dataslot

You can configure the properties of a Business Object dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 123.

The only difference is in the Initial Value section, where you can specify the initial value of the dataslot as described below.

To add a Business Object dataslot:

1. Click Browse to open the Business Object dialog box.
2. Select a java file and click OK, and a valid business object is displayed in the Initial Value box.
   These values are derived from business objects that were previously created. For more information, see Managing business objects on page 275.

For a Map dataslot

You can configure the properties of a Map dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 123.

The only difference is in the Initial Value section, where you can specify the initial value of the dataslot as described below.

To add a name/value pair to the table:

1. To add name/value pairs as choices in a multi-select list, click Add to open the Add dialog box, in which you can define your name/value pair.
   The Name of the option you enter will be displayed as its label. The Value you enter can be “true” or “false”. If “true”, it is selected by default when displayed; if “false”, it is not selected.
2. Click OK to add the defined name/value pair to the Initial Value table.
   You can also change the options displayed for a Map dataslot or provide localized values for the options. The name “coke” will be displayed as an option when the application is published on the Business Process Portal. To specify another drink in the case of a different locale or context, say “soft drink” and manually edit the properties file in the properties folder under the application by adding coke=soft drink as the Value.

For a Table dataslot

You can configure the properties of a Table dataslot in the following sections of the Dataslots tab:

Table 41: Table dataslot properties

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataslot</td>
<td>To modify the ID, type, and tags of the dataslot (defined in Creating user-defined dataslots on page 122). You cannot modify the dataslot ID if the dataslot is assigned to any workstep in the process.</td>
</tr>
<tr>
<td>Description</td>
<td>To specify the dataslot description, as discussed in Defining the dataslot description on page 130.</td>
</tr>
</tbody>
</table>
Chapter 13: Using dataslots

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
</table>
| Storage   | Specifies the Table definition for the dataslot. By default it is empty. You can set the Table definition from the storage tab. To set the Table definition, on the storage Tab, click Browse and select the Table and select the Table definition from the **Temp-Table** tab and click OK.  

**Note:** If you are unable to find the file in the Workspace Resources section of the Temp-Table, select File System from the drop-down. |
| Access    | (Not available for Web applications) Specifies the access properties for the dataslot. For more information, see Setting the dataslot access on page 133. |
| Usage     | If you have assigned the dataslot to a workstep, this section specifies how the dataslot is used in the process. For example, "Input for Activity 1" indicates that this dataslot is an input (or non-editable) dataslot for this workstep. For information on how to assign dataslots to individual worksteps in a process, see Setting workstep properties on page 137. |

For a Dataset dataslot

You can configure the properties of a Dataset dataslot in the following sections of the **Dataslots** tab:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataslot</td>
<td>To modify the ID, type, and tags of the dataslot (defined in Creating user-defined dataslots on page 122). You cannot modify the dataslot ID if the dataslot is assigned to any workstep in the process.</td>
</tr>
<tr>
<td>Description</td>
<td>To specify the dataslot description, as discussed in Defining the dataslot description on page 130.</td>
</tr>
</tbody>
</table>
| Storage   | Specifies the Dataset definition for the dataslot. By default it is empty. You can set the Dataset definition from the storage tab. To set the Dataset definition, on the storage Tab, click Browse and select the Dataset and select the Dataset definition from the **Prodataset** tab and click OK.  

**Note:** If you are unable to find the file in the Workspace Resources section of the Temp-Table, select File System from the drop-down. |
| Access    | (Not available for Web applications) Specifies the access properties for the dataslot. For more information, see Setting the dataslot access on page 133. |
| Usage     | If you have assigned the dataslot to a workstep, this section specifies how the dataslot is used in the process. For example, "Input for Activity 1" indicates that this dataslot is an input (or non-editable) dataslot for this workstep. For information on how to assign dataslots to individual worksteps in a process, see Setting workstep properties on page 137. |
For a LONGCHAR dataslot

You can configure the properties of a LONGCHAR dataslot in the following sections of the **Dataslots** tab:

### Table 43: LONGCHAR dataslot properties

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataslot</td>
<td>To modify the ID, type, and tags of the dataslot (defined in <em>Creating user-defined dataslots</em> on page 122). You cannot modify the dataslot ID if the dataslot is assigned to any workstep in the process.</td>
</tr>
<tr>
<td>Description</td>
<td>To specify the dataslot description, as discussed in <em>Defining the dataslot description</em> on page 130.</td>
</tr>
<tr>
<td>Initial Value</td>
<td>To specify the initial value of the dataslot. Enter text in the text area provided to create a static value; that is, a value that is displayed for each instance of the process. For example, entering “Carl” as the value for a dataslot, “Assignee”, it results in Carl being the Assignee for each process instance. Alternatively, to create a dynamic value, enter a dataslot name, preceded by the @ symbol, that displays the value of the designated dataslot at runtime. In this case, entering “@Creator” as the value for the Assignee dataslot means that the person who created the instance is the assignee. This value can change from instance to instance and can reflect changes made at runtime.</td>
</tr>
</tbody>
</table>

**Note:** When you select Combo as the format type for a LONGCHAR dataslot from the **Default Format** section and then define a choice list, you must assign the LONGCHAR dataslot’s initial value from the defined list. Otherwise, the process fails to publish.

**Note:** The LONGCHAR dataslot’s initial value must not contain the bar (“|”) character.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage</td>
<td>Specifies the size of data storage for the dataslot.</td>
</tr>
</tbody>
</table>

**Note:** Storage options are available only for the CHARACTER, LONGCHAR, DECIMAL, and Number dataslots.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access</td>
<td>(Not available for Web applications) Specifies the access properties for the dataslot. For more information, see <em>Setting the dataslot access</em> on page 133.</td>
</tr>
<tr>
<td>Default Format</td>
<td>To configure dataslot properties including the format type, label, and validations. For more information, see <em>Defining the dataslot format</em> on page 130.</td>
</tr>
<tr>
<td>Usage</td>
<td>If you have assigned the dataslot to a workstep, this section specifies how the dataslot is used in the process. For example, &quot;Input for Activity 1&quot; indicates that this dataslot is an input (or non-editable) dataslot for this workstep. For information on how to assign dataslots to individual worksteps in a process, see <em>Setting workstep properties</em> on page 137.</td>
</tr>
</tbody>
</table>
**Caution:** The usage of the LongChar dataslot is suggested only if the data is larger than 32k. For any smaller value, the usage of Character dataslot is suggested. Using Longchar dataslot might cause significant increase in response time.

The maxPostSize value for LongChar feature is set to 2 MB in the DatabaseMapping file in the location: $DLC$/oebpm/server/conf/resources/common. To increase the size to 5MB, edit the &lt;mapping&gt; section as shown below:

```xml
<mapping>
  <java>com.progress.lang.Longchar</java>
  <dataslot>ABL_LONGCHAR</dataslot>
  <database>LVARCHAR</database>
  <database-mb>LVARCHAR</database-mb>
  <size bytes="2097152">2097152</size>
</mapping>
```

to

```xml
<mapping>
  <java>com.progress.lang.Longchar</java>
  <dataslot>ABL_LONGCHAR</dataslot>
  <database>LVARCHAR</database>
  <database-mb>LVARCHAR</database-mb>
  <size bytes="5242880">5242880</size>
</mapping>
```

Also, edit the server.xml file in the location: $DLC$/oebpm/jboss/server/portalServer/deploy/jbossweb.sar to add maxPostSize attribute as shown in the following tables:

```xml
<Connector protocol="HTTP/1.1" port="18793" address="${jboss.bind.address}" connectionTimeout="20000" redirectPort="18002" URIEncoding="UTF-8" />
```

to

```xml
<Connector protocol="HTTP/1.1" port="18793" address="${jboss.bind.address}" maxPostSize="5242880" connectionTimeout="20000" redirectPort="18002" URIEncoding="UTF-8" />
```

### Defining the dataslot description

You can add a description (optional) for a dataslot by selecting the dataslot and entering the description text in the **Description** section of the **Dataslots** tab. The Description text area can accept any character or symbol, and has no restrictions on the amount of characters you can enter.

### Defining the dataslot format

You can use the **Default Format** section of the **Dataslots** tab to set properties such as the presentation format and the label of the dataslot in Business Process Portal, validation (if required). You can also specify whether the dataslot is editable and required.

**Note:** The **Default Format** section is not available for the Business Object dataslot.

**Table 44: Default Format for Dataslots** on page 131 lists the format properties, their descriptions, and the dataslot types for which they are available.
Table 44: Default Format for Dataslots

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Supported Dataslot Types</th>
</tr>
</thead>
</table>
| Type    | Determines how the dataslot should be presented in the interface. This is available for CHARACTER, LONGCHAR and DATETIMETZ dataslots only. | • As a text box, text area, or combo box for a CHARACTER or LONGCHAR dataslot.  
• Additionally, as a radio button, checkbox and label for CHARACTER or LONGCHAR dataslot in case of web applications.  
• “Date and Time” or “Date Only” for DATETIMETZ dataslot. |
| Label   | Defines the label of the dataslot in the interface. | For all dataslots. |
| Editable| Specifies whether the dataslot is editable or read-only in the interface. The Editable checkbox is selected, by default. | For all dataslots. |
| Required| Specifies whether the dataslot is mandatory or not. | Not available for LOGICAL dataslot. |
| Validation| Configures validation settings. | Available only for CHARACTER, LONGCHAR, INTEGER, INT64, and DATETIMETZ dataslots. For more information, see Specifying validation at the dataslot level on page 132. |

**Note:** For a CHARACTER or LONGCHAR dataslot with default format "Combo box," any choices that you define are only applicable when you use the dataslot in a workstep with auto-generated HTML presentation. If you use this dataslot in a Form workstep, the defined choices are ignored.

You can modify the format of a dataslot at the workstep level, allowing each workstep in a process to have a different format. For example, you can set the format of a dataslot as a combo box with the label “Enter a choice” in one workstep; and as a text box with the label “You selected:” in the next workstep. To modify the format of a dataslot at the workstep level, see the Dataslot Properties section for the workstep type; for instance, for an Activity workstep, see Defining properties of Activity worksteps on page 142.

### Format types for CHARACTER or LONGCHAR dataslot

Progress Developer Studio for OpenEdge enables you to display a dataslot as a Text Field (single line of text), a Text Area (multiple lines of text), or a Combo. In the case of Web applications, the dataslot has three additional formats, namely, Radio button, Checkbox, and Label (read-only text). Each of these formats are described in the following bulleted list.

- **Text Field** format - Select this format and then do the following:
  1. Enter data in the **Size** and **Length** box (only for Web applications) to define the dimensions of the dataslot as it appears on the interface.
  2. Select the **Password** checkbox to present text entered in this field as asterisks, same as the way passwords are commonly displayed.
Chapter 13: Using dataslots

- **Text Area** format - Select this format and then enter the width and height of the text area in the respective fields.

- **Combo box** format - Select this format and then do the following:
  1. To add a new choice for the combo box, click **New**, to open the **Choice** dialog box.
  2. Enter a Value and a Label in the **Choice** dialog box. A choice can only include alphanumeric characters and underscores (_).
  3. Click **OK** to add the choice you created to the Choices area.

     To modify an entry, select the choice in the Choices section and click **Modify**. To remove a choice, select the choice and click **Remove**. To change the order of choice entries, select the choice and click **Move Up** or **Move Down**.

- **Radio button** and **Checkbox** formats (only for Web applications) - The procedure for defining the options for these controls are same as those for a Combo box.

- **Label** format (only for Web application) - You can enter only one label for the dataslot.

  Changing the presentation format at the workstep level does not affect the presentation at the process level. When the same dataslot, occurs in the Summary activity workstep, it is not editable. With this feature, you can change the presentation of a selected dataslot for each Activity workstep.

**Specifying validation at the dataslot level**

Progress Developer Studio for OpenEdge provides a validation framework that enables you to specify validation at the dataslot level. You can now associate validation rules with a CHARACTER, a LONGCHAR, an INTEGER, an INT64, or a DATETIMETZ dataslot type.

*Table 45: Validation Rules for User-Defined Dataslots* on page 132 lists and describes the dataslot validation rules and the dataslot types for which they are available.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Available only for CHARACTER and LONGCHAR dataslots. Enter a Minimum Length and a Maximum Length for the string text.</td>
</tr>
<tr>
<td>Number validation</td>
<td>Available for CHARACTER, LONGCHAR and INTEGER dataslots. Select the Number type (Integer or Float) and enter the minimum value and the maximum value in the respective text boxes.</td>
</tr>
<tr>
<td>Decimal validation</td>
<td>Available for CHARACTER, LONGCHAR, DECIMAL, and Number dataslots. Enter the number of digits to the left and to the right of the decimal point in the respective text boxes.</td>
</tr>
<tr>
<td>Decimal validation (advanced)</td>
<td>Available for CHARACTER, LONGCHAR, DECIMAL, and Number dataslots. In addition to the Decimal validation rule, this rule enables you to set a range of digits allowed to the left and to the right of the decimal point.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Available only for CHARACTER and LONGCHAR dataslots. Define the Minimum Port Allowed or the Maximum Port Allowed. Default values are 0 for Minimum and 65535 for Maximum.</td>
</tr>
</tbody>
</table>
Creating user-defined dataslots

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>U.S. Social Security Number</td>
<td>Available only for CHARACTER and LONGCHAR dataslots. The predefined format (at runtime) is xxx-xx-xxxx.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Available only for CHARACTER and LONGCHAR dataslots. The format is predefined.</td>
</tr>
<tr>
<td>URL</td>
<td>Available only for CHARACTER and LONGCHAR dataslots. Select any of the allowed protocols (http, https, ftp, or all) and whether the Query strings are allowed.</td>
</tr>
<tr>
<td>Date Validation</td>
<td>Available only for DATETIMETZ dataslots. The format is predefined.</td>
</tr>
</tbody>
</table>

To assign a validation rule to a dataslot:

1. Select the CHARACTER, LONGCHAR, INTEGER, INT64, or DATETIMETZ dataslot in the All Dataslots section.
2. From the Default Format section, click Browse beside the Validation box.
   The Validation dialog box appears.
3. Select any of the available rules from the Validation Rule drop-down list. Depending on the validation rule you selected, you may have to enter additional information, as described in Table 45: Validation Rules for User-Defined Dataslots on page 132.
4. Click OK to save the changes you made to the dataslot properties.

**Note:** Validation rules associated with a dataslot are only applicable when you use the dataslot in a workstep with auto-generated HTML presentation. For more information, see Defining Auto-generated HTML presentations on page 182.

Setting the dataslot access

You can use the Access section in the Dataslots tab to define access properties of the dataslot.

**Note:** The Access section is not available for dataslots in Web applications.

From the Access section, you can select (or clear) any of the following access modifier checkboxes:

- **Public:** By default, all dataslots are public and this checkbox is selected. Public dataslots have persistent dataslot values even after the process instance is completed. If the Public checkbox is not selected, the dataslot is private and its value cannot be accessed from other Business Process Server components such as the Management module in Business Process Portal and BPM Events.

- **Management Access:** This checkbox is disabled for List, Map, Business Objects, and Object dataslot types. It allows you to make viewable or hide dataslots from view in the Application Status Viewer in the Management module in Business Process Portal. By default, the Management Access checkbox is selected and dataslots are visible in the Management module. With both Public and Management Access selected, editing dataslots in the Management module is allowed.

- **Global:** Select this checkbox to change the dataslot from a process instance-level dataslot to an application-level dataslot. When you create a Global dataslot, its value is shared for all process instances in an application. If you modify a Global dataslot value in one process instance, that dataslot value in all
instances of the application has to be changed. Global dataslots enable business applications to keep statistics of all instances of an application and provide accessibility to a workflow, which is important if workflow decisions are based on those statistics.

- **Tasks Column**: This checkbox is disabled for List, Map, Business Objects and Object dataslot types. Select this checkbox to add the dataslot as a column for the application in Business Process Portal. In the Business Process Portal, the Home module’s Task List page displays the dataslot label (or dataslot name if no label is assigned) as the column heading for the selected application.

**Note**: You must select the specific application in which the Tasks Column option was set. If the Application and Version drop-down list in Business Process Portal is set to All, the Tasks Column settings will not be displayed.

Data for the dataslot, however, is displayed in the column only if the dataslot is specified as input or output to that workstep.

### Exporting and importing dataslots

Progress Developer Studio for OpenEdge enables you to import or export dataslots, either singly or in bulk, to a file (CSV, XML and Business Rules Vocabulary Definition) which is only available to you.

**Note**: The Export/Import feature does not support attached documents. If a CHARACTER dataslot with an attachment is exported and then imported, an error may occur. You must first remove any attached documents before exporting or importing such CHARACTER dataslots. For BRVD feature, only Export functionality is supported and Import functionality is not supported.

### Exporting dataslots

You can export one or more user-defined dataslots to an existing file or to a file which you specifically create for the dataslots.

**To export dataslots:**

1. From the **Dataslots** tab, click the **Export** icon. The **Export Dataslots** wizard appears.

2. From the first page of the **Export Dataslots** wizard, select any of the following options, then click **Next**:  
   - **CSV (Comma-delimited) File**: to export the dataslots to a CSV (comma-delimited) file.
   - **XML File**: to export the dataslots to an XML file.
   - **Business Rules Vocabulary Definition File**: to export the dataslots to a BRVD file.

3. If you select the **CSV (Comma-delimited) File** option, the **CSV (Comma-delimited) File** page of the **Export Dataslots** wizard appears.
   a) If you want to export the dataslots to an existing CSV file, select the **Overwrite existing file without warning** checkbox to replace the contents of the existing file without any user warning.
   b) To create a new dataslot file, click **Browse File System**.
   c) Enter a name in the **File name** box and click **Save**. Alternatively, to export the dataslots to an existing file, select the file and click **Save**.
The dataslot file and its location is displayed in the text box provided in the CSV (Comma-delimited) File page.

4. If you select the XML File option, the XML File page of the Export Dataslots wizard appears.
   a) If you want to export the dataslots to an existing XML file, select the Overwrite existing file without warning checkbox to replace the contents of the existing file without any user warning.
   b) To create a new dataslot file, click Browse File System.
   c) Enter a name in the File name box and click Save. Alternatively, to export the dataslots to an existing file, select the file and click Save.
   The dataslot file and its location is displayed in the text box provided in the XML File page.

5. If you select the Business Rules Vocabulary Definition File, the Business Rules Vocabulary Definition File page of the Export Dataslots wizard opens.
   a) If you want to export the dataslots to an existing BRVD file, select the Overwrite existing file without warning checkbox to replace the contents of the existing file without any user warning.
   b) To create a new BRVD file, click Browse File System.
   c) Enter a name in the File name box and click Next. Alternatively, to export the dataslots to an existing file, select the file and click Next.

6. Click Next to display the Dataslots page of the Export Dataslots wizard.
   You can use the Dataslots page to select the dataslots that you want to export. The Dataslots page displays all user-defined dataslots in your process.
   a) If you have selected CSV or XML File, select the checkbox of each dataslot or the dataslot type (for example, "CHARACTER") checkbox (to select all dataslots of that type). Alternatively, click Select All to select all of the listed dataslots. To deselect the dataslots, click Deselect All.
   b) If you have selected Business Rules Vocabulary Definition File select the type of Dataslot from the Type drop down.

   Table 46: Dataslot Types and explanation

<table>
<thead>
<tr>
<th>Dataslot Type</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primitive</td>
<td>This option will export all dataslots of the types: Character, LONGCHAR, DATETIMETZ, Decimal, Integer, INT64 and Logical</td>
</tr>
<tr>
<td>Table</td>
<td>From the Table drop down, select the Table that you want to export</td>
</tr>
<tr>
<td>DataSet</td>
<td>From the DataSet drop down, select the DataSet you want to export.</td>
</tr>
</tbody>
</table>

7. Click Finish to export the dataslots. If you are exporting the dataslots to a file and have not selected the Overwrite existing file without warning checkbox, you will be prompted to click Yes to replace the content of the file with the exported dataslots.
Importing dataslots

You can import user-defined dataslots from an existing dataslot XML (or CSV) file or from an existing process template file.

**Note:** Import functionality is not supported for BRVD import. For BRVD, only export functionality is supported.

**To import dataslots:**

1. From the **Dataslots** tab, click the **Import** (_excel) icon. The **Import Dataslots** wizard appears.

2. From the first page of the **Import Dataslots** wizard, select any of the following options, then click **Next**:
   - **CSV (Comma-delimited) File**: to import the dataslots from a CSV (comma-delimited) file.
   - **XML File**: to import the dataslots from an XML file.

3. If you select the **CSV (Comma-delimited) File** option, the **CSV (Comma-delimited) File** page of the **Import Dataslots** wizard appears.
   a) To select the CSV file, click **Browse File System**.
   b) Select the CSV file and click **Open**
      The selected file and its location is displayed in the text box provided in the **CSV (Comma-delimited) File** page.

4. If you select the **XML File** option, the **XML File** page of the **Import Dataslots** wizard appears.
   a) Click **Browse File System** to browse to a file.
   b) Select the file and click **Open**.
      The dataslot file and its location is displayed in the text box provided in the **XML File** page.

5. Click **Next** to display the **Dataslots** page of the **Import Dataslots** wizard.
   You can use the **Dataslots** page to select the dataslots that you want to import.
   a) Select the check box of each dataslot or the dataslot type (for example, "CHARACTER") check box (to select all dataslots of that type). Alternatively, click **Select All** to select all of the listed dataslots. To deselect the dataslots, click **Deselect All**.

6. Click **Finish** to import the dataslots.
This chapter describes how to set properties of worksteps and other shapes that are used to create process templates in Progress Developer Studio for OpenEdge. Each process template must have one Start workstep, one or more intermediate worksteps, and one or more End worksteps, with the worksteps connected by connectors.

For details, see the following topics:

- About worksteps
- Defining properties of Start workstep
- Defining properties of Activity worksteps
- Defining properties of Adapter worksteps
- Defining properties of Subprocess worksteps
- Defining properties of Message worksteps
- Defining properties of End worksteps
- Defining properties of Decision gateways
- Defining properties of Or-Join gateways
- Defining properties of Exclusive Or-Join gateways
- Defining properties of AND gateways
- Defining link properties
- Adding script to a workstep
• Defining a Rollback
• Defining a Timeout in worksteps
• Managing multiple worksteps

About worksteps

Worksteps define the flow of business processes. You can create a workstep:

• In Business Processes by dragging one of these shapes into the Content pane: Start, Activity, Decision, Or-Join, Exclusive Or-Join, AND Gateway, Message, and End.

• In Web applications using these shapes: Start, Activity, Decision, Or-Join, and End.

Table 47: Types of Worksteps on page 138 lists and describes the types of workstep and how they appear in a process template.

Table 47: Types of Worksteps

<table>
<thead>
<tr>
<th>Workstep Type</th>
<th>Appearance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td><img src="activity.png" alt="Activity" /></td>
<td>This workstep is performed by a User (human performer). In a BPM process, an activity can be performed by an individual user or by a group of users. In a Web application, this workstep is performed only by a single user. For details, see Defining properties of Activity worksteps on page 142.</td>
</tr>
<tr>
<td>Adapter</td>
<td><img src="adapter.png" alt="Adapter" /></td>
<td>This is an activity workstep, performed by an adapter. For details, see Defining properties of Adapter worksteps on page 150.</td>
</tr>
<tr>
<td>Subprocess</td>
<td><img src="subprocess.png" alt="SubProcess" /></td>
<td>This workstep is a process by itself with its own process diagram and is external to the main process, including the subprocess worksteps. For details, see Defining properties of Subprocess worksteps on page 153.</td>
</tr>
<tr>
<td>External Activity</td>
<td><img src="external_activity.png" alt="External Activity" /></td>
<td>This is a monitoring workstep, performed by an external human performer. This workstep type is only available for Business Processes. For details, see Introducing monitoring process on page 171.</td>
</tr>
<tr>
<td>External Adapter</td>
<td><img src="external_adapter.png" alt="External Adapter" /></td>
<td>This is a monitoring workstep, performed by an external adapter performer. This workstep type is only available for Business Processes. For details, see Introducing monitoring process on page 171</td>
</tr>
</tbody>
</table>
Note: This chapter does not cover the properties of external activity and adapter worksteps. For these details, see Introducing monitoring process on page 171.

Although the properties of an Activity, Adapter, and Subprocess worksteps vary according to their performers, these worksteps have the following properties in common:

- **Name.** Progress Developer Studio for OpenEdge assigns each workstep a default name; for instance, the first Activity workstep added to a process template is displayed as Activity 1. You can replace the default name with a more descriptive name in the Properties view for the workstep.

- **Dataslots.** Dataslots are used to transfer information between worksteps. You can define editable inputs (information that flows into the workstep) and read-only outputs (information that is sent out to other worksteps) in the Dataslots tab of the Properties view for Adapter, Message and Subprocess worksteps; in the Fields tab of the Properties view for Start and Activity worksteps; and in the Configuration tab of the Properties view for Managed Adapter worksteps.

- **Performers.** Each of these worksteps can be assigned a performer. Performer types include: User, Adapter, and Subprocess.

### Workstep properties

You can configure properties of a workstep, using the Properties view for that workstep.

Note: The Properties view is available for each process template elements in Diagram, Overview, and Path Analysis tabs.

The Properties view for worksteps supports the following dynamic features:

- **General** tab: allows you to define performers for Activity (see Specifying general properties of Activity workstep on page 142) and Adapter (see Specifying general properties of Adapter workstep on page 151) worksteps (only in a Business Process). You can also specify the workstep label (as it appears in Business Process Portal) and define the presentation format for Start and Activity worksteps.

- **Dataslots** tab (or in the Configuration tab for Managed Adapter worksteps or in the Fields tab for Start or Activity worksteps): allows you to assign dataslots to the workstep and modify them as they would appear on Business Process Portal. For more information on defining dataslots for a workstep type, see the Dataslot Properties description for that workstep type; for instance, for the Start workstep, see Using the Fields tab of Start workstep properties on page 140.

- **Collaboration** tab (only available for Activity worksteps): allows you to select a level of collaboration and indicate the performers with whom you want to collaborate. You can also add such options to the workstep as reassigning tasks, adding Notes to a process, or sending Email or Instant Messaging.

- **Messaging** tab (only available for Start, Message, and End worksteps in Business Processes): allows you to select a message to initiate a process or a workstep; and to generate an outgoing message on the completion of a workstep or a process. Using this type of workstep provides a way to synchronize process events and to define actionable events at various stages of the process execution.

- **Alerts** tab (only available for Business Processes): Allows you to add alerts to be associated with activation or completion of the workstep.

- **Advanced** tab: Allows you to define rollback and set synchronization parameters; define recovery settings; and define script to be executed at specific times. For more information on these functions, see the Advanced Properties description for that workstep type; for example, for an Activity workstep, see Using Advanced tab of Activity workstep properties on page 146.
Defining properties of Start workstep

The Start workstep (◯) indicates the beginning of a Business Process Server process template. Each process must have one Start workstep. The Start workstep only contains output dataslots, which can be mapped to specific locations.

Note: The Properties view for worksteps in Business Processes have more features than those for Web Applications. In the following sections, only Properties view for Start worksteps in Business Processes are presented, which are applicable for Web applications as well, unless otherwise stated.

Click the Start workstep to view its properties in the Properties view, which includes six tabs (Start worksteps in Web applications include four tabs).

Specifying general properties of Start workstep

From the General tab of the Properties view:

1. Identify the workstep by entering a name in the Name box. The workstep name appears in the process template diagram. Workstep names can only include alphanumeric characters and underscores ( underscore).

2. Enter a label for the workstep in the Label box. Once you assign a label to a Start workstep, it always appears in the Start workstep in the process template diagram and in Business Process Portal—the Name of the Start workstep will no longer appear.

3. To modify the default look and feel of the presentation pages for the Start workstep in Business Process Portal, click the ellipsis button next to the Presentation box (for more information, see Defining workstep presentation format on page 179).

Note: You can enter a description (optional) for the workstep in the Description tab. Description can be up to 4095 characters.

Using the Fields tab of Start workstep properties

For Business Processes, you can use the Fields tab to assign and manage dataslots which control the information flow from the Start workstep. In Web applications, the Dataslots tab replaces the Fields tab.

The Header section displays the options for—Instructions, Priority—to be displayed in the header section of Business Process Portal's task details page (corresponding to this workstep). You can choose to show or hide such information as Instructions for the workstep in the Header section of the Start workstep.

To use the the Fields tab:

1. Select any or all of the checkboxes in the Options section, to display the corresponding fields in the user's Business Process Portal page.

2. Enter instructions for the workstep in the Instructions box. Instructions can be up to 255 characters. These instructions will appear in Business Process Portal.

Alternatively, you can link the instructions to a specific CHARACTER dataslot. To do so, select the Link instructions to Dataslot check box, then select the dataslot (if any) from the adjoining drop-down list. To create a new dataslot, click the adjoining ellipsis button to open the New Dataslot dialog box.
The user-defined dataslots assigned to the workstep are listed in the Fields section, which contains a table displaying the Icon, Name, Type, Category, Label, Editable, and Required columns. For information regarding these dataslot parameters, see Using dataslots on page 117.

Adding dataslots
To add a user-defined dataslot to the Fields section in the Fields tab:

1. Click Add to open the Add dialog box, which lists all the dataslots available to the process.
2. Select one or more dataslots and click OK to add them to the workstep.

Modifying dataslots
You can modify a dataslot listed in the Fields section by selecting it and clicking Modify, to open the Field Properties dialog box in which you can edit the selected dataslot's properties. The fields displayed in the Field Properties dialog box depends upon the type of the dataslot being edited. You can make the necessary modifications and then click OK.

Note: You cannot modify predefined system dataslots.

For a CHARACTER dataslot in a workstep with Flow presentation format, you can click in the Map column to map the dataslot to the corresponding dataslot in the Web application. You must map to the same dataslot type.

Important: Do not use dataslots with predefined values in a Start workstep. If any CHARACTER dataslot has predefined attachments and you add this type of dataslot to the Start workstep, these attachments will not be visible in Business Process Portal when an instance is created.

Note: For Business Processes, you can use the Alerts tab to associate an alert with a Start workstep when it is completed. For more information, see Associating an alert with a workstep on page 197.

Using the Messaging tab of Start workstep properties
For Business Processes, you can use the Messaging tab to select a message received when the Start workstep is activated, which starts a new process instance. Start worksteps in Web applications do not have the Messaging tab.

To assign a message to a Start workstep:

1. From the Messaging tab, expand General, then click in the Value column in the Enabled row, to enable a drop-down list.
2. Select True from the drop-down list enabled, to display a Message row.
3. Click in the Value column of the Message row, to open a drop-down list which displays a list of previously defined Messages. Select a message from the list, to view Header, Payload, and other available message components.
4. Click in the Value column for each of the Header and Payload rows to view a list of available dataslots. Select a dataslot to associate the Header or Payload item with a dataslot value.
After you have assigned a message, a **Message** icon (濉) is shown within the Start workstep, indicating that it can receive a message that, for example, can start a process instance. For more information about defining or editing messages, see **Using the Message Manager** on page 269.

### Using the Advanced tab of Start workstep properties

You can use the **Advanced** tab in the **Properties** view to define events, which are executed on completion of the Start workstep in a Business Process and on activation as well as completion of the Start workstep in the case of Web applications.

The **Advanced** tab for Business Processes contains the **When Completed** tab. Start worksteps in Web applications have a **Before Activation** tab as well as a **When Completed** tab.

1. To define the event, click **Add Script**.
   - The Graphical Event Logic (GEL) tool appears with the defined event. You can use this tool to configure the action to be executed. For more information, see **Using the GEL tool in BPM projects** on page 201.

2. To remove the defined event, click **Delete**.

### Defining properties of Activity worksteps

Activity worksteps are the basic unit of work, and must be performed in their entirety. An Activity workstep in a Business Process is an activity assigned to an individual user or to a group of users. An Activity workstep in a Web application can only be assigned to an individual user.

**Note:** The **Properties** view for worksteps in Business Processes have more features than those for Web applications. In the following sections, only **Properties** view for Activity worksteps in Business Processes are described, unless otherwise stated.

Click the Activity workstep to view its properties in the **Properties** view which contains six tabs (Start worksteps in Web applications contains four tabs).

### Specifying general properties of Activity workstep

From the General tab of the Properties view:

1. Identify the workstep by entering a name in the **Name** box. The name of the workstep is displayed in the process template diagram. Workstep names can only include alphanumeric characters and underscores (_).

2. Enter a label for the workstep in the **Label** box. This label of the workstep appears in Business Process Portal.

3. The **Performer** box (available only for Business Processes) displays the performer assigned to the Activity workstep (as described in **Assigning performers** on page 111. To assign other performer, click the **ellipses** button beside to the **Performer** box, to open the **Performer** dialog box.
a) All the User performer types available in the process are listed in the **Performer** dialog box. If there are many performers listed, you can search the performer using the Search box and any User name containing that string is displayed in the text area. For example, if you entered “mgr” in the Search box in the Performer dialog, two users, mgrA and remoteMgr, are listed. You can create a performer by clicking **New**, to open the **Performer** dialog box.

b) Click **OK**, to assign the selected user as the workstep performer and to return to the **General** tab.

4. From the **Default performer** box (available only for BPM processes), specify the default performer, to whom the Activity workstep is assigned if the workstep performer is not available. The default performer can be an individual user or a dataslot. This is an optional field. To assign a default performer, click the **ellipsis** button beside the **Default performer** box, then click the **Select a Performer** option to open the **Performer** dialog box that lists all the performers.

To remove the selected performer, click the **ellipsis** button beside the **Default performer** box, and select the **Clear** option.

5. The **Presentation** box defines the look and feel of the presentation pages for the Activity workstep. To change the presentation format, click the **ellipsis** button beside the **Presentation** box to open the **Presentation** dialog box (for more information, see **Defining workstep presentation format** on page 179).

6. To set the priority of the workstep, select any of the predefined options from the **Priority** drop-down list (available only for Business Processes). Predefined options include: **Low**, **Medium**, **High**, **Critical**, and **Use a dataslot**. If you select **Use a dataslot**, you can use the **Select Dataslots** dialog box to select any of the listed dataslots of CHARACTER type.

7. The **Overdue in** box displays the default duration (2 hours) in which the workstep needs to be completed. Modify the time in which the workstep is overdue by clicking the **ellipsis** button beside the **Overdue in** box, and select either of the following options.

   • **Enter a duration** option to open the **Duration** dialog box. Enter the number of days, hours, minutes, or seconds to specify the workstep’s duration and click **OK**.

   • **Use a Dataslot** option to open the **Select Dataslots** dialog box which lists the INTEGER and INT64 dataslots available in the process. Select a INTEGER or INT64 dataslot to specify a dynamic duration for the workstep, and click **OK**. You can use only dataslots with integer values for duration.

   **Note:** The value of the dataslot must be in seconds, since this is the unit of time that BP Server expects for the duration until workstep completion. For example, if you want to set the workstep overdue duration to two minutes, then enter the dataslot value as 120 seconds.

8. Select the **Skippable** check box to allow for an individual or member of a group to skip this work item (or task) at runtime. When the application is published on Business Process Portal, the task that represents the work item includes a **Skip** button that performers can click to skip the task. For example, if a work item is assigned to three performers and two of the performers choose to skip the work item, the third performer can perform the task. This feature is present only in Activity worksteps for Business Processes.

9. Select the **Collect Work Time** check box if you want to force the performer to enter the time it took them to complete the task. By selecting this checkbox, you create a footer in Business Process Portal that requires the user to enter the Days, Hours and/or Minutes they needed to complete the task. This feature is present only in Activity worksteps for Business Processes.

10. To make the Activity workstep execute multiple times, select the **Loop** checkbox. Follow the procedure in **Defining a Loop condition** on page 144 . This feature is not available for Web applications.
Defining a Loop condition

A Loop occurs when the workflow is repeated through the current workstep until a specified loop condition is met. To track the number of times the workstep is executed, you can define a counter that increments every time the loop is executed.

To define a Loop condition:

1. From the General tab of an Activity workstep’s Properties view, select the Loop checkbox, beside the adjacent field and ellipse button.
2. Click the ellipse button to open the Loop dialog box, in which you can define the Loop condition.
3. Enter a variable (note that the variable must be a INTEGER dataslot type) by clicking the ellipse button beside the Variables box. From the Select Dataslots dialog box, select a INTEGER dataslot type from those listed. Each time the workstep executes the loop, this variable is incremented by one.
4. From the Condition section, build a condition by selecting a dataslot from the drop-down list on the left and an operator from the middle drop-down list, and then selecting or entering a value in the drop-down list on the right. To enter a value, do the following:
   a) Open the drop-down list on the right and select Enter Value option, to open the Enter Value dialog box.
   b) Enter the value and click OK.
5. Click OK after defining the loop condition for this workstep.

As long as the defined condition is “true”, the workstep will execute a loop. When the condition reads “false”, the workflow passes to the next workstep.

Consider an example of a counter-controlled loop, where the first condition sets the workstep to iterate five times. To do this, set the count dataslot to “is less than or equal to”. On the sixth iteration, the workflow will go out of the loop and continue to the next workstep. This type of loop is useful if, for example, you wanted a user to enter data five times before proceeding to the next workstep.

The second condition indicates that the Assignee dataslot must equal “Jones”: if the assignee is not Jones, the condition is false and the workflow proceeds to the next workstep.

When a workstep is defined as a Looping workstep, the Loop icon (☐) appears within the workstep shape, indicating to other users that a loop occurs in this workstep.

Note: If a workstep has both a Skip condition and a Loop condition, the Skip condition is evaluated first. If it evaluates to true, the workstep is skipped; if false, the workstep is executed and the Loop condition is evaluated. If the Loop condition is evaluated as true, the Skip condition is evaluated again.

Note: You can enter a description (optional) for the Activity workstep in the Description tab. A description can be up to 4095 characters.

Using Fields tab of Activity workstep properties

You can use the Fields tab to assign and manage dataslots that control the information flow into and out of an Activity workstep. You can manage existing dataslots and add dataslots using the Fields tab, as described for the Start workstep (see Using the Fields tab of Start workstep properties on page 140).
Defining collaboration tasks

The Collaboration feature is available only for Activity worksteps in Business Processes. Collaboration allows you to set a number of options in BPM Designer which allows the activity workstep to appear as a collaborative task in Business Process Portal. Collaborative tasks allow application users to complete their work by collaborating with other users or groups (referred to as Collaborators). These options include the ability to select a level of collaboration as well as indicating the performers with whom you want to collaborate. You can also select other options such as reassigning tasks, adding Notes to a process, or sending Email or Instant Messaging.

To define collaboration properties:

1. Click the Collaboration tab in the Properties view for an Activity workstep.
2. From the Options section, select one or more of the following options that you want to include in Business Process Portal.
   
   • Collaborative Tasks—Select the appropriate options in the beside the drop-down list to indicate whether you want to allow the Business Process Portal user to edit the dataslots associated with the workstep, or only view the dataslots that are now read-only, or see no dataslots.

   **Note:** You can use a CHARACTER dataslot for specifying the collaborator.

   • Notes—Specify whether you want the Business Process Portal user to see notes at the Instance Level (for all worksteps in the instance) or at the Workstep Level (for the current workstep). For more details regarding Notes, see the Business Process Portal User’s Guide.

   • Reassign—By default, the assigned performer of this workstep can reassign the task to another performer. To disable reassigning, clear this checkbox.

   • Email. To allow the assigned performer of this workstep to communicate with any of the collaborators using e-mail.

   • Instant Messaging—To allow the assigned performer of this workstep to chat with any of the collaborators using Instant Messaging.

3. From the Collaborators section, add the collaborators and also specify the operations the workstep performer can perform with each collaborator in Business Process Portal. Note that there is a column added for each option that you select in the Options section.

   a) To add a collaborator, click Add, to open the Select Users dialog box, which you can select one or more of the users or groups and click OK to add them to the Collaborators list.

   **Note:** You cannot add (or create) a queue as a collaborator. Further, you cannot add a group with ‘Any’ member selected as a collaborator or a group with a defined role.

   b) For each of the specified collaboration options, select either “true” or “false” from the drop-down list.

   **Note:** To delete a collaborator from the list, select the user or group and click Remove.

For worksteps with default presentation, the options selected in the Options section are displayed in the Task Details page of the workstep and all the collaborators defined in the Collaborators section are available in the Collaborators list in the Create Collaboration page in Business Process Portal.
Note: For Business Processes, you can use the Alerts tab to associate an alert with an Activity workstep when it is initially activated, completed, or as an Overdue action when it is overdue. For more information, see Associating an alert with a workstep on page 197.

Using Advanced tab of Activity workstep properties

You can use the Advanced tab to configure advanced events for the Activity workstep on activation, before activation, on completion, when overdue, when an error occurs and on recovery.

The Advanced tab in the Properties view for a Business Process consists of six tabs, namely: Before Activation, On Activation, When Completed, Overdue Actions, On Error, and On Recovery. By default, the Advanced tab displays the Before Activation tab. Activity worksteps in Web applications have Before Activation and When Completed tabs (similar to those for the Start workstep).

Before workstep activation

You can use the Before Activation tab to configure procedures which occur before the Activity workstep is activated.

To configure procedures:

1. The Activation Limit checkbox is only available for a system process, as defined in ProcessType attribute in process properties (see Setting process properties on page 97). Select this checkbox and enter a value (greater than 0), which sets a maximum limit that this workstep is executed in loop for a process instance at runtime. To execute the workstep loop indefinitely, specify the value as -1. If no value is specified, the value of the bpserver.ws.max.activationcount parameter in the OEBPS_Home\conf\bpserver.conf file is considered as the maximum limit.

2. Select the Activate On checkbox to enter the date and time when the workstep will be activated. Click the ellipsis button and select one of the following options.
   - Enter a value option: to open the Activate On dialog box, in which you can select a static date value.
   - Use a dataslot option: to open the Select Dataslots dialog box, in which you can select any of the DATETIMETZ dataslots listed, to define a dynamic date for the workstep activation.

You can also add, edit or delete DATETIMETZ dataslots. These dataslots are saved as <ActivateOn>@dsname</ActivateOn>.

3. Select the Activate After checkbox to specify the time interval until activation starts. Click the ellipsis button and select one of the following options.
   - Enter a value option: to open the Duration dialog box in which you can enter a duration value in terms of days, hours, minutes, or seconds.
   - Use a dataslot option: to open the Select Dataslots dialog box, in which you select any of the INTEGER dataslots listed to define the interval until the workstep is activated. These dataslots are saved as <ActivateAfter>@dsname</ActivateAfter>.

Note: The value of this INTEGER dataslot must be in milliseconds, since this is the unit of time that BP Server expects for the duration until workstep activation. For example, if the workstep is to be activated after two minutes, then the dataslot value must be specified 120,000 milliseconds.
4. You can use the **Wait for Condition** dialog box to specify a condition to be satisfied before the workstep is activated. Click the ellipse button to open the **Wait for Condition** dialog box. Use the Expression Builder feature to define a valid condition.

   a) Select a data slot from the drop-down list on the left (The Basic mode only includes CHARACTER, INTEGER, INT64, LOGICAL, and DATETIMETZ data slot types; Advanced mode includes all data types). Select an operator. To complete defining the condition, select a data slot from the drop-down list on the right or enter a value.

   b) To add another condition, click ![And](image) and select the **And** or **Or** option. To remove a condition, click ![Delete](image)

   c) To create a condition, click **Advanced** option by adding specific data slots or by entering or pasting a condition. You can drag any of the data slots listed (from the **Dataslots** section) to the **Condition** text area and build a condition, for example, `jst.getStringDataSlot(“CREATOR”).equals(“Peter”).` 

d) To check on your expression’s validity, click **Validate**.

5. You can use the **Skip Condition** dialog box to define a condition which, when satisfied, allows the performer to skip the workstep before it becomes activated. Click the ellipse button to open the **Skip condition** dialog box. Procedures to define a condition is the same as those described for “Wait for Condition” feature.

6. You can use the **Execute script** box to define the event, which is executed before the workstep is activated.

   - To define the event, click **Add Script**. The Graphical Event Logic (GEL) tool appears with the defined event. You can use this tool to configure the action to be executed. For more information, see **Using the GEL tool in BPM projects** on page 201.
   - To remove the defined event, click **Delete**.

### On workstep activation

You can use the **On Activation** tab to configure procedures that occur when the Activity workstep is initially activated. This tab includes three sections namely, Exclude performers, Synchronization, and Rollback.

**You can perform the following steps:**

1. Use the **Exclude Performers** section to designate performers which you want to exclude from performing the current workstep. For more information, see **Excluding a performer** on page 150.

2. From the **Synchronization** section, select the **Send e-mail to performer and complete if answered** check box to send an e-mail to the performer of the workstep when it is activated. 

   If the performer answers the e-mail, the workstep is considered to be completed; or the performer can go to the Home module in Business Process Portal and complete the task there.

   **Note:** Make sure the e-mail address you entered is valid. No action will be taken, and no errors logged, if the e-mail address is invalid.

3. In the **Rollback** section, select the **Create rollback point** check box to designate this workstep as the rollback point from which the workflow will be restarted in the event of an error or system crash. For more information, see **Defining a Rollback** on page 167.

### On workstep completion

You can use the **When Completed** tab to define the action, which is executed on the completion of the Activity workstep.

You can use the **Execute script** box to define the event, which is executed on completion of the workstep.
• To define the event, click **Add Script**. The Graphical Event Logic (GEL) tool appears with the defined event. You can use this tool to configure the action to be executed. For more information, see *Using the GEL tool in BPM projects* on page 201.

• To remove the defined event, click **Delete**.

**Adding overdue actions**

You can use the **Overdue Actions** tab to set procedures that occur when the Activity workstep is overdue. This tab includes two sections, namely, Overdue Actions and On last overdue. Use the **Overdue Actions** table to add new overdue actions, edit or remove existing overdue actions, and change their sequencing. These actions are executed each time the workstep is overdue. For information regarding actions in the **On last overdue** section, see *For the last overdue action* on page 149.

BPM Designer calculates the due date of a workstep by adding the duration of the workstep (as defined in the **General** tab) to the time the workstep is actually activated. If the duration is not specified, the due date of an activated workstep is set to the next day. By default, BPM Designer checks all activated worksteps every 30 seconds and performs specified overdue actions.

**Note:** For more information on overdue actions, refer to the “Assigning Overdue Actions” section in Chapter 3 of the *Application Developer’s Guide*.

**To add an overdue action:**

1. From the **Overdue Actions** section, click **New**, to open the **Overdue Actions** dialog box. This dialog box contains a **Number of times to execute** box and three tabs, namely, **Actions**, **Script**, and **Alerts**. The **Actions** tab lists actions you can define for an overdue workstep.

2. In the **Number of times to execute** box, specify the number of times you want the Overdue actions to execute.

3. Select the **Send Email** checkbox to send an e-mail each time the Overdue is activated.
   a) Click the **ellipsis** button, to open the **Send Email** dialog box.
   b) Enter the required content in the appropriate boxes. Use comma-separated values to enter multiple e-mail addresses. Specify an e-mail address as @<DataslotName> to dynamically obtain a mapped dataslot value.

   **Note:** Make sure the e-mail address you entered is valid. No action will be taken, and no errors logged, if the e-mail address is invalid.

   c) Click **OK**, to return to the **Overdue Actions** dialog box.

4. Select the **Change priority** checkbox to set and change the priority of the overdue action. From the adjoining drop-down list, select any of the priorities listed.

5. Use the **Extend duration** section to extend the duration of an Overdue action. Enter duration in terms of days, hours, minutes, or seconds. The earlier duration defined for this workstep gets extended by this value. For example, after a workstep with a duration of one hour becomes overdue, you can extend the duration of an overdue action to two hours. The duration is now redefined to two hours starting from the time the workstep becomes overdue. The number of repeat actions you defined in **Number of times to execute** box extends the workstep’s duration that many times.

6. From the **Scripts** tab, enter script that will be executed for each Overdue Action. For more information on entering Java or JavaScript, see *Adding script to a workstep* on page 165.

7. Use the **Alerts** tab to add one or more alerts during the Overdue Action.
a) Click **Add** to add a new alert, to open the **Add** dialog box.
b) Select an alert, if available, from the drop-down list and click **OK** to add the alert to the overdue action.

**Note:** For details regarding creating an alert, see **Using alerts** on page 195.

**Note:** To remove an alert from the list, click **Remove**; or click **Move Up** or **Move Down** to change the sequencing of the Alerts. For more information, see **Associating an alert with an overdue action** on page 198.

8. After defining the Overdue Actions, click **OK**, to return to the **Overdue Actions** tab in the **Advanced** tab of the **Properties** view.

### For the last overdue action

You can use the On last overdue section in the **Overdue Actions** tab to define last overdue actions.

**To execute an On last overdue action:**

1. To change the performer for the last execution of an Overdue action, select the **Change performer** checkbox. Click the **ellipsis** button to open the **Change Performer** dialog box, in which you can define the next performer.

2. To force the completion of the workstep on the last time of an Overdue action, select the **Complete workstep** checkbox.

3. When a connector from the Activity workstep is of the Timeout Flow type, the **Activate Timeout Flow** checkbox is enabled. The Timeout Flow indicates the direction of a work flow after Overdue Actions have been executed and the Last Overdue action is completed. For more information on Timeout Flow, see **Defining a Timeout in worksteps** on page 168.

### On workstep error

You can use the **On Error** tab to select the rollback point to which the process will roll back in the event of an error. The **Activate rollback point** drop-down list is enabled only when you have a workstep with a rollback point defined (see Step 3) in your process.

### On workstep recovery

In certain instances, an Activity workstep may be stopped or suspended. In such cases, you can use the **On Recovery** tab to define the event to recover the data.

You can use the **Execute script** box to define the event, which is executed for workstep recovery.

- To define the event, click **Add Script**. The Graphical Event Logic (GEL) tool appears with the defined event. You can use this tool to configure the action to be executed. For more information, see **Using the GEL tool in BPM projects** on page 201.
• To remove the defined event, click **Delete**.

### Excluding a performer

BPM Designer allows you to exclude a performer of a previously executed workstep in a process template from any human-performed workstep that is performed by a queue. Excluded performers can include valid BPM Designer users, data slots that return users, and EJB applications that return users. Excluded performers cannot include groups or queues.

By introducing the excluded performer concept, BPM Designer supports the Four-Eyes Principle. In business processes, the Four-Eyes Principle states that the performer of one workstep should be excluded from acting as the performer of a subsequent workstep, even if that performer is a member of a group or queue that can perform the workstep. For example, if a manager creates a purchase request, then the same manager should not be able to approve the purchase request, and should be excluded from any performer list for the approval workstep.

**Note:** An exception in excluding performers occurs if a performer has been excluded from a workstep, but then that task has been delegated to the same performer in Business Process Portal. In this case, the performer can undertake and complete the delegated task.

#### To exclude a performer from an Activity workstep in a Business Process:

1. From the **Advanced** tab of the workstep's **Properties** view, click the **On Activation** tab.
2. From the **Exclude Performers** section, click **Add** to open the **Performer Exclusion** dialog box, in which you can select the performer to be excluded.
3. You can either exclude a specific performer or a performer of a previously executed workstep.
   a) To exclude a specific performer:
      - Select the **Performer by name** option from the **Exclude:** list.
      - Click the **ellipsis** button beside the **Performer** box, to open the **Performer** dialog box.
      - From the complete list of performers listed, select the performer to be excluded, then click **OK**, to return to the **Performer Exclusion** dialog box.

   a) To exclude the performer of a previously executed workstep in the process, select the **Performer of another workstep** option from the **Exclude:** list, then select the previous workstep from those listed in the **Workstep** list. This feature does not work if you try to exclude the performer of a succeeding workstep that has not yet been executed.
4. Click **OK** to add the excluded performer. You can add as many performers as required to the **Exclude Performers** table.

### Defining properties of Adapter worksteps

An adapter workstep is an activity workstep performed by an adapter which runs an external system, remote device, or an application that is on a remote server external to Progress Developer Studio for OpenEdge. You can either create an adapter workstep using a custom adapter or any of the predefined managed adapters (as described in **Defining and assigning performers** on page 103.
Properties view for worksteps in Business Processes have more features than those for Web applications. In the following sections, only Properties view for Custom Adapter worksteps in Business Processes are described, unless otherwise stated.

Click the Adapter workstep to view its properties in the Properties view, which contains five tabs (Adapter worksteps in Web applications contains four tabs).

### Specifying general properties of Adapter workstep

Similar to that for an Activity workstep (Specifying general properties of Activity workstep on page 142), you can use the General tab to define the general properties of an Adapter workstep.

1. Identify the workstep by entering a name in the Name box. Workstep names can contain only alphanumeric characters and the underscore (_) character can be used.

   **Note:** There is no default duration shown in the Overdue in box for Custom and Managed Adapters. There is no Performer box for managed adapters.

2. To define other general properties of an Adapter workstep that are identical to those already described for Activity worksteps, refer to Specifying general properties of Activity workstep on page 142.

   **Note:** You can enter a description (optional) for the adapter workstep in the Description tab. A description can be up to 4095 characters.

   **Note:** For Business Processes, you can use the Alerts tab to associate an alert with the Adapter workstep when it is initially activated, completed, or as an Overdue action when it is overdue. For more information, see Associating an alert with a workstep on page 197.

### Using the Dataslots tab of Adapter workstep properties

You can use the Dataslots tab to control the information flow into and from a workstep performed by a custom (user-defined) adapter. From the Dataslots tab, you can assign dataslots to the adapter workstep and manage existing dataslots.

**Note:** For a managed adapter, the Configuration tab replaces the Dataslots tab. For information on configuring the managed adapter and mapping dataslots between Managed Adapter inputs/outputs and dataslots in BPM Designer processes, see the Managed Adapters Guide.

Dataslots assigned to the adapter workstep are listed in a table in the Dataslots tab. You can add, modify, or remove the dataslots.

The Name column provides the name of the dataslot. The other two columns show whether the dataslot provides Input to the Adapter or Output from the Adapter. For information on mapping dataslots, see Mapping dataslots in an adapter workstep on page 152.

**To add dataslots to those listed in the table:**

1. Click Add, to open the Select Dataslot dialog box.
2. Select one or more dataslots and click OK to assign them to the adapter workstep.
You can modify the Input and Output adapter settings for the existing dataslots in the **Dataslots** tab. Click in the **Input to Adapter** or **Output to Adapter** column for the dataslot you want to modify, then select **true** or **false** in the drop-down list.

**Note:** To remove a listed dataslot, select it and click **Remove**.

---

### Mapping dataslots in an adapter workstep

Mapping dataslots play an important role in adapter worksteps. Mappings enable you to pass data between dataslots in a process and methods in an adapter, and to automatically handle occasions when the names of the dataslot do not match the names of the adapter methods.

When you define a dataslot as an input to an adapter, BP Server invokes a corresponding set method in the adapter to assign the dataslot value to the variable in the set method (adapter). Similarly, to retrieve a variable from an adapter to a dataslot, BP Server invokes a get method at runtime.

**Note:** For information on configuring and mapping any of the Managed Adapters, see the relevant chapters in the *Managed Adapters Guide*.

---

#### To map dataslots in an adapter workstep to a method in an external adapter:

1. From the adapter workstep **Properties** view, assign the dataslots for the adapter workstep, as described in *Using the Dataslots tab of Adapter workstep properties* on page 151.

   The **Fields** view, which is displayed by default, shows dataslots as Input to the adapter, Output from the adapter, or both.

2. Select the **Advanced** option from the drop-down list.

   The Advanced view automatically creates and displays the set methods used for adapter inputs and the get methods used for adapter outputs.

3. To edit an adapter input (set method), select an adapter input as displayed in the Advanced View and click **Modify**, to open the **Field properties** dialog box.

4. Click the **ellipsis** button beside the **Adapter input(s)** box to open the **Adapter input(s)** dialog box.

5. Enter a new set method name in the text box provided and click **Add**, which adds it to the list in the **Adapter input(s)** dialog box.

   **Note:** To delete a set method, select it from the list and click **Remove**. To change the sequence of listed set methods, use the **Move up** and **Move down** button.

6. After defining the set methods, click **OK** to return to the **Field properties** dialog box.

7. To add an adapter output (or get method), enter a name in the **Adapter output** box.

8. Click **OK** to complete the mapping of dataslots in the adapter workstep to methods in the external adapter.
Using the Advanced tab of Adapter workstep properties

You can use the **Advanced** tab in the **Properties** view to configure advanced events for the adapter workstep on activation, before activation, on completion, when overdue, when an error occurs, and on recovery. The **Advanced** tab for the adapter workstep is similar to the **Advanced** tab for the User-performed Activity workstep: it includes six tabs—**Before Activation**, **On Activation**, **When Completed**, **Overdue Actions**, **On Error**, and **On Recovery**. For more information, refer to *Using Advanced tab of Activity workstep properties* on page 146.

By default, the **Advanced** tab for the adapter workstep displays the **Before Activation** tab. Adapter worksteps in Web applications have **Before Activation** and **When Completed** tabs, in which you can define the action to be executed on activation and on completion of the adapter workstep (for more information, see *Adding script to a workstep* on page 165).

Features in the Advanced properties of the adapter workstep that differ from the Advanced properties in the Activity workstep include:

1. The **On Activation** tab includes:
   - The adapter queue section which includes the **Long running adapter** checkbox. You can select this checkbox to indicate if this adapter is a normal or a long running adapter. A long running adapter executes on a limited number of threads configured in a queue designated for long running adapters. Normal adapters executes on larger number of threads configured in a queue designated for regular adapters.
   - A synchronization function that provides a **Wait for the adapter to complete before proceeding** checkbox. Select this checkbox to set the Adapter workstep as synchronous that is, the process waits for the adapter to be completed before proceeding (this checkbox is disabled for Managed Adapters).
   - To enable inline execution of the adapter, select the **Execute on the same thread** checkbox if required.

   **Note**: In case of managed adapters, the **Execute on the same thread** checkbox is only available for Database and JMS adapters. You can disable this checkbox for these adapters. To do so, set the **inline-enabled** property to **false** in the Advanced Properties dialog box in the **Configuration** tab of the **Properties** view. For more information, see the *Managed Adapters Guide*.

   - The **On Activation** tab does not allow you to send an e-mail to a performer and complete the workstep if answered nor does it allow you to exclude any performer.

2. The **Overdue Actions** tab does not have a **On last overdue** section.

   **Note**: For more information on working with adapters, refer to the "Developing Adapters" section of the *Application Developer’s Guide*.

Defining properties of Subprocess worksteps

The Subprocess workstep is an activity workstep performed by another process. It allows you to nest a complete process into another process template.
Parent Process: Subprocess interaction

You can assign a process as performer of an activity to create a Subprocess workstep. At runtime, the parent process (which contains the subprocess workstep) and one of the subprocesses (if any) communicate with each other—the parent process may send data to the subprocess and the subprocess in turn sends data back to the parent process. A subprocess can receive one or more parameters as input and can return one or more values to the parent process.

You can define a parent process as a subprocess in a different application. There is no limit on the number of processes that are nested within a Subprocess workstep created in BPM Designer.

Important: For Web applications, the parent process and the subprocess must share the same HTTP session. Since Web applications have lightweight persistency between Web pages using the HTTP session, no communication is possible if they do not share the session.

A parent process identifies a subprocess by its name, or “signature”, and must provide the expected names for both input and output data.

To define the method “signature”, you must define the subprocess and specify the name and number of values which are expected as input and which values are returned to the parent process. If the names of the dataslots in the parent process match the names of the dataslots in the subprocess, default mapping occurs and you do not need to map the dataslots. However, it is more common occurs that these names do not match, and which you need to map the relevant dataslots. For more information, see Mapping dataslots in a subprocess workstep on page 155.

Note: Properties view for Subprocess worksteps in BPM processes have more features than those for Web Applications. In the following sections, only Properties view for Subprocess worksteps in Business Processes are described, unless otherwise stated.

Click the Subprocess workstep to view its properties in the Properties view, which includes five tabs (Properties view in Web applications contains four tabs).

Specifying general properties of Subprocess workstep

From the General tab of the Properties view:

1. Identify the workstep by entering a name in the Name box. The name of the workstep can only include only alphanumeric characters and underscore (_) character can be used.

2. When specifying the Performer in a Subprocess workstep, you must select a process to serve as the subprocess in the workstep. You can specify a process installed either on your local server or on a remote server.

   To define a performer (that is, to select a process) for the Subprocess workstep, click the ellipsis button beside the Performer box to open the Performer dialog box.

   a) All the subprocesses available in the process are listed in the Performer dialog box. If many subprocesses are listed, you can search the Subprocesses performer type using the Search box and any name containing that string is listed.

   b) After selecting a subprocess, click OK, to return a process installed to the Subprocess Properties view. The subprocess is defined as the performer of the Subprocess workstep.

3. To define other general properties of a Subprocess workstep which are the same as those described for Activity worksteps, refer to Specifying general properties of Activity workstep on page 142.
Using the Dataslot tab of Subprocess workstep properties

You can use the **Dataslots** tab to assign and manage dataslots which control the information flow into and from the Subprocess workstep.

**Note:** The **Dataslots** tab is not available for inline subprocesses.

You can add, modify, or remove dataslots assigned to the Subprocess workstep in the Dataslots tab, an easy-to-use interface where you can add new or modify existing dataslots.

By default, the **Fields** view is displayed, with dataslots listed in a table. The Name column lists the name of the dataslot. The other two columns indicate whether the dataslot is input or output for the subprocess.

You can add, modify, or remove dataslots, the same way as you manage dataslots for an Adapter workstep (as described in Using the Dataslot tab of Adapter workstep properties on page 151).

To assign a dataslot as input to output from the **Fields** view, click in the **Input to subprocess** or **Output from subprocess** column for the dataslot you want to modify, then select **true** or **false** in the drop-down list.

The input or output assignments are displayed in the **Dataslots** tab.

Mapping dataslots in a subprocess workstep

If the name and data type of the dataslots in a Business Process and the dataslots in a Web application are identical, default mapping occurs between the processes. If the name or data type differ, default dataslot mapping will not work correctly.

**Note:** Default dataslot mapping is case-sensitive. For example, dataslots called “Budget” and “budget” are not mapped by default and must be mapped in the workstep Properties.

**To map dataslots in a Subprocess workstep:**

1. From the drop-down list under Dataslots, select Advanced option, which displays the **Set dataslot(s)** and **Get dataslot** columns in the table below that.
   
   The Advanced view enables you to pass dataslot values from the subprocess to an input (Set) dataslot or to an output (Get) dataslot in a parent process.

   **Note:** For Input dataslots added to the subprocess workstep in a Web application, data from the Web subprocess is passed to the parent process only when the corresponding mapped dataslots are added to the End workstep of the Web subprocess.

2. Select a dataslot and click **Modify**, to launch the **Field Properties** dialog box. You can enter multiple Set dataslots and one Get dataslot for the Subprocess dataslot.

3. To map a parent process dataslot to one or more inputs in the subprocess, click the **ellipsis** button beside the **Set dataslot(s)** box to open the **Set Dataslots** dialog box.
a) In the text box, enter the name of the dataslot in the parent process that you want to map to the subprocess dataslot and click Add. The parent process dataslot is added to the dataslot list. Use the other command buttons to delete, or move a selected dataslot up or down.

b) Click OK to return to the Field Properties dialog box.

4. In the Field properties dialog box, enter an output dataslot name in the Get dataslot box to map a subprocess dataslot to an output dataslot in a parent process.

5. Click OK.

The dataslots to which you mapped the subprocess dataslots are displayed in the Set dataslot(s) and Get dataslot columns.

Important: There is a list of reserved dataslot names that should not be used as names for a user-defined dataslot in Web applications that communicate with BPM processes for; example, “workitemName”, “performer”, “returnPage”. For more information, see “Reserved Dataslot Names” section of Application Developer’s Guide.

Mapping document dataslots in subprocess worksteps

If the name and data type of the dataslots in a BPM process and the dataslots in a Web application are identical, default mapping occurs between the processes. If the name or data type differ, default dataslot mapping will not work correctly. For more information on mapping dataslots in a subprocess workstep, see the Developing BPM Applications with Developer Studio manual in the OpenEdge documentation set. Mapping Document dataslots in Subprocess worksteps can demand unique document handling. Currently, information in a Document dataslot of a subprocess workstep is of the passed-by-reference type, that means, a single copy of the Document dataslot is shared between the parent process and a subprocess. Any change made to a Document dataslot in a subprocess is immediately visible in the parent process, and any change in a Document dataslot in the parent process is immediately visible in a subprocess.

The following restrictions apply when mapping document dataslots between the parent process and subprocesses:

1. Document dataslots of a parent process can only be mapped to the instance document dataslots of a subprocess. No mapping is allowed to a global document dataslot of a subprocess. The possible combinations are presented in Table 48: Restrictions for Document Dataslots in Subprocess Worksteps on page 156.

Table 48: Restrictions for Document Dataslots in Subprocess Worksteps

<table>
<thead>
<tr>
<th>Level of Dataslot in Parent Process</th>
<th>Level of Dataslot in Subprocess</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>Instance</td>
<td>Allowed</td>
</tr>
<tr>
<td>Global</td>
<td>Instance</td>
<td>Allowed</td>
</tr>
<tr>
<td>Instance</td>
<td>Global</td>
<td>Not Allowed</td>
</tr>
<tr>
<td>Global</td>
<td>Global</td>
<td>Not Allowed</td>
</tr>
</tbody>
</table>

2. Document dataslots in a Private Flow are specific to the process instance and are removed when the process instance is completed. Doing so can lead to inconsistent data in the parent process when the subprocess is completed. Therefore, private document dataslots should not be passed from parent process to subprocess.
Note: For BPM processes, you can use the Alerts tab (which is not available for Inline subprocess workstep) to associate an alert with the Subprocess workstep when it is initially activated, completed, or as an Overdue action when it is overdue. For more information on using alerts with a workstep, see the Developing BPM Applications with Developer Studio manual in the OpenEdge documentation set.

Using the Advanced tab of Subprocess workstep properties

You can use the Advanced tab to configure advanced events for the Subprocess workstep on activation, before activation, on completion, when overdue, when an error occurs and on recovery. The Advanced tab of the Properties view for the Subprocess workstep is similar to the Advanced tab for an Activity workstep in that it contains six tabs—Before Activation, On Activation, When Completed, Overdue Actions, On Error, and On Recovery.

By default, the Advanced tab of the Subprocess workstep displays the Before Activation tab. Subprocess worksteps in Web applications have Before Activation and When Completed tabs, in which you can define the event to be executed on activation and on completion of the subprocess workstep (For more information, see Adding script to a workstep on page 165).

For information on procedures for defining advanced properties of a Subprocess workstep that are similar to Activity worksteps, see Using Advanced tab of Activity workstep properties on page 146. Features in the Advanced properties of the Subprocess workstep that differ from the Advanced properties in the Activity workstep are:

1. The On Activation tab contains the synchronization function that provides a Wait for the subprocess to complete before proceeding checkbox. Select this checkbox to set the workstep as synchronous: the process waits for the subprocess workstep to be completed before proceeding.

2. The Overdue Actions tab does not have an On last overdue section. You can change performers of overdue actions only for Activity worksteps.

Defining properties of Message worksteps

The Message workstep (✉️) allows you to use an incoming event or message to initiate a process or a workstep; and to generate an outgoing message with the completion of a workstep or a process. The Message workstep provides a way to synchronize process events and to define actionable events at various stages of the process execution. For information regarding defining messages and channels, see Managing messages and channels on page 269.

Note: The Message workstep is only available for Business Processes.

If the Message workstep is used to start the workflow, it indicates that one or more process instances can be directly created through messages and you are not required to go through Business Process Portal to start a process. If the Message workstep is used as a workstep within the workflow, it indicates that it will wait for a message before activating or will generate and send a message when a workstep event (for example, workstep activated or workstep completed) occurs.

Click the Message workstep to view its properties in the Properties view, which contains six tabs.
Specifying general properties of Message workstep

From the General tab of the Properties view:

1. Enter the workstep name in the Name box. The workstep name appears in the process template diagram. Workstep names can contain only alphanumeric characters and the underscore (_) character.

2. Enter a label for the workstep in the Label box.

   The label you assign to a Message workstep will appear in Business Process Portal. If no label is entered, the workstep will display an incremented label in Business Process Portal that begins with 'Message1'.

   **Note:** You can enter a description (optional) for the message workstep in the Description tab. Description can have to 4095 characters.

Using the Dataslots tab of Message workstep properties

You can use the Dataslots tab to define and assign dataslots that control the information flow into and out of the Message workstep. The Dataslots tab is similar to the Fields tab for the Start workstep, but without the Header section. For more information, see Using the Fields tab of Start workstep properties on page 140.

Using the Messaging tab of Message workstep properties

You can use the Messaging tab to subscribe to (or receive) a message from a local or remote server. It initiates an action in the current process template or generates and publishes (or send) a message to a local or remote server and initiates an action in a process in a remote location.

To define a message:

1. Use the Mode box to select the type of messaging: Subscriber or Publisher.

2. Click in the associated Value column, and then to select one of the two options: Publish or Subscribe. Select the appropriate option.

3. If you are in the Publish Mode, a Channel row is shown. Accept the default channel or click in the associated Value column, to open a drop-down list that displays all the previously defined channels. The Channel row is not displayed for Messages in the Subscribe mode since only the BP Server channel can be used to subscribe messages.

   **Note:** If you are in the Publish mode, you can only use remote channels. Local channels, such as the default BP Server channel, cannot be used to publish messages. For more information, see Using the Channel Manager on page 272.

4. Use the Handler box to select a handler (optional). In the Handler box, enter a Java class name that you want to use, to perform a specific action on the message.
5. From the **Message** row, click in the associated Value column and then click to view a drop-down list containing previously defined messages.

Selecting a message displays the Header and the payload sections.

6. In the **Header** and **Payload** sections, headers and payloads associated with the message are listed in the left column. Click in each associated Value column to display dataslots that are of the same type and are available in the current process.

- For example, map "orderID" to an available INTEGER dataslot type named "ds1"; or map "vendor" to "VendorName", an available CHARACTER dataslot.
- You can also enter a value by selecting the "<enter value>" option.

**Other Message workstep properties**

Open the **Alerts** tab, in which you can associate an alert with the Message workstep when it is initially activated or when it is completed. For more information, see **Associating an alert with a workstep** on page 197.

Use the **Advanced** tab to configure advanced events for the Message workstep on activation, before activation, on completion, when an error occurs and on recovery. These operations are similar to those for Activity worksteps (see **Using Advanced tab of Activity workstep properties** on page 146).

**Defining properties of End worksteps**

End worksteps (O) mark the end of the process flow. A process template must have at least one End workstep. Click the End workstep to view its properties in the **Properties** view. The **Properties** view of the End workstep for Business Processes contains four tabs. For web applications, it contains three tabs.

From the **General** tab, enter the label for the workstep in the **Label** box. Once you assign a label to an End workstep, it always appears in the process template diagram and in Business Process Portal. If no label is entered, the End workstep appears blank.

**Note:** You can enter a description (optional) for the End workstep in the **Description** tab. A description can be up to 4095 characters.

**Note:** For Business Processes, you can use the **Alerts** tab to associate an alert with an End workstep when it is activated or when it is completed. For more information, see **Associating an alert with a workstep** on page 197.

**Using the Messaging tab of End workstep properties**

For Business Processes, you can use the **Messaging** tab to associate a message with the End workstep: the message is published (sent) when the workstep is completed. The message typically starts a new action, such as sending an e-mail. End worksteps in Web applications do not have a **Messaging** tab.

To assign a message to an End workstep:
Chapter 14: Setting workstep properties

1. From the Messaging tab, expand General, then click in the Value column in the Enabled row, to open a drop-down list.

2. Select True from the drop-down list, to view Channel and Message rows.

3. Accept the default Channel or click in the Value column of the Channel row, to view a drop-down list of previously defined channels.

4. Click in the associated Value column of the Message row, to view a drop-down list of previously defined Messages. Select a message from the list: to view the Header and Payload sections.

5. Click in the Value column for each of the Header and Payload section rows to view a list of available dataslots. Select a dataslot to associate the Header or Payload item with a dataslot value.

After you have selected a message, a Message icon is shown within the End workstep, indicating a message will be sent when the process is completed. For more information about defining or editing messages, see Using the Message Manager on page 269.

Using the Dataslots tab for Web applications

The Dataslots tab is available for End worksteps in Web applications only. If you are planning to use the process as a subprocess, you can use the Dataslots tab to assign dataslots to the End workstep that will pass information onto the parent process.

You can add, modify, and remove dataslots assigned to the End workstep, similar to how you manage dataslots for other worksteps.

Defining properties of Decision gateways

The Decision gateway represents a division of the control flow of the process. A Decision gateway can contain multiple incoming and outgoing connectors. For each Decision gateway, at least one of the outgoing connectors must have an empty Condition (the Default connector), and the other connectors can each contain a condition. BPM Designer follows BPMN notation by automatically displaying the default connector as a line with a slash (/) through it.

Alternatively, you can get the equivalent of a Decision gateway by adding multiple outgoing connectors to a successor Activity workstep, and assigning a specified condition to some of the connectors. With this type of connector, any connectors with conditions are indicated by a small diamond at the start of the connector, and the default connector as a line with a slash (/) through it. Once the predecessor workstep is completed, one or more successor worksteps will be activated if conditions in the connectors are fulfilled.

Note: It is possible that the number of outgoing connectors for a Decision gateway can be more than the number of incoming connectors. This can occur when a Decision gateway has more than two outgoing connectors and two or more of these connectors fall within the probability range and are activated, resulting in an apparent discrepancy in simulation data. For an Exclusive Decision (see Defining Exclusive Decisions on page 161), however, only one outgoing connector is activated and the number of outgoing connectors will always be equal to the number of incoming instances.

Click the Decision gateway to view its properties in the Properties view. The Properties view of a Decision gateway includes two tabs—General and Description.

To define properties for the Decision gateway:
1. From the **General** tab, modify (if required) the name of the Decision gateway in the **Name** box. Enter the label for the gateway in the **Label** box. Once you assign a label to a Decision, it always appears in the process template diagram. If no label is entered, the Decision is blank.

2. To make the Decision gateway an exclusive decision gateway, select the **Exclusive** checkbox (available for Business Processes only). For details, see **Defining Exclusive Decisions** on page 161.

3. The **Links** section contains a table that lists all the multiple outgoing connectors (and condition, if any) from this gateway. You can modify or remove any connector by selecting it and then clicking **Modify** or **Remove**. For information on defining connector properties, see **Defining link properties** on page 163.

**Note:** You can enter a description (optional) for the Decision gateway in the **Description** tab. A description can be up to 4095 characters.

---

**Defining Exclusive Decisions**

An Exclusive Decision indicates that the workflow can go through only one outgoing connector, while the typical Decision executes all connectors that meet specified conditions. To set the Decision gateway as an Exclusive Decision gateway, select the **Exclusive** checkbox. When you select the **Exclusive** checkbox, the **Move Up** and **Move Down** buttons are displayed, allowing you to establish the sequence of the outgoing connectors.

This ordering is important because connectors are evaluated in sequence, and the first connector that fulfills the specified condition is executed. The remaining connectors are not evaluated.

In an Exclusive Decision, there must be only one default connector (that is, a connector with no condition). This connector is executed when conditions on the other connectors are not fulfilled. If there is more than one default connector or if there is no default connector, an error is displayed.

Once you have defined the Decision as an Exclusive Decision gateway, it is displayed as a Decision gateway with an ‘X’ through it ( ). According to BPMN conventions, the appearance of the Exclusive Decision icon is the same as that of the Exclusive Or-Join (XOR) icon. The Exclusive Decision differs in that it has a single predecessor workstep and multiple successor worksteps.

**Note:** The Exclusive Decision gateway is not available for Web applications.

---

**Defining conditions in links from decisions**

The condition associated with a connector coming from a Decision gateway uses Java operators that include "&&" for AND and "||" for OR. The expression reads from left to right and can be as long as required. Only user-defined datalsots can be used as the variables.

BPM Designer also provides expression validation: that means, expressions are checked and validated at design time, not at runtime. Application developers are notified of any errors in the expressions and can correct the errors before executing the application.

**Accessing datalsot values in a link**

You can compare datalsots by accessing a datalsot's value in a condition statement. For instance, if you have two datalsots (of type CHARACTER) such as TotalNumber and CurrentNumber, then you can express a condition as: CurrentNumber<TotalNumber.
You can also make different combinations using the AND and OR operators. You should not use parentheses. The expression evaluates from left to right. For instance, you can have: CurrentNumber>MinimumNumber AND CurrentNumber<TotalNumber.

Defining properties of Or-Join gateways

You can use an Or-Join gateway to connect multiple predecessor worksteps to one successor workstep. The successor workstep is performed only when any one of the predecessor worksteps are completed. The most common use of an Or-Join gateway is with a loop back or to connect to an End workstep. Alternatively, you can get the equivalent of an Or-Join by adding multiple incoming connectors to an Activity workstep, and this workstep will be activated when any of its predecessor worksteps are completed.

Click the Or-Join gateway to view its properties in the Properties view. The Properties view of the Or-Join gateway contains a General tab and a Description tab.

The Name, Label, and Description are not displayed in the process template diagram, but are displayed as text entries in the process summary.

Defining properties of Exclusive Or-Join gateways

You can use an Exclusive Or-Join gateway (XOR) to direct the process workflow to proceed only once from multiple predecessor worksteps to a successor workstep. When the Exclusive Or-Join (XOR) gateway is completed, any other predecessor human-performed worksteps that immediately precede the XOR are terminated. According to BPMN conventions, the Exclusive Or-Join (XOR) icon is the same to that of the Exclusive Decision icon. The Exclusive Or-Join (XOR) differs in that it has multiple predecessor worksteps and a single successor workstep.

Click the Exclusive Or-Join gateway to view its properties in the Properties view, which is similar in functionality as that for Or-Join gateway.

Note: The Exclusive Or-Join gateway is supported only in Business Processes.

Figure 13: Exclusive Or-Join example
Figure 13: Exclusive Or-Join example on page 162 illustrates an example of the Exclusive Or-Join (XOR), wherein three companies are scheduled to collect a package. When any of these companies pick up the package, the XOR gateway is activated and the predecessor worksteps are terminated. The XOR gateway then proceeds to activate the Confirmation workstep.

Note: The XOR gateway functions correctly (that is, terminates the remaining predecessor worksteps) only if the predecessor worksteps are all human-performed Activity worksteps.

The XOR gateway allows workflow to proceed from only one of the predecessor worksteps. This action differs from the Or-Join, which would allow workflow to continue from Activity 1, 2, or 3 as each of these Activity worksteps are completed.

Defining properties of AND gateways

You can use an AND gateway (†) to connect multiple worksteps to one successor workstep, or a single predecessor workstep to multiple successor worksteps. The successor workstep is activated only if all the predecessor worksteps are completed. This feature enables you to synchronize the completion of multiple predecessor worksteps. When an AND gateway has multiple incoming connectors, it must have a single outgoing connector: in this case, the AND Gateway acts as an And-Join. When an AND Gateway has a single incoming connector, it can have multiple outgoing connectors: in this case, the AND Gateway acts as an And Fork (or Split). These variations in incoming and outgoing connectors for AND gateways are illustrated in Figure 8: Examples of Gateway connectors on page 79.

Click the AND gateway to view its properties in the Properties view, which is similar in functionality to that of the Or-Join gateway.

Note: The AND gateway is supported only in Business Processes.

Defining link properties

You can use the Connect Shapes link in the Tasks pane (see Connecting worksteps on page 76) to define the workflow connection (or links) between process template elements. You can either use the Normal Flow to link worksteps in the workspace, or the Compensation Flow to define the workflow in the event of a rollback (see Defining a Rollback on page 167), or the Time-out Flow (see Defining a Timeout in worksteps on page 168).

You can define links with or without conditions. In Decision gateway (see Defining properties of Decision gateways on page 160), you can modify an existing link condition in the Properties view, as described in this section.

For Business Processes

You can now assign a condition to a link in the process template diagram. In previous releases, you could assign a condition only to a link from a Decision gateway. Once you assign a condition to a link that does not have a Decision as a predecessor workstep, the link becomes the equivalent of a Decision gateway.

To define the properties of a standard link in Business Processes:
1. Click the link to view its properties in the Properties view.

2. Assign a name to the link in the Name box, and add a label in the Label box of the General tab.

3. To assign a condition to the link, clear the Default checkbox to view the Basic and Advanced settings. By default, the Basic setting is displayed. For information on Advanced settings, see Step 5 below.

4. Use the features of the Basic setting to build an expression based on existing conditions.

   a) Select a dataslot from the drop-down list on the left (the Basic mode only includes CHARACTER, INTEGER, INT64, LOGICAL, and DATETIMETZ dataslot types; the Advanced mode includes all data types). Select an operator from the adjacent drop-down list. Operator values change, depending on the dataslot type: For example, a CHARACTER dataslot displays more options than a INTEGER dataslot.

      Tip: If you want to evaluate a Null value for a CHARACTER dataslot, you only need to select 'is null' from the Operator drop-down list.

   b) Select a dataslot from the drop-down list on the right, or select Enter value option to open the Enter Value dialog box, in which you can enter a static value.

   c) Click \( \text{add another condition, enabling the And/Or operand.} \)

   d) Select And or Or and add as many conditional expressions as required.

   e) To remove a conditional expression, click \( \text{remove} \).

5. To configure the condition using Advanced settings, select Advanced option to view a list of dataslots and a Condition text area wherein you can build more complex expressions or to cut and paste expression that have been defined elsewhere.

   Note: For a business object dataslot in your process, type the name of the dataslot (for example, \( \text{bods1} \)) to view all the attributes of the associated business object, or you can select any of the listed attributes.

When defining link's condition, please note that:

- You can enter or paste an expression in the Condition text area, or drag a dataslot from the Dataslot list to add it to the advanced condition.

- When you add an expression in the Advanced setting, it overwrites all expressions which you created in the Basic setting. Click Validate to verify if the expression is valid.

- Click Basic option to delete the expressions in the Advanced setting and to return to the Basic setting.

   Note: You can enter a description (optional) for the link in the Description tab. A description can be up to 4095 characters.

### For Web applications

To define the properties of a link from an Activity workstep in Web applications:

1. Click the link to view its properties in the Properties view.

2. Assign a name to the link in the Name box and enter the label in the Label box.

3. BPM Designer supports three types of link for Web applications namely, Submit button, Hyperlink, and Image. Select the link type from the Type list.
• Select the **Submit button** option to display a **Submit** button on the interface page. Data is passed on from this interface page to the next interface page. Enter text in the **Label** box to be displayed as the name of the button, replacing the default Submit label for the button.

**Note:** For detailed information about creating multiple submit buttons out of a workstep, see **Creating multiple command buttons in web applications** on page 191.

• Select the **Hyperlink** option to create a line of text on the interface page that functions as a hyperlink. The hyperlink connection is displayed as a dotted line (•••••). In the Label box, enter the hypertext label that you want to appear on the image or text link seen on the workstep interface page in your browser. You can also open the dialog box in your browser to add a brief description that will appear when you move the mouse over the image.

• Select the **Image** option to create an image link on the interface page. In the Label box, enter the hypertext label to be displayed on the image or text link seen on the workstep interface page in your browser. Specify the image file name to appear on the workstep interface in the **Image** box. Store application images under the `Workspace_Home\<ProjectName>\<ProcessName>\images` folder for a single application or under the `Workspace_Home\common\images` folder for shared images for multiple applications. For images stored outside the Progress Developer Studio for OpenEdge installation directories (for example, in a Web server folder), specify the full URL in the Image box. Select the **Submit** checkbox, to ensure that information from dataslots on the current interface page is passed on the next interface page. If the **Submit** checkbox is cleared, no data is passed on to the next interface page and the link in the process template diagram is displayed as a dashed line, not a solid line.

**Note:** You can enter a description (optional) for the connector in the **Description** tab. A description can be up to 4095 characters.

When using links in Web applications, please note that:

• You must select the **Submit** checkbox for Image types of connectors in order to pass on data to the next page.

• Activity worksteps that includes output dataslots can use a link of the link type. Image type links can be used only if the **Submit** checkbox is selected. Activity worksteps without output dataslots must contain connectors of the Image type, or a connector type with a value.

• Selecting **Submit button** as the link type for an Activity workstep automatically creates a **Submit** button in the application interface. You can override the default “Submit” label by entering a label name in the Label box of the **Properties** view for the link.

## Adding script to a workstep

You can use script to add customized business logic into worksteps in processes. Adding Java or JavaScript (for Business Processes) or Java (for Web applications) to a workstep enables you to accomplish a wide range of activities, including:

• Executing rules as an Adapter workstep, without having to write a Java program.

• Manipulating dataslots within a workstep, without having to write an adapter.

• Performing a Script’s regular expressions, searching function and pattern matches, as well as using its Math Library feature, to run complex calculations on dataslot values.
In Business Processes, you can use Java or JavaScript to add customized business logic to Start, Activity, Adapter, Subprocess, and Message worksteps. In Web applications, you must use Java to add customized business logic into all these worksteps, except Message (which is not supported). Each of these worksteps include an Execute script function in their respective Properties view. From the Advanced tab of the respective workstep’s Properties view, use the following supported tabs to define the action scripts.

Table 49: Script Tabs

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Purpose</th>
<th>Supported worksteps (Business Process)</th>
<th>Supported worksteps (Web)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before Activation</td>
<td>Executes the script before the workstep is started, but after the precondition is executed.</td>
<td>Activity, Adapter, Subprocess, and Message</td>
<td>Start, Activity, Adapter, and Subprocess</td>
</tr>
<tr>
<td>When Completed</td>
<td>Executes the script after the workstep is completed.</td>
<td>Start, Activity, Adapter, Subprocess, and Message</td>
<td>Start, Activity, Adapter, and Subprocess</td>
</tr>
<tr>
<td>Overdue Actions (Scripts tab in Overdue Actions)</td>
<td>Executes the script when an action is overdue.</td>
<td>Activity, Adapter, and Subprocess</td>
<td>Not supported</td>
</tr>
<tr>
<td>On Recovery</td>
<td>Executes the script after a rollback has recovered the specified data. See Chapter 10 of the Application Developer’s Guide for information regarding rollback process.</td>
<td>Activity, Adapter, Subprocess, and Message</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

**Note:** BPM Designer automatically converts any previous BP Server/BPM Webflow expressions to the current Java-style expressions.

**To add Script to a workstep:**

1. Open a workstep’s Properties view, and click the Advanced tab.
2. From the Advanced tab, click the appropriate tab wherein you want to add the script.
3. You can use the Execute script box to define the script. Click Add Script. The Graphical Event Logic (GEL) tool appears with the defined event. You can use this tool to configure the action to be executed. For more information, see Using the GEL tool in BPM projects on page 201.

**Note:** For detailed information on using JavaScript and for JavaScript examples, see “Using JavaScript in a Workstep” section of the Application Developer’s Guide.
Defining a Rollback

BPM Designer allows you to add a “rollback” operation to a workstep in a Business Process, which has already been completed earlier in a process; that is, the workflow is restarted from the designated rollback workstep in the process. This process is required to restore the original information and eliminate the numerous changes that can occur to the process between the designated rollback workstep and the currently activated workstep.

To define the Rollback, you must set a workstep as a rollback point and specify which dataslot values are saved. In addition, you have the option of:

- Writing JavaScript code to handle a rollback request.
- Configuring an Activate workstep that, after the rollback is performed, activates the given workstep and returns to the same state as when that workstep was first performed.

In a rollback, the workflow will be restarted from the workstep selected as the rollback point in the process. You can only apply a rollback point to Activity, Adapter and Subprocess worksteps in Business Processes.

You can define a rollback either by using the Compensation Flow type of connector or by using the workstep’s Properties view.

Using the Compensation Flow connector

You can use the Compensation Flow connector (see Connecting worksteps on page 76) to define the workflow in case of a rollback.

1. Click the Connect Shapes link in the Tasks pane, to view the three supported Flow types.

2. Click the Draw compensation flow connectors icon and connect the workstep that initiates the rollback to the rollback point workstep from where the workflow will be restarted.

An example of a rollback is shown in Figure 14: Example of a Process with Rollback and Timeout on page 167, in which Activity 5 initiates the rollback and Activity 1 is the Rollback Point.

Figure 14: Example of a Process with Rollback and Timeout
Inserting a Compensation Flow automatically makes the target workstep the rollback point. As seen in Figure 14: Example of a Process with Rollback and Timeout on page 167, the Rollback Point workstep is marked with a \( \longleftrightarrow \) icon and the start of the Compensation Flow connector is indicated by the \( \rightarrow \) link.

**Using Properties view**

You can also define a rollback using the **Advanced** tab of the workstep’s **Properties** view.

**To define the rollback point:**

1. Click the **Advanced** tab of the **Properties** view of the target workstep to which you want to roll back.
2. From the **On Activation** tab, select the **Create rollback point** check box.

   **Note:** The first time a rollback workstep is activated, BP Server takes a snapshot of all selected dataslot values for later replacement.

3. To select one or more dataslots that will retain their original values during a rollback, click the **ellipsis** button beside the **Save dataslot values for** box, to open the **Save dataslot values** dialog box.
   
   You need to specify the dataslot names for replacement because some processes use many dataslots and restoring all dataslot values in each rollback can compromise server performance. This option helps the workflow process to replace the selected dataslot values with the original dataslot values.
   
   a) To add dataslots, click **Add** to open the **Select Dataslots** dialog box, in which you can select any dataslots containing the value you want to save. Click **OK** to add it to the Save Dataslot Values table.
   
   **Note:** To remove one or more dataslots from the table, select the dataslot names and click **Remove**. To edit a user-defined dataslot, select the dataslot and click **Modify**.

   b) Click **OK** to save your selections.

**Activating rollback point**

**To activate specific rollback points for other worksteps that may fail:**

1. Click the **Advanced** tab of the **Properties** view of the workstep from where you want to roll back.
2. From the **On Error** tab, select the rollback point option from the **Activate rollback point** drop-down list.

   **Note:** For detailed information about creating an application using the Rollback Process, see the **Application Developer’s Guide**.

**Defining a Timeout in worksteps**

You can use the Timeout feature to indicate the direction of a process workflow after Overdue Actions for the workstep have been executed and the Last Overdue action is completed.

**To define a Timeout:**
1. Click the **Connect Shapes** link in the Tasks pane, to display the three supported Flow types.

2. Click the **Draw time-out flow connectors** (●) icon and connect the workstep that begins the timeout flow to the next workstep in the timeout workflow.

   In the example shown in the Figure 14: Example of a Process with Rollback and Timeout on page 167, Activity 2 initiates the timeout and Activity 3 is the next step in the Timeout flow. The source workstep of a Timeout Flow is marked with a ●. The Activate timeout flow checkbox in the On Overdue tab of the Advanced tab of the target workstep’s Properties view is automatically activated.

3. To remove the Timeout Flow, clear the **Activate timeout flow** checkbox, or right-click the Timeout Flow connector and click **Remove**.

### Managing multiple worksteps

You can perform the same operation on multiple worksteps in a process template using the **Select** icon in the palette.

### Modifying multiple workstep properties

You can simultaneously edit multiple worksteps of the same type. For example, you can select all Activity worksteps in a process template and assign the same performer to all, or change the Priority of all Adapter worksteps at the same time.

**To modify multiple worksteps:**

1. Click the **Select** (●) icon in the palette and drag the worksteps to be selected.
   Alternatively, you can press **CTRL** and then click the worksteps to be selected.

   **Figure 15: Selecting Multiple Worksteps of the Same Type**

   ![Diagram](image)

   The **Properties** view displays the name as “(multiple worksteps)” in a read-only box.

2. Modify properties such as the performer, priority, and duration, as required. For instance, change the priority to Critical.
Aligning and spacing worksteps

BPM Designer allows you to align selected worksteps and distribute selected worksteps at equal intervals.

To align worksteps or other components in a process template diagram:

1. Use the Select tool to select the worksteps and other components that you want to align.
2. Click the Select and Change Layout link in the Tasks pane, displaying the Layout options in the Layout Tasks panel.

   Table 50: Layout options on page 170 lists the available layout options.

Table 50: Layout options

<table>
<thead>
<tr>
<th>Layout Operation</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align shapes horizontally</td>
<td>To align the selected components horizontally.</td>
</tr>
<tr>
<td>Align shapes vertically</td>
<td>To align the selected components vertically.</td>
</tr>
<tr>
<td>Distribute shapes evenly on the horizontal</td>
<td>To evenly space the selected components horizontally. If you select more than two components, only the components between the one on the far left and the one on the far right are moved.</td>
</tr>
<tr>
<td>Distribute shapes evenly on the vertical</td>
<td>To evenly space the selected components vertically. If you select more than two components, the uppermost and lowermost components are not moved and the other components are evenly distributed in reference to the upper and lower components.</td>
</tr>
<tr>
<td>Auto layout</td>
<td>Generates an ideal layout for process template elements, thus eliminating the need for manual adjustment.</td>
</tr>
</tbody>
</table>
Introducing monitoring process

Progress Developer Studio for OpenEdge enables you to design and configure a Monitoring process, which uses business events to monitor an external process on Business Process Server platform. This chapter describes how you can create a monitoring process.

**Note:** For detailed description of the working of monitoring process, see Chapter 29: "Working with Monitoring process" in *BP Server Developer’s Guide*.

For details, see the following topics:

- Introduction
- Designing a monitoring process
- Using process refresh
- Simulating a monitoring process

**Introduction**

A monitoring process offers complete insight into an existing process, which can be executing on packaged applications such as ERP, CRM, or legacy applications. As the monitoring process is executed and moves from one state to the next, Business Process Server can capture monitoring information: this provides an end-to-end visibility into the process for business users.

A monitoring process:

- Retrieves performer information along with other data from the event.
• Records the time stamp of the event as and when it occurs, rather than when the event is received by Business Process Server.

• Handles events that are received in a different sequence than the sequence of occurrence. For example, if A-B-C-D is the sequence in which events occur, they may be received in the sequence A-B-D-C. The monitoring process takes care of such anomalies.

A monitoring process must contain one user-defined CHARACTER dataslot, identified as External Instance ID (EIID). This dataslot can have null value and is used to identify each instance of the monitoring process. The value of EIID must be unique across all instances of the monitoring process. For example, for an “Order” process, the “Order ID” is unique across multiple orders and can be selected as the EIID.

**Supported events**

A monitoring process supports the following types of external events. For more information regarding external events, see the *BP Server Developer’s Guide*.

Table 51: Supported events

<table>
<thead>
<tr>
<th>Operation Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CREATE_INSTANCE</td>
<td>This event triggers the creation of the process instance of the monitoring process in Business Process Server. The event contains the EIID, whose value is unique for this process instance.</td>
</tr>
<tr>
<td>ACTIVATE_WORKSTEP</td>
<td>This event triggers the activation of the workstep in the monitoring process. The target workstep is identified by values of the EIID, process name, and workstep name in the event.</td>
</tr>
<tr>
<td>COMPLETE_WORKSTEP</td>
<td>This event triggers the completion of the workstep in the monitoring process. The target workstep is identified by values of the EIID, process name, and workstep name in the event.</td>
</tr>
<tr>
<td>UPDATE_DATASLOT</td>
<td>This event updates the dataslot values in the process instance of the monitoring process in Business Process Server. The instance is identified on basis of the EIID and process name in the event.</td>
</tr>
</tbody>
</table>

**Designing a monitoring process**

You can create a Business Process (as discussed in *Creating a Business Process* on page 41) that can be used as a monitoring process. The following restrictions apply to a monitoring process:

• It must include at least one monitoring workstep. A monitoring workstep can be of type, External activity or adapter, which receives external events for activation and completion.

• It must include a CHARACTER dataslot selected as the EIID, as discussed in *Assigning EIID* on page 175.

• Any dataslot, associated with a monitoring workstep, must be editable, so that its value can be modified by the external event. For more information, see *Using dataslots* on page 176.

**Note:** You cannot design a monitoring process using a Web application.
Configuring monitoring workstep

Setting workstep properties on page 137 describes how you can add and configure activity, adapter and other workstep types in BPM Designer. Similarly, you can add and configure monitoring worksteps for tasks performed by external participants.

BPM Designer supports the following types of monitoring worksteps performed by external participants:

- **External Activity**: This workstep is performed by an user, specified in the triggering event. In case the event does not include the performer's name, you can configure a default performer for this workstep.

  Note: The name of the external performer, as well as the default performer, need not be defined in your monitoring process template.

- **External Adapter**: This workstep is triggered and performed by an external system performer.

To add a monitoring workstep:

1. Create a Business Process using Progress Developer Studio for OpenEdge.
2. From the Tasks pane, click the Assign Participants link and expand the **External** folder.
   a) To add an external activity workstep, drag the **External User** icon.
   b) To add an external adapter workstep, drag the **External Adapter** icon.

   Similar to activity and adapter worksteps, you can use the Properties view to configure workstep properties for the external activity and adapter worksteps.

The Properties view is similar to that for an Activity workstep (as discussed in Defining properties of Activity worksteps on page 142) with the following exceptions:

- From the General tab, you cannot assign or change the performer in the Performer box. This is because the performer is from the external system and need not exist in the current process template.

- In addition to selecting an individual performer or dataslot, you can use the Default performer box to specify a performer, who does not exist in the current process template. For more information, see Default performer for monitoring workstep on page 174.

- If you select the Wait For Activation checkbox, then the external activity workstep waits and processes the ACTIVATE_WORKSTEP event before proceeding with the COMPLETE_WORKSTEP event, even if it has arrived. If the Wait For Activation checkbox is not selected, then the workflow processes the event which comes first. For example, if COMPLETE_WORKSTEP event comes before ACTIVATE_WORKSTEP event, then it is processed and the ACTIVATE_WORKSTEP event is moved to invalid event table.

- The General tab does not contain Priority, Presentation, Skippable, and Collect Work Time fields, as they are not applicable of a monitoring workstep.

- You can use the Dataslots tab to add dataslots. For more information, see Using dataslots on page 176.

- There is no Collaboration tab, because it is not required in a monitoring workstep.

- The Advanced tab contains only the following tabs:
  - The Before Activation and When Completed tab, in which you can only enter the respective code to be executed.
  - The On Overdue tab does not contain the Change Performer and Complete workstep checkboxes.
**Note:** You can also configure these properties by right-clicking on the external activity and external adapter worksteps and selecting **Properties**. For more information, refer to **Workstep properties** on page 139.

**Note:** You can configure the remaining external activity properties, as discussed in **Defining properties of Activity worksteps** on page 142.

The Properties view is similar to that for an external activity workstep. The only exception is that there is no default performer, because this field is not applicable for an adapter workstep.

**Default performer for monitoring workstep**

You can specify a default performer for an external activity workstep, by clicking the **ellipsis** button beside **Default performer** box in the **General** tab, and then performing any of the following operations by selecting the appropriate option:

- **To assign an existing performer:**
  1. Select the **Select a Performer** option. The **Performer** dialog box appears, which lists all the performers in the current process.
  2. Select any of the performers listed and click **OK** to assign the selected user as the default performer.

- **You can create and assign a new performer as a default performer.** To create and assign a new performer:
  1. Select the **Select a Performer** option.
  2. From the **Performer** dialog box, click **New** to open the **Performer** dialog box.
  3. Enter the name of the performer in the **Name** box.

    Alternatively, click the **ellipsis** button beside the **Name** box, then select either of the following options.

    **Table 52: Performer options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an Existing User</td>
<td>To add a user defined in the User Management tool (see <strong>Working with User Management tool</strong> on page 259).</td>
</tr>
<tr>
<td>Use a Dataslot</td>
<td>To select a CHARACTER dataslot as the performer.</td>
</tr>
</tbody>
</table>

    4. Click **OK** to add the selected performer to the list of performers in the **Performer** dialog box.
    5. Click **OK** to assign the new performer as the default performer.

- **You can add a performer that does not exist in the process template.**
  1. Select the **Enter a new value** option
  2. From the **Default Performer** dialog box that appears, type the name of the performer.
  3. Click **OK** to assign the specified performer as the default performer.

To change the default performer, click the **ellipsis** button beside the **Default performer** box, and select the **Select a Performer** option. From the **Performer** dialog box that appears, select another performer from the list of available performers.
To remove the selected default performer, click the ellipsis button beside the Default performer box, and select the Clear option.

### Assigning EIID

You can assign an EIID to the monitoring process after adding a monitoring workstep. You can assign only one dataslot as the EIID.

The dataslot assigned as the EIID must satisfy the following requirements:

- Must be User-defined with type, CHARACTER.
- Value must be unique across all instances of the monitoring process.
- Storage type must be VARCHAR with size 128.

**To assign the EIID to a monitoring process:**

1. Click a blank area of the Diagram tab, to open the Properties view. For details regarding process properties, see Setting process properties on page 97.

   The Properties view displays the additional Monitoring tab.

2. Click the ellipsis button beside the External Instance Id Dataslot box and then select one of the following options:

   - **Use a User Dataslot**: The Select Dataslot dialog box that appears, lists the user-defined CHARACTER dataslots in this process. Select a dataslot, then click OK to assign it as the EIID. Alternatively, you can click New to create a CHARACTER dataslot and then assign it as the EIID.

   - **Use ProcessInstanceId**: Assigns the system dataslot, “ProcessInstanceId”, as the EIID.

The assigned dataslot is displayed in the External Instance Id Dataslot box. To clear this selection, click the ellipsis button beside the External Instance Id Dataslot box and then select the Clear option.

### Using a Subprocess

In some cases, you may need to use multiple EIIDs in the same monitoring process. For example, an “Order” process requires a unique Order ID during ordering, as well as Shipment ID during product shipment.

You can handle this requirement by using a subprocess. In the above example, the subprocess can handle the shipment process. For more information regarding subprocesses, see Defining a subprocess as a performer on page 108.

**Note:** You cannot use an inline subprocess to handle this requirement.

As the subprocess is an independent process model, it can have its own EIID (for instance, ShipmentID), which can be mapped to a dataslot from the parent process. If required, the parent process can pass on its EIID (example, OrderID) to the subprocess at the time of its creation.

**Important:** Ensure that the value of the dataslot in the parent process, mapped to the EIID of the subprocess, is not null (or empty); otherwise the subprocess instance will be suspended.
Using dataslots

Table 53: Supported dataslots on page 176 lists the dataslot types that you can assign to a monitoring workstep in the monitoring process.

Table 53: Supported dataslots

<table>
<thead>
<tr>
<th>Dataslot</th>
<th>Java Type</th>
<th>Comments (if any)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER</td>
<td>String</td>
<td>Any character length longer than the maximum length specified for the process template, is truncated.</td>
</tr>
<tr>
<td>INTEGER</td>
<td>Double</td>
<td></td>
</tr>
<tr>
<td>INT64</td>
<td>Long</td>
<td></td>
</tr>
<tr>
<td>LOGICAL</td>
<td>Boolean</td>
<td></td>
</tr>
<tr>
<td>DATETIME-TZ</td>
<td>Long</td>
<td>Date must be specified in milliseconds.</td>
</tr>
<tr>
<td>LIST</td>
<td>List</td>
<td></td>
</tr>
<tr>
<td>Map</td>
<td>Map</td>
<td></td>
</tr>
</tbody>
</table>

Note: Dataslots of the type Object and Business Object are not supported for monitoring process.

The following business events can modify the value of the dataslots in the monitoring process instance.

- **UPDATE_DATASLOT**: This event can update the value of any user-defined dataslot (of the type listed in Table 53: Supported dataslots on page 176) in the monitoring process, including those dataslots not added to the monitoring workstep. This event identifies the process instance using the EIID value, before updating the dataslot values. If the value of the dataslot passed on by the event is invalid, then the dataslot update fails.

- **COMPLETE_WORKSTEP**: This event can only update the values of the dataslots (of the type listed in Table 53: Supported dataslots on page 176), added to the monitoring workstep. This event triggers the completion of the monitoring workstep, only after updating the dataslot values. If the value of the dataslot passed on by the event is invalid, then the dataslot update fails.

Note: The UPDATE_DATASLOT and COMPLETE_WORKSTEP events cannot update the EIID value.

To add a dataslot to a monitoring workstep:

1. From the Properties view of the workstep (external activity or adapter), click the Dataslots tab.
2. Click Add to open the Select Dataslots dialog box, which lists all the user-defined dataslots in the monitoring process.

Note: You must add only editable dataslots to a monitoring workstep.

3. Select the dataslot to be added, then click OK to add the dataslot to the table in the Dataslots tab.
Using process refresh

BPM Designer provides the Process Refresh feature, which allows you to refresh an installed application on Business Process Server servers. For information regarding process refresh, see Managing changes in Business Processes on page 307.

All the restrictions and rules of process refresh are applicable for a monitoring process as well. Note that:

- The data slot marked as the EIID cannot be changed.
- Converting a monitoring workstep to other workstep types (or the converse) is supported for process refresh.
- The value of the EIID in all process instances of the monitoring process being refreshed, must be unique or null.

Simulating a monitoring process

Progress Developer Studio for OpenEdge provides the Simulation feature, which allows you to configure and execute simulation for Business Processes. For information regarding simulation, see Configuring and running simulation on page 221.

You can configure and run simulation for a monitoring process the same way you simulate any other process in Progress Developer Studio for OpenEdge. You need to remember the following points for optimum performer utilization in a simulation run for a monitoring process:

- The Simulation project considers a separate individual performer for each external activity workstep. For example, if your monitoring process contains four external activity worksteps, simulation considers four separate individual performers, each listed as “Performer of <external_activity_workstep_name>” in the list of performers.
- There may be cases of multiple external activity worksteps, being performed by the same external user. In such cases, the implementation (in the previous bulleted point) will not indicate the accurate performer utilization. To resolve this issue, you need to enter the same performer name as the default performer in each workstep.
Defining workstep presentation format

OpenEdge BPM Designer allows you to add multiple presentation types such as Portal, Mobile, GUI, Rollbase and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

The presentation formats available are:

- **Portal:**
  - **Auto-generated:** This is the default HTML presentation form, automatically generated at runtime in Business Process Portal.
  - **Custom:** Enables you to define a customized Java Server Page (JSP).
  - **Flow:** Available only for Business Processes. Enables you to start and design a Web application from a Business Process.
  - **Flow (private):** Available only for Business Processes. This is the same as the Flow format but can be used only in the process template in which it is placed.

In OpenEdge 11.7, the Form Editor has been removed from BPM projects. In earlier releases, the Form Editor enabled you to design a customized interface with Form as the presentation format for Activity worksteps (and for Start worksteps in Business Processes). This format in the **Portal** presentation type has been removed for both Business Processes and Web applications.
When you import an existing BPM Processor Web application that has worksteps with Form as the presentation format into OpenEdge 11.7, the worksteps are not affected as long as their presentation type is not modified. Modifying their presentation type and changing the current presentation format overrides the current format as it is not supported in OpenEdge 11.7, and you will NOT be able to use the imported forms. You can choose to continue or cancel the action in the confirmation message that appears while modifying the presentation type.

**Note:** When importing existing BPM projects, ensure that you build the projects before importing them into OpenEdge 11.7.

**Note:** You can use Kendo UI® Builder by Progress® (Kendo UI Builder) to create new forms in OpenEdge 11.7. In Progress Developer Studio, click Help > Samples to find the KUIB sample app in the Samples page.

- **Mobile:** Available only for Business Processes. Enables you to complete an activity workstep (in a Business Process) on a Mobile device.

- **GUI:** Available only for Business Processes. Enables you to complete an activity workstep from a GUI for .NET desktop application.

- **Tablet:** Available only for Business Processes. Enables you to complete an activity workstep on a Tablet.

- **Other:** Available only for Business Processes. You choose Other to complete an activity workstep using an interface other than the options listed above. For example, if you want to complete an activity workstep on an iPad, you select Other as the presentation type for the activity in Business Process.

- **Rollbase:** This presentation type is to help users to view/edit/complete worksteps from a Rollbase application.

This chapter describes how to define presentation (or interface) types for Business Processes and Web applications.

For details, see the following topics:

- Defining workstep presentation for Business Processes
- Defining workstep presentations for Web applications

### Defining workstep presentation for Business Processes

You can change the look and feel of the presentation pages for Start or Activity worksteps in Business Processes. You can add multiple presentation types such as Portal, Mobile, GUI, Rollbase, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, a Rollbase application or a Tablet device.

**To define the presentation format:**

1. Click the Start or Activity workstep in the process template to display its properties in the Properties view.
2. From the General tab, click the Add button from the Presentation section to display the Add Presentation dialog box.
3. Select Portal from the Type drop-down list. Other presentation type options available are Mobile, GUI, Tablet, Rollbase and Other.
Note: You can add multiple presentation types such as Portal, Mobile, GUI, Rollbase and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, a Rollbase application or a Tablet device.

4. Select the presentation format option from the Form Type drop-down list. The options are Auto-generated, Custom JSP, Flow, and Flow (private).

5. If required, modify the presentation name in the Name box. You cannot specify a name for the Auto-generated format.

Alternatively, you can map worksteps (with Custom JSP and Flow presentations) to CHARACTER dataslots to dynamically associate the workstep with a JSP file or a Web application respectively. You need to set the initial value of the CHARACTER dataslot to a Web application (*.BpmWebFlow) or a valid JSP file (existing in the <project_name>\jsp folder). This feature is not available for Web applications.

a) From the Form Type drop-down list, select the appropriate option. The available options are Custom JSP, Flow, and Flow (private). The Form Type drop-down is not available for Mobile, GUI, Tablet, or Other as the presentation types.

b) Click the ellipsis button beside the Name or URL text field, then select Use a Dataslot option to display the AddDataslots dialog box. Select the CHARACTER dataslot to be mapped to the workstep presentation, then click OK to add the dataslot in the Name box.

6. Click OK, to return to the Properties view.

Note: You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the Presentation Type already exists. Do you want to override?. Click OK to override the presentation type.

For more details regarding each of the presentation formats available for BPM processes, refer to Table 54: Presentation Format for Business Processes on page 181.

Table 54: Presentation Format for Business Processes

<table>
<thead>
<tr>
<th>Presentation Type</th>
<th>Format</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal</td>
<td>Auto-generated</td>
<td>Defining Auto-generated HTML presentations on page 182.</td>
</tr>
<tr>
<td></td>
<td>Custom</td>
<td>Defining custom presentations on page 182.</td>
</tr>
<tr>
<td></td>
<td>Flow</td>
<td>Using a Flow presentation on page 183.</td>
</tr>
<tr>
<td></td>
<td>Flow (private)</td>
<td>Using a Flow (private) presentation on page 184.</td>
</tr>
<tr>
<td>Mobile</td>
<td>-</td>
<td>Defining Mobile presentation on page 185</td>
</tr>
<tr>
<td>GUI</td>
<td>-</td>
<td>Defining GUI presentation on page 187</td>
</tr>
</tbody>
</table>
### Defining Auto-generated HTML presentations

Progress Developer Studio for OpenEdge provides a default HTML presentation for Start and Activity worksteps, automatically generated at runtime in Business Process Portal. For instance, the Assignment sample application uses the auto-generated format.

Business Process Portal uses the Header options and dataslots specified in the workstep’s Properties view (see *Using the Fields tab of Start workstep properties* on page 140). In addition to Header options that include the Instruction and Priority fields directly under the heading, Business Process Portal also displays fields corresponding to the read-only and editable dataslots specified in the Fields tab in the workstep’s Properties view. In the figure above, the Task name, Assignee, Priority, Due Date, and Instructions boxes are editable; that is, you can enter data in these fields and the data is passed on to the next workstep.

**Note:** If you enter a file name without an extension for the HTML type, Progress Developer Studio for OpenEdge automatically adds the `.html` extension.

### Defining custom presentations

The Custom presentation form for Business Processes can be used with HTML forms. To add custom JSP presentations like the HTML presentations, the presentation of the JSP forms can be edited using an HTML editor that supports JSP tags. In addition, the logic part of the JSP (implemented in Java) can be modified to customize the content of the presentation using any text editor. For example, it is possible to add Java code to populate the content of a drop-down list from a database query.

If you select the Custom option in the Presentation dialog box in the Start or Activity worksteps properties, Progress Developer Studio for OpenEdge creates a Java Server Page (JSP) workstep presentation.

### Using external editors

Progress Developer Studio for OpenEdge allows you to open generated files in external editors and to customize a workstep or another application file in the selected external editor. For Activity worksteps with a Custom presentation or for user-created Adapter worksteps, you can use the Default (Notepad) and Wordpad as external editor options. This feature is not available for other workstep types.

**Note:** You can also use the External Editor feature to open Text files using Notepad as the default editor, Excel files using Excel as the default editor, and PDF files using Adobe Acrobat as the default editor. To configure these external editors to your requirements, navigate to *DesignerFileTypes.xml* in the *Workspace_Home\com.savvion.studio\conf\resources\designer* folder.
To use an external editor for customizing Activity (with Custom presentations) or Adapter worksteps (that are not predefined):

1. Right-click the Activity or Adapter workstep that you want to customize, point to the **Open With** option, and then select an external editor option.

   **Note:** In order to use an external editor, the application file must be a custom JSP presentation form. You cannot use an external editor for worksteps with a Default presentation form.

   The file is generated, then opened in the specified external editor: for example, in WordPad.

   **Note:** BPM CustomUI API tags are now delimited by {}, instead of the previously used <>.

2. Select the fields to be edited, and apply customizations that can include changing the background color or adding a border, or modifying or deleting dataslots.


4. To view the customized interfaces from Progress Developer Studio for OpenEdge, open the customized form’s file from its folder in the Project Explorer view; for instance, open the *Activity1.jsp* file from the JSP folder.

5. Publish the application as described in [Publishing an application](#) on page 59. To republish the customized interfaces without reinstalling the applications, select the **Copy files to Server only** option in the Publish wizard.

6. Select the **Go to Business Process Portal** check box to view the customized interfaces in your Web browser.

---

**Defining Flow presentations**

You can use the Flow presentation (available only in a Business Process) to execute a Web application without opening it from Business Process Portal. You need to only click on a connector provided in the interface to launch a Web browser with this format. OpenEdge BPM Designer provides two Flow options in the **Presentation** dialog box:

- **Flow** starts a Web application from a workstep in the Business Process by redirecting the Web application to the BPM WebFlow server (see [Using a Flow presentation](#) on page 183).

- **Flow (private)** creates a workstep that is restricted to the current process template and is not redirected to the BPM WebFlow server. You must copy the files in the Web application to the *webapp* folder in Progress Developer Studio for OpenEdge. For more information, see [Using a Flow (private) presentation](#) on page 184.

---

**Using a Flow presentation**

You can define an Activity workstep (in a Business Process) with Flow presentation type to start a Web application in Progress Developer Studio for OpenEdge. As this workstep runs in a Web browser, the Web application it calls must be installed.

**To define a Flow presentation for a workstep:**

1. From the **Properties** view, click the **General** tab to view the **Presentation** section.

2. Click **Add** to open the **Add Presentation** dialog box.
3. Select **Portal** from the **Type** drop-down list.

4. Select the **Flow** option from the **Form Type** drop-down list.

5. Click the **ellipsis** button beside the **Name** text field to open the **Add Dataslots** dialog box.

6. You can modify the name of the default Flow interface in the **Name** box. The default name is the name of the current workstep followed by the *.*.BpmWebFlow extension.

   The .BpmWebFlow extension indicates to the servlet that it should invoke the appropriate methods of the BPM WebFlow server to get the URL for the BPM WebFlow server and redirect the Web application to that page. The BPM WebFlow server implements a dispatcher that takes as input the Web application name and produces the URL of the Start workstep of the Web application.

7. Click **OK** to define the Flow presentation format for this workstep.

## Opening a Flow presentation

After defining the presentation format of the workstep as Flow, you can either create a new Web application or select any existing Web application.

**To open flow presentation:**

1. Right-click the workstep with Flow presentation, then click **Open Flow** to launch the Open `<workstep_name>` dialog box.

2. Select either an existing web application (in **Existing** folder) or **Web application Project**.

3. Click **OK** to open the flow presentation workstep. If you select an existing web application (in **Existing** folder), the process template of this web application is displayed. Alternatively, if you select **Web Application Project**, the New Web application wizard is launched, using which you create a Web application.

## Using a Flow (private) presentation

Unlike the Flow presentation type, the Flow (private) presentation type does not require you to publish and install the Web application in order to execute properly in its process template. Additionally, upon subsequent modifications to the input or output dataslots of the workstep in a Business Process with a Flow (private) presentation, the dataslots of the private flow are automatically updated to reflect the input and output changes in the workstep. This results in the automatic dataslot synchronization between Business Processes and Flow (private) applications. Removing dataslots from the Business Process does not remove corresponding dataslots in the Flow (private) application, but is interpreted as disassociating the dataslots in the Business Process from the dataslots in the Flow (private) application.

Right-click the workstep with a Flow (private) presentation and selecting **Open**, launches a Web application (without any Web application wizard).

The defined process appears in the Project pane as a process with a **SWT** extension in a WebApp folder. The process functions only in the current process, and you need not define and publish a Web application to use this type of workstep.

---

**Note:** If an application is used as a Flow (private) application in Progress Developer Studio for OpenEdge, you cannot use it as a stand-alone Web application; similarly, an installed Web application cannot be used as a Flow (private) workstep.

---

**To create a Flow (private) presentation for a workstep:**

1. From the **Properties** view, click the **General** tab to view the **Presentation** section.

2. Click **Add** to open the **Add Presentation** dialog box.
3. Select **Portal** from the **Type** drop-down list.

4. Select the **Flow (private)** option from the **Form Type** drop-down list.

5. Modify, if required, the default name in the **Name** box. The default name is the name of the current workstep. Alternatively, you can associate a dataslot with the Flow (private) workstep.
   a) Click the **ellipsis** button beside the **Name** box.
   b) Select the **Use a dataslot** option.
   c) Select the dataslot from the **Add Dataslots** dialog box.
   d) Click **OK** to add the dataslot.

6. Click **OK** to define the presentation format for this workstep.

7. Right-click the workstep and click **Open Flow** to open a blank Web application with the same name as the Flow (private) workstep.

The Flow (private) workstep is now confined to the current process template. Any dataslot that you create in the Web application (invoked from the Flow (private) workstep) are confined to the Web application and cannot be used in the Business Process. To pass dataslot values from the Business Process to the Web application, you must create the dataslot with the same name and type in both processes.

### Defining Mobile presentation

You can define an activity workstep (in a Business Process) with presentation type as Mobile to complete the activity using a Mobile device. As the activity runs in a Mobile device, you must install a mobile app in the device. Then, you must map the mobile app's URL to the activity workstep (in a Business Process) to access the activity.

**Note:** You can build and install mobile apps using Progress Software’s Telerik Platform and you can access supported Progress data resources from mobile apps built in the Telerik Platform using Progress Data Services such as OpenEdge and Rollbase. For more information, see the *Progress Data Services Guide and Reference*, which you can reference from the [http://clouddataobject.github.io/](http://clouddataobject.github.io/).

**To define a Mobile presentation for an activity workstep:**

1. Select an activity workstep in a Business Process for which you want to define the presentation type as Mobile.
2. From the **Properties** view, click the **General** tab to view the **Presentation** section.
3. Click **Add** to open the **Add Presentation** dialog box.
4. Select Mobile from the **Type** drop-down list.
5. Specify the mobile app file path or URL in the **URL** text field. For example, `https://<host>:<port>/mobile/activity.html`.
   Alternatively, you can map workstep with Mobile presentation format to CHARACTER dataslot to dynamically associate the workstep with a mobile app URL. You need to set the initial value of the CHARACTER dataslot to a valid mobile app URL.
   a) Click the **ellipsis** button beside the **URL** text field.
   b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.
c) Select a CHARACTER dataslot to be mapped to the workstep presentation.
d) Click OK to add the dataslot and then close the Add Dataslots dialog box.

6. Click OK to add the Mobile presentation format for the activity workstep.

Note: You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the Presentation Type already exists. Do you want to override?. Click OK to override the presentation type.

The Mobile presentation format is mapped to the selected activity workstep. The defined Mobile presentation type is displayed in the Presentation section.

Note: You can add multiple presentation types such as Portal, Mobile, GUI, Rollbase, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

Defining Rollbase presentation

You can define an activity workstep (in a Business Process) with presentation type as Rollbase to complete the activity using a Rollbase application. Then, you must map the Rollbase page ID to the activity workstep (in a Business Process) to access the activity.

To define a Rollbase presentation for an activity workstep:

1. Select an activity workstep in a Business Process for which you want to define the presentation type as Rollbase.
2. From the Properties view, click the General tab to view the Presentation section.
3. Click Add to open the Add Presentation dialog box.
4. Select Rollbase from the Type drop-down list.
5. Specify the Rollbase page ID in the ID text field. For example, 1400.

Alternatively, you can map workstep with Rollbase presentation format to CHARACTER dataslot or LongChar dataslot to dynamically associate the workstep with a Rollbase page ID. You need to set the initial value of the CHARACTER dataslot to a valid Rollbase application page ID.

a) Click the ellipsis button beside the ID text field.
b) Select Use a dataslot to open the Add Dataslots dialog box.
c) Select a CHARACTER dataslot to be mapped to the workstep presentation.
d) Click OK to add the dataslot and then close the Add Dataslots dialog box.

6. Click OK to add the Rollbase presentation format for the activity workstep.

Note: You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the Presentation Type already exists. Do you want to override?. Click OK to override the presentation type.

The Rollbase presentation format is mapped to the selected activity workstep. The defined Rollbase presentation type is displayed in the Presentation section.
Note: You can add multiple presentation types such as Portal, Mobile, GUI, Rollbase and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, Rollbase application or a Tablet device.

Defining GUI presentation

You can define an activity workstep (in a Business Process) with presentation type as GUI to complete the activity using a GUI for .NET desktop application. As the activity runs a GUI for .NET desktop application, you must develop a OpenEdge GUI for .NET application. Then, you must map the GUI for .NET application name (ABL class .cls filename) to the activity workstep (in a Business Process) to access the activity.

Note: For more information on developing OpenEdge GUI for .NET applications, see the OpenEdge Getting Started: Introducing the Progress Developer Studio for OpenEdge Visual Designer guide.

To define a GUI for .NET presentation for a workstep:

1. Select an activity workstep in a Business Process for which you want to define the presentation type as GUI.
2. From the Properties view, click the General tab to view the Presentation section.
3. Click Add to open the Presentation Types dialog box.
4. Select GUI from the Type drop-down list.
5. Specify an ABL class (.cls) file in the Name field. For example, SampleApp.cls.
   Alternatively, you can map workstep with GUI presentation format to CHARACTER dataslot to dynamically associate the workstep with an ABL .cls filename. You need to set the initial value of the CHARACTER dataslot to a valid ABL .cls filename.
   a) Click the ellipsis button beside the Name text field.
   b) Select Use a dataslot to open the Add Dataslots dialog box.
   c) Select the CHARACTER dataslot from the Add Dataslots dialog box.
   d) Click OK to add the dataslot and then close the Add Dataslots dialog box.
6. Click OK to add the Mobile presentation format for the activity workstep.

   Note: You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the Presentation Type already exists. Do you want to override?. Click OK to override the presentation type.

The GUI presentation format is mapped to the selected activity workstep. The defined GUI presentation type is displayed in the Presentation section.

Note: You can add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.
Defining Tablet presentation

You can define an activity workstep (in a Business Process) with presentation type as Tablet to complete the activity using a Tablet device. As the activity runs in a Tablet device, you must install a mobile app in the device. Then, you must map the mobile app's URL to the activity workstep (in a Business Process) to access the activity.

**Note:** You can build and install mobile apps using Progress Software’s Telerik Platform and you can access supported Progress data resources from mobile apps built in the Telerik Platform using Progress Data Services such as OpenEdge and Rollbase. For more information, see the Progress Data Services Guide and Reference, which you can reference from the [http://clouddataobject.github.io/](http://clouddataobject.github.io/).

To define a Tablet presentation for an activity workstep:

1. Select an activity workstep in a Business Process for which you want to define the presentation type as Tablet.
2. From the **Properties** view, click the **General** tab to view the **Presentation** section.
3. Click **Add** to open the **Add Presentation** dialog box.
4. Select **Tablet** from the **Type** drop-down list.
5. Specify the mobile app file path or URL in the **URL** text field. For example, `https://<host>:<port>/tablet/activity.html`. Alternatively, you can map workstep with Tablet presentation format to CHARACTER dataslot to dynamically associate the workstep with a mobile app URL. You need to set the initial value of the CHARACTER dataslot to a valid mobile app URL.
   a) Click the **ellipsis** button beside the **URL** text field.
   b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.
   c) Select a CHARACTER dataslot to be mapped to the workstep presentation.
   d) Click **OK** to add the dataslot and then close the **Add Dataslots** dialog box.
6. Click **OK** to add the Tablet presentation format for the activity workstep.

**Note:** You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the **Presentation Type already exists. Do you want to override?**. Click **OK** to override the presentation type.

The Tablet presentation format is mapped to the selected activity workstep. The defined Tablet presentation type is displayed in the **Presentation** section.

**Note:** You can add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

Defining Other presentation

You can define an activity workstep (in a Business Process) with presentation type as Other to complete the activity using a device other than the defined presentation types such as Portal, Mobile, GUI, or Tablet.
To define a Tablet presentation for an activity workstep:

1. Select an activity workstep in a Business Process for which you want to define the presentation type as Other.
2. From the Properties view, click the General tab to view the Presentation section.
3. Click Add to open the Add Presentation dialog box.
4. Select Other from the Type drop-down list.
5. Specify the filename in the Other text field.
   Alternatively, you can map workstep with Other presentation format to CHARACTER dataslot to dynamically associate the workstep with a file. You need to set the initial value of the CHARACTER dataslot to a valid file that you want to use to complete the activity.
   a) Click the ellipsis button beside the URL text field.
   b) Select Use a dataslot to open the Add Dataslots dialog box.
   c) Select a CHARACTER dataslot to be mapped to the workstep presentation.
   d) Click OK to add the dataslot and then close the Add Dataslots dialog box.
6. Click OK to add the Other presentation format for the activity workstep.

Note: You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the Presentation Type already exists. Do you want to override?. Click OK to override the presentation type.

The Other presentation format is mapped to the selected activity workstep. The defined Other presentation type is displayed in the Presentation section.

Note: You can add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

Defining workstep presentations for Web applications

Similar to Business Processes, you can define the look and feel of the presentation pages for Activity worksteps in Web applications. For Web applications, you cannot change the presentation format for the Start workstep.

After you have developed a Web application, you can view it as a series of presentation pages (or interfaces) in your Web browser by entering the appropriate URL. For example, to view the BarChartDemo Web application, enter the following URL: http://<machine_name>.<domain_name>:<port_number>/sbm/BPMWebFlow/BarChartDemo/Start.jsp.

To change the look and feel of the presentation pages for Activity worksteps in Web applications perform the following steps:

1. From the General tab of the Properties view of an activity workstep, click the ellipsis button beside the Presentation box to open the Presentation dialog box.
2. Select the presentation format option from the Type drop-down list. For Web applications, the available options are Auto-generated and Custom.
3. If required, modify the presentation name in the Name box.
4. Click OK to return to the Properties view.

For more details regarding each of the presentation formats available for Web application, refer to Table 55: Presentation Format for Web application components on page 190.

Table 55: Presentation Format for Web application components

<table>
<thead>
<tr>
<th>Presentation Format</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-generated</td>
<td>Using the Auto-generated presentation on page 190.</td>
</tr>
<tr>
<td>Custom</td>
<td>Using the custom presentation on page 190.</td>
</tr>
</tbody>
</table>

### Using the Auto-generated presentation

For Web applications, BPM Designer enables you to generate JSP forms with HTML interfaces using XSL. XSL-based interfaces provide greater flexibility and are easier to customize.

### Using the custom presentation

BPM Designer provides a Custom presentation option for Web applications that enables you to further customize presentation forms that were created using the Default presentation option. You can also customize JSP files that were imported from outside sources.

Use the Custom presentation option to retain any changes that you made to the presentation form—these changes are preserved after the application is published. Presentations that are created using the Default options are not preserved following application publishing.

### Customizing presentation pages

You can add, edit, or delete customized features to the presentation pages by modifying workstep, connector and/or dataslot properties for Web applications in BPM Designer.

### Specifying hyperlinks between Presentation pages

You can add hyperlinks to connect workstep presentation pages in Web applications. In contrast, Business Processes do not allow linking to other workstep presentations; users must click a Submit or Complete button to move the process forward to the next step.

You can create hyperlinks from one workstep to another workstep within a Web application by choosing any of the available three hyperlink connector types namely, Submit button, Hyperlink, and Image. For details regarding these link types, see Defining link properties on page 163 and For Web applications on page 164.
The following process template segment is taken from the SVBSurvey_Ver2 sample process and illustrate defining customized text hyperlinks.

**Figure 16: Sample Application Connector Properties Defined in the Process Template**

![Diagram showing connector properties](image)

In **Figure 17: SVB Survey Sample Application Presentation** on page 191, the properties entered in the connector Properties view are displayed on the workstep presentation as text hyperlinks “Privacy Policy” and “Start The Survey”.

**Figure 17: SVB Survey Sample Application Presentation**

![Survey presentation with hyperlinks](image)

**Creating multiple command buttons in web applications**

OpenEdge BPM Designer automatically displays multiple command buttons (Submit button, Hyperlink, or Image) in the presentation page of an Activity workstep that has multiple outgoing connectors. Each command button corresponds to each of the outgoing connector.

By default, the Properties view for each connector contains a blank Label box that inserts the default label in the presentation page. To change the default label, in the Properties view, enter a new label in the Label box, which replaces the default label for the button.

**To create multiple Command buttons:**

1. Add worksteps to the application and connect them to an Activity workstep. In the example illustrated in **Figure 18: Creating Multiple Command Buttons for an Activity Workstep** on page 192, four Link type connectors are added to the “Activity 2” workstep.

2. Click each of the connector to display its Properties view.

3. Select the appropriate option from the Type drop-down list as illustrated in **Figure 18: Creating Multiple Command Buttons for an Activity Workstep** on page 192.
4. Assign a name and enter a label for each connector. The label for the *moreinfo* connector is "Need more information", the *approve* connector’s label is “Approve Request,” the *reject* connector’s label is “Reject Request”, and the label for the *defer* connector is "Defer indefinitely."

Figure 18: Creating Multiple Command Buttons for an Activity Workstep

5. Click **File > Save** or the **Save** icon to save the changes.

6. Publish the Web application, as described in *Publishing an application* on page 59. In the interface (or presentation) page, these values appear as labels of the buttons.

Figure 19: Multiple Command Buttons in the Interface page

---

**Note:** When the application user has two or more options in a presentation, the conditions are mutually exclusive—the user cannot click more than one Submit button at the same time.

After generating multiple command buttons in a workstep, you can run a process instance during which conditions are checked to see whether the name attribute of the link connection has a value. Consequently, the flow transfers to the next appropriate workstep.

**Note:** BPM Designer automatically generates a **Reset** button for each presentation page that contains editable fields.

---

**Preserving customization after process reinstall**

After a Web application is uninstalled through Business Process Portal, a warning indicates which worksteps have been customized and where they are saved.

A JSP file is generated for the Start workstep (*Start.jsp*) and for each Activity workstep. You can customize these JSP files to modify their presentation. Do not attempt to customize the *Start.jsp*, because it contains information about the control flow of your Web application. When uninstalling a Web application, customized JSPs are saved under `OEBPS_HOME\BPMWebFlow\<App_Name>\jsp.bak\$timestamp`.

You can get the value of any data in *Table 56: JSP Internal Data in Presentation Files* on page 193 using the `BpmWebFlow.getDS jsp` tags.
Table 56: JSP Internal Data in Presentation Files

<table>
<thead>
<tr>
<th>Internal Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BP Server-specific tags:</strong></td>
<td></td>
</tr>
<tr>
<td>workitemName</td>
<td>workitem name</td>
</tr>
<tr>
<td>BPMCustomUIAPI_instanceName</td>
<td>process instance name</td>
</tr>
<tr>
<td>ptName</td>
<td>process template name</td>
</tr>
<tr>
<td>returnPage</td>
<td>URL to which the BPM WebFlow process is to return</td>
</tr>
<tr>
<td><strong>Business Process Portal-specific tags:</strong></td>
<td></td>
</tr>
<tr>
<td>BPMCustomUIAPI_priority</td>
<td>task priority</td>
</tr>
<tr>
<td>BPMCustomUIAPI_startDate</td>
<td>task start date</td>
</tr>
<tr>
<td>BPMCustomUIAPI_dueDate</td>
<td>task due date</td>
</tr>
<tr>
<td>BPMCustomUIAPI_instruction</td>
<td>task instruction</td>
</tr>
<tr>
<td>BPMCustomUIAPI_user</td>
<td>user who is executing the BPM WebFlow process</td>
</tr>
</tbody>
</table>

OpenEdge Business Process Server: Developing BPM Applications with Developer Studio
Using alerts

Progress Developer Studio for OpenEdge provides the Alerts functionality for Business Processes, which you can define and associate with selected worksteps. Using Alerts, you can notify application users in Business Process Portal of a predefined event, such as change in the status of a process instance or in case of an exceptional condition being satisfied. In BPM Designer, you can use the Alerts tab to define a pool of alerts that can be associated with selected worksteps. These alerts can be associated with selected worksteps using the Alerts tab in the workstep’s Properties view, at various transition points (such as, “On activation”, “When completed”, and “On Overdue”). during execution of the process.

The associated alerts appear in Business Process Portal under the My Alerts tab when, for example, a specific workstep is activated or when it is completed. Each alert must contain a message. Alerts can be assigned to one or more specified recipients or they can be triggered by a particular condition. For information on managing alerts in Business Process Portal, see the Business Process Portal User’s Guide.

For details, see the following topics:

• Reviewing the Alerts tab
• Defining an alert
• Associating an alert with a workstep

Reviewing the Alerts tab

You can view the "default" alert and define new alerts in the Alerts tab of the BPM Designer interface.

Click the Alerts tab for a new Business Process, to view the All Alerts section, which contains all the alerts available to the process template.
You can perform the following operations in the **Alerts** tab:

### Table 57: Alerts tab operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define an alert</td>
<td>See <a href="#">Defining an alert</a> on page 196.</td>
</tr>
<tr>
<td>Remove an alert</td>
<td>Select the alert to be removed, then click <strong>Remove</strong>. You cannot remove the &quot;default&quot; alert.</td>
</tr>
<tr>
<td>Modify existing alerts</td>
<td>Select the alert to be modified, then modify its properties in the respective sections of the <strong>Alerts</strong> tab.</td>
</tr>
<tr>
<td>Filter the alert list</td>
<td>Enter text in the <strong>type filter text</strong> box to filter the alert list and display all alerts whose names contain the matching letters.</td>
</tr>
<tr>
<td>Group (or ungroup) the alert list</td>
<td>By default, all alerts are grouped under alert severity categories, namely, Critical, High, Medium, and Low. To ungroup the alert list, click the <strong>No Grouping</strong> icon in the <strong>All Alerts</strong> section. To group the performer list under severity categories, click the <strong>Group by Severity</strong> icon in the <strong>All Alerts</strong> section.</td>
</tr>
<tr>
<td>Collapse the alert list</td>
<td>Click the <strong>Collapse All</strong> icon.</td>
</tr>
</tbody>
</table>

## Defining an alert

You can define new alerts in the **Alerts** tab.

**To define an alert:**

1. Load the Business Process (**SPT**) for which you want to define the alert.
2. From the **Alerts** tab, click **Add**.
   - The **New Alert** wizard appears.
3. From the first page of the **New Alert** wizard, you can specify the alert name, severity, and description of the alert.
   a) Type the name of the alert in the **Name** box. The name can only include alphanumeric characters and underscore ("_"). Do not start the alert name with a numeric character. The name for an Alert should not exceed 64 characters.
   b) Select an option from the **Severity** drop-down list; options are: Critical, High, Medium, and Low. The Severity indicates to the alert recipients the urgency with which they should respond to the Alert.
   c) Enter a description (optional) of the alert in the **Description** box. This will enable other users of the application in BPM Designer to determine the intent of the alert.
4. Click **Next**. From the second page of the **New Alert** wizard, you can define a condition that activates the alert when the condition is satisfied.
a) To define an alert condition, click **Condition** to open the **Condition** dialog box.

b) Select a dataslot from the drop-down list on the left. Only CHARACTER, INTEGER, INT64, LOGICAL, and DATETIME-TZ dataslot types are listed.

c) Select an operator. To complete defining the condition, select a dataslot from the drop-down list on the right or enter a value.

d) To add another condition, click and select **And** or **Or** option from the drop-down list. To remove a condition, click .

e) Click the **Advanced** option to go to the advanced mode where you can create a condition by adding specific dataslots or by entering (or copy-paste) a condition.

f) To verify the expression’s validity, click **Validate** in basic or advanced mode, and the “Validation successful” message appears.

5. Click **Next**. You can use the third page of the **New Alert** wizard to specify the alert message.

   In the **Message** box, enter the content of the message that you want the alert recipients to see when they open the Alert. You can enter static or dynamic values in the message. For dynamic values, you can use dataslots (${dataslot_name} or ${@System_dataslot}). Press CTRL+SPACE to view the list of dataslots in the process. Select the dataslot to be added and press ENTER to add the dataslot in the **Message** box. For example, a message reading "Vacation request of ${days} has been filed by ${@CREATOR}" will use the days dataslot (a dataslot in the User category) and the @CREATOR dataslot (a System category dataslot) to obtain dynamic values for the number of days and the name of the person who filed the vacation request at runtime.

   Note: If you use a System dataslot, it must be prefixed with "@".

6. Click **Next** to define the recipients of the alert.

   a) Click **Add** to open the **Performer** dialog box, which lists performers of type, "User" and "Group" (group of sub-type, "All") in the process.

   Note: You cannot add queues, groups of type "Any," or comma-separated lists of multiple performers as alert recipients.

   b) Select a single (or multiple) performer and click **OK** to assign your selected user or group as the alert recipient.

   To delete a recipient, select the recipient and click **Remove**.

7. Click **Finish** to add the defined alert to the **Alerts** tab.

**Associating an alert with a workstep**

After defining the alert in the **Alerts** tab, you must associate the alert with a workstep at various workstep transition points (such as, "On activation", "When completed", and for an Overdue Action in "On Overdue") during execution of the process. You can associate an alert with a Start, End, Activity, Adapter, or Subprocess workstep. In the case of the Start workstep, you can associate the alert only on completion of the workstep.

To associate an alert with a workstep:
1. From the workstep’s **Properties** view, open the **Alerts** tab.

   The Alerts tab displays the **On Activation** and **When Completed** sections. For the Start workstep, the **When Completed** section is only displayed.

2. To associate the alert with the workstep when the workstep is initially activated, add the alert to the table in the **On Activation** section.

   To associate the alert when the workstep is completed, add the alert to the table provided in the **When Completed** section.

3. Click **Add** to display the **Add** dialog, which lists all the available Alerts.

   a) Select an Alert from the drop-down list provided.

   b) Select the **Send SMS** check box to send the alert message as an SMS to the alert recipients. The alert message is sent to the recipient's phone number, as registered on Business Process Portal.

   **Note:** To enable using SMS for sending alerts, the Business Process Server property `oebps.sms.enable` must be set to **TRUE** in the `oebps.conf` configuration file. In addition, you can set the `oebps.sms.failonerror` property to **TRUE** for suspending a workstep when SMS sending fails. The `oebps.conf` file is located in the `OEBPS_HOME\conf` directory.

   You must update the `oebpssms.properties` file in the `OEBPS_HOME\conf` directory with the SMS gateway provider details.

   The Alert is added to the table in the **Properties** view.

### Associating an alert with an overdue action

You can also associate an alert to be activated in the event of an Overdue Action to an Activity, Adapter, and Subprocess workstep.

**To associate an alert:**

1. In the **Advanced** tab of the workstep’s **Properties** view, click the **On Overdue** tab.

2. To add a new Overdue Action, click **New**, to open the **Overdue Actions** dialog box.

3. Enter a number in the **Number of times to execute** box to indicate the number of times the Alert will be repeated.

4. From the **Alerts** tab, click **Add** to add an alert as described in **Associating an alert with a workstep** on page 197.

   The Alert is added to the list of alerts in the **Overdue Actions** dialog box.

**Note:** You can also add an Alert as an action in the Schedule, Timeout, Process Path, Decision Counter, Task Assignment, and File Poller Rule Wizards. For more information, see **Defining rules with Rule Wizards** on page 287.
Working with Graphical Event Logic tool

Progress Developer Studio for OpenEdge provides the Graphical Event Logic tool (henceforth referred to as GEL tool), which allows you to configure actions for worksteps (for example, on workstep completion).

For details, see the following topics:

- Benefits
- Exploring the GEL tool
- Using the GEL tool in BPM projects
- Other GEL tool operations

Benefits

The GEL tool provides the following benefits:

- Provides a centralized location to configure multiple actions.
- Provides a framework to define logic actions without scripting. This is useful for business users, who do not have knowledge of Java (or JavaScript) languages.
- Easy user interaction using GEL actions, which can be simply dragged to configure the logic. Additionally, you can easily rearrange and remove actions.
- Allows you to develop customized GEL actions.
- Provides a consistent UI design across Progress Developer Studio for OpenEdge modules. The GEL tool is currently used in the Logic content pane tab in the Progress Developer Studio for OpenEdge interface.
Exploring the GEL tool

This section describes the commonly-used user interface elements of the GEL tool. You can access the GEL tool from the Logic tab in the Progress Developer Studio for OpenEdge interface.

The following table describes the commonly-used elements in the GEL tool interface.

<table>
<thead>
<tr>
<th>Table 58: GEL Editor Components</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item</strong></td>
</tr>
<tr>
<td>Toolbar</td>
</tr>
<tr>
<td>• <strong>Expand all</strong> ( ) icon, to display the details of all added actions.</td>
</tr>
<tr>
<td>• <strong>Collapse all</strong> ( ) icon, to hide the details and only display the list of actions.</td>
</tr>
<tr>
<td>• <strong>Show only functions for selection</strong> ( ) icon, to filter the list of displayed actions based on the process template element you select in the Diagram content pane tab. To activate this function, select this icon and click the element (for example, &quot;Activity1&quot;) in the Diagram tab. The Logic tab displays only those actions defined for &quot;Activity1&quot; workstep.</td>
</tr>
<tr>
<td>• The <strong>Search</strong> box, which can be used to search the action name. Type the text to be searched in the <strong>Search</strong> box.</td>
</tr>
<tr>
<td>Main pane</td>
</tr>
<tr>
<td>• For each listed event, you can click the <strong>View/Change info</strong> ( ) icon to enter information about the event (for example, &quot;This block contains actions that are performed before the activation of Activity1 workstep.&quot;). You can enter your customized text in the <strong>Information</strong> dialog box that appears. Alternatively, you can open the <strong>Information</strong> dialog box by right-clicking the event header and selecting the <strong>View/Change info</strong> option. Similarly, you can enter information for each action that you drag to the added event. For more information, see Adding information to action blocks on page 206.</td>
</tr>
<tr>
<td>Palette pane</td>
</tr>
<tr>
<td>• You can also create custom GEL actions and include the same in the Palette pane, as discussed in Customizing GEL Actions on page 206.</td>
</tr>
</tbody>
</table>
Using the GEL tool in BPM projects

This section describes how you can configure logic actions for a Business Process (or Web application) using the GEL tool. The Logic content pane tab provides the list of defined events for worksteps. Before using the GEL tool, you must define the logic event in the Advanced tab of the workstep Properties view. For example, to define a logic event for Start workstep, see Using the Advanced tab of Start workstep properties on page 142.

Note: In the following sections, the Logic view for Business Process is presented, which is applicable to Web applications as well, unless otherwise stated.

GEL Actions in BPM projects

The following table lists the out-of-the-box GEL actions in the Palette pane for a Business Process (or Web application).

Table 59: Palette pane in BPM projects

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Operations pane</td>
<td>Displays the list of data operations that you can drag to a defined event in the Logic tab. For information on data operations, see Adding data operations on page 201.</td>
</tr>
<tr>
<td>Value Expressions pane</td>
<td>Displays the list of value expressions that you can add in the Logic tab. For information on value expressions, see Adding value expressions on page 202.</td>
</tr>
<tr>
<td>Other pane</td>
<td>Displays the list of expression constructs (including IF-THEN, IF-THEN-ELSE, and WHILE loop) and custom Java (and JavaScript) code. For more information, see Adding control structures and custom script on page 203.</td>
</tr>
<tr>
<td>Conditions pane</td>
<td>Displays the list of comparison conditions, validations, and custom conditions that you can drag to an expression construct in the Logic tab. For information on conditions, see Adding Conditions on page 204.</td>
</tr>
<tr>
<td>JSTools API</td>
<td>Displays the list of API methods that you can configure for a defined event in the Logic tab. For information on JSTools API methods, see Using JSTools API on page 205.</td>
</tr>
</tbody>
</table>

Adding data operations

You can use the Data Operations pane in the Logic tab to add data operations to listed events.

You can drag and configure the following GEL actions for each added event.

- **Set Dataslot**: Sets the value of a user-defined dataslot to a constant value. Alternatively, you can set the value of the dataslot to a value expression, as discussed in Adding value expressions on page 202.

- **Set Context Variable**: Allows you to define a context variable and set its value to a constant value. Alternatively, you can set the value of the variable to a value expression, as discussed in Adding value expressions on page 202.
• **Copy Value (generic):** Copies a constant value to the selected user-defined dataslot. Alternatively, you can copy values between value expressions, as discussed in **Adding value expressions** on page 202.

### Adding value expressions

You can use the **Value Expressions** pane in the **Logic** tab to add value expressions to GEL actions with data operations (as discussed in **Adding data operations** on page 201) and expression constructs with conditions (as discussed in **Adding Conditions** on page 204).

You can remove the default options of data operations and conditions and replace it with any of the value expressions. To perform this, you must first close the default option (for example, the "(constant) <value_box>" for the **Set Dataslot** action) and then drag the value expression to the placeholder labeled, "Drop value expression here."

You can drag and configure the following GEL actions.

- **User Dataslot:** To use a user-defined dataslot. For instance, you can set the value of another user-defined dataslot (or variable) to a user dataslot.

- **System Dataslot:** To use a system (or predefined) dataslot. For instance, you can set the value of a user-defined dataslot (or variable) to a system dataslot. This option is not available for Web applications.

- **Constant Expression:** To use a constant expression (or constant value). For instance, you can use this to revert the **Set Dataslot** and **Set Context Variable** actions (if you have changed the default options) to its default target constant value.

- **Custom Expressions:** To use customized Java (or JavaScript). For instance, you can specify a Java (or JavaScript) function that returns a particular value, which can be assigned to a variable (or dataslot).

**Note:** You can also use the AutoComplete functionality to automatically add script functions. To activate AutoComplete, type `jst.` (for a Business Process) or `bean.` (for a Web application) in the respective box.

- **Context Variable:** To use a context variable. For instance, you can copy the value of a context variable to another context variable.

### Value expressions in web applications

For Web applications, you can use the **Value Expressions** pane for additional value expressions used for complex expressions and date/time operations.

You can drag and configure the following additional GEL actions.

- **Complex Expressions:** Used for complex expressions. The supported actions are:
  - **Number Operation:** Used to perform arithmetic operations (add, subtract, divide, and multiple) on other value expressions. For instance, you can calculate the sum of values of two user-defined dataslots (or variables).
  - **String Concatenation:** Used to perform String concatenation on other value expressions. For instance, you can concatenate the string values of two user-defined dataslots (or variables).
  - **Statistical Operation:** Used to perform Statistical operations (sum, average, minimum, maximum) on multiple value expressions. For instance, you can calculate the average of values of two user-defined dataslots (or variables).
  - **Date/Time:** Used for adding date and time expressions. The supported GEL actions are:
• **Date-Only**: Used to add a date expression in dd-mm-yyyy format. You can modify the default date by clicking the icon.

• **Date/Time**: Used to add date (in dd-mm-yyyy format) and time (in hh:mm:ss format) expressions. You can modify the default date by clicking the icon and the default time by using the arrow keys.

• **Time Interval**: Used to assign a time interval with days, hours, minutes, and seconds boxes. You can modify the default values in these boxes by using the arrow keys.

---

### Adding control structures and custom script

You can use the **Other** pane in the **Logic** tab to add control structures and custom script to listed events. You can drag and configure the following GEL actions for each added event.

- **Control Structures**: Used to add expression constructs. The supported actions are:
  - **If-Then** and **If-Then-Else**: Used to add an IF-THEN and IF-THEN-ELSE constructs. For the IF block, you must add a condition, as discussed in Adding Conditions on page 204.
  - **While loop**: Used to add a WHILE loop. For the WHILE block, you must add a condition, as discussed in Adding Conditions on page 204.
  - **For loop**: Used to add a FOR loop.

  **Note**: Depending on your requirement, you can also create nested actions using the above control structures.

- **Return value**: Used to return the specified value.

- **Custom**: Used to add customized Java (or JavaScript). The supported actions are:
  - **Custom script (one line)**: Used to add a single line of code.
  - **Custom script (multi-line)**: Used to add multiple lines of Java (or JavaScript) code.

  **Note**: You can also use the AutoComplete functionality to automatically add script functions. To activate AutoComplete, type `jst.` (for a BPM process) or `bean.` (for a Web application) in the respective box.

- **Query APIs for DataSet and TempTable**: You can use this feature to execute an API support query like:
  - `jst.insertRow("<dataslot_name>", "<table name>", map)`; which creates another map to adds a record.
  - `jst.deleteRow("<dataslot_name>", "<table name>", map)`; which deletes multiple records that match values specified in the table.

  **Note**: If any of the column in the map does not have a matching value with the corresponding column for a row in the table, that row will not be deleted.

The dataslot can either be a TempTable or a ProdataSet.
Adding Conditions

You can use the **Conditions** pane in the **Logic** tab to add conditions to IF-THEN, IF-THEN-ELSE, and WHILE constructs.

You can drag and configure the following conditions.

- **Comparisons**: Used to compare value of an added dataslot (or variable) with static values or value in another added dataslot (or variable), and also to check the length of the entered value. The supported conditions are:
  - **Numerical Comparison**: Compares the value of a user-defined dataslot to a number. Alternatively, you can replace the user dataslot and the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 202.
  - **String Comparison**: Compares the value of a user-defined dataslot to a Character. Alternatively, you can replace the user dataslot and the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 202.
  - **Boolean Comparison**: Checks if the value of a user-defined Logical dataslot is true or false. Alternatively, you can replace the user dataslot and the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 202.
  - **Object Comparison**: Compares the values of user-defined dataslots of the same dataslot type. Alternatively, you can replace the user dataslot boxes with any of the value expressions, as discussed in Adding value expressions on page 202.
  - **Null/Empty String**: Used to check if a user-defined dataslot contains a value or not. Alternatively, you can replace the user dataslot box with any of the value expressions, as discussed in Adding value expressions on page 202.
  - **String length**: Used to check the string length of a user-defined dataslot. Alternatively, you can replace the user dataslot and the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 202.

- **Other**: Used to apply validation rules and customized code as conditions in expression constructs. The supported conditions are:
  - **Regex validation**: Used as a regular expression (regex) validator. Matches the value of a user-defined dataslot to a regex constant value. Alternatively, you can replace the user dataslot and the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 202.
  - **Complex condition**: Used to add multiple (or cascading) conditions. You can configure this condition to perform the action if all (or any) of the conditions are satisfied.
  - **Custom condition (one line)**: Used to add a single line of Java (or JavaScript) condition.
  - **Custom condition (multi-line)**: Used to add multiple lines of Java (or JavaScript) condition. Depending on your requirement, you can build your code block that returns true (or false) value.
Note: You can also use the AutoComplete functionality to automatically add script functions. To activate AutoComplete, type `jst.` (for a Business Process) or `bean.` (for a Web application) in the respective box.

---

Using JSTools API

You can use the **JSTools API** pane in the **Logic** tab to add JSTools API methods to listed events. This pane is not available for Web applications.

You can drag and configure the JSTools API methods from each of the following categories:

- **Getters**: includes methods that return a value. You can use these methods:
  - To assign a value to a dataslot (or variable) in data operations (see Adding data operations on page 201) instead of a value expression.
  - In conditions (see Adding Conditions on page 204) to replace the user dataslot and constant expression boxes.

- **Setters**: includes methods that store a value. The supported methods are:
  - `setDueDate()`: Used to specify the user-defined dataslot to store the due date value. Alternatively, you can replace the user dataslot box with any of the value expressions, as discussed in Adding value expressions on page 202.
  - `setInstruction()`: Used to store the instructions entered as a constant value. Alternatively, you can replace the constant expression box with any of the value expressions, as discussed in Adding value expressions on page 202.
  - `setPerformer()`: Used to store the performer entered as a constant value. Alternatively, you can replace the constant expression box with any of the value expressions, as discussed in Adding value expressions on page 202.
  - `setXPathValue()`: Used to specify the user-defined dataslot to store the passed XPath constant value at the specified XPath location. Alternatively, you can replace the XPath and Value constant expression box with any of the value expressions, as discussed in Adding value expressions on page 202.
    setXPathValue can be used to set xpath value in LONGCHAR or TempTable/Dataset (Use SDO XPath for TempTable/DataSet).

- **insertRow**: This API accepts three arguments- DataSlotName, TableName, Java Map Object. Java Map Object has key-value pairs for the table’s ‘column name’ and their ‘values’. Values in the map can either be provided as java objects or as a string. The entry for Insert is as follows:

  ```java
  gel.insertRow(<DataslotName>, <TempTable Name>, map)
  ```

- **delete Row**: This API accepts three arguments- DataSlotName, TableName, Java Map Object. Java Map Objects have key-value pairs for the table’s ‘column name’ and their ‘values’. The entry for Delete is as follows:

  ```java
  gel.deleteRow(<DataslotName>, <TempTable Name>, map)
  ```

---

OpenEdge Business Process Server: Developing BPM Applications with Developer Studio 205
Note: Users should add only those columns (in the map) for which a row with matching data has to be deleted. For example, if input map has four columns and if a row does not have matching data even for a single column out of the four, the row will not be deleted. If the input map has a wrong column name, none of the rows get deleted because every column name in the map should match with a column in the table and the data should match too. Values in the map can be provided either as a java object or a string.

- **get(dataslot, xpath):** This can be used to get xpath value in a longchar or TempTable/Dataset. (Use SDO XPath for TempTable/DataSet)

- **Utility:** provides the following utility methods:
  - **sendMail():** Used to send a mail. This utility allows you to specify the email address, subject, and message as constant values. Alternatively, you can replace the constant expression boxes with any of the value expressions, as discussed in Adding value expressions on page 202.
  - **writeLog():** Used to debug Java (or JavaScript) code. This utility allows you to specify the debug message as a constant value. Alternatively, you can replace the constant expression box with any of the value expressions, as discussed in Adding value expressions on page 202.

Note: You can also use the AutoComplete functionality to automatically add the above functions. To activate AutoComplete, type jst. (for a Business Process) or bean. (for a Web application) in the respective box.

### Other GEL tool operations

This section describes other GEL tool operations such as adding information to action blocks and customizing GEL actions.

#### Adding information to action blocks

In addition to storing information for each listed event, the GEL tool allows you to add customized information for each action block within the added event. In the case of an action block containing a large number of actions, this information is useful in providing a summary of the action block.

To add information for an action block, right-click the blank portion of an action block and select the View/Change info option. You can enter the customized information in the Information dialog box that appears. The entered information is displayed when the action block is collapsed.

#### Customizing GEL Actions

Progress Developer Studio for OpenEdge stores all out-of-the-box GEL actions (listed in the Palette pane of the GEL tool) as XML files in the following subfolders of the Workspace_Home\.com.savvion.studio\scripting folder:

- **bpserver** folder, which contains GEL action files for BPM processes.
- **bpmwebflow** folder, which contains GEL action files for Web applications.

The following table lists the GEL action files available in each of the above folders:
### Table 60: List of GEL action files

<table>
<thead>
<tr>
<th>For</th>
<th>GEL Action files</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Processes</td>
<td>main.palette</td>
<td>The initial file to be loaded and which contains the list of other GEL action files used along with the overall structure including the categories and the labels.</td>
</tr>
<tr>
<td></td>
<td>data_operations.palette</td>
<td>Includes the GEL actions in the <strong>Data Operations</strong> pane, as described in Adding data operations on page 201.</td>
</tr>
<tr>
<td></td>
<td>value_expressions.palette</td>
<td>Includes the GEL actions in the <strong>Value Expressions</strong> pane, as described in Adding value expressions on page 202.</td>
</tr>
<tr>
<td></td>
<td>other.palette,</td>
<td>For the <strong>Other</strong> pane, which includes the GEL actions in the sub-categories, namely <strong>Control Structures</strong> and <strong>Custom</strong>, as described in Adding control structures and custom script on page 203.</td>
</tr>
<tr>
<td></td>
<td>control_structures.palette,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>custom.palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td>conditions.palette,</td>
<td>For the <strong>Conditions</strong> pane, which includes the GEL actions in the sub-categories, namely <strong>Comparisons</strong> and <strong>Other</strong>, as described in Adding Conditions on page 204.</td>
</tr>
<tr>
<td></td>
<td>conditions_comparison.palette,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>conditions_other.palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td>jst.palette, jst_get.palette,</td>
<td>For the <strong>JSTools API</strong> pane, which includes the GEL actions in the sub-categories, namely <strong>Getters</strong>, <strong>Setters</strong>, and <strong>Utility</strong>, as described in Using JSTools API on page 205.</td>
</tr>
<tr>
<td></td>
<td>jst_set.palette,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>jst_utility.palette (located in the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>jst folder)</td>
<td></td>
</tr>
<tr>
<td>Web applications</td>
<td>The list and description of GEL action files are same as that for Business Processes, with the following differences:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Does not include the JST palette files.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Includes the <strong>value_expressions_complex.palette</strong> and</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>value_expressions_datetime.palette</strong> files, which include the GEL actions in the sub-categories, namely <strong>Complex Expressions</strong> and <strong>Date/Time</strong>, as described in Value expressions in web applications on page 202.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can use the **main.palette** file to define the categories and the list of GEL action files. Each `<category>` tag defines the category label and the path of this category in the tree. For the path of subcategories, you must prefix it with the category name. The order of the subcategories in this file is important, as this same order is displayed in the tree. Each of the action files includes the list of action items.

**Note:** To define a localized value, you must use the `$property.key` syntax to refer to a value in your property file. Custom property files must be stored in the same folder location as the `*.palette` files. Progress Developer Studio for OpenEdge provides two property files namely, `scripting.properties` and `scripting_ja.properties`, to be used for localization.
You can create your own categories and custom GEL action files. You must include the same in the main.palette file so that the GEL tool (when launched later) displays your custom categories and actions.

Each <item> tag of an action includes the following attributes:

- **label** of the action item that is displayed in the tree.
- **path**, which defines the location in the tree where the action item appears.
- **icon**, which defines the image file to be used for the action item.

The grid item within the <item> tag is used to organize the widgets in a grid format. For example, the grid item for the "Set widget value" action item includes the following attributes:

- **label** to add the label, "Set the value of."
- **choiceWidget** to add a combo box. The id="widget" attribute is used in code generation to refer to the widget's selected value. The type="WIDGET" attribute is used to list all available (or those specified in the filter tag) widgets on your form.
- **label** to add the "to" label.
- **entryWidget** to add a text box or text area. The id attribute is used in code generation to refer to this widget. The presentation attribute is used to specify either a text box or a text area.

The <template> tag contains the script to be executed using the values entered (or selected) in the listed fields. The ${<widgetID>} syntax is used to refer the widget ID (for example, ${widget} or ${character}) and is replaced (at runtime) with value entered in the widget with this ID.

**Note:** For detailed information on all tags and attributes that can be used in the .PALETTE files, see Action script tags on page 208.

**Action script tags**

You can use the following tags and attributes in the .PALETTE (out-of-the-box and custom) action files:

- **<palette version=1.0>**
  
  This is the root tag of each .PALETTE file. You must ensure that the version attribute value is the same in your custom file.

- **<category label="" path="" icon=""/>**
  
  Defines the category label (for example, "data operations") and category path (for example, "expressions/data_operations").

- **<item label="" path="" icon=""/>**
  
  Defines the label of the action item (for example, "Set widget value") and the path of the category under which this item is listed (for example, "expressions/data_operations").

- **<grid>**
  
  The grid container tag with the <widgets> tag, which contains the list of nested widgets.

- **<template>**
Located in the body of the widget and specifies the script generated by the widget. Uses \${widgetID} to refer to the value of the widget. For list widget values, this tag can include the prefix and suffix using the prefix \${list} suffix format, where \${list} refers to the list of multiple list widget statements, separated by a new line delimiter.

- `<choice Widget type="" filter=""`<br>
  This is a combo box widget, which allows you to select a form control, adaplet, or a constant value. The type attribute is used to set the type of values (WIDGET, ADAPLET, or CONSTANT). In the case of the type="WIDGET" attribute value, you can add the filter attribute to specify a comma-separated list of widget types to be displayed. The available widget types are BUTTON, CHECK_BOX, COMBO_BOX, CUSTOM, DATETIME, IMAGE, LINK, LIST, NONE, OBJECT, RADIO_BUTTON, TEXT_AREA, TEXT_FIELD, XML, and DIVIDER. Alternatively, you can use the predefined widget type lists namely, *ALL (for all widgets), *INTEGER_WIDGETS (for widgets with integer values), or *CHARACTER_WIDGETS (for widgets with string values). You can use the following tags within the `choiceWidget` block:

  - `<choice type="" presentation="">value</choice>`<br>
    You can add multiple `choice` tags to list the choices in the combo box widget. The type attribute value must match the value of the type attribute in the `choiceWidget` tag. The presentation attribute is used only for type="CONSTANT" attribute value and value is displayed in place of the value specified.

  - `<selection type="" presentation="">value</selection>`<br>
    Used to specify the default selection among the list of choices in the combo box widget. The type attribute value must match the value of the type attribute in the `choiceWidget` tag. The presentation attribute is used only for type="CONSTANT" attribute value and value is displayed in place of the value specified.

- `<string id="" value="">`<br>
  You can use this tag to predefine a list of widgets that can replace the comma-separated value of the filter attribute in `choiceWidget` tag. This is useful when the list of widgets in the filter attribute is long and also when you can reuse this string ID at multiple locations. The id attribute is used to set a unique name (for example, "CHARACTER_WIDGETS") and the value attribute is the comma-separated list of widgets.

  - To define the `<string>` tag for use in a single .PALETTE file, you must add the `<string>` tag definition once before the `choiceWidget` tags in which you want to use it. For example, refer the `<string id="MY_WIDGETS" value="CHECK_BOX,COMBO_BOX,LIST,TEXT_AREA,TEXT_FIELD"/>` in any `choiceWidget` tag as `choiceWidget type="WIDGET" filter="MY_WIDGETS"` by using the "ID" syntax.

  - Alternatively, to define the `<string>` tag for use in all .PALETTE files, you must add your `<string>` tag definition in the main.palette file. The main.palette file contains predefined `<string>` tags, namely, ALL, INTEGER_WIDGETS, and CHARACTER_WIDGETS. You can refer the predefined and custom `<string>` tags in the `choiceWidget` tags by using the "ID" syntax.

- `<entryWidget presentation="" validation="">`<br>
  This is a text box (or text area) widget. The presentation attribute is used to specify if the widget is a text box (value, "FIELD") or a text area (value, "AREA"). The validation attribute is optional and is used to limit the type of values that you can enter. The available values are FLOAT, INTEGER, or NONE. You can use the following tag within the `entryWidget` block:

  - `<reference type="" dataType="" encoding="">value</reference>`
Used to specify how to manage the value entered in the widget. The `type` attribute is used to set the type of value (WIDGET, ADAPLET, DATASLOT, or CONSTANT) that you can enter in the widget. You must enter any widget ID (in your form) for `type="WIDGET"` attribute value, or adaplet (in your form) name for `type="ADAPLET"` attribute value, or any constant value for `type="CONSTANT"` attribute value. For Datat slot type, the `dataType` attribute is used to specify the type of data to be stored in the datat slot. Supported values are LOGICAL, BUSINESSOBJECT, DATE, INTEGER, INT64, OBJECT, and CHARACTER. The `encoding` attribute (generally used only for constant values) is used to encode the entered string during script generation. Supported values are NONE (no encoding is performed), JAVA_STRING (to encode the entered value as a Java string), HTML (to replace characters (for example, ">") with its HTML code (in this case, ">")), HTML_JAVA_STRING (to combine HTML and JAVA_STRING encodings), and Business Process_STRING_CONSTANT (used in constant expression boxes to exclude the “@” and “$” characters).

```
  <list label="" prompt="" allowedContent="" max="" delimiter=""/>
```

This is a list container widget used in IF-THEN and IF-THEN-ELSE constructs. The `label` attribute is optional and used to specify the label (for example, "If," "then," or "else"). The `prompt` attribute (optional) is displayed in the list body when it is empty (for example, "drop an expression here."). The `allowedContent` attribute is used to specify the type of GEL actions that can be dragged on this list. Supported values are EXPRESSION (to drag expression actions) and LOGICAL (to drag conditions that return true or false values). The `max` attribute value is used to specify the maximum number of action files that can be dropped on the list. The `delimiter` attribute (optional) is used to specify the string value used to separate the code generated by each widget in the list.

```
  <operationJoin allowedContent="" label="" prompt=""/>
```

This is similar to the list container widget and is used for complex nested conditions joined with an operator. All attributes used in this tag are used for the same purpose as the `<list>` tag attributes. You must use the following tag within the `<operationJoin>` block:

```
    <operation>
```

Used to define the widget to select the type of join operation ("all" or "any") of the list.

```
  <datetime presentation="">
```

Available only for Web applications. This widget is used for entering date and time (or date only) values. The `presentation` attribute is used to specify if the widget is a date-only box (value, "DATE_ONLY") or a date and time box (value, "DATE_TIME"). You can use the `<reference>` tag within the `<datetime>` block to specify the default value (in milliseconds), which is the elapsed time (in milliseconds) from the Unix epoch time (January 1, 1970). You can specify a negative value to specify a default value prior to the Unix epoch time. If you do not specify any value in the `<reference>` tag, the current date (and time) is displayed in the widget at runtime.

```
  <interval>
```

Available only for Web applications. This widget is used for entering the time interval values in days, hours, minutes, and seconds. You can use the `<reference>` tag within the `<interval>` block to specify the number of seconds in the selected time interval.

```
  <info>
```

This attribute stores information of each configured event block added in the Logic tab. You can directly add the information by clicking the View/Change info icon for the block in the Logic tab.

```
  <label>
```

This is the label widget used to specify text.
You can use the following attributes in all widgets and the <grid> tag.

- **id=""**
  
  The widget ID value, which is referred using the `${widgetID}` syntax from the <template> tag.

- **content=""**
  
  Used to specify the type of content returned by the widget. Supported values are **EXPRESSION** (to return a script expression (such as, `alert('Hello');`) and **LOGICAL** (to return a logical value (true or false)).

- **row="" col="" rowspan="" colspan="" fill="true|false"**
  
  The **row** and **col** attributes are used to specify the position of the widget in the grid. For example, `row="0" col="0"` places the widget in row 1 and column 1 of the grid. The **rowspan** and **colspan** attributes are optional and are used for widgets, which span more than cell in the grid. The **fill** attribute is optional and used to control the layout of the widget in the grid. If set to true (default), the widget displays as expanded and fills the allocated space. If set to false, the widget does not expand in the allocated space.

- **collapsible="true|false" collapsed="true|false"**
  
  The **collapsible** attribute is used to specify if the widget can be collapsed (true) or not (false). For collapsible widgets, the **collapsed** attribute is used to specify the default state of the widget. The widget displays the toggle expand button (for collapsed="true") and collapse button (for collapsed=false).

- **description=""**
  
  Provides the description text for a widget block. This is useful when the complete widget block is not displayed (for example, when the block is collapsed).

- **searchable="true|false"**
  
  If set to true (default), the content of the widget is indexed and included when you search in the Graphical Event Logic (GEL) Editor. If set to false, the contents of this widget cannot be searched.
Using the Servers view

You can use the Publish wizard which facilitates application publishing, as discussed in Publishing an application on page 59. Additionally, you can use the Servers view to configure and publish processes as modules on the connected Business Process Server. You can use the Servers view to:

• Publish single (or multiple) processes (or modules) in a BPM project on the Business Process Server.
• Define Business Process Servers on local (or remote) machines, along with the connection and login details.
• Start and stop the Business Process Server running on the local machine.
• Copy modules between the available Business Process Servers.

For details, see the following topics:

• Creating a server
• Creating a Business Process Cluster Server
• Opening Servers view

Creating a server

Progress Developer Studio for OpenEdge provides the New Server wizard using which you can define a Business Process Server along with its connection and login details.

To create a server:
1. From the File menu, select New > Other to launch the New wizard.


   **Note:** Alternatively, right-click in the Project Explorer view, then select New > Server to launch the New Server wizard.

3. From the Define a New Server page of the New Server wizard, select Progress Software Corporation > Progress OpenEdge Business Process Server and configure the server properties, as described in Table 61: Server properties on page 214.

   **Table 61: Server properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server's host name</td>
<td>For Progress Business Process Sever, the server host name is set to &quot;localhost&quot;. You can specify a name or IP address of the server, located on the local or remote machine.</td>
</tr>
<tr>
<td>Server name</td>
<td>Modify (if required) the server name. The name is displayed for this server in the Servers view.</td>
</tr>
<tr>
<td>Server runtime environment</td>
<td>This field appears only if you have added a server runtime environment in the Preferences dialog box (see Adding server runtime environment on page 215). You can select from the available options in the drop-down list provided. To add a server environment, click Add to open the Progress OpenEdge Business Process Server wizard page, which you can use to define a different server name and location. You can also configure the available runtime environments by clicking Configure runtime environments to open the Servers Runtime Environments dialog box.</td>
</tr>
</tbody>
</table>

4. Click Next to open the Progress OpenEdge Business Process Server page. This page appears only if you have not added a server runtime environment in the Preferences dialog box (see Adding server runtime environment on page 215).

   **Note:** The Progress OpenEdge Business Process Server page is disabled if you have specified a remote server in the previous page.

   a) In the Runtime environment name box, modify (if required) the default server name.

   b) In the Server location box, enter the full path of the Business Process Server location, or click Browse to select the folder location.

5. Click Next to open the Progress OpenEdge Business Process Server page, in which you can set (or modify) the Business Process Server connection information.

   Table 62: Server connection properties on page 214 describes the server connection properties with default values retrieved from the specified Business Process Server installation.

   **Table 62: Server connection properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host name</td>
<td>(Read-only) The host name of the specified Business Process Server.</td>
</tr>
<tr>
<td>Http port</td>
<td>The default value is set to 18793. You can modify the server port number, if required.</td>
</tr>
</tbody>
</table>
Adding server runtime environment

You can add server runtime environments in the Preferences dialog box, in order to use any of these added server environments when defining a server.

To create a server runtime environment:

1. From the Window menu, click Preferences, to open the Preferences dialog box.
2. Expand Server > Runtime Environments in the left pane. The Server Runtime Environments page appears.

   This page displays the list of existing server runtime environments. You can perform the following operations:

   • To add a server runtime environment, click Add. The first page of the New Server Runtime Environment wizard appears.
     1. Select Progress Software Corporation >Progress OpenEdge Business Process Server.
     2. Select the Create a new local server checkbox to add a server runtime environment on the local machine.
     3. Click Next to open the Progress OpenEdge Business Process Server page. In the Runtime environment name box, modify (if required) the default server name. In the Server location box, enter the folder path of the Business Process Server location, or click Browse to select the folder location.
     4. Click Finish to add the server runtime environment.

   • To modify an existing server runtime environment, select it and click Edit.
   • To remove a server runtime environment from the list, select it and click Remove.
• To search for server runtime environments on local and remote machines, click Search.

3. After defining the server runtime environments, click OK to close the Preferences dialog box.

Creating a Business Process Cluster Server

Progress Developer Studio for OpenEdge provides the New Server wizard using which you can define a Business Process Server along with its connection and login details.

To create a server:

1. From the File menu, select New > Other to launch the New wizard.

   Note: Alternatively, right-click in the Project Explorer view, then select New > Server to launch the New Server wizard.

3. From the Define a New Server page of the New Server wizard, select Progress Software Corporation > Progress Business Process Cluster Server and configure the server properties, as described in Table 63: Server properties on page 216.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server's host name</td>
<td>For Progress Business Process Cluster Sever, the server host name is set to &quot;localhost&quot;. You can specify a name or IP address of the server, located on the local or remote machine.</td>
</tr>
<tr>
<td>Server name</td>
<td>Modify (if required) the server name. The name is displayed for this server in the Servers view.</td>
</tr>
</tbody>
</table>

4. Click Next to open the OpenEdge Business Process Cluster Server page. This page appears only if you have not added a server runtime environment in the Preferences dialog box (see Adding server runtime environment on page 217).

   Note: The OpenEdge Business Process Cluster Server page is disabled if you have specified a remote server in the previous page.

   a) In the Credentials area, enter the Username and Password.

   b) In the Business Process Server URLs box, enter the full path of the Business Process Server location, or click Import to import the server location.

5. Click Next to open the Add and Remove page, in which you can add (or remove) the project modules to be configured on this server.

This page displays the list of project modules in the Available section, which you can add to the Configured section. You can perform the following operations:

• To add a specific project module from the Available section, select the project module and click Add to add it to the Configured section.
• To add all project modules listed in the **Available** section to the **Configured** section, click **Add All**.

• To remove a specific project module from the **Configured** section, select the project module and click **Remove**.

• To remove all project modules listed in the **Configured** section, click **Remove All**.

6. Click **Finish**. The defined server and its configured project modules are displayed in the Servers view. For information on operations in the Servers view, see **Opening Servers view** on page 217.

### Adding server runtime environment

You can add server runtime environments in the **Preferences** dialog box, in order to use any of these added server environments when defining a server.

**To create a server runtime environment**:

1. From the **Window** menu, click **Preferences**, to open the **Preferences** dialog box.
2. Expand **Server > Runtime Environments** in the left pane. The **Server Runtime Environments** page appears.
   
   This page displays the list of existing server runtime environments. You can perform the following operations:

   • To add a server runtime environment, click **Add**. The first page of the **New Server Runtime Environment** wizard appears.
     
     1. Select **Progress Software Corporation > Progress OpenEdge Business Process Server**.
     2. Select the **Create a new local server** checkbox to add a server runtime environment on the local machine.
     3. Click **Next** to open the **Progress OpenEdge Business Process Server** page. In the **Runtime environment name** box, modify (if required) the default server name. In the **Server location** box, enter the folder path of the Business Process Server location, or click **Browse** to select the folder location.
     4. Click **Finish** to add the server runtime environment.

   • To modify an existing server runtime environment, select it and click **Edit**.
   • To remove a server runtime environment from the list, select it and click **Remove**.
   • To search for server runtime environments on local and remote machines, click **Search**.

3. After defining the server runtime environments, click **OK** to close the **Preferences** dialog box.

### Opening Servers view

Progress Developer Studio for OpenEdge lists all the defined servers and the configured project modules in the Servers view. You can use the Servers view to modify the server information, connection details, publishing settings, and server timeouts.

The Servers view displays the defined servers, along with the added project modules. To edit the server settings, double-click the server name to open the Server Editor. You can configure the server settings as described in **Table 64: Server Editor fields** on page 218.
### Table 64: Server Editor fields

<table>
<thead>
<tr>
<th>Server settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Information</td>
<td>To modify the server host name and runtime environment in the appropriate fields.</td>
</tr>
<tr>
<td>Connection Information</td>
<td>To modify the server connection details including host name, http port number, and user credentials in the appropriate fields.</td>
</tr>
<tr>
<td>Publishing</td>
<td>To modify the publishing settings for the server. You can select any of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Automatically publish when resources change</strong>, to publish the project modules automatically when they are modified.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Automatically publish after a build event</strong>, to publish the project modules automatically after building the project. You can also specify the time interval in seconds in the <strong>Publishing interval (in seconds)</strong> box.</td>
</tr>
<tr>
<td>Timeouts</td>
<td>To modify the time limit for starting and stopping the server. The default limit is 600 seconds for starting the server and 120 seconds for stopping the server.</td>
</tr>
</tbody>
</table>

You can also add and remove project modules in the defined server. Right-click the server name in the Servers view, then click **Add and Remove** option to open the **Add and Remove** page, which displays the available and configured project modules in the server. You can add or remove the project modules.

You can associate the project modules with the corresponding projects in the Project Explorer view. From the Servers view, click **View Menu ( ⌬ ) > Link with Project Explorer**. When you select a project in the Project Explorer view, the server containing the associated project module expands and highlights the project module.

**Note:** For a common resource project added as a project module, you can change the adapter type. Right-click the project module and select either **BP Server Adapter** or **Web Application Adapter**. If you change the objects of a common resource project published on a local (or remote) server, you must restart the local (or remote) server in order to reflect the changes.

In the Servers view, you can also:

- Copy project modules between defined servers, as described in **Copying modules** on page 218.
- Publish the project modules to the defined server, as described in **Publishing project modules** on page 219.

### Copying modules

In the Servers view, you can copy project modules from a defined server to another server.

To copy a project module from a defined server in the Servers view, right-click the project module and select the **Copy Module** option. Right-click the defined server to which you want to copy the module, then select the **Paste Module** option.
You can also copy multiple (or all) project modules from a defined server in the Servers view.

- To copy multiple project modules, select the modules. Right-click the selection and select the **Copy Modules** option. Right-click the defined server to which you want to copy the modules, and then select the **Paste Modules** option.

- To copy all project modules from a defined server, right-click the server name and select the **Copy Modules** option. Right-click the defined server to which you want to copy the modules, and then select the **Paste Modules** option.

### Publishing project modules

In the Servers view, you can publish project modules to the configured Business Process Server environment. Alternatively, you can configure automatic publishing for the defined server in the Server Editor.

If you are publishing all project modules associated with a defined server for the first time, then the Publish operation publishes all modules to the Business Process Portal. For project modules in the server that were previously published, then the Publish operation publishes only those modules that are not in synchronized state.

Before publishing, you can select the following options after right-clicking the project modules in the Servers view.

**Table 65: Project modules options**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inherit ACL</td>
<td>To retain any user permissions in the version of the process you are creating, which are associated with the parent process. By selecting this option, you ensure that when you publish this version on Business Process Portal, it will have the same user permissions as the original process.</td>
</tr>
<tr>
<td>Publish as a Web service</td>
<td>To publish the process as a Web service. For a previously published process, you can clear this option to change the option to Republish. This does not unpublish the process from the web services.</td>
</tr>
</tbody>
</table>

**To publish the project modules associated with the defined server:**

1. In the Servers view, right-click the defined server and select **Start** option to start the Business Process Servers.
   
   The server name displays the "[Started]" status when the Business Process Server is successfully started.

2. Right-click the server and select the **Publish** option to publish the associated project modules to the Business Process Server.
   
   The server name displays the "[Synchronized]" status when all project modules are successfully published to the Business Process Server.

**Republishing project modules**

For project modules in the server that were previously published, the server name displays the "[Republish]" state if you have modified any of the previously published project modules.

**Table 66: Republishing options for a previously published module** on page 220 describes the **Republish** options available after right-clicking the server name in the Servers view.
### Table 66: Republishing options for a previously published module

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean</td>
<td>To reinstall all project modules on the configured Business Process Server.</td>
</tr>
<tr>
<td>Copy Files to Server Only</td>
<td>To copy any updated files to the server.</td>
</tr>
<tr>
<td>Refresh Process Template</td>
<td>To apply changes in the associated process template to the active process instances in the server. This option is disabled if the changes cannot be applied to the process instances.</td>
</tr>
</tbody>
</table>
Configuring and running simulation

Progress Developer Studio for OpenEdge provides the Simulation project (see Creating a simulation project on page 56), which you can use to configure and run simulation for multiple processes. The Simulation project is implemented using a new simulation engine and is detached from the process workflow. You can perform simulation activities like defining and configuring scenarios, execution, and generating reports and analysis, using the simulation perspective in Progress Developer Studio for OpenEdge.

Progress Developer Studio for OpenEdge provides two perspectives namely, Progress OpenEdge BPM Simulation perspective (for configuring simulation parameters) and the OpenEdge BPM Run Simulation perspective (for monitoring the simulation run, and then generating simulation reports).

The Simulation perspectives provides:

• **Faster Testing for Design Flaws**: Allows you to quickly uncover potential problems in a process design. Instead of using a testing environment that requires two servers—one for production and one for testing—to create and test instances of the process, you can run a process in the Simulation perspectives as many times as required.

• **Estimated Cost of Resources**: Enables you to estimate the cost of the process, or the number of resources that the process will consume. You can define consumable (or single usage) resources (such as, equipment, electricity, and paper) and non-consumable (or reusable) resources (such as, computer and printer) at the process level to calculate the total estimated cost of the process.

• **Utilization of Business Calendar**: Allows you to set performer availability as defined in the organization-level business calendar. For details regarding business calendar, see Working with Business Calendar on page 265.

• **Identification of Bottlenecks**: Assigns worksteps to performing resources; for example, users or user groups for Activity worksteps. The simulation engine locks a performing resource during the execution of the workstep and releases it when the workstep is completed. Bottlenecks occur when another workstep needs the same performing resource, and must wait for the performing resource to be released from the previous workstep. Until then, the task for the next workstep is placed in a waiting queue. The simulation engine

---

OpenEdge Business Process Server: Developing BPM Applications with Developer Studio
Designing a simulation

To run a process simulation, you must first design a process template that illustrates the business process you want to simulate. The process template below shows an approval process that requires the reviewer to decide if the request meets specific critical criteria. If the performer of the Review Request workstep decides it is non-critical, it is sent by e-mail to a group at a remote location for submittal.

Each Activity workstep must be assigned a work time, or the Simulation will not execute. For the default scenario, the Review Request workstep assigned to any member from “MgrGroup” has an assigned work time of two hours; and the Submit Request workstep assigned to any member from the “ebmsgroup” has a work time of 50 minutes.
If any member from the MgrGroup decides the request is critical, it is sent to the Exec Approve workstep, where a senior executive (performer, “exec”) will approve or reject it. The approved requests are sent to the Submit Request2 workstep, where they are assigned to any member of group1. For the default scenario, the Exec Approve workstep has an assigned work time of 2 hours and the Submit Request2 workstep has a work time of 50 minutes. Each of the Adapter worksteps has an estimated duration of 10 minutes. The entire process has an estimated duration of 6 hours.

The probability settings for each pair of multiple outgoing connectors must total 100%, or the Simulation will not execute. For the default scenario, the IfCritical connector is assigned a 40% probability, the IfNotCritical connector has a 60% probability, the Submit connector is assigned a 70% probability, and the Reject connector has a 30% probability.

Adding a process

You can add a completed process to a simulation project from the Design perspective.

1. Open the Business Process (*.spt) to be added to the simulation project.

2. From the toolbar, click Start simulation icon ( ).

   If the current Business Process has been added as a process to a simulation project, the Simulate dialog box appears, which lists the simulation projects containing the Business Process.

   For a Business Process that has not been added to a simulation project, the New Simulation Project wizard appears, using which you can create a new simulation project (as described in Creating a simulation project on page 56) and add the current Business Process.

3. From the Simulate dialog box, select an existing simulation project, or click Simulation Project to add the Business Process to a new simulation project.

4. Click OK.

Simulation constraints

Please note the following constraints when designing your simulation:

• Each Activity workstep must be assigned a work time, or the Simulation will not execute.

• The probability settings for each pair of connectors out of a workstep must add up to 100%, or the Simulation will not execute.

• The simulation engine uses duration to estimate the work time for each workstep, providing a “worst case scenario” in which all the worksteps are executed taking the maximum allowed time.

• Since the simulation engine does not use dataslots, it assumes that a performer linked to a dataslot is a group, if the ALL or ANY options have been selected; or a single performer, if neither ALL or ANY was selected.

• There are no limits on resources.
Exploring the Progress OpenEdge BPM Simulation perspective

The Progress OpenEdge BPM Simulation perspective in the Progress Developer Studio for OpenEdge interface provides a central location where you can view or edit all the simulation parameters for each of your simulation scenarios. This section describes the Progress OpenEdge BPM Simulation perspective user interface.

The commonly used panes and views in the Progress OpenEdge BPM Simulation perspective are further described in Table 67: Progress OpenEdge BPM Simulation Perspective Components on page 224.

Table 67: Progress OpenEdge BPM Simulation Perspective Components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Explorer View</td>
<td>The Project Explorer displays the contents of active projects, including the Simulation project. It consists of a hierarchical view of all the files that make up the active project.</td>
</tr>
<tr>
<td>Simulation Control Editor (or Simulation controller)</td>
<td>The Simulation Control editor contains the following three sections.</td>
</tr>
<tr>
<td></td>
<td>• Scenarios, to add and remove scenarios. For details, see Adding a scenario on page 225.</td>
</tr>
<tr>
<td></td>
<td>• Processes, to add (or remove) processes. It also displays the current processes, performers, and resources in the project. You can view (and edit) the properties for added scenarios, as well for each individual process (and its worksteps), path, performer, and resource in the Properties view.</td>
</tr>
<tr>
<td></td>
<td>• Controls, which contains controls to start, stop, pause, exit the simulation run, as well as set the speed of the simulation. For operations, see Running a process simulation on page 239.</td>
</tr>
<tr>
<td>Properties view</td>
<td>Allows you to view (an edit) the properties for a selected item in the Simulation Control Editor. You can define (or edit) properties for the current simulation project, as well as for each of the added processes, worksteps, connectors, paths, performers, and resources. You can define the objectives for each of these components (see Defining objectives on page 234) and manage resources (see Managing resources on page 233).</td>
</tr>
<tr>
<td>Processes view</td>
<td>Consists of a Process tab for each of the added processes. Each Process tab comprises of the:</td>
</tr>
<tr>
<td></td>
<td>• Show Process drop-down list, which lists the current process and inline subprocesses (if any). For information regarding inline subprocess, see Defining an inline subprocess on page 109.</td>
</tr>
<tr>
<td></td>
<td>• Diagram view, which displays the process template diagram.</td>
</tr>
</tbody>
</table>
Configuring a simulation scenario

Progress Developer Studio for OpenEdge creates a single "default" scenario for each simulation project. You can add scenarios to the simulation project and configure simulation settings for each scenario independently. You can also import and export scenario information between simulation projects. After running simulation for each scenario, you can compare the results of the selected scenarios.

Configuring a Simulation scenario consists of:

- **Simulation configuration**: includes setting the simulation start (and stop) date and time. For details, see [Modifying simulation settings for a scenario](#) on page 226.

- **Process configuration**: includes configuring simulation properties for each process (simulation start and stop date and time, number of instances, randomization method) and for each process workstep (specifying worktime with time deviation method, specifying the resources, specifying the probabilities in case of multiple outgoing connectors and for Decision gateway).

- **Performer and Resource configuration**: includes setting the cost of each workstep performer, as well as defining consumable and non-consumable resources and their properties.

- **Objectives definition**: includes setting simulation objectives for the process, workstep, path, and for the usage of performers and resources.

**Note**: Any process or resource that you add in the Simulation perspective, is independent of simulation scenarios.

The following sections describe how to add a scenario and configure simulation properties for individual scenarios, and import and export scenario information.

Adding a scenario

Progress Developer Studio for OpenEdge enables you to create simulation scenarios in which you can change resources, the size of a group, the probabilities out of Decisions, and other simulation parameters.

**To define a new scenario:**

1. From the **Scenarios** section in the **Simulation Control Editor**, click the **Add** icon ( ), opening the **Add Scenario** dialog box.

2. Enter a name for the scenario in the **Name** box. This is mandatory.

3. From the **Using scenario** drop-down list, select any of the existing scenarios as a template for the new scenario. Resources, as well as processes and performers, defined in the scenario used are provided in the new scenario.

4. Click **OK** to add the new scenario to the Scenario drop-down list. Create as many additional scenarios as required.

To remove the scenario displayed in the Scenario drop-down list, click ❌.
Modifying simulation settings for a scenario

You can modify the simulation settings for the default scenario, as well as for any added scenarios. By default, any scenario created (see the preceding section) as a copy of the “default” scenario has the same simulation start and stop time as the default scenario.

To modify the simulation settings for a particular scenario:

1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be configured.

2. From the Processes section, click the current simulation project (in this case, simul1). In the Properties view, the General tab displays the details (name, label, description, and default currency) of the current simulation project. If required, enter the label and description and modify the default currency symbol in the respective boxes.

3. Click the Scenario tab to view the simulation settings (including simulation start time and end time) for the selected scenario (as described in Step 4 in Creating a simulation project on page 56). Modify the settings, as required.

4. From the Objectives tab, add the objectives for the selected scenario. For details, see Defining objectives on page 234.

5. From the Calendar tab, you can view the project calendar settings configured for the current scenario (as described in Creating a simulation project on page 56). Modify the settings, as required.

Importing and exporting a scenario

You can import and export scenario information between simulation projects using the Simulation Control Editor. You can also import scenario real-time data from the server. Importing and exporting scenario information enables you to:

- Modify scenario information using any XML Editor, independent of Progress Developer Studio for OpenEdge.
- Replace the current scenario settings with the imported scenario information, thus eliminating the need to configure each parameter in the scenario.

Exporting a scenario

To export scenario information to a simulation scenario file (*.ssf):

1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be exported.

2. Click the Export current scenario information icon ( ), opening the Export To dialog box.

3. Modify the default file name, if required, then click Save to save the *.ssf file in the Workspace_Home\<Application_Name>\exports folder.

Importing a scenario

To import a scenario information file (*.ssf) to the current scenario:
1. From the **Scenarios** drop-down list in the **Scenarios** section (in the **Simulation Control Editor**), select the scenario to be replaced.

2. Click the **Import information into current scenario** icon, to open the **Import Scenario Data** wizard.

3. From the first page of the **Import Scenario Data** wizard, select the source from which you want to import data.

4. Click the **Local file** option to import scenario data from the local *.ssf* file, then click **Next**.

5. From the **Import file details** page, click the **ellipsis** button next to the **Select file** box, then select the *.ssf* file containing the required scenario information.

6. Click **Finish** to import the selected scenario information to your simulation project.

7. Click the **Server (Real-Life)** option to import real-time scenario information from the server, then click **Next**.

8. Specify the server IP address and port number in the respective boxes.

9. Enter the user name and password required to connect to the server.

10. Modify (if required) the start date and end date in the **Start Date** and **End Date** boxes by clicking the adjoining **ellipsis** button. For details, see **Specifying a date** on page 237. Data of all the process instances that have been completed in this date range (between start and end date) are retrieved from the server.

11. Click **Connect** to verify the connection to the server.

12. Click **Next** to display the Scenario Difference Page.

   The left pane of the **Scenario Difference** page displays the simulation-related components of the current scenario including the added processes (and their individual worksteps), subprocesses (if any), performers, and resources. This structure is similar to the **Processes** section of the **Simulation Control Editor**.

13. Click any component to view the difference in the current and real-time data in the table provided in the right pane.

   **Table 68: Real-time data table** on page 227 describes each column in the real-time data table.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the simulation-related properties for the selected component. For example, instance count, duration, randomization type, and start time for a process.</td>
</tr>
<tr>
<td>Old Value</td>
<td>Displays the current value.</td>
</tr>
<tr>
<td>New Value</td>
<td>Displays the real-time value. Once imported, this value replaces the old value.</td>
</tr>
</tbody>
</table>

14. Click **Finish** to import the real-time scenario data to your current scenario.

**Note:** After running the simulation, you can also generate a real-time comparison report which compares the result of a simulation run with the server real-time data. For more information, see **Generating real-time comparison report** on page 250.
Configuring simulation parameters for a process

You can use the Processes section in the Simulation Control Editor to add processes as well as configure simulation parameters for each of the added processes and its worksteps. You can also configure simulation properties for each of the workstep paths in the process.

To add and configure simulation parameters for each process for a particular scenario:

1. From the Processes section, click the Add ( ) icon, opening the Required Project Selection dialog box, which lists the current projects in Progress Developer Studio for OpenEdge.
2. Click the project to be added, then click OK.
   The selected process is added to the list of processes under the Processes folder. To remove a process from the simulation project, select the process from the list of processes, then click . You cannot remove a subprocess.
   Note: In case you modify the process template after adding the process to the simulation project, select the process, then click the Refresh icon to reflect the changes made in the added process. You will need to reconfigure the simulation settings for any process workstep, which has been impacted by the change.
3. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be configured.
4. Expand the Processes folder, then click the process (for instance, Process1) whose simulation properties you want to configure. In the Properties view, the General tab displays the process details (name and label) of the selected process. You cannot modify any information in this tab.
5. Click the Instances tab to view the simulation settings (process start time, instances, and randomization type) for the selected process, as configured when adding the process in the New Simulation Project wizard. If required, modify the settings, as described Creating a simulation project on page 56.
   Note: In a simulation project with multiple processes, if you do not want to include a particular process in the simulation run, enter “0” as the process instance count.
   Note: The Instances tab does not appear for Subprocesses.
6. From the Objectives tab, add the objectives for the selected process. For details, see Defining objectives on page 234.
7. Use the Calendar tab to include calendar restrictions for the current process. For details, see Setting calendar on page 236.

Alternatively, you can view the entire list of added processes and subprocesses in a tabular format by clicking the Processes folder in the Processes section of the Simulation Control Editor.

The Master Processes section table displays a list of main processes and the Auxiliary Processes section table displays subprocesses (if any). You can add, modify, or delete a main process by clicking the appropriate button.

You can also configure simulation properties for each workstep in the process and for each of the workstep paths and connectors, as described in the following sections.
For worksteps

You can configure simulation settings for individual worksteps in a process. Workstep configuration is applied to the selected scenario only.

1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be configured.
2. Expand the Processes folder, then expand the process (for instance, Process1). Expand the Worksteps folder to display the list of contained worksteps.
3. Click the workstep to be configured. Alternatively, you can click the workstep in the Diagram view.

In the Properties view, the General tab displays workstep details including name and label. You cannot modify any information in this tab. The rest of the tabs vary depending on the type of the selected workstep, and are described in the table below.

**Table 69: Configuring a Workstep**

<table>
<thead>
<tr>
<th>Workstep type</th>
<th>Subtabs in the Properties view</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Activity/ Adapter/ Subprocess worksteps</strong></td>
<td></td>
<td>For an Activity or Adapter workstep, review the workstep performer in the Performer box. From the Time Distribution section (available only for Activity worksteps), you can modify randomization method for workstep instances (see Choosing a randomization method on page 236).</td>
</tr>
<tr>
<td></td>
<td><strong>Task</strong></td>
<td><strong>Note:</strong> You cannot configure the worktime distribution for an adapter workstep. By default, it is set to 1 second. For an Activity workstep with a Timeout connector, use the Timeout section to enable the workstep timeout functionality. You can specify the timeout duration in terms of hours, minutes, and seconds in the respective boxes. For a Subprocess workstep, click the Using worktime option and specify the randomization method for the workstep instances in the Worktime Distribution section.</td>
</tr>
<tr>
<td>Probability</td>
<td></td>
<td>Allows you to configure the probability setting for worksteps with multiple outgoing connectors. For details, see Setting the probabilities on page 231.</td>
</tr>
<tr>
<td>Objectives</td>
<td></td>
<td>Allows you to add objectives for the workstep (example, the total completion time for all instances of the workstep must not exceed 10 hours). For details, see Defining objectives on page 234.</td>
</tr>
<tr>
<td>Resources</td>
<td></td>
<td>Allows you to add resources (consumable and non-consumable) and the quantity likely to be consumed for this workstep. For non-consumable resources, you cannot specify a consumption count more than the available count.</td>
</tr>
<tr>
<td>Start/ End workstep</td>
<td><strong>Objectives</strong></td>
<td>Allows you to add objectives for the workstep (example, the total count of workstep instances created must exceed 10). For details, see Defining objectives on page 234.</td>
</tr>
</tbody>
</table>
Subtabs in the Properties view

<table>
<thead>
<tr>
<th>Workstep type</th>
<th>Subtabs in the Properties view</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision gateway</td>
<td>Probability</td>
<td>Allows you to configure the probability setting for the default connector and the conditional connector. For details, see <a href="#">Setting the probabilities</a> on page 231.</td>
</tr>
<tr>
<td></td>
<td>Objectives</td>
<td>Allows you to add objectives for the Decision gateway. For details, see <a href="#">Defining objectives</a> on page 234.</td>
</tr>
<tr>
<td>Other Gateway types</td>
<td>Objectives</td>
<td>Allows you to add objectives for the particular gateway. For details, see <a href="#">Defining objectives</a> on page 234.</td>
</tr>
</tbody>
</table>

Alternatively, you can configure (or modify) simulation settings for worksteps by clicking the Workstep folder for the selected process in the Processes section of the Simulation Control Editor.

The General tab displays the Activity Worksteps section table (containing all the activity worksteps), Adapter Worksteps section table (containing adapter worksteps), Decision Worksteps section table (containing decision gateways), Inline Worksteps section table (containing inline subprocess worksteps), Subprocess Worksteps section table (containing subprocess worksteps), and Other Worksteps section table (containing additional worksteps such as Start and End). You can modify the simulation settings for any workstep by selecting it and then clicking the adjoining Modify button.

For connectors

You can use workstep connectors to configure a delay between the connecting worksteps. This introduces a time delay between workstep instance creation during the simulation run. This configuration is applied to the selected scenario only.

To configure a connector delay:

1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be configured.
2. Expand the Processes folder, then expand the process (for instance, Process1). Expand the Connectors folder to display the list of workstep connectors.
3. Click the connector to display the connector properties in the Properties view. In the Properties view, the General tab displays connector details including name, label, type (default or conditional) as well as the names of the connecting worksteps. You cannot modify any information in this tab.
4. Use the Delay tab to configure the connector delay.
   • From the Delay Distribution section, choose a method of randomizing the duration of delay between workstep instances in the simulation. For information regarding randomizing methods, see [Choosing a randomization method](#) on page 236.
For paths

A simple process consisting of a couple of Activity worksteps with Start and End worksteps, has an isolated path from start to completion. A complex process (for instance, a manufacturing system) can have a network of paths providing multiple routes between the same two locations. For such cases, Progress Developer Studio for OpenEdge provides path analysis functionality in order to determine the shortest path or the least expensive path.

You can define paths for individual processes in a simulation project. You can configure these added paths differently for different scenarios.

Note: A defined path must contain more than one Activity workstep.

To define a path:

1. Expand the Processes folder, then expand the process (for instance, Process1).
2. Click Paths to display the Paths table in the Properties view. This table displays the list of defined paths for this project. You can add new paths, and modify or delete existing paths.
3. Click Add, opening the Path dialog box.
4. Enter the name and a brief description of the path in the Name and Description boxes respectively.
5. The Available Choices section displays a list of all the elements contained in the process. Select the element that denotes the starting location of your path, then click the Move Left (➡️) icon to add the element to the Current Path section. The Successors section on the right, now displays the elements following the added element in the process.
6. Continue adding elements to build the path.

   To delete a path element, select the element in the Current Path section, then click ✖️. You can only remove the last added element. To reset the path elements, click ⏯️.

7. After building the path, click OK to add the path to the Paths table in the Properties view.
8. After you define a path, expand the Paths folder for this process to view the added path. Click the path to view the path properties in the Properties view, where you can modify the path properties, as well as define objectives. To define path objective for a particular scenario:
   a) Select a scenario from the Scenario drop-down list in the Simulation Control Editor.
   b) Click the added path to be configured.
   c) From the Objectives tab of the Properties view, add the objectives for the selected path. For details, see Defining objectives on page 234.

Setting the probabilities

You can use the Probability tab in the Properties view to review or change probability settings for:

- Activity worksteps with multiple outgoing connectors.
- Activity worksteps with a defined loop condition (see Defining a Loop condition on page 144).
- Decision gateways.

To configure the probability settings for any of these worksteps:
1. Select a scenario from the Scenario drop-down list in the Simulation Control Editor.
2. Click the Activity workstep or Decision gateway to be configured, then click the Probability tab in the Properties view.

**Note:** To perform this operation, you need to understand how to configure multiple connectors originating from a workstep. For details, see Using multiple connectors on page 77.

The Probability tab displays the Default bar, which represents default connectors with no specified condition. Additionally, it may display the following bars:

- **Conditional** bars, which represent connectors with a specified condition.
- **Looping** bar (only for Activity worksteps), if the workstep contains a loop condition.
- **Compensation** bar (only for Activity worksteps), which represents connectors with a compensation flow.

The sum of the Probability values (on the right side) always equals 100%.

3. You can modify the probability value of all bars, except the Default bar. Use your cursor to move any of the probability bars to the right or left, or specify a value in the adjoining box. This automatically adjusts the value in the Default bar.

4. For worksteps with multiple conditional connectors, you can also add a Multiple Condition bar, which represents a condition when multiple conditional connectors are executed (that is, when the condition in all the connectors are satisfied).

**Note:** You cannot add a multiple condition bar for an Exclusive Decision gateway.

a) Click Add to open the Conditional Links dialog box, which displays all the conditional links from the workstep.

b) Click the conditional link to be added. Press CTRL, and then click the other conditional link to be added. You need to select at least two conditional link to enable the OK button.

c) Click OK to add a multiple condition bar to the Probability tab. You can now adjust the probability value for this bar, as explained in Step 3.

To remove a multiple condition bar, select the bar and then click Remove. You cannot remove any of the other probability bars.

### Managing performers

You can define the simulation properties for the assigned performers using the Performers section in the Simulation Control Editor. You can review (or modify) the settings for human performers (individual and group) and adapter performers. Performer configuration is applied to the selected scenario only.

**To configure simulation settings for a performer:**

1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be configured.

2. From the Processes section in the Simulation Control Editor, expand Performers to display four subfolders namely, Systems (containing any adapter performers), Individuals (containing single human performers), Groups (containing a group of human performers), and Queues (containing any queue performers).
In case you add (or modify) groups in the User Management tool after adding the process (containing the group performer) to the simulation project, select the Groups folder, then click the Refresh icon to reflect the changes made in the group members.

3. Expand these folders to view the respective performers assigned to the worksteps in the processes added to this project.

4. Click each performer to review the current performer information in the Properties view.

   • For an Adapter performer, review the name of the performer in the General tab. Enter a number (greater than 0) in the Limit box to specify the maximum number of times you want to invoke the adapter. Enter an amount (greater than 0) in the Cost box that provides a value for the cost per adapter invocation. In this case, the adapter will be invoked three times at the cost of $5.75 per invocation; any additional invocations must wait until one of the three invocations has completed its task. Use the Objectives tab to add objectives for the performer, as described in Defining objectives on page 234.

   • For an individual performer, review the name of the performer in the General tab. Enter the hourly cost for the performer in the Per Hour box. Use the Objectives tab to add objectives for the performer, as described in Defining objectives on page 234. Use the Calendar tab to add calendar restrictions for the performer, as described in Setting calendar on page 236.

   • The Properties view is similar for group and queue performers. Review the name of the performer in the General tab. In the Members tab, click the From User Management option to configure the performer settings as defined in the User Management tool. Alternatively, click the Virtual option to enter a virtual group size in the Number of Members box and the hourly cost of each group member in the Cost (per Hour) box. You need to specify a minimum virtual group size more than or equal to 1.

   **Note:** The From User Management option is only enabled for groups and queues existing in the User Management tool and containing group members. For more information, see Managing groups on page 262 and Managing queues on page 263.

   **Note:** You can use the Calendar tab to add calendar restrictions for the group or queue performer, as described in Setting calendar on page 236.

Alternatively, you can configure (or modify) simulation settings for performers by clicking the Performers folder in the Processes section of the Simulation Control Editor.

The General tab displays the Individual Performers section table (containing individual performers), System Performers section table (containing adapter performers), Group Performers section table (containing group performers), and Queue Performers section table (containing queue performers). You can modify the simulation settings for any performer by selecting it and then clicking the adjoining Modify button.

**Tip:** You can also click any of the four subfolders under the Performers folder (in the Simulation Control Editor) to view and modify the simulation settings for the respective performer type.

**Managing resources**

You can define resources independent of any process or scenario. Resources are any expendable items, but do not include personnel. Progress Developer Studio for OpenEdge supports two types of resources, namely:

• **Consumable** resources: These are the resources that are used up during the simulation and may typically include either Services (such as electricity, gas) or Supplies (such as paper, staples). These resources are
usually modeled either as a function of time or associated with an events, such as the completion of an operation.

- **Non Consumable** resources: These are the shared resources with multiple activities waiting for the same resource. These type of resources are most likely to affect system performance, as they may cause bottlenecks. An example of a non-consumable resource is machinery.

**To define a new resource (consumable or non-consumable):**

1. From the **Processes** section in the Simulation Control Editor, expand **Resources** to display the **Consumables** and **NonConsumables** folders.

2. Click each of the respective folders to display the **Consumables** or the **Non Consumables** table in the **Properties** view. This table displays the list of defined resources for this project. You can add new resources, modify existing resources, and delete resources from the respective **Properties** view.

3. Click **Add** in the respective **Properties** view, opening the **Consumable Resource** dialog box, or the **Non Consumable Resource** dialog box.
   a) For a consumable resource, enter the appropriate data in the **Name**, **Unit**, and **Cost** boxes. The name of the resource cannot contain any blank spaces. Data entered in the Unit box must contain only alphabetic characters.
   b) For a non-consumable resource, enter the appropriate data in the **Name**, **Availability**, and **Cost** boxes. Enter a number in the Availability box, which indicates the quantity of the resource that can be shared.

4. Click **OK** to save the resource and add it to the respective table in the **Properties** view.

5. After you define a resource, expand the **Consumables** or **NonConsumables** folder (in the Simulation Control Editor) to view the added resources. Click the resource to view the resource properties in the **Properties** view.
   a) From the **General** tab, modify (if required) the respective resource properties.
   b) From the **Objectives** tab, add the objectives for the selected resource. For details, see the following **Defining objectives** on page 234 section.

Alternatively, you can view the entire list of added resources in a tabular format by clicking the **Resources** folder in the **Processes** section of the **Simulation Control Editor**.

The **General** tab displays the **Consumable Resources** section table (containing list of consumable resources) and **Non Consumable Resources** section table (containing list of non-consumable resources). You can add, modify, or delete a consumable or non-consumable resource by clicking the appropriate button.

**Defining objectives**

Progress Developer Studio for OpenEdge allows you to define objectives, which helps achieve goals for optimum time, cost, and resource utilization. You can define objectives at process, workstep, and path levels, as well as for defined performers and resources. Any violation of these objectives during simulation execution are listed in the **Violations** view in the Simulation perspective.

Progress Developer Studio for OpenEdge provides a predefined set of properties for objectives. You can define a condition for these properties, whose values are set according to cost, count or a time duration.

**To define an objective:**
1. Type the name of the objective in the **Name** box.

2. From the **Condition** drop-down list, select the operator. The available options are: `==` (equal to), `!=` (not equal to), `<` (less than), `>` (greater than), `<=` (less than or equal to), and `>=` (more than or equal to).

3. In the adjoining text box, enter the condition value in terms of a number (for count- or cost-based objectives) or in terms of hours, minutes, and seconds (for duration-based objectives).

   **Table 70: Predefined Properties** on page 235 provides the complete list of predefined properties and their description.

**Table 70: Predefined Properties**

<table>
<thead>
<tr>
<th>Property name</th>
<th>Available for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completion Duration</td>
<td>Simulation project only</td>
<td>Sets the duration for the complete simulation.</td>
</tr>
<tr>
<td>Created instances count</td>
<td>Process and workstep</td>
<td>Sets the number of instances created for a process or workstep.</td>
</tr>
<tr>
<td>Completed instances count</td>
<td>Process and workstep</td>
<td>Sets the number of completed instances for a process or workstep.</td>
</tr>
<tr>
<td>Terminated instance count</td>
<td>Process and workstep</td>
<td>Sets the number of instances terminated for a process or workstep.</td>
</tr>
<tr>
<td>Aggregate completion time</td>
<td>Process and workstep</td>
<td>Sets the total completion time of all instances of a process or workstep.</td>
</tr>
<tr>
<td>Average completion time</td>
<td>Process and workstep</td>
<td>Sets the average completion time of all instances of a process or workstep.</td>
</tr>
<tr>
<td>Total Task Count</td>
<td>Individual Performer</td>
<td>Sets the total count of tasks performed by the performer.</td>
</tr>
<tr>
<td>Total Task Duration</td>
<td>Individual Performer</td>
<td>Sets the total duration of tasks performed by the performer.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Performer and Resource</td>
<td>Sets the total cost of a performer or resource.</td>
</tr>
<tr>
<td>Average Cost per Task</td>
<td>Individual Performer</td>
<td>Sets the average cost of a performer for each completed task.</td>
</tr>
<tr>
<td>Total Utilization</td>
<td>Individual Performer and Resource (Non-consumable)</td>
<td>Sets the utilization value of a performer or a non-consumable resource.</td>
</tr>
<tr>
<td>Total Count</td>
<td>Resource (consumable)</td>
<td>Sets the total count for a consumable resource.</td>
</tr>
<tr>
<td>Average Cost</td>
<td>Resource (Non-consumable)</td>
<td>Sets the average cost of a non-consumable resource.</td>
</tr>
<tr>
<td>Total Invocations</td>
<td>Adapter Performer</td>
<td>Sets the number of adapter invocations.</td>
</tr>
<tr>
<td>Traversal Count</td>
<td>Path</td>
<td>Sets the total count for traversing a path.</td>
</tr>
<tr>
<td>Property name</td>
<td>Available for</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Summed Traversal Time</td>
<td>Path</td>
<td>Sets the total time for traversing a path for all process instances.</td>
</tr>
<tr>
<td>Average Traversal Time</td>
<td>Path</td>
<td>Sets the average time for traversing a path for all process instances.</td>
</tr>
</tbody>
</table>

The defined objective is added to a table in the **Objectives** tab of the **Properties** view in the Simulation perspective. You can also modify or remove the objective from the table by clicking the respective buttons.

### Setting calendar

Progress Developer Studio for OpenEdge enables you to set calendar restrictions for each project added to your simulation project, as well as for each human performer (individual and group) and queue performer in your simulation project.

You can use the **Calendar** tab in the **Properties** view for the process or performer to configure the calendar restriction.

You can click any of the following options to configure calendar settings:

- **None** to exclude all calendar restrictions. This option is not available for human and queue performers.
- **User management** to include calendar restrictions as specified in the calendar created using the Business Calendar tool, as discussed in Working with Business Calendar on page 265.
- **Project** to include calendar restrictions as specified in the project calendar for the current simulation project.
- **Local** to configure process-specific calendar settings using the **Workdays** and **Sessions** sections provided. This operation is similar to configuring the project calendar, as discussed in Step 5 in Creating a simulation project on page 56.

### Performing other operations

This section describes commonly used simulation-related operations such as, selecting a randomizing method and selecting a date.

### Choosing a randomization method

Progress Developer Studio for OpenEdge supports two types of randomization in the Simulation perspective; namely, randomizing the time of intervals between process instances; or randomizing the duration of work time for a specific workstep in the process.

- To randomize the time interval between process instances, use the **Instances** tab of the **Properties** view for a process, as described in Step 5 in Configuring simulation parameters for a process on page 228 section.
- To randomize the work time for a specific workstep instance, use the **Task** tab of the **Properties** view for a Activity, Adapter, or Subprocess workstep, as described in Step 3 in For worksteps on page 229 section.

Progress Developer Studio for OpenEdge provides four probability distribution types, which are described below:
### Table 71: Probability distribution types

<table>
<thead>
<tr>
<th>Distribution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>Use this option to maintain the same interval between instances in the simulation. You can define the mean interval between instances in the adjoining boxes in terms of hours, minutes, and seconds. This is used when the duration is fixed, and does not change over time.</td>
</tr>
<tr>
<td>Negative Exponential</td>
<td>A continuous probability distribution that is often used to characterize the time between events or the durations of activities. It does not assume a predetermined pattern of distribution. A Negative Exponential distribution is used when the probability decreases over time.</td>
</tr>
<tr>
<td>Normal</td>
<td>Use this option to define the symmetrical, bell-shaped distribution pattern that is often used for a simulation. This distribution pattern is determined by its mean and the standard deviation. You can use the adjoining Mean and Std-dev boxes to set the mean and standard deviation in terms of hours, minutes, and seconds. In a typical normal distribution, 70% of results fall between one standard deviation above and one standard deviation below the mean. The standard deviation is a measure of how tightly items are clustered around the mean in a set of data. A low standard deviation means that the results are tightly clustered; a high number that the distribution is widely spread. <strong>Note</strong>: If the Standard Deviation setting is more than the Work Time value for a workstep and results in the range of the deviation being a negative value, then only the absolute value of the deviation (not the negative value) is used for running the simulation.</td>
</tr>
<tr>
<td>Uniform</td>
<td>A discrete uniform distribution option that represents a uniform distribution pattern within a finite set of possible values. The possible values are set within the minimum and the maximum value specified in hours, minutes, and seconds. This is used when the process instance count (or the worktime duration of a workstep instance) is fixed over a specified range of values.</td>
</tr>
</tbody>
</table>

### Specifying a date

You can enter (or modify) a date (and time) in the At time box for a Date, for instance, when specifying the simulation start and stop time for a simulation project and for process worksteps.

**To specify the date and time:**

1. Click the **At time** option (if you are specifying a date for the first time) to display the current system date and time in the adjoining text box.

2. To specify another date (or time), click the adjoining **ellipsis** button to open the Calendar dialog box, which display the current month’s calendar. By default, the calendar highlights today’s date and current time.

3. To select a date from the displayed month, click the desired date.

4. To display the calendar for another month, use the arrows provided next to the month. Click the arrow pointing right for the next month, or the arrow pointing left for the previous month. Alternatively, to select any other month, you can click on the current month and then select the desired month from the list.

5. Similarly, to display the calendar for another year, click the current year and then type the desired year. Alternatively, you can use the adjoining controls to increment (or decrement) the year by one. Click outside the year control to accept the changed year.
6. To change the default time from the **Time** box, click the hour, minute, and second boxes and type the respective values. Alternatively, you can use the adjoining controls to increment (or decrement) the respective value. You can also use these controls to switch between **AM** and **PM**.

7. Click **OK** to display the selected date and time in the text box adjoining the **At time** option.

### Validating the simulation project

The **Simulation** perspective provides an advanced validation framework, which lists common configuration errors for selected simulation components. You cannot run the simulation unless you rectify these errors.

From the Simulation Control Editor, you can identify the erroneous simulation components, which are highlighted with a red square; for instance, ![Request Status](image). Table 72: Validation Errors on page 238 lists the common validation errors, where they occur, and their resolution.

#### Table 72: Validation Errors

<table>
<thead>
<tr>
<th>Component</th>
<th>Error Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulation</td>
<td>The absolute start time is not specified.</td>
<td>Specify a relative start time for the <strong>At time</strong> option in the <strong>Scenario</strong> tab of the simulation project’s <strong>Properties</strong> view.</td>
</tr>
<tr>
<td>Project</td>
<td>The absolute completion time is not specified.</td>
<td>Specify a relative stop time for the <strong>At time</strong> option in the <strong>Scenario</strong> tab of the simulation project’s <strong>Properties</strong> view.</td>
</tr>
<tr>
<td>Scenario</td>
<td>A scenario configured with system start time and absolute end time.</td>
<td>From the <strong>Scenario</strong> tab of the simulation project’s <strong>Properties</strong> view for the selected scenario, select any available option other than system time (for simulation start) and <strong>At time</strong> (for simulation stop).</td>
</tr>
<tr>
<td></td>
<td>Absolute start time for a scenario is greater than absolute stop time.</td>
<td>From the <strong>Scenario</strong> tab of the simulation project’s <strong>Properties</strong> view for the selected scenario, specify a relative time for simulation stop higher than the relative time for simulation start.</td>
</tr>
<tr>
<td></td>
<td>For a process with absolute start time, the scenario is set to system start time.</td>
<td>From the <strong>Scenario</strong> tab of the simulation project’s <strong>Properties</strong> view for the selected scenario, specify an absolute time for the simulation start.</td>
</tr>
<tr>
<td></td>
<td>Absolute start time for a scenario is greater than absolute start time for any of the added processes.</td>
<td>From the <strong>Scenario</strong> tab of the simulation project’s <strong>Properties</strong> view for the selected scenario, specify an absolute time for the simulation start lesser than the absolute start time for each process.</td>
</tr>
<tr>
<td>Process</td>
<td>The absolute start time is not specified.</td>
<td>Specify a relative time for the <strong>At time</strong> option in the <strong>Instances</strong> tab of the process’ <strong>Properties</strong> view.</td>
</tr>
<tr>
<td></td>
<td>Process instance count is unlimited with simulation stop time set to completion of process instances.</td>
<td>Specify a process instance count in the <strong>Instances</strong> tab of the process’ <strong>Properties</strong> view.</td>
</tr>
</tbody>
</table>
### Running a process simulation

After designing the process simulation in the **Progress OpenEdge BPM Simulation** perspective, you can run the simulation in the **OpenEdge BPM Run Simulation** perspective to discover potential design flaws. For example, you can now quickly identify such problems as loops that repeat too frequently or bottlenecks in the process.

Each simulation run represents a simulation for a set of resources. It could have single or multiple processes running in parallel.

The commonly used panes and runtime views in the **OpenEdge BPM Run Simulation** perspective are described in **Table 73: OpenEdge BPM Run Simulation Perspective Components** on page 240.

<table>
<thead>
<tr>
<th>Component</th>
<th>Error Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process / Workstep</td>
<td>For Uniform randomizing method, the maximum duration is lesser than the minimum duration.</td>
<td>Specify the maximum duration for Uniform distribution type greater than the minimum duration.</td>
</tr>
<tr>
<td>Performer / Resources</td>
<td>Cost of the performer or resource is zero.</td>
<td>From the <strong>General</strong> tab for the added performer’s (individual, group, and adapter) and for the added resource’s (consumable and non-consumable) <strong>Properties</strong> view, specify value greater than zero in the respective cost fields.</td>
</tr>
<tr>
<td>Non-consumable Resource</td>
<td>Specified count of the resource is zero.</td>
<td>From the <strong>General</strong> tab for the added non-consumable resource’s <strong>Properties</strong> view, specify count greater than zero in the <strong>Availability</strong> box.</td>
</tr>
<tr>
<td>Consumable Resource</td>
<td>The resource has no defined unit of measure.</td>
<td>From the <strong>General</strong> tab for the added consumable resource’s <strong>Properties</strong> view, specify a unit in the <strong>Unit</strong> box.</td>
</tr>
<tr>
<td>Group Performer</td>
<td>The group performer has a virtual group size equal to zero.</td>
<td>From the <strong>Members</strong> tab for the added group’s <strong>Properties</strong> view, specify the virtual member count greater than or equal to one.</td>
</tr>
<tr>
<td>Path</td>
<td>The path contains only one workstep.</td>
<td>From the <strong>General</strong> tab for the defined path’s <strong>Properties</strong> view, specify the path length greater than one.</td>
</tr>
<tr>
<td>Workstep</td>
<td>The consumption count for an added non-consumable resource is greater than the available count.</td>
<td>From the <strong>Resources</strong> tab for the workstep’s <strong>Properties</strong> view, specify the count of the added non-consumable resource less than its available count.</td>
</tr>
</tbody>
</table>
To run a process simulation:

1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario for which you want to run the simulation.

2. From the Controls section of the Simulation Control Editor, clickplay button to begin the process simulation.

3. If you are currently not in the OpenEdge BPM Run Simulation perspective, you are prompted to switch to this perspective. Click Yes to run the process simulation in the OpenEdge BPM Run Simulation perspective. Alternatively, click No to run the process simulation in your current perspective. If you select the Remember my decision check box, Progress Developer Studio for OpenEdge does not display any prompt and executes your selected command the next time you run a process simulation.
Running a process simulation

Note: You can modify the above selected configuration for running the process simulation using the Simulation > UI page in the Preferences dialog box. For information, see Using the Simulation page on page 101.

During the simulation run, you can perform any of the following operations from the Controls section of the Simulation Control Editor:

Table 74: Simulation Controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause ( )</td>
<td>To pause the simulation. Click to resume the simulation.</td>
</tr>
<tr>
<td>Stop ( )</td>
<td>To stop the simulation and return to the start of the simulation.</td>
</tr>
<tr>
<td>Exit ( )</td>
<td>To stop the simulation and exit from the OpenEdge BPM Run Simulation perspective. Progress Developer Studio for OpenEdge prompts you to switch to the Progress OpenEdge BPM Simulation perspective. You can click the appropriate button, similar to as described in Step 3 above.</td>
</tr>
<tr>
<td>Speed control</td>
<td>To control the simulation speed between low and high.</td>
</tr>
</tbody>
</table>

You can view the overall progress of the simulation project in the Simulation Status section.

The Start date and time displays the Simulation Start setting, as configured for this scenario in the Scenario tab of the Properties view (see Modifying simulation settings for a scenario on page 226). The Current date and time indicates the progress of the simulation in date and time values, with its final value calculated according to the Simulation Stop setting, as configured for this scenario in the Scenario tab of the Properties view.

During the simulation run, you can view the process-related information in the Processes view (as described in Viewing process information on page 241).

You can also monitor the usage of performers and resources, as well as review objective violations and performance bottlenecks (and recommendations) in their respective views. For details, see Viewing project information on page 243.

Viewing process information

The Processes View consists of a Process tab for each of the added process in the simulation project. Click each Process tab to view the simulation information for the process in the Diagram and Details views. By default, the Details view is hidden. To show (or hide) either of the views for each Process tab, click the respective button in the Processes view.

The Details view displays the progress status of the completed process instances during the simulation run. It also displays the instance count (required, completed, created, terminated), the workitem cost (total, average, minimum, maximum), and the duration (total, average, minimum, maximum) of the completed process instances. The adjoining table contains the:

- Worksteps tab, which lists the worksteps of the current process and the number of workstep instances, which have been created, activated, completed, terminated, and timed out, along with the total, average, maximum, and minimum duration taken to complete the instances.
- Workitems tab, which lists the workitem tasks for each instantiated workstep, along with number of workitems completed, the total worktime for each workitem, and the cost (total, minimum, maximum, average) for
completing each workitem. Additionally, this tab displays the number of tasks waiting in queue for the performer to become available, with the total, minimum, maximum, and average waiting time.

- **Connectors** tab, which lists the workstep connectors of the current process and the number of connector traversals, which have been created, completed, and terminated, along with the total completion and termination duration taken for each connector.

- **Consumables** tab, which indicates the consumption details of consumable resources for each assigned workstep. Resource details for each workstep include cost per unit, workitem count, consumption count, and total cost.

- **Non Consumables** tab, which indicates the consumption details of non-consumable resources for each assigned workstep. Resource details for each workstep include cost per hour, workitem count, requirement, usage time, and total cost.

- **Paths** tab, which displays information for each defined path in the process. Path information includes path name, the number of times the path was traversed, and the duration (total, minimum, maximum, average) of path traversal. Additionally, this tab displays the cost (total, minimum, maximum, average) of traversing a path. For details regarding paths, see **Configuring simulation parameters for a process** on page 228 > For paths on page 231.

Additionally, the **Details** view displays simulation information for the current process in the following sections:

**Table 75: Details View Information**

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>Displays the same data as in Status progress bar, but in numeric values. Additionally, it displays the number of terminated process instances.</td>
</tr>
<tr>
<td>Cost</td>
<td>Displays the cost data for workitem tasks (or instantiated worksteps). Cost includes the cost of workitem performers and resources (if any). The <strong>Total</strong> cost indicates the total completion cost of all workitems, the <strong>Average</strong> cost indicates the average cost of workitems, the <strong>Minimum</strong> cost indicates the least expensive workitem, and the <strong>Maximum</strong> cost indicates the most expensive workitem.</td>
</tr>
<tr>
<td>Completed Instance Time</td>
<td>Displays the duration of completed process instances in terms of hours, minutes, and seconds. The <strong>Minimum</strong> value indicates the shortest completion time, the <strong>Maximum</strong> box indicates the longest completion time, and the <strong>Average</strong> box indicates the average completion time for process instances. The <strong>Total</strong> value indicates the cumulative completion time for all instances.</td>
</tr>
</tbody>
</table>

Additionally, each **Process** tab contains the following components:

- **Show Process** drop-down list, where you can also view the runtime data for an inline subprocess by selecting the process. For information regarding inline subprocess, see **Defining an inline subprocess** on page 109.

- Contains the **Status** progress bar, which indicates the total number of process instances required, along with the number of instances created and completed. The total number of process instances required are depicted in light green color, those created (and in progress) in olive green, and those completed in bluish green. You can also move your pointer over the progress bar, to view the same information in numeric terms.

In the **Diagram** view (which is displayed by default), each process workstep displays a number in parenthesis, which indicates the number of activated instances.

Each workstep (and associated path) displays a color-coded heatmap, which enables you to:
• Determine the number of activations for each workstep, relative to the rest of the worksteps in the workflow.
• Identify potential bottlenecks in the process.

Table 76: Heatmap Color Coding on page 243 describes the color coding used for heatmaps.

Table 76: Heatmap Color Coding

<table>
<thead>
<tr>
<th>Color Gradient</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue to White</td>
<td>For workstep activations from minimum to median value(^2).</td>
</tr>
<tr>
<td>White to Red</td>
<td>For workstep activations from median to maximum value.</td>
</tr>
</tbody>
</table>

A bottleneck can be identified by a red-colored workstep immediately followed by one or more white-colored worksteps.

Tip: When unexpected results occur during a simulation, such as the number of activations of a workstep not matching the number of instances, it may result in the presence of Inclusive Decisions. We recommend that you use Exclusive Decisions in this type of process.

**Viewing project information**

The OpenEdge BPM Run Simulation Perspective provides additional views—**Individuals**, **Systems**, **Consumables**, **NonConsumables**, **Violations**, and **Recommendations**—where you view overall simulation information, independent of the processes. Click the **Individuals**, **Systems**, **Consumables**, and **NonConsumables** views after starting the simulation run. Click the **Violations** and **Recommendations** views after completing the simulation run (as described in **After completion of simulation** on page 245).

• **Individuals** view: indicates the utilization of individual (or human) performers in the process, and the current task (if any) for each performer.

The **Individuals** view displays the following runtime information of individual performers:

Table 77: Individuals view

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the performer. A blue icon indicates that the performer is available. A grey icon indicates that the performer is unavailable.</td>
</tr>
<tr>
<td>Cost per Hour</td>
<td>Displays the cost per hour defined for each performer.</td>
</tr>
<tr>
<td>Available For</td>
<td>Displays the total duration (in terms of hours, minutes, seconds) for which this performer is available.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the performer, which is the product of the hourly cost of the performer and the total time (in hours) for which the performer is available.</td>
</tr>
<tr>
<td>Task Count</td>
<td>Displays the number of tasks currently assigned to this performer.</td>
</tr>
<tr>
<td>Total Usage Time</td>
<td>Displays the total work-time (in terms of hours, minutes, seconds) for this performer.</td>
</tr>
</tbody>
</table>

\(^2\) Median is calculated by dividing the sum total of all activated workstep instances by the number of worksteps.
<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Utilization %</td>
<td>Displays the percentage of the total usage time of the performer, relative to the available time.</td>
</tr>
<tr>
<td>Current Tasks</td>
<td>Indicates the current task (if any) performed by this performer. The format used is: <code>&lt;processname&gt;-&gt;&lt;taskname&gt;</code>.</td>
</tr>
</tbody>
</table>

- **Systems** view: indicates the utilization of system (or adapter) performers in the process, and the current task (if any) for each performer.

The **Systems** view displays the following runtime information of adapter performers:

**Table 78: Systems view**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the adapter performer. A blue icon indicates that the performer is available. A grey icon indicates that the performer is unavailable.</td>
</tr>
<tr>
<td>Cost per Invocation</td>
<td>Displays the cost per invocation as defined for each adapter.</td>
</tr>
<tr>
<td>Invocations</td>
<td>Displays the total number of invocations of this adapter.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the adapter, which is the product of the cost per invocation and the number of invocations.</td>
</tr>
<tr>
<td>Current Tasks</td>
<td>Indicates the current task (if any) performed by this adapter. The format used is: <code>&lt;processname&gt;-&gt;&lt;taskname&gt;</code>.</td>
</tr>
</tbody>
</table>

- **Consumables** view: displays the utilization of consumable resources in the simulation run for this scenario.

The **Consumables** view displays the following runtime information of consumable resources:

**Table 79: Consumables view**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the resource used.</td>
</tr>
<tr>
<td>Cost per Unit</td>
<td>Displays the cost of resource as defined for this scenario.</td>
</tr>
<tr>
<td>Consumer Count</td>
<td>Displays the total number of workstep instances that have used this resource.</td>
</tr>
<tr>
<td>Consumed Count</td>
<td>Displays the total number of the resource units consumed.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the resource, which is the product of cost of the resource and the consumed count.</td>
</tr>
</tbody>
</table>

- **NonConsumables** view: displays the utilization of non-consumable resources in the simulation run for this scenario.

The **NonConsumables** view displays the following runtime information of non-consumable resources.
Table 80: NonConsumables view

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the resource used.</td>
</tr>
<tr>
<td>Units</td>
<td>Indicates the number of available resource units.</td>
</tr>
<tr>
<td>Cost per Hour</td>
<td>Displays the cost of resource as defined for this scenario.</td>
</tr>
<tr>
<td>Required in Tasks</td>
<td>Displays the number of workstep (or task) instances that require this resource.</td>
</tr>
<tr>
<td>Requirement</td>
<td>Displays the total count of the resource required.</td>
</tr>
<tr>
<td>Used in Tasks</td>
<td>Displays the number of workstep (or task) instances that have used this resource.</td>
</tr>
<tr>
<td>Total Usage Time</td>
<td>Indicates the total duration (in hours, minutes, seconds) of consumption of the resource.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the resource, which is the product of cost of the resource and the total usage time.</td>
</tr>
</tbody>
</table>

After the simulation run is completed, all status indicators are green (for completed) and the Exit Simulation button is activated.

**After completion of simulation**

You can view the final status of the performers (individual and system) and resources (consumable and non-consumable) used during this process simulation, from the respective views. You can view any violations and recommendations by clicking the respective view, as described in this section.

- **Violations view**: lists violations (if any) in the objectives defined (see Defining objectives on page 234) in the current scenario.

The following table provides the violation information:

Table 81: Violation information

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Indicates the source whose objective has been violated. Possible sources are the simulation project, process, workstep, performer, resource, and path.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the objective that was violated.</td>
</tr>
<tr>
<td>Condition</td>
<td>Displays the condition defined in the violated objective.</td>
</tr>
<tr>
<td>Path</td>
<td>Displays the path to the source whose objective has been violated. This is applicable only for defined paths and worksteps (including worksteps of an inline subprocess). The format used is: &lt;processname&gt;-&lt;source&gt;.</td>
</tr>
</tbody>
</table>
• **Recommendations view**: lists bottlenecks and other problems encountered during the simulation run. An example of a bottleneck can be that a particular workstep had a high waiting time, before using a particular resource or performer.

The following table provides the recommendations information:

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Indicates the source where the problem has arisen.</td>
</tr>
<tr>
<td>Problem</td>
<td>Displays the description of the problem.</td>
</tr>
<tr>
<td>Recommendation</td>
<td>Displays the statement of a possible solution to the problem. For example,</td>
</tr>
<tr>
<td></td>
<td>“Increase resources used by workstep.”</td>
</tr>
</tbody>
</table>

### Generating a simulation report

After running a simulation for a scenario, you can generate a Simulation result (*.srf) and report (*.html or *.xls) files.

- **Result**: Only one result (*.srf) file is generated for each simulation run, which could have a single process or multiple processes. You can use the result file later to generate simulation reports. You can also generate comparison reports (see Comparing simulation results on page 249) by using multiple result files. For example, you can generate multiple result (*.srf) files after simulating with different scenarios.

- **Report**: You can generate a simulation report in HTML or Excel format either directly after a simulation run or later from the result (*.srf) file. You can select and create reports according to your requirement.

To generate the Simulation report:

1. From the Generate section of the Simulation Control Editor, click the Result icon ( ), opening the Simulation Report dialog box.
2. Modify (if required) the name of the default result file.
3. Click OK to save the result file. You can view the result file in the Project Explorer view in the <project>esults folder.
4. Right-click the result file (*.srf), then click Simulation Report > Generate Report.

Alternatively, from the Generate section of the Simulation Control Editor, click the Report icon ( ), opening the Simulation Reports dialog box, which lists the out-of-box reports and custom reports (if any). For details regarding adding custom reports, see Adding custom reports on page 248.

5. Depending on your requirement, you can generate any of the listed report types. Click each report type to view its description in the adjoining area. Select the report type to be generated.
6. From the Output section, select the format (HTML or Excel) from the Format drop-down list. Modify (if required) the name of the generated file in the File box.
7. Select the report type to be generated, then click OK.

The Simulation report (in HTML format) contains the main section in links, which you can click to navigate to the respective topic. Additionally, it displays the summary charts (only in HTML format) displaying the overall cost per process and cost per resource (and performer) used in the simulation project. For more information, see the following Viewing simulation report details on page 247 section.
Note: Simulation reports in Excel format do not display charts.

Viewing simulation report details

The generated Simulation report contains the following main sections:

- **Process simulation result** on page 247
- **Resource usage results** on page 248
- **Violations and recommendations** on page 248
- **Setting calendar** on page 236

Note: The simulation report is saved directly under the simulation project folder `Workspace_Home\<project_name>\reports\`.

Process simulation result

This section provides the following sub-sections for each of the added processes and subprocesses:

- **Instance Completion Status**: (Can be viewed in Basic, Cost, and Time reports also) Displays the total number of process instances required, created, completed, and terminated.

- **Instance Execution Time**: (Can be viewed in Basic and Time reports also) Displays the duration of the completed process instances, along with the minimum, maximum, and average time.

- **Instance Completion Cost**: (Can be viewed in Cost report also) Displays the total completion cost of all workitems, along with minimum, maximum, and average cost.

- **Workstep Execution Status and Time**: (Can be viewed in Basic and Time reports also) Displays the instance count (created, activated, completed, terminated, timed out) for each of the process worksteps, along with the duration (total, minimum, maximum, average) taken to complete all the workstep instances. You can view this information in Tabular and Chart format.

- **Workitems Time and Cost**: (Can be viewed in Cost and Time reports also) Displays the workitem count (created, completed, terminated) for each task, along with the completion cost (total, average, minimum, maximum) of each workitem. Additionally, this section displays the number of workitem instances, which waited in queue for the performer to become available, along with the total, minimum, maximum, and average waiting time. You can view this information in Tabular and Chart format (which displays the workitem status and total cost).

- **Workstep Connectors**: (Can be viewed in Basic, Cost, and Time reports also) Displays the instance count (created, completed, terminated) for each of the workstep connector, along with the aggregate delay duration taken to complete or terminate the connector traversals. You can view this information in Tabular format only.

- **Path Analysis Status and Execution Time**: (Can be viewed in Basic, Cost, and Time reports also) Displays the traversal count, the traversal duration (total, minimum, maximum, average), and traversal cost (total, minimum, maximum, average) for each defined path. You can view this information in Tabular and Chart format.
Resource usage results

This section provides a usage summary for both performers and resources in the following sub-sections. You can view this section in Basic, Cost, and Time reports also.

• **Human Performers**: Displays the cost (hourly, total), duration available for, assigned task count, total usage time, and utilization percentage for each human performer. You can view this information in Tabular and Chart format.

• **System Performers**: Displays the number of invocations, cost (hourly, total), duration available for, assigned task count, total usage time, and utilization percentage for each system performer. You can view this information in Tabular and Chart format.

• **Consumable Resources**: Displays cost, consumed count, and consumer count for each consumable resource. You can view this information in Tabular and Chart format.

• **Non-consumable Resources**: Displays cost, required in tasks, requirement, used in tasks, and total usage time for each consumable resource. You can view this information in Tabular and Chart format (similar in format to that of Consumable resource).

Violations and recommendations

This section lists all the violations and recommendations generated for the simulation run. You can view this section in the Violations and Recommendations report also.

Calendar

You can view this section in the Time report also. This section contains the following sub-sections:

• **Process Calendar**: Displays the calendar settings for each of the added processes. The calendar information includes calendar type, workdays, and details of the work sessions.

• **Human Performer**: Displays the calendar settings for each human performer (individual and group). The calendar information includes calendar type, as well as workdays and work sessions for simulation calendar type.

Adding custom reports

In addition to the out-of-box reports, you can add your own custom reports to meet specific requirements. You need to save your customized report file (in *.xslt format) in the following folders, located in the Workspace_Home\.com.savvion.studio\simulation\reports\folder.

• **Normal**: stores all the out-of-box reports. You can add a new report or create a copy of any of the listed reports and modify it (as required) using any XML editor. You can then add the report property in the reports.xml file.

• **Comparison** (optional): stores all the out-of-box comparison reports. You can add a new comparison report or create a copy of any of the listed comparison reports and modify it (as required) using any XML editor. You can then add the report property in the reports.xml file. For details, see Comparing simulation results on page 249.

To add a custom report to the \Normal folder:

1. Open the reports.xml file using any XML editor.
2. In the <Reports> tag, add the custom report parameters.
A sample entry is provided below:

```xml
<Report name="Custom Report" xslFileName="MyCustomReport.xslt" defaultAffix="custom">
<Description>My customized report.</Description>
</Report>
```

where the `<Report>` tag contains the following attributes and tags:

- **name** indicates the report name as it should appear in the report list.
- **xslFileName** indicates the name of the saved report file (in *.xslt format).
- **defaultAffix** indicates the default affix to be contained in the generated HTML file name.
- **Description** tag provides the description of the report.

3. Save the `reports.xml` file.

### Comparing simulation results

You can generate a comparison report (HTML or Excel) from multiple result (*.srf) files, each of which represent the result of a simulation run. You can also generate a real-time comparison report to compare the results of a simulation run with the real-time server data. You can select the type of the comparison report, similar to that for simulation report types.

**Note:** You need to create at least two results files, before you can generate a comparison report. You can also compare result files generated across simulation projects.

**To generate a comparison report:**

1. If you are in the OpenEdge BPM Run Simulation perspective, click the Progress OpenEdge BPM Simulation perspective to switch to the Progress OpenEdge BPM Simulation perspective.

2. From the Project Explorer view, select the result (*.srf) files (located in `<project>\results` folder), which you want to compare.

3. Right-click the selected result files, then click Simulation Report > Generate Comparison Report, opening the Simulation Reports dialog box.

4. Depending on your requirement, you can generate any of the listed report types. Click each report type to view its description in the adjoining area. Select the report type to be generated.

5. From the Output section, select the format (HTML or Excel) from the Format drop-down list. Modify (if required) the name of the generated file in the File box.

6. Click OK.

The comparison report includes a generated Result ID (Result 1, Result 2, and so on, depending on the number of result files being compared). Additional information includes the scenario used, the simulation run start (and stop) date and time, the simulation duration and total cost for each of the Result IDs.

Additionally, the comparison report includes all the main sections of the corresponding simulation report as described in Viewing simulation report details on page 247. Each of the main and sub-sections includes data for all the generated Result IDs in a tabular format.

**Note:** The “Violations and Recommendations” section is included only in the Violation and Recommendation comparison report.
Generating real-time comparison report

You can also generate a real-time comparison report (HTML or Excel) by comparing the result of a simulation run to the real-time data from a server.

To generate the real-time comparison report:

1. After performing a simulation run, click the Realtime Report icon from the Generate section of the Simulation Control Editor, opening the first page of the Realtime Comparison wizard, which is similar to second page of the Import Scenario Data wizard.

   Alternatively, you can right-click a result file (*.srf), then click Simulation Report > Generate Realtime Comparison Report.

2. To establish connection to your server:

   a) Specify the server IP address and port number in the respective boxes.
   b) Enter the user name and password required to connect to the server.
   c) Modify (if required) the start date and end date in the Start Date and End Date boxes by clicking the adjoining ellipsis button. For details, see Specifying a date on page 237.

      Data of all the process instances that have been completed in this date range (between start and end date) are retrieved from the server.
   d) Click Connect to verify the connection to the server.

3. Click Next, opening the second page of the Realtime Comparison wizard, which lists the report type that you can generate.

4. Review the available report type and its description.

5. From the Output section, select the format (HTML or Excel) from the Format drop-down list. Modify (if required) the name of the generated file in the File box.

6. Click Finish to generate the realtime comparison report, which is similar to the comparison report.
Configuring dashboard widgets

Progress Developer Studio for OpenEdge provides the Widgets Configuration tool, which enables you to create and configure widgets that can be used in Business Process Portal dashboards by portal users or administrators to develop customized dashboards or dashboards that can be used as a Common Resource. For information about customizing dashboards in Business Process Portal, see the Business Process Portal User’s Guide and the Business Process Portal Administrator’s Guide.

The Widgets Configuration tool is only available for Business Processes and Common Resource projects. When launched from a Business Process, the widget is specific to that process. When launched from a Common Resource project, the new widget can be used by all applications. After you have configured a widget, Progress Developer Studio for OpenEdge creates a top-level widgets.xml file that contains all widgets created for that application, or all widgets created for the Common Resource. The application-specific widgets.xml file is located under the application’s folder (Workspace_Home\<Application_Name>). The application-independent widgets.xml file is located under the common resource’s folder.

On successful publishing of the specific application or Common Resource containing dashboard widgets, the widgets.xml file is registered with the server.

For details, see the following topics:

- Using the Widgets Configuration tool
- Enabling Google gadgets

Using the Widgets Configuration tool

To configure a dashboard widget:
1. Select the Business Process (or Common Resource project) in the Project Explorer view.

2. From the Tools menu, click Widgets Configuration Tool, opening the Widgets Configuration Tool dialog box, which displays any existing widgets that have been configured for the specific process.

3. To configure a new widget, click Add to open the Widget Properties dialog box.

4. From the General tab, you can enter the following general information about the widget:
   a) Enter a name for the widget in the Name box. The name can contain only alphanumeric characters, and must not contain any blank spaces and no special characters except underscore (“_”) and dollar (“$”). Do not start the widget name with a numeric character.
   b) Type a category in the Category list in order to group widgets. The category name is case insensitive, for example, “MyCategory” and “mycategory” is grouped in the same category.
   c) Select any of the available widget types from the Type drop-down list.
      Table 83: Widget Types on page 252 lists the available widget types.

Table 83: Widget Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphical</td>
<td>Represent widget information in the form of a chart.</td>
</tr>
<tr>
<td>Tabular</td>
<td>Represents widget information in tabular format.</td>
</tr>
<tr>
<td>Infopad</td>
<td>Displays infopad information of the selected application.</td>
</tr>
<tr>
<td>Scorecard</td>
<td>Displays scorecard information.</td>
</tr>
<tr>
<td>Global Dataslot</td>
<td>Displays the selected global dataslots of the current project. For information regarding creating a global dataslot, see Setting the dataslot access on page 133.</td>
</tr>
<tr>
<td>Other</td>
<td>Used for creating your own widget type. For details, see the example provided in Enabling Google gadgets on page 255.</td>
</tr>
<tr>
<td>Composite UI</td>
<td>Used to define a widget for external applications. Select this option to render custom JSP files.</td>
</tr>
</tbody>
</table>

Note: If you select the Graphical type, make sure that the data used in the SQL Query (see Table 84: Property Fields on page 253) is in the proper format — it must have a String field that acts as a label for each element (for example, a bar in a bar chart or a section in a pie chart) followed by a numerical field that provides the size of each element (for example, the height of a bar in a bar chart).

d) Enter the Description and Title of the widget in the appropriate boxes.

e) Enter the width and height of the widget (in terms of pixels) in the Width and Height boxes. The maximum permissible value for both parameters is 2048.

The fields in the Properties tab vary, depending on the widget type you have selected in the General tab.

Table 84: Property Fields on page 253 describes the common property fields and the widget type-specific property fields, where you need to enter information.
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common Fields</td>
<td>Available for Graphical and Tabular types. Enter (or copy-paste) an SQL query in this box. Note: For an SQL query on multiple tables with identical column names in the same select clause, the resultset may be inconsistent. For consistent results, use an alias name for each of the duplicate columns.</td>
</tr>
<tr>
<td>SQL query</td>
<td>Available for Graphical and Tabular types. If you want the widget to support a drill-down function, enter a URL in this box or click Add (in case of Tabular) to add multiple URLs. You can also use the following keywords to specify a parameterized URL: • #PARAM# to replace with the label of the chart section that the user clicks on. • #CATEGORY# (applicable only for Bar charts) to replace the drill-down URL parameter with the SQL query value (first column of the database query) of the clicked bar chart section. • #SERIES# (applicable only for Bar charts) to replace with the value (second column of the database query) of the clicked chart section.</td>
</tr>
<tr>
<td>Drilldown URL</td>
<td>Available for Graphical and Tabular types. Used to specify where to display the target URL for a drill-down operation. Available options are Inline (to display in the same window), Browser (to display in a separate browser window), and Popup (to display in popup dialog box).</td>
</tr>
<tr>
<td>Open Drilldown In / Open In</td>
<td>Available for all widget types. Used to add a customized JSP file for rendering the widget. To add your customized JSP file, click Add to open the Add box where you can define the name and value of any parameters that must be passed at runtime.</td>
</tr>
<tr>
<td>Custom Presentation JSP file</td>
<td>Available for Infopad and Global dataslots types. Used to select the application whose infopad information or global dataslots is to be represented in the widget.</td>
</tr>
<tr>
<td>Target URL</td>
<td>Available for Other and Composite UI types. Enter the target URL in the URL box as any of the following values: • Absolute value, for example, <a href="http://www.progress.com">http://www.progress.com</a> or an entire URL with the protocol, host, and port number. • Using Server alias: to specify the URL with the server alias, as specified in the server-config.xml file. This value is only available for Composite UI type. • Relative value, where you can specify the URL without the server alias. The server alias value is provided at runtime. This value is only available for Composite UI type. Click Add to define parameters to the target URL.</td>
</tr>
</tbody>
</table>
## Field Name | Description
--- | ---
**Widget-specific fields** |  
**Graphical widget** | Select the chart type from the Chart type drop-down list. Options are: Area, Line (2D and 3D), Meter, Vertical Bar (2D and 3D), Horizontal Bar (2D and 3D), Pie (2D and 3D), Doughnut (2D and 3D), Funnel, Pyramid, and Bar 3D Line.  
**Infopad widget** | For the specified application, select any of the module and infopad option from the Module name and Infopad name lists. You can specify how to slice the infopad information (row or column) and the slice parameter in the Slice on value box. You can point to the adjoining Help ( ) icon for details regarding each component.  
**Scorecard widget** | Select the scorecard type (Scorecard, Perspective, or KPI). Depending on your choice, you can select the scorecard, perspective, and KPI from the respective lists. To populate these lists, you need to create the scorecard components for the current application in Business Process Portal. Additionally, you need to access the same application workspace on your Business Process Server installation from Progress Developer Studio for OpenEdge or import the application project (containing the scorecard files) to your workspace.  
**Global dataslot widget** | If the current project contains global dataslots, you can select the project name from the Application name drop-down list. From the Global dataslots box, select the global dataslot to be displayed in the widget. You can use the SHIFT key to select a range of global dataslots or use the CTRL key to select particular global dataslots.

5. Click **Save** to return to the Widgets Configuration Tool dialog box, where the widget you just defined is added to the list of available widgets.

### Note:
To edit an existing widget, select the widget, then click **Modify** to open the Widget Properties dialog box, where you can modify the widget properties. You can also click **Copy** to copy a selected widget, which you can then open and modify if required. To remove a widget, select it and click **Remove**. You can also change the position of a selected widget by using the **Move Up** or **Move Down** buttons.

6. Click **Save** to save the configurations you made to the widget. The widgets.xml file appears in the Project Explorer view under the BPM or Common Resource project.

7. To edit the existing widget configuration file, double-click the widgets.xml file (in the Project Explorer view) to open the file in an XML editor.
Note: If you have added a graphical meter widget, you need to add the following property in the widgets.xml file to configure the range and intervals. For example,

```xml
<properties>
  <property name="range" value="0,100" />
  <property name="intervals" value="normal:0,40:#79E879|warning:40,60:#FFEA00|critical:60,100:#FF5219" />
</properties>
```

where the "range" property is used to specify the meter range and the "intervals" property is used to specify the name, range, and color (in hexadecimal value) of the individual intervals.

Alternatively, you can start the **Widgets Configuration Tool** dialog box, where you can select one of the available widgets and make the desired changes.

8. Publish the changes to the existing file to the server, and you can use the **Refresh** option in the Publish wizard to refresh the existing widgets with the changes (for more information, see Publishing an application on page 59.

---

**Enabling Google gadgets**

You can use the Widgets Configuration tool to add Google-enabled gadgets like Map, Weather, and News as widgets to your dashboard.


1. From the **General** tab of the Widgets Configuration tool, select **Other** as the widget type.

2. From the **Properties** tab of the Widgets Configuration tool, specify the Target URL as “http://www.gmodules.com/ig/ifr” in the **Target URL** box and parameters for each gadget type:

Table 85: Gadget parameters on page 255 describes the parameters for each gadget type.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **url**        | Applicable for all the enabled gadgets. Specifies the individual URL for each of the Google gadgets. Value is:  
                * http://www.google.com/uds/modules/elements/localsearch/localsearch.xml (for Map gadget)  
                * http://www.google.com/ig/modules/builtin_weather.xml (for Weather gadget)  
                * http://www.gstatic.com/ig/modules/tabnews/tabnews.xml (for News gadget)  |

| **up_location** | Applicable for Map and Weather gadgets. Specifies the location for which the map or weather forecast needs to be rendered, for example, Santa Clara. |

<p>| For Map widget  | <strong>Note:</strong> You can use the Map component only if you have a valid license for the Google Maps. |</p>
<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>up_mapType</td>
<td>Specifies the type of map to be rendered. Available options are m (for map type), s (for satellite), and t (for terrain).</td>
</tr>
<tr>
<td>up_idleZoom</td>
<td>Specifies the magnification level of the map. For example, 11.</td>
</tr>
<tr>
<td>up_selectedText</td>
<td>Specifies the location to be pointed at, when the user searches for a place in the Search box. For example, progress.</td>
</tr>
<tr>
<td></td>
<td><strong>For Weather widget</strong></td>
</tr>
<tr>
<td>up_scale</td>
<td>Specifies the unit of temperature. Available options are C (for Celsius) and F (for Fahrenheit).</td>
</tr>
<tr>
<td>up_title</td>
<td>Specifies the title of the dashboard widget. For example, Santa Clara.</td>
</tr>
<tr>
<td></td>
<td><strong>For News widget</strong></td>
</tr>
<tr>
<td>up_edition</td>
<td>Specifies the news edition to be rendered. For example, us (for U.S. edition), in (for India edition), and so on.</td>
</tr>
<tr>
<td>up_items</td>
<td>Specifies the number of news items to rendered.</td>
</tr>
<tr>
<td>up_show_image</td>
<td>Specifies whether to display images in the news feed. Values are 0 (for false) and 1 (for true).</td>
</tr>
<tr>
<td>up_font_size</td>
<td>Specifies the font size of the news feeds, for example, 12 pt.</td>
</tr>
<tr>
<td>up_selectedTab</td>
<td>Specifies the default tab to be displayed on rendering. The value starts with 0.</td>
</tr>
</tbody>
</table>

Shown below is a sample widgets.xml file containing the configuration details for the Google gadgets.

**For Map gadget:**

```xml
<other name="MapWidget">
  <description>Widget to search and display location in a map.</description>
  <category>Map</category>
  <title>Map</title>
  <width>320</width>
  <height>320</height>
  <jsp>/bpmportal/common/DefaultOtherWidget.jsp</jsp>
  <properties/>
  <targeturl url="http://www.gmodules.com/ig/ifr">
    <param name="url">http://addthisshare.com/localsearch.xml</param>
  </targeturl>
  <param name="up_location">Santa Clara</param>
  <param name="up_mapType">m</param>
  <param name="up_idleZoom">11</param>
  <param name="up_selectedText">savvion</param>
</other>
```
For Weather gadget:

<other name="WeatherWidget">
<description>Displays the weather forecast for the next 5 days</description>
<category>weather</category>
<title>Weather</title>
<width>200</width>
<height>300</height>
<jsp>/bpmportal/common/DefaultOtherWidget.jsp</jsp>
<properties/>
<targeturl url="http://www.gmodules.com/ig/ifr">
<param name="url">http://hosting.gmodules.com/ig/gadgets/file/10916253967963397174/weather.xml</param>
<param name="up_location">Santa Clara</param>
<param name="up_scale">F</param>
<param name="up_title">Santa Clara</param>
</targeturl>
</other>

For News gadget:

<other name="NewsWidget">
<description>Displays News feeds from Google</description>
<category>news</category>
<title>News</title>
<width>320</width>
<height>320</height>
<jsp>/bpmportal/common/DefaultOtherWidget.jsp</jsp>
<properties/>
<targeturl url="http://www.gmodules.com/ig/ifr">
<param name="url">http://hosting.gmodules.com/ig/gadgets/file/104342096967082496017/google-news.xml</param>
<param name="up_ned">us</param>
<param name="up_items">5</param>
<param name="up_show_image">1</param>
<param name="up_font_size">12pt</param>
<param name="up_selectedTab">4</param>
</targeturl>
</other>
Working with User Management tool

Progress Developer Studio for OpenEdge provides the User Management tool, which allows you to add and manage users, groups, and queues, as well as view and update the organization hierarchy.

All the members created using the User Management tool, are available to newly created BPM processes and can be assigned to Activity worksteps.

The User Management tool includes a Organization Chart Viewer, that enables you to view the specified organization as a hierarchy of users and groups.

For details, see the following topics:

• Types of members
• Starting User Management tool
• Printing organization chart
• Managing nodes

Types of members

The User Management tool supports three types of members, as described in Table 86: Member Types on page 260.
### Table 86: Member Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Represents the basic entity of the user management tool. Typical attributes of a user include user name, real name, and title.</td>
</tr>
<tr>
<td>Groups</td>
<td>Represents a set of users performing related tasks, for instance, the HR group. Attributes include leader name and group members. A group can include another group.</td>
</tr>
<tr>
<td>Queues</td>
<td>Represents a set of users and groups.</td>
</tr>
</tbody>
</table>

## Starting User Management tool

You can start the User Management tool by clicking **OpenEdge > Tools > Users**.

The User Management tool consists of two panes. The left pane displays a tree consisting of the member node types namely **Users**, **Groups**, and **Queues**. You can define members, which then appear under the respective node type (see Managing nodes on page 261).

You can also search for members using the Search box in the left pane. Click the down-arrow provided and select either of the following options:

- Flat search: This search provides a flat list of all matching members, containing the search text.
- Tree search: This search displays the result in a tree structure, indicating the node type and if present, its position in the organization hierarchy.

The right pane displays by default, the Organization Chart Viewer initially with blank tree node. After adding users and groups, the viewer is automatically updated to display the organization hierarchy. Additionally, you can expand (and collapse) parts of the organization hierarchy, thus providing views at different detail levels.

The Organization Chart Viewer has the following features:

- Each expandable (or collapsible) node displays the group and the group leader (optional). The topmost node displays the organization name and the leader (optional). The title of the added user, if defined, is also displayed.
- You can double-click any node to view the user details.
- You cannot add (or remove) nodes directly from the Chart Viewer.
- Queues are not displayed in the Chart Viewer. The Chart Viewer only displays users and groups (including groups within a group).

### To customize the Organization Chart Viewer:

1. In the **Organization Name** box (in the right pane), type the name of your organization.
2. To specify the organization leader, click the ellipsis button next to the **Leader** box, opening the **Select User** dialog box, which displays a list of defined users (as described in Managing users on page 261).
3. Click the user from the list, then click **OK**. You can also use the **Search** box to search for a user.
4. Click **Apply** to add the organization name and the leader name to the blank topmost node in the Organization Chart Viewer. The organization name is also displayed and represents the root node in the left pane of the User Management tool.
Note: Henceforth, you can click the root node at any point of time, to view the updated Organization Chart Viewer.

**Printing organization chart**

You can also print the Organization chart displayed in the Organization Chart Viewer.

1. Click **File > Print chart** opening the **Print** dialog box, which displays a print preview of the organization chart.
2. Modify the print settings, if required, then click **Print**.

**Managing nodes**

You can use the User Management tool to add users, groups, and queues as members in the respective member nodes. You can then use the defined members as performers in newly created process templates.

You can click any member node or member in the left pane to view the details screen in the right pane. Alternatively, you can double-click any node in the Organization Chart Viewer to display the member details.

**Managing users**

You can add (and manage) individual users from the User list.

1. Click **Users** node in the left pane, displaying the user list in the right pane.
   - The user name and the real name is displayed by default. To hide (or show) either of the columns, right-click any column header and mark (or unmark) the appropriate options.
2. To create a user, click **New** to open the user details screen, where you can enter the following user details: **Table 87: User details** on page 261 describes each user information field.

**Table 87: User details**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>(Required) Enter the system name of the user. The username appears as the performer in your process template. You can also search for a user by entering the username in <strong>Search</strong> box in the User List screen.</td>
</tr>
<tr>
<td>Real Name</td>
<td>Enter the full name of the user (example, David Brown). This name appears in the Organization Chart Viewer for this user. To display the user in the Chart Viewer, you need to add the user to a group.</td>
</tr>
<tr>
<td>Title</td>
<td>Enter the designation (or title) of the user in the organization. If specified, the title also appears along with the real name in the Organization Chart Viewer.</td>
</tr>
<tr>
<td>E-mail</td>
<td>Enter a valid e-mail address of this user.</td>
</tr>
</tbody>
</table>
3. After entering the user information, click **OK** to add the user to the user list. The user is also added as a member to the **Users** node in the left pane.

   To remove a user (or multiple users) from the user list, select the users and click **Remove**. The User Management tool prompts you for confirmation. Click **Yes** to remove the selected users. To modify user details, select the user and click **Modify** to open the user details screen, where you can modify the user information.

### Managing groups

You can add (and manage) groups from the Groups list.

1. Click **Groups** node in the left pane, displaying the group list in the right pane.

   The group name and label is displayed by default. To hide (or show) either of the columns, right-click any column header and mark (or unmark) the appropriate options.

2. To create a group, click **New** to open the group details screen, where you can enter the following group details.

   Table 88: Group details on page 262 describes the group detail fields.

   **Table 88: Group details**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Name</td>
<td>(Required) Enter the name of the group. The group name appears as the group performer in your process template. You can also search for a group by entering the group name in <strong>Search</strong> box in the Group List screen.</td>
</tr>
<tr>
<td>Group Label</td>
<td>Enter the group label (example, Human Resources). This label appears as the group label in the Organization Chart Viewer for all added users.</td>
</tr>
<tr>
<td>Leader</td>
<td>Click the adjoining <strong>ellipsis</strong> button to select a group leader. From the <strong>Select User</strong> dialog box, click the user to be selected as the group leader, then click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Calendar</td>
<td>Click the adjoining <strong>ellipsis</strong> button to specify a calendar (if defined). This action includes the business calendar restrictions for the group members.</td>
</tr>
<tr>
<td>Group Members</td>
<td>Use this section to add the group members, as discussed in Adding group members on page 263.</td>
</tr>
</tbody>
</table>

3. Click **OK** to add the group to the groups list. The group is also added as a member to the **Groups** node in the left pane.
To remove a group (or multiple groups) from the groups list, select the groups and click **Remove**. The User Management tool prompts you for confirmation. Click **Yes** to remove the selected groups. To modify group details, select the group and click **Modify** to open the group details screen, where you can modify the group information.

**Adding group members**

You can use the **Group Members** section to add group members that can include individual users and other groups.

**To add and configure a group member:**

1. Click **Add** to open the **Select Members** dialog box, which lists all the defined users and groups.
2. Click the member to be added, then click **OK** to add the member to the list of members.
   
   You can also search for a member using the **Search** box. To remove a member from the member list, select the user and click **Remove**.
3. You can also specify a role (optional) for the group member.
   
   a) Select the added member, then click **Role**, opening the **Select Role** dialog box.
   
   b) Select an existing role from the drop-down list provided or enter a new role.
   
   c) Click **OK** to define the role for the group member.

**Managing queues**

You can add (and manage) queues from the Queue list.

1. Click **Queues** node in the left pane, displaying the queue list in the right pane.

   The queue name and label is displayed by default. To hide (or show) either of the columns, right-click any column header and mark (or unmark) the appropriate options.

2. To create a queue, click **New** to open the queue details screen, where you can enter the following queue details:

   **Table 89: Queue details** on page 263 describes the queue information fields.

   **Table 89: Queue details**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue Name</td>
<td><em>(Required)</em> Enter the name of the queue. The queue name appears as the queue performer in your process template. You can also search for a queue by entering the queue name in <strong>Search</strong> box in the Queue List screen.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Queue Label | Enter the queue label. Queue labels do not appear in the Organization Chart Viewer.
Queue Members | You can use this section to add queue members that can include individual users and other groups. Click Add to open the Select Members dialog box, which lists all the defined users and groups. Click the member to be added, then click OK to add the member to the list of members. You can also search for a member using the Search box. **Note:** You cannot add another queue as the queue member. To remove a member from the member list, select the member and click Remove.

3. Click OK to add the queue to the queue list. The queue is also added as a member to the Queues node in the left pane.

To remove a queue (or multiple queues) from the queue list, select the queues and click Remove. The User Management tool prompts you for confirmation. Click Yes to remove the selected queues. To modify queue details, select the queue and click Modify to open the queue details screen, where you can modify the queue information.

### Importing users

You can also import user information from a selected server.

1. Click File > Import, opening the Import dialog box.

2. In the Server URL box, modify the URL (if required) of the server from where you want to retrieve user information. You cannot import user information from an LDAP Realm.

3. Click OK.
Working with Business Calendar

Progress Developer Studio for OpenEdge provides the Business Calendar tool, using which you can define an organization-level calendar and assign them to workstep performers for simulation projects. For details regarding usage of business calendar in the Simulation perspective, see Configuring and running simulation on page 221.

You can start the Business Calendar by clicking OpenEdge > Tools > Calendars.

For details, see the following topics:

- Understanding the Business Calendar
- Using the Business Calendar tool

Understanding the Business Calendar

The Business Calendar provides a default out-of-box calendar, which displays the calendar for the current year. The default calendar does not display any non-working days, except on Saturday and Sunday.

You can create your own calendar using the default calendar settings, and customize the calendar according to your preferences. For example, you can create separate calendars for your offices in different countries.

The default calendar has the following working schedule:

- Working hours from 8 a.m. to 5 p.m. with 12 noon to 1 p.m. designated as lunch hour.
- Every Saturdays and Sundays are designated as non-working days.

You can also create customized working schedules using the Business Calendar tool, and then apply them to multiple calendars. You can use a customized schedule to:
• Change the default working hours.
• Change the working and non-working days of the week. For instance, mark “Saturday” as a working day or mark “Friday” as a non-working day.
• Mark a particular date (example, 25th December) as a non-working day.

Using the Business Calendar tool

You can use the Business Calendar tool to add (and manage) calendars and schedules.

Managing calendars

You can perform the following operations to manage calendars.

• To add a calendar, click the Add icon ( ) from the Calendar tool, to add a calendar (example, “Calendar1”) to the Calendar drop-down list.

  Note: Each added calendar (Calendar1, Calendar2, and so on) is a copy of the configuration set in the working schedule of the default calendar.

• To rename the added calendar, click the Rename icon ( ), opening the Calendar name dialog box.
  1. Type the modified name of the calendar.
  2. Click OK to rename the calendar.

• To delete a calendar, select the calendar in the Calendar drop-down list, then click the Remove ( ) icon. The Business Calendar tool prompts you for confirmation. Click OK to remove the selected calendar.

  Note: You cannot rename nor delete the default calendar.

Managing schedules

You can create customized working schedules, which are independent of calendars. You can then apply a schedule to a single day, or a sequence of days, or even to all the days of the year. You can also apply a schedule to multiple calendars.

To define a schedule:

1. Click a single day of your calendar, or drag across consecutive days, opening the Select Schedule dialog box, using which you can define (or select) a schedule.

2. Click the Add ( ) icon to add a schedule (example, “Schedule1”) to the Schedule drop-down list.

  Note: Each added schedule (Schedule1, Schedule2, and so on) contains the original settings of the default schedule. Any changes made to the default schedule are not reflected when you add a schedule.
3. Enter a description for the schedule (example, “Recruitment Schedule”) in the **Description** box.

   **Note:** You can rename the schedule by clicking the **Rename** icon, to open the **Schedule name** dialog box, where you can enter the modified name. To delete a schedule, click the **Remove** icon. You cannot rename nor delete the default schedule.

4. From the **Workdays** section, select (or clear) the appropriate checkboxes for the work days in this schedule. For the default schedule, Monday to Friday are marked as working days, with Saturday and Sunday designated as non-working days.

   **Tip:** To create a schedule for company holidays, clear all the checkboxes in the **Workdays** section.

5. The **Workhours** section displays two time segments namely, **AM** and **PM**. For the default schedule, the work-hours are 8-12 (in the AM segment) and 1-5 (in the PM segment). To manage work-hours:

   • Use the slider along the starting and ending time of each segment to change the default work-hours.
   • You can remove a work-hour segment by right-clicking on it, then clicking **Remove**.
   • You can also insert additional work-hour segments, by right-clicking a blank portion of the **Workhours** section, then clicking **Insert**.

   The work-hours that you set is applied to all the working days selected in the **Workdays** section.

6. You can set different work-hours for single (or multiple) working days in the **Exceptions** tab.

   a) Select the checkbox for the working day whose work-hours you want to modify.

   b) Modify the work-hours, as described in Step 5.

7. Click **OK** to create and apply the schedule to the selected days of your calendar.

   The selected days are highlighted by a color, which is unique and randomly selected for each customized schedule. Move your pointer over any highlighted day to view the name of the customized schedule.

**Overwriting a schedule**

You can overwrite a schedule for selected day (or days) with another schedule.

1. Drag across the calendar days, whose schedule is to be overwritten.

2. From the **Select Schedule** dialog box, select any schedule from the **Schedule** drop-down list.

3. Click **OK** to apply the schedule to the selected days.

   **Note:** You can apply a different schedule to each day of the calendar year. You can also use the same schedules for other calendars created using the Business Calendar tool (see **Managing calendars** on page 266).
Managing messages and channels

Progress Developer Studio for OpenEdge provides the Message Manager and the Channel Manager, which enable you to define, manage, and store messages and channels. These messages and channels can then be used when developing Message worksteps in the process workflow.

You can assign a defined message to a:

• Start workstep in a Business Process (as described in Using the Messaging tab of Start workstep properties on page 141).

• Message workstep in a Business Process (as described in Defining properties of Message worksteps on page 157).

• End workstep in a Business Process (as described in Using the Messaging tab of End workstep properties on page 159).

For details, see the following topics:

• Using the Message Manager

• Using the Channel Manager

Using the Message Manager

You can use the Message Manager to create messages and define the following message properties.

• **Message template** (or the body of the message).

• **Message header** data that can be used to identify the message, for instance, the receiver process ID or Email ID.
Payload properties that specify the actual XML message content.

Message correlation mechanism to identify the workstep instance to which the message is to be delivered.

To open the Message Manager:

1. From the Tools menu, click Messages, opening the Message Manager dialog box, which displays messages (if any) in the Messages section.
2. To define a new message, click New, opening the Add New Message dialog box.
3. Enter the message name in the Message Name box, and a description of the message in the Description box.
4. Define the other properties of the message, as described in the following sections.

Defining the message template

You can use the Template tab to define the message template. From the Template tab, enter the XML template in the text area provided.

Alternatively, you can click Browse to browse to the folder where message descriptor templates (*.xml) are stored. Predefined templates are stored in the Workspace_Home\.com.savvion.studio\messaging\messages folder.

Defining the message header

You can use the Header tab to define the header for the message. The header contains data that can be used to identify the message. By default, Progress Developer Studio for OpenEdge provides 13 predefined headers — five of these headers are displayed in the Header tab, the remaining eight can be added to the Header tab.

To add headers:

1. From the Header tab, click Add, opening the Add Header Property dialog box.
2. Select the System Property checkbox to add more predefined headers to the message.
   
   The Name box now displays a drop-down list containing eight more header types including ReceiverTaskName, ReceiverPriority, and SenderEmail. Since these headers are predefined, the Type box is disabled.
3. To define your own header, clear the System Property checkbox. Enter a name for the header in the Name box and choose a type from the Type drop-down list.
4. Click OK to add the header to the list in the Header tab.

Note: To remove a header, select the header in the Header tab and click Remove. You can only modify your defined header. To do so, select your header and click Modify.

Defining payload properties

You can use the Payload tab to provide the informational content, or the body, of the message. You must enter payload information in the Payload table. If no payload information is shown, click Add to open the Add Payload Property dialog box, where you can define the payload properties.
1. Enter the payload name in the **Name** box.

2. Depending on the type of information in the payload, select the type for the payload from the **Type** drop-down list. For example, select `java.lang.String` for textual content, and `int` for basic numerical content.

3. Enter an XPath expression in the **XPath Expression** box.
   Alternatively, from the **Tree View** tab, click the expression in the XPath tag to display it in the **XPath Expression** box. Click **Evaluate** to see if there are matches to the String Content.
   You can view the payload as a Tree View or XML Source by opening the respective tabs.

4. Click **OK** to add the payload property to the **Payload** tab.

### Defining message correlation

You can use the **Correlation** tab to define a correlation with the Payload Property defined in the previous tab. You need to define Message correlation to identify the workstep instance to which the message is to be delivered. Message Correlation is based on the comparison of payload data with the dataslot values.

**To add correlation properties:**

1. From the **Correlation** tab, click **Add** to open the **Add Correlation Properties** dialog box.
2. Enter a name for the Correlation in the **Name** box.
3. Select the Payload Property from the **Payload Property** drop-down list. The list displays the payload properties defined in the **Payload** tab, as well as the header defined in the **Header** tab.
4. Click **OK** to add the Correlation in the table in the **Correlation** tab.

**Note:** If required, you can use the **Namespaces** tab to define additional namespaces.

5. After defining the message properties, click **OK** to add the message to the **Message Manager** dialog box.
   An Information prompt appears, informing you that the *.xml file containing the message has been saved to the **Workspace_Home\com.savvion.studio\messaging\messages** folder and that you can export it to the server. Click **OK**.

**Note:** To modify an existing message in the Message Manager, select it and click **Edit**, opening the **Edit Message** dialog box, which is similar to the **Add New Message** dialog box. To remove a message from the Message Manager, select it and click **Delete** in the Local section.

### Exporting and importing messages

You can use Message Manager tool to export messages to the Business Process Servers, in order to share them with other Progress Developer Studio for OpenEdge users. You can also import one or more messages from the Business Process Servers in order to use them in your process templates.

#### Exporting a message

**To export a message:**
1. From the **Message Manager** dialog box, select a message (single or multiple) and click **Export** in the Remote section.

2. From the **List of Messages to be exported** dialog box that appears:
   a) Check the server address in the **Server URL** box. Modify it, if required.
   b) Enter your user name and password in the respective boxes, then click **OK**.

   An Information alert appears, informing you that the “MessageDescriptor(s) were successfully exported to the server.”

**Importing a message**

**To import a message:**

1. From the **Message Manager** dialog box, click **Import** to open the **Import Messages** dialog box.
2. Check the server address in the **Server URL** box. Modify it, if required.
3. Enter your user name and password in the respective boxes, then click the **Connect to Server** ( ![ ] ) icon.

   All the messages available for import are displayed in the table in the **Messages** section.
4. Select a message and click **OK**.

   An Information alert appears, informing you that the “Selected MessageDescriptor(s) were successfully imported...”

**Using the Channel Manager**

Progress Developer Studio for OpenEdge provides the Channel Manager tool to store and manage channels, which are used as a JMS-based communication medium with Message Subscriber worksteps and external softwares (for instance, SAP NetWeaver).

Business Process Server uses the default "BP Server Channel" to send and receive messages for Message Subscriber worksteps. BP Server channel uses a fixed JMS destination of type, Queue (point-to-point). For external softwares, Business Process Server uses a fixed JMS destination of type, Queue or Topic (for broadcasting).

**To open the Channel Manager:**

1. From the **Tools** menu, click **Channels**, opening the **Channel Manager** dialog box, which displays the default BPServerChannel.
2. To add a new channel, click **New**, opening the **Add New Channel** dialog box, where you can add a channel for a Local server (default) or a Remote server.
3. Enter a name and description for the channel in the respective boxes.
4. For a local channel, you can only use the "Queue" destination type, as displayed in the read-only **Destination Type** drop-down list.
5. Enter a Destination name in the **Destination Name** box.

   For a Local channel, the Destination name must be that of a topic already defined on your local server (for instance, jms/Business ProcessMessageQueue). For a Remote channel, the Destination name can be either a topic or a queue that has already been defined.
6. To create a channel for a Remote server, click the **Remote** option in the **Server Properties** section, to enable and make changes in the following fields.

   a) From the **Destination Type**, select either **QUEUE** (for messages that can be received by an individual or by any member of a group) option or **TOPIC** (for messages that can be received by all members of a group) option.

   b) Enter the respective JMS properties for your application server (Initial Factory, Provider URL, Principal or Credential) in the respective boxes. Refer to the `OEBPS_Home\conf\oebpsjndi.properties` for the properties. For instance, the value of the Provider URL parameter should be that of the `jmsserver/jmscluster` and not the `ejbcluster` property.

7. Click **OK** to save the new channel to the `Workspace_Home\.com.savvion.studio\messaging\channels` folder.

### Exporting and importing channels

You can use Channel Manager tool to export channels to the Business Process Servers, in order to share them with other Progress Developer Studio for OpenEdge users. You can also import one or more channels from the Business Process Servers in order to use them in your process templates.

#### Exporting a channel

**To export a channel:**

1. From the **Channel Manager** dialog box, select one or more channels, then click **Export** in the Remote section.

2. From the **List of Channels to be exported** dialog box that appears:
   
   a) Check the server address in the **Server URL** box. Modify it, if required.

   b) Enter your username and password in the respective boxes, then click **OK**.

   An Information alert appears, informing you that the “Channel(s) were successfully exported to the server.”

#### Importing a channel

**To import a channel:**

1. From the **Channel Manager** dialog box, click **Import** to open the **Import Channels** dialog box.

2. Check the server address in the **Server URL** box. Modify it, if required.

3. Enter your user name and password in the respective boxes, then click the **Connect to Server** ([ ] icon.

   All the channels available for import are displayed in the table in the **Channels** section.

4. Select a channel and click **OK**.

   An Information alert appears, informing you that the “Selected channel(s) were successfully imported...”
Managing business objects

Progress Developer Studio for OpenEdge provides the Business Object Manager tool, which enables you to define and manage business objects. For each business object, you can add and manage attributes, where data is stored and accessed.

Business objects are fully interoperable, plug-and-play, distributed components that encapsulate traditional lower-level objects that implement a business process. In Progress Developer Studio for OpenEdge, business objects act as a collection of datslots that can behave as a single, reusable unit. Business Objects also supports complex nested structures, including collection of other business objects. Using business objects, you can incrementally adjust business applications to fit your changing organizational needs, use them to rapidly build new applications entirely from reusable components, and dramatically reduce your development and maintenance costs.

For details, see the following topics:

- Using the Business Object Manager
- Using business objects in applications

Using the Business Object Manager

You can use the Business Object Manager tool to create and maintain business objects in Progress Developer Studio for OpenEdge. The stored objects can be persisted internally and externally.

To create and manage a business object:
1. Open a Business Process, Web application, or a Common Resource project.

2. From the **Tools** menu, click **Business Objects**, opening the **Business Object Manager** dialog box, which displays the list of default business objects with category, "demo."

**Note:** To modify an existing business object, select it from the Business Object Manager dialog box, then click **Edit** to make the changes in the Edit Business Object dialog box.

3. To create a new business object, click **New**, opening the **Create New Business Object** dialog box.

4. Type the name of the business object in the **Name** box. Avoid upper-case and special characters in the name.

5. Select a category from the **Category** drop-down list. To define a category, click the **ellipsis** button next to the **Category** list, to open the **New Category** dialog box, where you can define a new category.

6. In the **Data Source Reference** box, enter the description of the datasource (if any) being referenced. In the **Description** box, enter a description of the business object. This information is optional and help users identify business objects.

7. To define attributes for the business object, click **Add** to open the **New Attribute** dialog box.
   a) Define the attribute properties by entering relevant information in the appropriate field components. **Table 90: Defining Business Object Attributes** on page 276 describes the field components.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the attribute. Attribute name must not contain any special characters, and can have up to 64 characters. You need to precede any upper-case character with at least two lower-case characters.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of attribute. Options include Character, Long, Double, BigDecimal, Logical, Timestamp, and any business object that you have previously defined.</td>
</tr>
<tr>
<td><strong>Note:</strong> Progress Developer Studio for OpenEdge does not support business objects with circular reference. For example, if a business object, &quot;bo1&quot; contains the business object, &quot;bo2&quot; as an attribute, then &quot;bo2&quot; cannot contain &quot;bo1&quot; as an attribute.</td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>The size of the attribute. You can modify the size only for String type.</td>
</tr>
<tr>
<td>Default value</td>
<td>Enter (or modify) the default value for the attribute, if required. The default values are 0 (for Long), 0.0 (for Double and BigDecimal), false (for logical), and current date (for TimeStamp). To change the current date for Timestamp, click the <strong>Open Time Chooser</strong> (找个) icon.</td>
</tr>
<tr>
<td>Primary Key</td>
<td>Select this checkbox to make this attribute the primary key. Only one attribute can be assigned as the primary key.</td>
</tr>
<tr>
<td>Read Only</td>
<td>Select this checkbox to make this attribute read-only.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Select this checkbox to make this attribute mandatory (or required).</td>
</tr>
</tbody>
</table>
If you select an existing business object as the attribute type and select the **Collection** checkbox, then you can retrieve multiple records from the selected business object. For example, if you create a attribute called Addresses and select a business object for "Employee Records," you can display the "Employee Records" attribute data.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection</td>
<td>If you select an existing business object as the attribute type and select the Collection checkbox, then you can retrieve multiple records from the selected business object. For example, if you create a attribute called Addresses and select a business object for &quot;Employee Records,&quot; you can display the &quot;Employee Records&quot; attribute data.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the attribute. This is optional.</td>
</tr>
</tbody>
</table>

a) Click **OK** to add the attribute to the Attributes list in the Create New Business Object dialog box.

8. After you have added all the required attributes, click **OK**.

The new business object is added to the list in the Business Object Manager dialog box.

### Importing business objects

You can define business objects by importing files of the following types:

- Business Object XML files, as discussed in Importing a business object from Business Object XML file on page 277.
- XSD files, as discussed in Importing a business object from an XSD file on page 277.
- Java Bean files, as discussed in Importing a business object from a Java Bean file on page 278.

#### Importing a business object from Business Object XML file

You can import one or more business object from an XML file, which is only available to you (or the ones that others have shared with you).

To import a business object from BO XML:

1. From the Local section of the Business Object Manager dialog box, click Import. The Import dialog box appears.
2. Select Business Object XML and then click OK. The Open dialog box appears.
3. Select single (or multiple) XML files and click Open to display the list of business objects. By default, all business objects are selected.
4. Click Open. The details of the business object file appears in business object details dialog box.
5. Click OK. The selected business objects are added to the list in the Business Object Manager.

#### Importing a business object from an XSD file

An XSD file can contain multiple tags each of which can be converted to a business object. You can select the tags to be imported as business objects.

**Prerequisite:**

1. You must have a JDK version 5.0 or higher installed on your machine for importing business object from an XSD.
2. In the System Environment Variables for PATH variable add the JDK bin directory. For example, C:\Program Files\Java\jdk1.6.0_26\bin.
This must be updated because, the XSD functionality uses the xjc utility bundled with a JDK version 5.0 or higher found in the bin directory of the JDK installation.

**Note:** Only JRE is bundled with Progress Developer Studio for OpenEdge.

To import a business object from an XSD file:

1. From the Local section of the Business Object Manager dialog box, click Import. The Import dialog box appears.

2. Select XSD and then click OK. The XSD Import dialog box appears.

3. To add an XSD file as the source, click Add. The Add Source dialog box appears.

   a) You can enter the absolute path of the XSD file in the Location box.

      Alternatively, click the ellipsis button beside the Location box to browse and select the XSD file.

   b) Select the existing Category or create a new category based on the requirement.

   c) Click OK.

   In the XSD Import dialog box, the XSD details appear in the Sources section and the business objects available in the XSD are displayed in the Types section. Click Modify in the Sources section to select another XSD file or category. Click Delete in the Sources section to delete the selected XSD file. To modify any of the listed business objects in the Types section, select the business object and click Modify. You can modify the details including name and category.

4. Click Generate.

   The list of business object that you can import appears in Business Objects To Import dialog box.

5. Select one (or more) business object and click OK. The selected business objects are added to the list in the Business Object Manager.

**Importing a business object from a Java Bean file**

Java Beans encapsulates multiple objects into a single object (or bean).

To import a business object from a Java Bean file:

1. From the Local section of the Business Object Manager dialog box, click Import. The Import dialog box appears.

2. Select JavaBean and then click OK. The Java Bean Import dialog box appears.

3. To add a Java Bean file as the source, click Add. The Add Source dialog box appears.

   a) Click the ellipsis button beside the Location box to browse and select the Java file or a folder containing multiple Java files.

   b) Select the existing Category or create a new category based on the requirement.

   c) Select Linked Source checkbox. If you select the Linked Source checkbox, then the information of linking the source is passed on to the BO type as well.

   **Note:** The Linked Source feature is available only for importing a Java file and it is unavailable if you have selected a folder which contains multiple Java files. If you generate the Java file in a common resource project, the original Java file is referenced if you have selected the Linked Source checkbox.
d) Click OK.

Note: The default (or initial) value of Java files with initialized variables is not imported.

In the **JavaBean Import** dialog box, the JavaBean details appear in the **Sources** section and the business objects available in the Java bean are displayed in the **Types** section. Click **Modify** in the **Sources** section to select another JavaBean file or category. Click **Delete** in the **Sources** section to delete the selected JavaBean file. To modify any of the listed business objects in the **Types** section, select the business object and click **Modify**. You can modify the details including name, category, and linked source attribute.

4. Click **Generate**.

The list of business object that you can import appears in **Business Objects To Import** dialog box.

5. Select one (or more) business object and click **OK**. The selected business objects are added to the list in the Business Object Manager.

**Exporting a business object**

You can use Business Object Manager tool to export business objects to a file available only to you in order to share them with other Progress Developer Studio for OpenEdge users.

**To export a business object:**

1. From the **Business Object Manager** dialog box, select one or more listed business objects, then click **Export**, to open the **Export** dialog box.
2. Select the **File** option to export the business objects to an XML file that is available only to you (or you can share this file with others).
   - The **Save** dialog box appears, in which you can export the business objects in XML format.
   a) Select the folder where you want to export the selected business objects.
   b) Click **Save**.
      - For each selected business object, a separate XML file is created, which contains the business object definitions encoded in it.

   A message appears, informing you that the business object was successfully exported.

**Generating business objects**

You can use Business Object Manager tool to generate business objects, in order to use the business objects as Business Object dataslots in your process template (see *For a Business Object dataslot* on page 127).

**To generate a business object:**
1. Create a Common Resources project (in this example, BizObjects) in Progress Developer Studio for OpenEdge. For more information, see Using common resources on page 44.

2. Select the BizObjects common resource project that now appears in the Project Explorer. From the Tools menu, click Business Objects.

3. From the Business Object Manager dialog box, select the business object you want to generate, then click Generate.

A message appears, indicating that a java file was generated.

4. To check that the business object was generated correctly, select the BizObjects common resource in the Project Explorer view and from File menu, click Refresh. Expand the Business Objects folder under the BizObjects common resource, then expand the category to display the java file (with the same name as the business object) and all its attributes.

5. Publish the Common Resource project to compile the business objects to the Business Process Server. For information regarding publishing, see Publishing an application on page 59.

Using business objects in applications

You can use Business Objects in your process templates, as described in the following sections.

Note: Business objects are not supported on worksteps with default HTML presentation format.

Using business objects in a link

You can use business objects in links to filter for specific conditions. For information regarding links, see Defining link properties on page 163.

To use a business object in a link:

1. Open the Properties view for a conditional link, then click Advanced option to open the Advanced setting for that link.

2. Drag the business object dataslot (in this example “BOds”) from the Dataslots section to add it to the Condition section.

3. Build the condition for the business object. For business objects, you can use the AutoComplete functionality, which lists all the attributes of the business object.

4. To see if the condition is valid, click Validate.

A message stating “Validation successful” must appear.

Using business objects in scripts

You can use scripts (as described in Adding script to a workstep on page 165) to set the value of business object attributes. You can add the required script in the Before Activation and When Completed tabs of the workstep Properties, as well as an overdue action.

Progress Developer Studio for OpenEdge provides the getExprEval() method, which returns a ObjectGraphService object. You can use this object to set the attribute values of the specified business object.
The following code provides an example of this functionality:

```javascript
var empObj_DS = jst.getDataSlotValue("Employee_DS");
var exprEval = jst.getExprEval();
exprEval.setValue(empObj_DS, "firstName", "Sam");
jst.putDataSlot("Employee_DS", empObj_DS);
```

where Employee_DS is the dataslot of type, "Business Object" mapped to the "empObj_DS" business object with "firstName" attribute.
Progress Developer Studio for OpenEdge provides the Managed Adapter Browser tool, which enables you to perform operations on managed adapters, such as creating a copy, renaming, deleting, importing an external Managed Adapter configuration file, exporting configuration information to a specified file, and opening the Adapter Configurator GUI to configure a selected managed adapter.

Note: For information regarding configuring each managed adapter, see the relevant chapters in the Managed Adapters Guide.

For details, see the following topics:

- Using the Managed Adapter Browser

Using the Managed Adapter Browser

The Managed Adapter Browser is available for both Business Processes and Web applications.

To use the Managed Adapter Browser:

1. From the Tools menu, click Managed Adapters.
   - The Managed Adapter Browser tool appears with a list of all the managed adapters, as described in Using managed adapters on page 107.

2. Expand any adapter, then select the default generic adapter.
   - You can perform any of the following operations in the Managed Adapter Browser.
Table 91: Managed Adapter Browser Operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make Copy</td>
<td>Creates a copy of the selected managed adapter in the same folder, with a default name that is one increment higher than the previous managed adapter in the folder. A copy of the generic adapter (example, GenericDBAdapter) is named DBAdapter_1, while a copy of user-defined adapter (example, DBAdapter_1) would be named DBAdapter_1_1.</td>
</tr>
<tr>
<td>Rename</td>
<td>Renames a user-defined adapter. You cannot rename a predefined managed adapter (example, GenericEmailAdapter).</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a user-defined adapter. You cannot remove a predefined managed adapter (example, GenericEmailAdapter).</td>
</tr>
<tr>
<td>Import</td>
<td>Imports an external Managed Adapter configuration file. From the Open dialog box that appears, select the *.aar file that you want to import.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports all configuration information to a file. You can then use this file to import the configurations to other users. You can export multiple configuration files. From the Open dialog box that appears, select one or more *.aar files that you want to export, or create a new file. Click Open to import the selected preconfigured managed adapters to the specified file.</td>
</tr>
<tr>
<td>Configure</td>
<td>Opens the Configuration user interface for the selected managed adapter type, where you can configure the Managed Adapter. For information on configuring managed adapters, see the Managed Adapter’s Guide.</td>
</tr>
</tbody>
</table>

Preconfiguring managed adapters

You can use the Managed Adapter Browser to preconfigure managed adapters. For instance, you can preconfigure information regarding the mail server in the Email adapter. Although you can enter this information every time you use the Email adapter in any of your business processes, it may be more convenient to preconfigure the adapter. By preconfiguring a managed adapter, you do not need to enter the same information every time.

**To preconfigure a managed adapter:**

1. Select the adapter (generic or user-defined) to be configured. In this case, select the Email adapter.

2. Click the Configure ( ) icon to display the Email Adapter Configurator dialog box.

3. Enter the preconfiguring information in any of the displayed tabs, according to your requirement. In this case, click the Configuration tab to enter the mail server information.

4. Set the Mail Host parameter to the name of your SMTP server. If your environment requires some special settings, you may enter them in the Extra Properties text area.

5. If your e-mail (SMTP) server requires authentication, enter a user name and password in the appropriate fields.
Note: In most cases, you may only need to modify the Mail Host parameter to the name of your SMTP server. For more information, see the full list of SMTP server properties found at Sun’s javax.mail documentation at the URL address: http://java.sun.com/products/javamail/javadocs/index.html.

6. After entered your preconfiguring information, click OK to close the Adapter Configurator.

From now on, the configuration you set will be preset by default every time you use the Email Adapter in a business process.
Defining rules with Rule Wizards

Business Rules enable you to monitor business events and messages and to control business processes. In Business Process Server, you can use BPM Events, which is the business rule engine, to create and manage business rules. For information regarding business rules, see the BPM Events User’s Guide.

Progress Developer Studio for OpenEdge enables you to define rules for selected worksteps of a Business Process. You can define rules using the Rule Wizards (as described in this chapter) and then customize your rules (as described in the Customizing rules using Rule Editor).

**Note:** You cannot define business rules for Web applications.

Progress Developer Studio for OpenEdge provides a group of Rule Wizards with intuitive graphical user interfaces that you can use to quickly create simple or complex rules for the current process or a specific workstep.

A Rule Wizard is an intuitive graphical user interface that enables you to define a set of rules and reuse it in multiple applications.

Rule wizards provide the following benefits:

- You do not have to duplicate rules for each application.
- Customized rules can be carried over from other applications.
- Reliable and tested rule wizards speed up application development time.
- You do not necessarily need to know the rule language.

Progress Developer Studio for OpenEdge provides the following Rule Wizards arranged under the respective category:
<table>
<thead>
<tr>
<th>Category</th>
<th>Rule Name</th>
<th>Rule Description</th>
<th>For more information, see...</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>New Rule</td>
<td>Provides a blank, generic set of rules that can be applied to a process or an Activity workstep.</td>
<td>Using the New Rule wizard on page 289.</td>
</tr>
<tr>
<td>Schedule</td>
<td></td>
<td>Enables you to automatically schedule or defer actions that must be executed on or before a particular date or time. Can be applied only to a process.</td>
<td>Using the Schedule Rule wizard on page 290.</td>
</tr>
<tr>
<td>Notification</td>
<td>Process Path</td>
<td>Enables you to specify the timeout value for a process path, that is, a set of worksteps within a process template. This is an expanded version of the Time-out rule, and can be applied to a process or an Activity workstep.</td>
<td>Using the Process Path Rule wizard on page 292.</td>
</tr>
<tr>
<td>Time-Out</td>
<td></td>
<td>Provides a set of rules that is applied if a workstep has not finished by a specified time. Can only be applied to an Activity workstep.</td>
<td>Using the Time-Out Rule wizard on page 294.</td>
</tr>
<tr>
<td>Metrics</td>
<td>Monitoring</td>
<td>Provides a set of rules that enables you to set specific workstep monitoring actions. Can be applied to a process or an Activity workstep.</td>
<td>Using the Monitoring Rule wizard on page 296.</td>
</tr>
<tr>
<td>Business Metric</td>
<td></td>
<td>Enables business managers who need to monitor a business process to define a process’s business metrics. Can only be applied to an Activity workstep.</td>
<td>Using the Business Metric Rule wizard on page 297.</td>
</tr>
<tr>
<td>Decision Counter</td>
<td></td>
<td>Enables you to keep track of the number of times a particular path out of a Decision gateway has been taken for a specific process. Can only be applied to a Decision gateway.</td>
<td>Using the Decision Counter Rule wizard on page 299.</td>
</tr>
<tr>
<td>Task Management</td>
<td>Task Assignment</td>
<td>Provides a set of rules that enable you to define criteria that automatically assigns tasks. Can only be applied to an Activity workstep performed by ANY member of a group.</td>
<td>Using the Task Assignment Rule wizard on page 301.</td>
</tr>
<tr>
<td>Integration</td>
<td>Process Control</td>
<td>Enables you to receive XML messages from external applications that trigger the execution of rules. Can only be applied to a process.</td>
<td>Using the Process Control Rule wizard on page 303.</td>
</tr>
<tr>
<td></td>
<td>File Poller</td>
<td>Enables you to poll a file system for specific events or patterns, triggering a user-defined rule to process the system event. Can only be applied to a process.</td>
<td>Using the File Poller Rule wizard on page 304.</td>
</tr>
</tbody>
</table>
Accessing Rule Wizards

You can access all the rule wizards, arranged under their respective categories, by clicking the Create Rules link in the Tasks pane.

You can activate the respective Rule Wizard by dragging the corresponding icon to the Content pane (to apply it to a process or to a specific workstep). Each icon represents a rule template, or a parameterized rule file consisting of a set of generic rules that meet specific requirements.

For information on each rule wizard, refer to the specific section, as described in the following sections.

Note: At any point in the Rule Wizard, click Back to go back to the previous wizard page. Click Cancel to exit the wizard. Click Help to open a Help file for more information.

Using the New Rule wizard

The New Rule wizard provides a blank, generic rule set that enables you to define a new rule module for the application or to a selected Activity workstep to meet your specific requirements.

To apply a new generic rule:

1. From the General category, drag the New Rule ( ) icon to the Content pane to apply the rule to the process or to an Activity workstep in the active process template, to open the New Rule wizard.
2. Click Next to continue.
3. From the Module Type page, select the **Rule Module** option to create rule files, rule groups and rule modules, or select the **Data Module** option to create a dynamic map structure that provides quick and easy access to values in infopads and persistent maps that are contained in this map structure. Click **Next** to continue.

4. In the **Name** box, type the name of the rule module to which the new rule will be assigned. Click **Next** to continue.

5. In the File Name box, modify (if required) the name of the rule file name or click the adjoining **ellipses** button to change the location where the rule file is saved.

6. Click **Finish** to complete the new rule and apply it to the process or selected workstep.

---

**Using the Schedule Rule wizard**

You can use the Schedule Rule Wizard to automatically schedule and execute an action on or after a specific date or time. You can only apply this rule wizard to a process. If you try to apply it to a workstep, a **Rules** message appears informing you that you cannot apply this rule wizard to a workstep.

1. From the **General** category, drag the **Schedule** ([ ]) icon to the blank portion of the Content pane to apply the rule to the process, to open the **Schedule** wizard.

2. Click **Next** to continue. From the second page of the wizard, you can assign a name to the rule and define the timing of the scheduled/deferred action.
   
   a) Enter the name for the rule template you want to create in the **Name** box. A name must start with a letter, and can contain only alphanumeric characters and underscores. This rule template creates a set of rules designed to execute the actions for the selected process.

   b) From the **Schedule Start Period** section, select either of the following options to define when the action is activated:

      • If you select the **Duration** option, click the **ellipses** button next to the **Duration** box, opening the **Duration** dialog box, where you can specify the workstep duration. Enter the duration in terms of days, hours, minutes, and seconds in the respective boxes. Select the **Business time** checkbox to measure the workstep duration only during your business organization’s specified business hours (if you use **Business time**, you must have a system calendar defined).

      • If you select the **Deadline** option, click the adjoining **ellipses** button, opening the **Calendar** dialog box, which displays the current date and time. Specify the deadline year and month in the respective fields, and choose a day in the calendar. Enter the hour, minute and seconds in the boxes provided. Data entered in these three boxes start with zero; example, 00 is midnight and 01 is 1 AM. Hours are indicated from 0 - 23, example, 3:00 PM is entered as 15:00:00.

   c) Click **Next** to continue.

3. From the Reschedule page, you can specify the period and manner in which the rule can be rescheduled.

   a) In the **Reschedule Period** section, click the **ellipses** button provided, opening the **Duration** dialog box where you can define the duration to which the rule can be rescheduled.

   b) In the **Reschedule Till** section, choose an option that enables you to reschedule until the selected condition is satisfied. For example, if you select the number of rescheduling as three, you can only reschedule three times.
c) Click **Next** to continue.

4. From the Actions page, you can define the actions to occur every time a scheduled/deferred event is triggered. Select the action to be added from the drop-down list provided, then click **Add** to add each of the following actions:

   • **Send Mail**: Opens the **Send Mail** dialog box, where you can enter a valid e-mail address in the **To** and **From** boxes, as well as the **Subject** and **Message** in the respective boxes. Click **OK** to add it to as an action.

     **Important:** Make sure the e-mail address you entered is valid. No action will be taken, and no errors logged, if the e-mail address is invalid.

     • **Alerts**: allows you to add a defined alert. For information on defining Alerts, see Defining an alert on page 196.

     **Note:** If you add a custom alert with condition as the action, the condition is ignored at runtime. The alert is triggered on basis of the time-out condition of the rule wizard. This is applicable to any rule wizard configured with the Alerts action.

     • **Install Process Template**: Installs the specified process template. You can choose to install the current process, or select another process template.

     **Note:** To trigger this action for a process that is not deployed on Business Process Servers, you must copy the folder of the project (containing this process files) from the workspace folder to OEBPS\HOME\ebmsapps folder.

     • **Create Process Instance**: Create a process instance of the current process, or another process.

     **Note:** For the Create Process Instance action in all supported rule wizards, the Manager box of the process template whose instance is to be created, must contain a hard coded value.

     • **DBAdapter**: Add the DBAdapter managed adapter as an action and execute this adapter through rules or when a specified event is triggered. For more information regarding DBAdapter, see Chapter 6: "Database Managed Adapter" in Managed Adapter Guide.

     **Note:** To edit an action, select the action in the provided list, then click Edit. To delete an action, select the action and click Remove.

5. After defining all actions, click **Next** to continue. Review the Summary page, which provides a summary of all the measures to be computed and the rules and actions defined with the rule wizard.

6. From the Save As page, modify (if required) the name of the rule file in the **File Name** box, or click the adjoining **ellipsis** button to change the location of the rule file. Ensure that the modified location of the rule file is at the same folder level as that of the rules folder.

7. Click **Finish** to create the rules folder in the location you specified. The rule file must be separately installed on the BPM Events server before it becomes active.
Using the Process Path Rule wizard

You can use the Process Path rule wizard to specify the timeout value for a selected process path; that is, a path or branch consisting of a set of worksteps within the process template. You can also specify the actions to be taken if the path is or is not completed within the specified time.

You can invoke the Process Path rule wizard multiple times on the same process template to create and define process path policy on different worksteps.

To apply a Process Path Time-out rule to a process or to a workstep:

1. From the Notification category, drag the Process Path ( ) icon to the Content pane or to the selected Activity workstep(s) to which the rule is to be applied, to open the Process Path wizard.
2. From the Description page, review the description of the rule wizard and click Next to continue. Click Cancel at any time to exit the wizard.
3. From the Workstep Definition page, you can define when the timeout monitoring starts and when it ends.
   a) Enter the name for this set of rules in the Name box.
   b) Select the appropriate Rule Filter condition option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).
   c) In the Path Start box, define the start of the timeout monitoring by clicking the adjoining ellipsis button, which opens the Path Start dialog box. Select a workstep from the list, then select the status of the workstep from the Activity drop-down list. Click OK.
   d) In the Path End box, define the end of the timeout monitoring, similar to that for Path Start
   e) Click Next to continue.
4. From the Time Definition page, you can specify the duration or set the deadline to initiate one or more actions that will be taken if the process path is or is not completed within the specified time.
   a) From the Path Timeout section, select either of the following options to set the period of the timeout:
      • If you select the Duration option, you can define the workstep’s duration. as discussed in 2.b on page 290.
      • If you select the Deadline option, you can enter the date and time, as discussed in 2.b on page 290.
   b) Click Next to continue.
5. From the Actions page, you can specify the actions to be taken if the task is not completed in the specified time. You can define as many actions as required, or proceed to the next page without specifying any action.
   a) Select any of the following actions from the drop-down list provided, then click Add to add the action:
      • Send Mail: Opens the Send Mail dialog box. Type a valid e-mail address in the To and From boxes, as well as the Subject and Message in the respective boxes. You can also select the runtime values of dataslots or performers to be included in the e-mail by clicking the Dataslots or Performer option and selecting the values from the corresponding drop-down list. Click Select to add the dataslot or performer to the e-mail message.
      • Alerts: allows you to add a defined alert. For information on defining Alerts, see Defining an alert on page 196.
• **Change Priority**: allows you to change priority of the current process instance or workstep. For each selection, you can choose either the current instance (or workstep) or use dataslot to select another instance (or workstep) at runtime. Changes include selecting another priority, increasing (or decreasing) the priority, or using the dataslot to select the priority at runtime.

• **Change Duedate**: allows you to change due date of the process instance or workstep. For each selection, you can choose either the current instance (or workstep) or use dataslot to select another instance (or workstep) at runtime. Changes include selecting a relative date (in terms of duration) or an absolute date.

• **Modify Dataslot(s)**: allows you to modify dataslots of the current process instance or use dataslot to select another instance at runtime. For either selection, add the dataslots to be modified.

• **Install Process Template**: Installs the specified process template. You can choose to install any process template from the Progress Developer Studio for OpenEdge workspace folder, or select the process from a CHARACTER dataslot.

• **Create Process Instance**: allows you to create a process instance from the current process; or select the process from a dataslot (displays only CHARACTER dataslots); or select a process template from the Progress Developer Studio for OpenEdge workspace folder.

• **DBAdapter**: to add the DBAdapter managed adapter as an action and execute this adapter through rules or when a specified event is triggered. For more information regarding DBAdapter, see Chapter 6: "Database Managed Adapter" in *Managed Adapter Guide*.

• **Generate**: allows you to generate an event. You need to specify the event type and value in the respective boxes. You can add event attributes, whose values can be retrieved from dataslots.

• **Schedule**: allows you to schedule an event. Select either a relative date (based on duration) or an absolute date, for the specified event.

• **Complete Process Instance**: This is similar to the **Create Process Instance** action. This action allows you to complete the current process instance or use a dataslot (displays only CHARACTER dataslots) to select another process instance at runtime.

b) Click **OK**. The added action is displayed in the list provided.

c) Select the **Monitor Timeout Occurrences** checkbox to capture information about the workitems that were completed on time as well as those that were not completed on time.

d) Click **Next** to continue.

6. From the next Actions page, you can specify the actions to be taken when the task is completed within the specified time. You can define multiple actions, or proceed to the next page without specifying any action.

a) Select an action from the drop-down list provided, then click **Add** to add any of the following actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Mail</td>
<td>Sends a e-mail message. This operation is same as that for the previous wizard page.</td>
</tr>
<tr>
<td>Time Counter</td>
<td>Allows you to perform time functions (sum, maximum, minimum) on elapsed time expressed in units including hours, minutes, seconds, business hours, business minutes, and business seconds.</td>
</tr>
</tbody>
</table>

b) Click **Next** to continue.
7. From the Report Measures Distribution page, you can define how the measures calculated by the previous worksteps are to be distributed.

   • Select the **No distribution** option to create an undistributed result.
   • Select the **By attribute** option to define a distribution based on specified values of a selected dataslot. Click the adjoining **ellipsis** button to open the **By attribute** dialog box:
      
      a) Select one of the process dataslots from the **Attribute** drop-down list.
      
     b) Select the **Aggregate entry** checkbox to aggregate the measures and store the sum of all the occurrences of the selected attribute’s values.
      
     c) You can select either of the following options:
      
     • **Explicit values** option to enter explicit values that will specify the distribution. For example, if you select the CHARACTER "dsMgr" dataslot in the **Attributes** list that contains the names of managers, enter specific character values in the text box provided (Washington, Alfredo, or McMartin), then click **Add** to add each name to the list below. The rule will then only be applied to instances when one of these names occurs in the selected Attribute.
     
     • **Scale** option to enter numeric values that will specify the distribution — this option is only valid for INTEGER dataslots. For example, if you select the INTEGER "percent" dataslot in the **Attributes** list that contains data on test results, enter values in the Start, End and Step boxes that provide a range for the distribution (example, 40 for the Start, 80 for the End, and 10 for the Step). This indicates that values will be reported that occur between 40 and 80 and at intervals of 10. Select the **In Range** checkbox to only report on values within the specified range. If it is not checked, all results are generated including those outside the specified range.

   d) Click **OK** to implement the changes and return to the Distribution Definition page.

   e) Click **Next** to continue.

8. From the Summary page, review the summary of the parameters you have selected for the Process Path rule wizard. Click **Next** to continue, or click **Back** if you want to return to previous pages and make corrections.

9. From the Save As page, modify (if required) the name of the rule file in the **File Name** box, or click the adjoining **ellipsis** button to change the location of the rule file.

10. Click **Finish** to create the new Process Path rule file in the specified location. The rule wizard also creates another rule file in the same folder with the name of **Processpath_<WS_Name>_param.rtp**. Progress Developer Studio for OpenEdge automatically compiles the rule file and creates a *.bpo file when you click **Finish**.

### Using the Time-Out Rule wizard

You can use the Time-Out rule wizard, a parameterized rule file that applies specified actions if a workstep has not completed after a specified duration or by a specified deadline.

For example, you can use the Time-Out rule wizard to apply the following actions to a workstep: If a selected workstep is not completed in two days, the task will be reassigned, its priority will be changed to High, and an e-mail will be sent to a specified address.

You can only apply this rule wizard to an Activity workstep. If you try to apply it to a process, a **Rules** message appears informing you that you cannot apply this rule wizard to a process.

**To apply a Time-Out rule to an Activity workstep:**
1. From the Notification category, drag the Time-Out (⏰) icon to the workstep in the process template to which the rule is to be applied, to open the Timeout wizard.

2. From the Description page, review the description of the rule wizard, then click Next to continue. Click Cancel at any time to exit the wizard.

3. From the second page of the wizard, you can assign a name to the rule and specify the duration or set the deadline required to complete the workstep.
   a) Enter a name for the rule in the Name box.
   b) Select the appropriate Rule filter condition option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).
   c) From the Timeout section, select either of the following options to set the period of the duration:
      - If you select the Duration option, you can define the duration of time to elapse before the action is activated. as discussed in 2.b on page 290.
      - If you select the Deadline option, you can set the specific date and time when the action will be activated. as discussed in 2.b on page 290.
   d) Click Next to continue.

4. From the Actions page, you can specify the actions to be taken in case of a workstep timeout. You need to define at least one action.
   a) The procedure for all these actions are similar to as described in Step 5 on page 292 for Process Path Wizard, except for the following additional actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Re)Assign Workitem(s)</td>
<td>Allows you to reassign the workitem to the specified user. Alternatively, you can use the runtime value of a dataslot or performer to specify the assignee to whom the workstep is reassigned, by clicking the Dataslots or Performers option, selecting from the corresponding drop-down list, and clicking Select.</td>
</tr>
<tr>
<td>Complete workstep</td>
<td>Allows you to select a dataslot and define the dataslot's value. When the workstep is completed, the values you have defined will be mapped to the selected dataslot.</td>
</tr>
</tbody>
</table>

   b) Select the Monitor Timeout Occurrences checkbox to capture information about workitems that were completed on time as well as workitems that were not completed on time.
   c) Click Next to continue.

5. From the Summary page, review the actions that will be applied if the selected workstep is not completed by the specified time. Click Next to continue, or click Back to return to previous pages and make corrections.

6. From the Save As page, modify (if required) the name of the rule file in the File Name box, or click the adjoining ellipsis button to change the location of the rule file.

7. Click Finish to create the new Time-Out rule file in the specified location.

The new rule is now applied to the selected workstep(s).
Using the Monitoring Rule wizard

You can use the Monitoring rule wizard, which is a parameterized rule file that enables you to monitor an entire process or a selected Activity workstep. For example, you can define the time intervals needed to monitor a specific action or the number of occurrences of a specific event. In addition, you can distribute the data according to time intervals or to dataslot values.

To apply the Monitoring rule to a process or an Activity workstep:

1. From the Metrics category, drag the Monitoring icon to the Content pane or to selected Activity workstep(s) to which the rule is to be applied to open the Process Monitoring wizard.

2. From the Description page, review the description of the rule wizard, then click Next to continue. Click Cancel, at any time, to exit the wizard.

3. From the Program page, you can define when the process monitoring starts and when it ends.
   a) Enter the name for the rule in the Name box
   b) Select the appropriate Rule filter condition option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).
   c) Select either of the following options to indicate if the process monitoring is time-specific or not.
      - No time constraints option to indicate that the monitoring is not time-specific.
      - Period option to specify the time period during which the monitoring is conducted. Click the ellipsis button next to the Start and End boxes to display the Calendar dialog box, where you can define the date and time. For more information, see 2.b on page 290.
   d) After making the selection, click Next to continue.

4. From the Report Measures page, you can define the counters that can be used to monitor a process or a selected workstep. Select one or more of the following counters from the drop-down list provided, then click Add. After defining the counters, click Next to continue.
   - Occurrence Counter: Used to monitor specific occurrences in a process (or a selected workstep). From the Occurrence Counter dialog box, select any of the following options to monitor the process instances:
     - Completed instances (started during monitoring period): All completed process instances started during the specified monitoring period.
     - Started instances to date: All started process instances.
     - Currently active instances (started, not completed): All active process instances.
   - Time Counter: Used to monitor a specific time unit in a process (or a selected workstep).
     - From the Operation drop-down list, select the timing operation. Options include: Average, Sum, Minimum, and Maximum.
     - From the Time unit drop-down list, select the time unit in which the timing operation is measured. Options include: Hours, Minutes, Seconds, Business Hours, Business Minutes and Business Seconds.
   - Value Counter: Used to monitor specific dataslot values in a process (or a selected workstep).
Using the Business Metric Rule wizard

You can use the Business Metric rule wizard to enable managers (or other users with manager permissions) to define business metrics for a specific Activity workstep in a process. Business metrics are numeric values that can be computed or aggregated based on the value of a dataslot in the process template. You can carry out an aggregation over multiple instances of the process template. Examples of business metrics include "TotalSales" figures or "InventoryCount" for an item or "NumberofDefects" for a product component. You can monitor and measure these values across process instances and distribute them over time or other criteria. You can also define certain action rules that will be executed based on the values of a specific metric.

Business metric values are stored in BPM Events Infopads and persisted in the database. Managers (or other users with manager permissions) can view these values from the Infopads viewer applications in the Management module in Business Process Portal.
You can invoke the Business Metric rule wizard multiple times on the same process template to create different metrics, but each metric must be defined on a different workstep.

To apply the Business Metric rule to an Activity workstep that contains a numeric dataslot:

1. From the **Metrics** category, drag the **Business Metric** icon to the Activity workstep in the process template to which the rule is to be applied, to open the Business Metric wizard.

2. From the Description page, review the description of the rule wizard, then click **Next** to continue. Click **Cancel**, at any time, to exit the wizard.

3. From the Business Metric Period Definition page, you can specify the time period when the defined rule is activated.
   a) Select the appropriate **Rule filter condition** option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).
   b) Select the period when the business metric rules are active, by selecting either of the following options:
      • **No time constraints** option where the business metric monitoring starts immediately upon rule execution and continues indefinitely.
      • **Period** option, where you can set the start and end date (and time) for the active period. Click the *ellipsis* button next to the **Start** and **End** boxes to display the **Calendar** dialog box, where you can define the date and time.
   c) Click **Next** to continue.

4. From the Metric Definition page, you can define the business metric name as well as aggregate functions that generate rules to compute these measures.
   a) Enter the name of the metric rule in the **Name** box.
   b) Select a dataslot from the **Select Dataslot** drop-down list to be used for monitoring and computing the value of the business metric. This list contains all available numeric dataslots.
   c) Select any of the following metric options from the **Compute Measures** drop-down list, then click **Add**.
      • **Average**, which computes the running average of the selected dataslot across all process instances during the active time period when the selected workitem completes.
      • **Sum**, which computes the additive value of the selected dataslot across all process instances during the active time period. This computation is based on the workitem completion event for the selected worksteps.
      • **Maximum**, which tracks the maximum value of the selected dataslot across multiple process instances during the active time period when the selected workitem completes. Click **Add** to open the **Maximum** dialog box. Enter the maximum value and click **OK**.
      • **Minimum**, which tracks the minimum value of the selected dataslot across multiple process instances during the active time period when the selected workitem completes. Click **Add** to open the **Minimum** dialog box. Enter the minimum value and click **OK**.
   d) After adding all the options, click **Next** to continue.

5. From the Report Measures Distribution page, you can define how the business metric is distributed across time periods or based on the value of a dataslot in the process.
   • **No distribution**: creates an undistributed business metric.
   • **By time periods**: distributes the data by a specified time period, based on the starting time of the instance.
     For more information, see 5 on page 297.
• **By attribute**: distributes the data based on values specified for a selected dataslot. Click the adjoining ellipsis button to display the **By attribute** dialog box.

Click **Next** to continue.

6. From the Business Rules page, you can define business rules and conditions for the business metric.
   a) Click **Add** to open the **Business Rule Editor** dialog box, where you can define conditions and actions for the selected metric.
   b) Enter a name for the rule in the **Rule Name** box.
   c) To add a condition, click **Add** in the **Condition(s)** section, opening the **Business Rule Conditions** dialog box.
   d) To define the initial clause of a condition, click the ellipsis button on the left side, to open the **Business Metric Attributes** dialog box. Click the Dataslot option to select a INTEGER or INT64 dataslot as the attribute, or the Metric option to select any of the available metrics (as selected in the Metric Definition page), or the Value option to enter a specific value.
   e) From the **Business Rule Conditions** dialog box, select an operand from the drop-down list in the middle, and complete the condition by clicking the ellipsis button on the right side, to define a second clause using the **Business Metric Attributes** dialog box.
   f) Click **OK** to return to the **Business Rule Conditions** dialog box, and click **OK** to add the condition to the **Condition(s)** panel.
   g) From the **Action(s)** section, you can specify the actions to be taken in the case if the condition is satisfied. You need to define at least one action. The procedure for all these actions are similar to as described in Step 5 on page 292 for Process Path Wizard.
   h) When you have finished defining the conditions and actions for the business rule, click **OK** to add the new rule condition to the Business Rules page.
   i) Click **Next** to continue.

7. From the Summary page, review the summary of the parameters you have selected for the Business Metric rule wizard. Click **Next** to continue, or click **Back** to return to previous pages if you need to return to previous pages and make corrections.

8. From the Save As page, modify (if required) the name of the rule file in the **File name** box, or click the adjoining ellipsis button to change the location of the rule file.

9. Click **Finish** to create the new Business Metric rule file in the specified location. The rule wizard also creates another rule file in the same folder with the name of **BM <WS Name>_param.rtp**. Progress Developer Studio for OpenEdge automatically compiles the rule file and creates a '*.bpo' file when you click **Finish**. You must, however, separately install the compiled rule file on the BPM Events server before it becomes active.

---

**Using the Decision Counter Rule wizard**

You can use the Decision Counter Rule Wizard to create a set of rules that count the number of times a particular decision path from a specific Decision gateway has been taken by instances of the process template. This rule wizard creates a monitoring table that keeps a count of the total number of times the decision was executed as well as a count of the number of times each decision path was taken. The Decision Counter rule wizard also enables you to set the time when the counter is activated and its duration.
Chapter 27: Defining rules with Rule Wizards

1. From the Metrics category, drag the Decision Counter icon on the Decision gateway that you want to monitor, to open the Decision Counter wizard.

2. From the Description page, review the description of the rule wizard, then click Next to continue. Click Cancel, at any time, to exit the wizard.

   **Note:** Click Back at any time to go back to the previous page. Click Cancel at any time to exit the wizard. Click Help to open a Help file for more information.

3. From the second page, you can assign a name and define the timing of the monitoring of the paths from the selected Decision gateway.
   
a) Enter the name for the rule template you want to create in the Name box.

b) Select the appropriate Rule filter condition option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).

c) Select either of the following options to define when the decision counter is activated.
   - **Indefinite** option to immediately activate the decision counter and to continue indefinitely.
   - **Period** option to set the specific starting and ending date (and time) for the decision counter, as discussed in 2.b on page 290.

d) Click Next to continue.

4. From the Report Measures Distribution page, you can define how to distribute the computed measures across time periods or based on the value of a dataslot in the process.
   - **No distribution** if you do not want to distribute the computed measures.
   - **By time periods:** distributes the data by a specified time period, based on the starting time of the instance. For more information, see Step 5
   - **By attribute:** distributes the data based on values specified for a selected dataslot. Click the adjoining ellipsis button to display the By attribute dialog box.

   After defining all distributions, click Next to continue.

5. From the Action page, you can specify the actions to be taken every time a particular decision path is traversed. You can define as many actions as required, or proceed to the next page without specifying any action. The procedure for all these actions are similar to as described in Step 5 on page 292 for Process Path Wizard.

6. From the Summary page, review the summary of all the measures to be computed and the rules and actions (if any) defined with the rule wizard. Click Next to continue, or click Back to return to previous pages if you need to return to previous pages and make corrections.

7. From the Save As page, modify (if required) the name of the rule file in the File name box, or click the adjoining ellipsis button to change the location of the rule file.

8. Click Finish to create the rule file in the specified location. The rule file must be separately installed on the BPM Events server before it becomes active.
Using the Task Assignment Rule wizard

You can use the Task Assignment rule wizard to schedule algorithms to automatically assign tasks of Available status for worksteps performed by any of the members of a group. You can also use this rule wizard to exclude a specific performer from a work assignment, to activate a rule immediately or at a specified date, and to perform specified actions upon assignment of the task.

You can invoke this rule wizard to define task assignment policies for different worksteps in the same process template.

You can only apply the Task Assignment rule to a human-performed workstep where the performer is ANY member in a group:

1. From the Task Management category, drag the Task Assignment icon to the Activity workstep of the process template to which the rule is to be applied, to open the Task Assignment wizard.

2. From the Description page, review the description of the rule wizard, then click Next to continue. Click Cancel, at any time, to exit the wizard.

3. From the Name Definition / Time Constraints page, you can assign a name and set the time constraint for the defined rule.
   a) Enter the name for the rule template you want to create in the Name box. Progress Developer Studio for OpenEdge creates a rule file that has the prefix "TA" appended to the workstep name.
   b) Select the appropriate Rule filter condition option to set the rule filter condition by filtering for process template name (filters for a specific process) or for application name (filters for all versions of an application).
   c) Select either of the following options to set the Time Constraint for the rule, which is the period when the task assignment rules are active:
      • Indefinite option to immediately start the task assignment on rule execution and to continue indefinitely.
      • Period option to set the starting and ending date (and time) for the period of validity. as discussed in 2.b on page 290.
   d) Click Next to continue.

4. From the Scheduling page, you can set parameters such as the duration of task assignment delay, and the task scheduling algorithm for the workitems.
   a) To define the delay for task assignment, click the ellipsis button provided in the Delay Task assignment by section, opening the Duration dialog box. Specify the time the task will wait before being assigned to a performer, depending on the option selected in the Task Scheduling Algorithm section.

   Note: The Delay for Task Assignment is not applicable for the Single Task algorithm.

   b) From the Task Scheduling Algorithm section, select any of the following options from the drop-down list provided, then click Add.
      • Random Scheduling: Each workitem is randomly assigned to a group member (or an individual user from multiple users).
      • Round-robin Scheduling: Each subsequent workitem is assigned to the next user in the user list for the group. The last assigned user is stored in an Infopad for persistence.
• **Exclude User Scheduling**: Excludes a user who was the performer of another workstep or is linked to a dataslot from performing the current workitem. From the Exclude User Scheduling dialog box, you can select the workstep that the excluded user performs, or the dataslot that the excluded user is linked to. This option is based on the Four-eyes Principle and allows for peer level reviews.

• **External Scheduling**: Each subsequent workitem is assigned to a user-specified class that can be invoked for scheduling. This class must implement a special interface, which will be invoked by the rules when the task becomes available. Ensure that the specified class name is a fully qualified class name.

• **Task Load Balancing**: Business Process Portal generates a load count (a count of all the items assigned to a user) based on the total number of workitems in a user’s task list, and the user with the minimum load count is assigned the next item. For new applications, the checkbox in the Task Load Balancing dialog box can remain cleared. For applications that have been running, select the checkbox to balance the task load from the current status.

• **Single-Task Scheduling**: Each subsequent workitem is assigned to the next user in the group at a rate of one task at a time from the available pool of workitems. The group member only works on one task at a time. When that task is completed, another is assigned to the member. This option is not applicable to the Delay for Task Assignment.

c) From the **User Information Update** section, you can provide connection options and user refresh mechanism to the user management system. Use any of the following connection options to update the user management system when a user is added or removed:

• **Direct Connection**. Connects to the user management system continuously and gets the updated list of users before performing task assignment.

• **Periodically**. Connects to the user management system and gets periodic updates of user information. You can specify the period using the Duration dialog box. If you select the **Business time** checkbox, ensure that a system calendar is set before publishing this process.

• **Only Once (At Deployment)** Connect to the user management system only when the rule becomes active.

d) Select the **Re-assign Removed User’s Task** checkbox to reassign tasks assigned to the removed user to other group members.

e) Click **Next** to continue the rule wizard.

5. From the Post Task Assignment Actions page, you can specify the actions to be taken after the task has been assigned. You can define as many actions as required, or proceed to the next page without specifying any action. The procedure for all these actions are similar to as described in Step 5 on page 292 for Process Path Wizard.

6. From the Summary page, review the summary of the parameters you have selected for the Task Assignment rule wizard. Click **Next** to continue, or click **Back** to return to previous pages if you need to return to previous pages and make corrections.

7. From the Save As page, modify (if required) the name of the rule file in the **File name** box, or click the adjoining **ellipsis** button to change the location of the rule file.

8. Click **Finish** to create the new Task Assignment rule file in the specified location. The rule wizard also creates another rule file in the same folder with the name of `TA_<WS_Name>_param.rtp`. Progress Developer Studio for OpenEdge automatically compiles the rule file and creates a *.bpo file when you click **Finish**. You must, however, separately install the compiled rule file on the BPM Events server before it becomes active.
Using the Process Control Rule wizard

You can use the Process Control rule wizard to trigger the execution of rules using XML messages. This type of rule wizard can only be applied to a process, not a workstep. This rule wizard enables Progress Developer Studio for OpenEdge to receive XML message schema from, and interact asynchronously with, external applications.

To apply a Process Control rule to a process:

1. From the Integration category, drag the ProcessControl ( ) icon to the Content pane, opening the Process Control wizard.

2. From the Description page, review the description of the rule wizard, then click Next to continue. Click Cancel, at any time, to exit the wizard.

3. From the second page, you can assign the name of the rule module to which the Process Control rule will be assigned, and define the actions.
   a) From the Process Action(s) section, you can select any of the following actions from the drop-down list provided, then click Add. You need to define at least one action.
      - **Create Process Instance**: creates an instance of the process when an XML message for creating a process instance is received. From the Create Process Instance dialog box, enter the name of the creator and an instance name prefix (optional). You can also use the Priority drop-down list to set the priority of the process instance. You can also add dataslots (with default values) to the process instance. Click Add to open the Select Dataslots dialog box, where you can select a dataslot and click OK to add the dataslot in the Name/Value table. You can add as many default dataslot values as required.
      - **Complete Workstep(s)** completes the selected worksteps in the process when an XML message for completing worksteps is received. To add worksteps, click Add, opening the Complete Workstep(s) dialog box. Click Add to open the Workstep Dataslot(s) dialog box, where you can select a workstep to be added from the Workstep drop-down list. Optionally, you can add dataslots (with default values) to the workstep. You can add as many default dataslot values as required, and use these values when the specified workstep is completed.
      - **Update Dataslot(s)** allows you to modify the value of selected dataslots when an XML message for updating dataslot values is received. To select the dataslots to be updated, from the Update Dataslot(s) dialog box, click Add, opening the Select Dataslots dialog box. Select a dataslot from those listed and click OK. You can add as many dataslot (with default values) as required.

   b) Click Next to continue.

4. From the Summary page, review the summary of the parameters you have selected for the Process Control rule wizard. Click Next to continue, or click Back to return to previous pages if you need to return to previous pages and make corrections.

5. From the Save As page, modify (if required) the name of the rule file in the File name box, or click the adjoining ellipsis button to change the location of the rule file.

6. Click Finish to create the new rule file in the specified location, and apply it to the process.
Using the File Poller Rule wizard

You can use the File Poller rule wizard to poll a file system for a specific event or pattern of a folder or file, which triggers a user-defined rule to process that event. You can also use the file system to asynchronously interact with external applications without needing to develop application-specific adapters. This wizard also collects statistical data on the number of messages received by action type and a count of the successful processing of such events. This information is collected in Statistics and Configuration infopads. The Statistics infopad dynamically adds a row whenever a new event or folder is detected.

This type of rule wizard can only be applied to a process, not a workstep.

To apply a File Poller rule to a process:

1. From the Integration category, drag the FilePoller ( ) icon to the Content pane, opening the File Poller wizard.

2. From the Description page, review the description of the rule wizard, then click Next to continue. Click Cancel, at any time, to exit the wizard.

3. From the second page, you can enter the name of the rule group, as well as specify the Poll start time and interval.
   a) Enter the name for the rule template you want to create in the Name box.
   b) From the Poll Start Time section, you can define when the file polling action is activated.
      • If you select the Duration option, you can define the duration of time to elapse before the action is activated. as discussed in 2.b on page 290.
      • If you select the Deadline option, you can set the specific date and time when the action will be activated. as discussed in 2.b on page 290.
   c) From the Poll Interval section, click the ellipsis button provided to open the Duration dialog box where you can set the time interval between file polls.
   d) Click Next to continue.

4. From the Defining Folders page, you can specify the parent root of the folder that you want to poll, as well as the file name pattern and other settings.
   a) To select the root folder, click the ellipsis button next to the Root Folder box, then browse to and select the root folder.
   b) To specify the folder under the root folder that will be polled, click the ellipsis button next to the Folder Name box, opening the Folder Name dialog box.
      • Enter the name of the folder to be polled in the Folder Name box.
      • If required, add a prefix or suffix to the polled folder, in the supported date format, by selecting the appropriate option.
   c) From the File Name Pattern section, you can select any of the following pattern options for the file polling.
      • RegExp Pattern option to specify the Regular Expression pattern for files in the folder that is to be polled. For example, this pattern accepts a text representing the file name with an extension or you can enter a regular expression that the actual files need to match, example, entering .+log matches any file name with a log extension.
• **Name Prefix** option to specify a file name pattern. Click the adjoining ellipsis button, opening the Name Prefix dialog box, where you can specify the name of the file in the File Name box. Optionally, you can select an appropriate option from the File Name Prefix/Suffix section to poll files by the date format that is prefixed or suffixed to a String value.

• **External Filter** option to specify a user-defined Java class that implements the java.io.FilenameFilter interface. You must implement this class and keep its compiled version in the classpath of the BPM Events server under the \workspace/<ApplicationName>/adapters folder.

d) From the **Sort Using** drop-down list, you can control the order in which the FileFound events are fired (in the case that multiple files have changed). The available sorting options are **Size** (file size), **Name** (file name), **Extension** (file extension), and **Modification Time** (the default selection).

e) From the **Order By** drop-down list, select either **ASC** (ascending) or **DESC** (descending) option.

f) Click **Next** to continue.

5. From the Actions page, you can select any of the following actions from the drop-down list provided, then click **Add**. You need to define at least one action.

• **Create Process Instance** creates a process instance as a result of the polling of specified files.

  a) In the Creator box, define the user ID (must be a valid Application User) to be used as the name of the creator of the process instance. If you use the default, "(manager)", it is replaced by the user ID of the process manager.

  b) In the Instance Name Prefix box, enter the name of the process instance to be created. This name is automatically assigned a suffix that contains "#", followed by the unique system-generated ID of the process instance. If you use the default, "(docname)", it is replaced by the file name of the incoming document that triggers this rule.

  c) Select an option from the Priority drop-down list to specify the priority of the process instance.

  d) The Document Dataslot(s) drop-down list displays all the available Document dataslots in the current process template. Select the dataslot in which the incoming document is uploaded when creating the process instance. You can also initialize the Document dataslots by clicking Add to open the Select Dataslots dialog box. Select a Document dataslot from the list and click **OK**.

  • The procedures to define the remaining actions are similar to as described in Step 5 on page 292 for Process Path Wizard. The only exception is for **Send Mail** action, you can only specify e-mail addresses in the **To** and **From** boxes, and the e-mail subject and message in the respective boxes.

6. From the Summary page, review the summary of the parameters you have selected for the File Poller rule wizard. Click **Next** to continue, or click **Back** to return to previous pages if you need to return to previous pages and make corrections.

7. From the Save As page, modify (if required) the name of the rule file in the **File name** box, or click the adjoining ellipsis button to change the location of the rule file.

8. Click **Finish** to create the new rule file in the specified location and apply it to the process.
Managing changes in Business Processes

Business processes are rarely static and continually undergo changes. Progress Developer Studio for OpenEdge enables you to make changes to an active process template and apply these changes to the installed process and its running process instances.

For details, see the following topics:

• Managing changes through Process Refresh

Managing changes through Process Refresh

Progress Developer Studio for OpenEdge provides the Process Refresh feature that enables you to update an installed application. Depending upon the type of change, some of these changes are applied to its currently running process instances. Although you can manage changes in a process by creating a new version of the process, the changes you want to make may be relatively minor and it may be easier to use the Process Refresh feature.

Process Refresh replaces APIs that enabled users to update some application metadata and apply it to running process instances, but this method involved numerous API calls and was prone to error. In addition, you were not able to use the APIs to add worksteps or dataslots to the application. Process Refresh not only enables you to add worksteps or dataslots, but also to change many of the properties of worksteps and dataslots. You can then use the Refresh Process template option in the Publish wizard to seamlessly and immediately apply these changes to all running and future process instances at runtime.

Note: During process refresh, do not perform any activity related to the process and its instances, until the process refresh is completed.
As an example, let us consider a loan approval process that, as shown in Figure 21: Loan Approval Process Example on page 308, has three types of decisions: Approved, Rejected and Second Level Approval. A change in policy dictates the addition of a new type of approval called Special Approval, where loan approvals that exceed a specified amount require the approval of the Chief Financial Officer (this change to the existing process is shown in the dashed box in Figure 21: Loan Approval Process Example on page 308). With Process Refresh, you can add this special level of approval and, if the changes are valid, immediately apply them to all running process instances.

Figure 21: Loan Approval Process Example

To use the Process Refresh feature:

1. Make changes to an installed application in Progress Developer Studio for OpenEdge, as shown in Figure 21: Loan Approval Process Example on page 308.
2. Verify that it has no errors, and publish it by selecting Project > Publish. For more information, see Publishing an application on page 59.
3. During the publishing, for the Publish Wizard page, select the Refresh Process Template option to apply the changes you made in the installed application to all its process instances.
4. Click Next to continue.
   - If the changes you have made are valid and allowed, the publish operation is successful, and changes you have made in the installed application are adopted by all running process instances.
   - If the changes you have made are not valid and not allowed, the Refresh Process Template button is disabled. Click << Details to display information about the changes that need to be corrected.
5. The final page of the Publish wizard appears. Click Finish to complete.

You can view the changes in the application in the existing process instances of the application.

See the following section, Criteria for changes in Process Refresh on page 308, for a description of the changes that are allowed and not allowed in Process Refresh.

Criteria for changes in Process Refresh

The following general principles outline the types of changes that are supported or not supported during Process Refresh.

- Adding worksteps. You can add worksteps, provided the following condition is met:
If a rollback is enabled for the installed process, then do not add new worksteps and do not change the process flow.

The target of the added workstep is not an existing AND gateway with single outgoing connector (or And Join). For an illustration of And (Join), see Figure 8: Examples of Gateway connectors on page 79.

• Modifying process properties. You can modify most of the process properties. For more information, see Process properties criteria on page 309.

• Modifying worksteps. You can modify certain properties of worksteps (for more information, see Workstep properties criteria on page 310), except in the following case:
  • You cannot modify the source worksteps for all existing AND gateways.
  • You cannot add or change a rollback point or reactivate workstep to an existing workstep.

• Deleting worksteps. You cannot delete worksteps.

• Adding dataslots. You can add instance level and global level dataslots to the process.

• Modifying dataslots. You can modify certain properties of dataslots for a Process Refresh (for more information, see Dataslot properties criteria on page 311).

• Deleting dataslots. You cannot delete dataslots.

### Process properties criteria

Table 93: Process Properties Modified during Process Refresh on page 309 lists the types of changes to process properties (see Defining process properties on page 97) that are allowed or not allowed during Process Refresh. The Properties column refers to the properties listed in the General and Description tabs of the Properties view for the process. The Changes Allowed column represents changes in workstep properties for all process instances that will take effect immediately. The Changes Effective Only for... column indicates that the changes will only take effect for process instances created after the Process Refresh, and will have no effect on currently running process instances.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Changes Effective Immediately for all Process Instances</th>
<th>Changes Effective Only for Process Instances Created After Refresh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Manager</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Version</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Duration</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Category</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Sub-category</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>
### Workstep properties criteria

You can change only specific workstep properties before running a Process Refresh. Some of these changes will not take effect until after the first activation of the workstep.

Table 94: Changes Allowed/Not Allowed to Workstep Properties for Process Refresh on page 310 presents the types of changes to workstep properties that are allowed or not allowed during Process Refresh. The **Changes Allowed** column represents changes in workstep properties that will take effect immediately. The **Changes Effective At First...** column indicates that the changes will only take effect when a new process instance is created and the workstep is initially activated.

### Table 94: Changes Allowed/Not Allowed to Workstep Properties for Process Refresh

<table>
<thead>
<tr>
<th>Properties</th>
<th>Changes Allowed</th>
<th>Changes Not Allowed</th>
<th>Changes Effective At First Activation of Workstep</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td>Label</td>
<td>Name</td>
<td>Performer(^3), Presentation, Priority, Overdue in, Skippable, Collect Work Time, and Loop</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Description text</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Fields - Header panel</strong></td>
<td>Show Instructions, Show Priority, Show start date, Show due date</td>
<td></td>
<td>Instructions</td>
</tr>
<tr>
<td><strong>Fields - Fields section</strong></td>
<td>Label, Editable, Required, Format, Add, Modify, Remove, Move up, Move down for input/output dataslots(^4)</td>
<td>Name, Type</td>
<td></td>
</tr>
<tr>
<td><strong>Collaboration</strong></td>
<td>Collaborative Tasks created before Refresh(^5)</td>
<td>Notes, Reassign, Email and Instant Messaging. Also Collaborative Tasks created after Refresh.</td>
<td></td>
</tr>
<tr>
<td><strong>Alerts</strong></td>
<td></td>
<td>Alert updates</td>
<td></td>
</tr>
</tbody>
</table>

---

\(^3\) Cannot change from individual performer to group performer with ANY role. Cannot change group performer role from Any to All or All to Any.

\(^4\) When a process instance is activated for the Adapter and Subprocess worksteps, the output dataslots follow the original process. When the workstep is activated, it will follow the new, changed process.

\(^5\) After executing a Process Refresh, changes made in the process are not refreshed in Collaborative tasks that were created before the Process Refresh. Collaborative tasks created after a Process Refresh inherit the changes resulting from a Process Refresh.
### Properties

<table>
<thead>
<tr>
<th>Properties</th>
<th>Changes Allowed</th>
<th>Changes Not Allowed</th>
<th>Changes Effective At First Activation of Workstep</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced - Before</td>
<td>Wait for condition&lt;sup&gt;6&lt;/sup&gt;</td>
<td>Name, Rollback, Synchronization for Adapter and Subprocess worksteps</td>
<td>Activate on, Activate after, Skip Condition, Execute script</td>
</tr>
<tr>
<td>Advanced - On</td>
<td></td>
<td></td>
<td>Exclude performers, Send e-mail... for Activity worksteps</td>
</tr>
<tr>
<td>Activation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced - When</td>
<td>Execute script</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Completed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced - On</td>
<td>Overdue actions&lt;sup&gt;7&lt;/sup&gt;, Change performer and Complete workstep On Last</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overdue</td>
<td>Overdue actions&lt;sup&gt;7&lt;/sup&gt;, Change performer and Complete workstep On Last</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced - On</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error</td>
<td>Actions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced - On</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recovery</td>
<td>Execute script</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced - On</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Dataslot properties criteria

You can change only specific dataslot properties before running a Process Refresh.

**Table 95: Changes Allowed/Not Allowed to Dataslot Properties for Process Refresh** on page 311 represents the types of changes to dataslot properties that are allowed or not allowed during Process Refresh. The **Properties** column refers to the tabs and fields seen in a New Dataslot/Modify Dataslot dialog box.

**Table 95: Changes Allowed/Not Allowed to Dataslot Properties for Process Refresh**

<table>
<thead>
<tr>
<th>Properties</th>
<th>Changes Allowed</th>
<th>Changes Not Allowed</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Value&lt;sup&gt;8&lt;/sup&gt;</td>
<td>Name, Type</td>
</tr>
<tr>
<td>Default Format</td>
<td>Type, Label, Choices&lt;sup&gt;9&lt;/sup&gt;, Editable, Required</td>
<td>Scale and Precision in Numeric - DECIMAL dataslots, appendwith in CHARACTER dataslots</td>
</tr>
<tr>
<td>Access</td>
<td>Management Access, Tasks Column</td>
<td>Public, Global&lt;sup&gt;10&lt;/sup&gt;</td>
</tr>
<tr>
<td>Storage</td>
<td></td>
<td>Type, Size</td>
</tr>
</tbody>
</table>